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0.CVICENI

CIL

Vytvorit Sablonu pro dalsi kapitoly tutorialu, kterd bude obsahovat osy, roviny a parametry modelu.

EOKORYS

PREDPOKLADY

e ZADNE

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Vytvoreni nového modelu

v Tvorba pomocné geometrie
v’ Vytvareni parametrd modelu
v UloZeni Sablony

v Nastaveni vychozi Sablony
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Krok ¢.1 Vytvoreni nové Sablony

1. V nastrojove listé kliknéte na tlacitko O New @

2. V nabidce Type vyberte moznost [_IPart (viz obr.). Type Subtype

3. V nabidce Sub-type vyberte moznost Solid (viz obr.). :

. - , v .. {:} i Sketch @ Solid

4. Zadejte SABLONA jako nazev soucasti. ) Composite

5. Odskrtnéte tlaCitko Use default template (viz obr.). © [ Part ) Shestmetal

> Dialog tedy bude vypadat stejné jako na obrazku. O [T] Assembly ) Bulk

6. Potvrdte tlacitkem . O i, Manufacturing
i Dirawing
7 F Format
1 |E| Report
i L Diagram
i E| Layout
7 @ b arkuip
Mame SABLOMA,
Commaon Manme
[ Use default template

7. Vyberte z navt’)l'dky Sablon volbu Empty. [E] New File Options X

8. Potvrdte tlacitkem 2], T

emplate
|Em|:|ly | [ Browse... ]
uni_zolid_template
Farameters
Copy aszociated drawings
Krok ¢.2 Vytvoreni soufadného systému

!’ b g L] I:I Vs s . r T4 Ie v ve - - ra
> Nejprve si povSimnéte ikonek If /jaxi?e & v horni nastrojové listeé , které urcuji viditelnost pomocnych
rovin/pomocnych os/pomocnych bodii/soufadného systému/poznamek v hlavnim grafickém okné.

I » A
9. Aktivujte ikony |Z&llXEH
10. V bocni nastrojové listé kliknéte na ikonu
» Tim vlozite soufadny systém €SO do modelu. V hlavnim grafickém okné se zobrazi tento systém (viz obr.).

e

50
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Krok ¢.3 Vytvoreni pomocnych rovin NARYS, PUDORYS a BOKORYS

11.V boéni nastrojové listé kliknéte na ikonu /.
>  Systém nyni automaticky vytvori tfi roviny a ndm uz zbyva jen je pojmenovat.

' DileZité pro orientaci a dal3i praci v tomto tutorialu je pojmenovani jednotlivych pomocnych rovin a os PRESNE TAK, JAK
/ e 'y JETO UVEDENO NIZE.

L& J

» Roviny budeme pojmenovavat dle vyzna¢enych smé&rl souradného systému x,y,z.

> Pojmenujeme rovinu lezici ve smérech x a y jako rovinu PUDORYS (tato rovina tedy bude kolma na smér z)

12. Podivejte se kterd rovina je kolmda na smér z. (viz obr. vlevo)

13. Ve stromé kliknéte pravym tlacitkem mysi na tuto rovinu a z nabidky vyberte Rename (viz prostiedni obr.).
14. Prejmenuijte tuto rovinu na: PUDORYS (viz obr. vpravo).

DT ki1

[T SABLOMA PRT

230 [ SABLOMAA.PRT
£7 DML A 50
7 DTmz £7 DTML
£F DTMZ
& Irser  DoCe £7|PupoRys |
Group & Insert Here
SuUppress

> Tentyz postup budeme opakovat u dalsich dvou rovin.

> Pojmenujeme rovinu lezici ve smérech y a z jako rovinu BOKORYS (tato rovina tedy bude kolma na smér x)

15. Podivejte se kterd rovina je kolma na smér x. (viz obr. vlevo)

16. Ve stromé kliknéte pravym tlacitkem mysi na tuto rovinu a z nabidky vyberte Rename (viz prostfedni obr.).
17. Pfejmenuijte tuto rovinu na: BOKORYS (viz obr. vpravo).

:I SABLOMA PRT :l SABLOMAPRT
A0 HxCs0
7 DML 77|eokoRys T
/7 DTM2 L7 pThz
£F PUDORYS
Delete % Inserk Here
Group
Suppress

»  Zbyvajici rovina kolma na smér y se bude jmenovat NARYS.
18. Ve stromé kliknéte pravym tlacitkem mysi na zbyvajici rovinu a z nabidky vyberte Rename (viz prostfedni obr.).
19. Pfejmenujte tuto rovinu na: NARYS (viz obr. vpravo).

[ SABLOMA PRT :l SAELCMA.PRT
2050
£ F BOKORYS
F7|MsRvs T
Delete £ F PUDORYS
P Insert — & Insert Here
Suppress




Krok ¢.4 Vytvoreni pomocnych os OSA_X, OSA_Y a OSA _Z

> Nyni vytvofime tfi osy a nazveme je OSA_X, OSA_Y a OSA_2Z.
» Nazvy os budou korespondovat se sméry soufadného systému.
F

20. V bocni nastrojové listé kliknéte na ikonu /.

>  Osu vytvoFime tak, Ze vybereme dvé roviny, jejichZ je tato osa priseénici.
> Nejprve vytvoiime osu OSA_X jako prlsecnici rovin NARYS a PUDORYS.

21. Kliknéte levym tlacitkem na rovinu NARYS.

22. Drzte CTRL a kliknéte levym tlacitkem na rovinu PUDORYS.
23. Kliknéte v dialogu DATUM AXIS na zalozku Properties.

24, Zde prejmenuijte vytvarenou osu na OSA_X (viz obr. vpravo).
25. Potvrdte tlatitkem L2 ],

EOKORYS

B DATUM AXIS X]
Flacement | Display | Properties
References

MARYS:FIDATUM P... Through
FUDORYS:F2DATU...  Through

Offset references

= DATUM AXIS (X
Placemert | Display | Froperties
Mame (0549 | i]
»  Nyni vytvofime osu OSA_Y jako prisecnici rovin BOKORYS a PUDORYS. B DATUM AXIS rs-—(l

26. V bocni nastrojové listé kliknéte na ikonu < .

27. Kliknéte levym tlacitkem na rovinu BOKORYS .

28. Drzte CTRL a kliknéte levym tlacitkem na rovinu PUDORYS.
29. Kliknéte v dialogu DATUM AXIS na zélozku Properties.

30. Zde prejmenuijte vytvarenou osu na OSA_Y (viz obr. vpravo).
31. Potvrdte tlagitkem L3,

BOKORYS

Flacement | Dizplay | Properties
References

BOKORYS:F1[DATU...  Through
PUDORYS:F2DATU...  Through

Dffzet references

® DATUM AXIS X

Placement | Display | Properties

Name 054 T ]




>  Nyni vytvofime osu OSA_Z jako prisenici rovin NARYS a BOKORYS.

32. V bocni nastrojové listé kliknéte na ikonu '/ .

33. Kliknéte levym tlacitkem na rovinu NARYS .

34. Drzte CTRL a kliknéte levym tlacitkem na rovinu BOKORYS.
35. Kliknéte v dialogu DATUM AXIS na zalozku Properties.

36. Zde prejmenuijte vytvarenou osu na OSA_Z (viz obr. vpravo).

37. Potvrd'te tla&itkem 3K,

B DATUM AXIS 3
Flacement | Displap | Propertiss
References

BOKORYS:F1DATU...  Through
MNARYS:FIADATUM P... Through

Oftzet references

Flacement | Display | Properties
Name |054_7 ﬂ

> Timto jsme vytvorili prvni ¢ast Sablony, kterou tvofi pomocné prvky.

BOKORYS

FUDORYS
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Krok ¢.5 Vytvoreni pohled(

» Vytvofime standardni pohledy NARYS, BOKORYS, PUDORYS, PRAVY, DOLNI a ZADNI.

A+ .
38. Spustte prikaz “* Reorient.
39. V dialogovém okné Orientation vyberte Orient by reference.
> Nyni se vas systém pta na zadani dvou referenci pro orientovani modelu.

40. Reference 1: vyberte Front (predni) a vyberte rovinu NARYS.
41. Reference 2: vyberte Top (hornl'i a vyberte rovinu PUDORYS.
Save

42. Novy pohled ulozte tlacitkem

BOKORYS

FUDORYS

MNARY'S

pod ndzvem NARYS (viz obr. vpravo).

X

B Orientation

Type
Options
Referance 1
Frant <

E] NARYS:FIDATUM PLANE]

Reference 2
Top w
PLDORYS:FADATUM PLANE]

Standard Orientation
Default Orientation

Mame |MARTS
[ Set ] [ Save ] [ Delete]
l Ok ] [ Eancel] [ Unda ]

>  Nyni vytvofime pohled BOKORYS.

43, Kliknéte na i a zadejte reference:

44. Reference 1: vyberte Front (predni) a vyberte rovinu BOKORYS.
45, Reference 2: vyberte Top (horni) a vyberte rovinu PUDORYS.

46. Novy pohled ulozte tladitkem [_2ave

EORORYS

FUDORYS

MNARYS

pod nazvem BOKORYS (obr. vpravo).

B Orientation

Type

Orient by reference W

Optionz

Reference 1
Frant “
BORORYS:FZDATUM PLAME]
Reference 2
Top v
PUDORYS:F4DATUM PLAME]

Standard Orientation
Default Orientation
MARYS

Mame |BOKORYS
[ Set ] [ Save]

[ Delete ]

[ ak. ] [Eancel] [ Idrdo ]
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> Nyni vytvofime pohled PUDORYS.

47. Kliknéte na i a zadejte reference:

48. Reference 1: vyberte Front (predni) a vyberte rovinu PUDORYS.

49, Reference 2: vyberte Bottom (dolni) a vyberte rovinu NARYS.
&

50. Novy pohled ulozte tlacitkem pod nazvem PUDORYS (obr.

EOKORYS

MNARYS

FUDORY S

vpravo).

B QOrientation

Tepe

Orient by reference w

Options

Reference 1

Frant A
PUDORYS:F4DATUM PLANE]

Reference 2

Battarm b
HARYS: FDATUM PLAME]

Standard Onientation
Drefaulk Orientation
BOKORYS

MARYS

Mame |PUDORYS
[ Set ] [ Save]

[ Delete ]

[ 0k, ] [Eancel] [ IUndo ]

> Nyni vytvofime pohled DOLNI.

51. Kliknéte na i a zadejte reference:

52. Reference 1: vyberte Back (zadni) a vyberte rovinu PUDORYS.

53. Reference 2: vyberte Bottom (dolni) a vyberte rovinu NARYS.
h

54. Novy pohled ulozte tlacitkem

FUDORYS

MNARY S

BOKORYS

pod nazvem DOLNI(viz obr. vpravo).

B Orientation

Type

Orient by reference -

O ptions

Reference 1
Back w
UDORYS:FADATUM PLANE]

Reference 2
Top w

E] NARYS:FIDATUM PLANE]

w Saved Views

Standard Orientation
Drefault Orientation
BOKORYS

MaRYS

PUDORYS

Mame | DOLMI
[ Set ]

[ Save ] [ Delete]

[ ]9 ] [Cancel] [Llnu:h:u]
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> Nyni vytvofime pohled PRAVY.

55. Kliknéte na i a zadejte reference:

56. Reference 1: vyberte Front (predni) a vyberte rovinu BOKORYS.
57. Reference 2: vyberte Top (horni) a vyberte rovinu PUDORYS.

58. Novy pohled ulozte tlacitkem

BOKORYS

pod nazvem PRAVY(obr. vpravo).

PUDDRYS

NARYS

B Orientation

Type

Orient by reference w

Option:

Reference 1
Frant W
{DKORYS:F2[DATUM PLANE)

Feference 2
Top W

UDORYS:F4DATUM PLANE]

Standard Ornientation
Drefault Orientation
BOKORYS

MNARYS

PUDORYS

Mame |PRAYY
[ Set ] [ Save] [Delete]

[ []:4 ] [Eancel] [UndD]

> Nyni vytvofime pohled ZADNI.

59, Kliknéte na i a zadejte reference:

60. Reference 1: vyberte Back (zadni) a vyberte rovinu NARYS.

61. Reference 2: vyberte Top (horni i a vyberte rovinu PUDORYS.
Save

62. Novy pohled ulozte tlacitkem

pod nazvem ZADNI(viz obr. vpravo).

BOKORYS

FUDDRYS

NARYS

B Orientation

Type

Orient by reference w

Reference 1
Back A
NARYS:F3DATUM PLANE)
Reference 2
Top w

UDORYS:FADATUM PLANE]

Standard Orientation
Default Onentation
BOKORYS

DOLMI

MHARYS

PRAWY

PUDORYS

Mame | ZA0MNI
[ Set ] [ Save] [Delete]

[ 1]9 ] [Eancel] [Llnu:h:u]
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Krok ¢.6 Vytvoreni standardnich parametr modelu

» Parametry modelu slouzi k uchovavani dat tykajici se soucasti. Tyto data Ize nasledné nacist pfimo do razitka vykresu,
razitko se tak z velké Casti nevypliiuje ru¢né, coz ma fadu vyhod:

o Urychleni prace

o Automaticka aktualizace dat

o Uchovani stejnych dat v modelu i ve vykrese
> Nyni si pfipravime standardni parametry, které se pouzivaji zejména v razitku vykresu.
63. V nabidce Tools vyberte piikaz Parameters...
> Otevre se prazdné dialogové okno Parameters. (viz obr.).

B Parameters

File Edit Parameters Tools Show
Loak In

[ Pat v | (] 5ABLONA v|

Fiter By | Al v|

M arme Type Walue [Deszignate  Access Source Dezcrig

< | >

] A
Ok Rezet Cancel

64. Kliknéte na tlacitko .

65. Do kolonky Name vypliite nazev parametru: POZICE.

66. V kolonce Type vyberte typ parametru Integer (tzn. Ze obsah parametru bude celé nezaporné Cislo).
67.V kolonce Value nechte v rdmci Sablony hodnotu 0.

>  Ostatni kolonky nechame beze zmény.

»  Tim jsme vytvofili prvni parametr, ktery bude obsahovat &islo pozice modelu v sestavé a mizeme pokracovat
nadefinovanim dalsiho parametru.

B Parameters

File Edit Parameters Tools Show

Look In
Part v ‘ (JSABLONA v
Filter Ey | & v
Harne Type Yalue Dezignate | Access Source Description Restricted | Unit

POZICE Integer 0 O Beful . serDeii |:|

E I ik W |[ Fropertiez. .. ]@
Ok Reset Cancel




68. Kliknéte na tlacitko .

69. Do kolonky Name vyplite nazev parametru: AUTOR.
70. V kolonce Type vyberte typ parametru String (tzn. obsah parametru bude textovy).
71. Kolonku Value nechame v ramci Sablony prazdnou, tu budeme vypliovat az v jednotlivych modelech.

> Tim jsme vytvorili dalsi parametr, ktery bude obsahovat jméno autora modelu.

B Parameters

9=]E3

v

File Edit Parameters Show
Look In
[Pat v ‘ CISABLONS,
Filter By | Al |
Mame Type Walue Dezignate | Access Saurce Dezcription. Restricted | Unit
POZICE Integer 0 O EllﬁlFuII .. UserDefi...
AUTOR String ] E"lﬁhFuII . UgerDefi.. I:l ‘

[+]=)

GET

w |[ Properties... ]@

Ok Rezet Cahcel

» Nyni vytvofime parametr C_HMOTNOST, tento parametr bude vzdy obsahovat Cistou hmotnost soucasti.

72. Kliknéte na tlacitko .

73. Do kolonky Name vyplite nazev parametru: C_HMOTNOST.
74.V kolonce Type vyberte typ parametru Real Number (tzn. obsah parametru bude realné Cislo).

75. Uzavrete dialogové okno Parameters tlacitkem ok ],

B Parameters

CEX

Fil= Edit Parameters Tools Show
Look, In
| Part v|||jSAELDNA v/
Filter By | &l v
MHame Type Y alue Desighate | Access Source Description Restricted |~ Unit
POZICE Integer 0 L @oFul .. UserDei
AUTOR Stiing O @aful . UserDefi. A
C_HMOTNOST RealNumber 0000000 O Beful . Usereli |:|

[+]=]

| [LET

“ |[ Properties. .. ] @

Ok Reset Cancel




> Nyni si ukazeme, jak Ize vytvorit tzv. relaci, pomoci které se pfi kazdé regeneraci modelu pfifadi vypoctena hodnota cisté
hmotnosti do parametru C_HMOTNOST.

76. V nabidce Tools vyberte prikaz Relations...

» Otevre se prazdné dialogové okno Relations. (viz obr.).
77. Do tohoto okna napiste relaci: C_HMOTNOST=PRO_MP_MASS (viz obr.).

78. Uzaviete dialogové okno tlacitkem Cox ],

CEX

B Relations
File Edit Insert Parameters Ukilities  Show
Look In

[ Part I “

w Felations

oo Y B B X 802 [ fx

+ | c_hmothost=pro_mp_mass

(02 B

Imitial b

p Local Parameters

Ok [ Reset ][ Cancel ﬂ

» . Dle starsiho zplsobu Ize také do relaci pridat tento vyraz pro pocitani Cisté hmotnosti:
L) c_HMOTNOST=CEIL(MP_MASS(""),3)

> Opét zobrazime dialogové okno Parameters a dodefinujeme zbyvajici parametry.
79.V nabidce Tools vyberte pfikaz Parameters...
80. Nadefinujte stejnym postupem (viz body 68-71) zbyvajici parametry dle obrazku.

& Parameters

File Edit Parameters Tools Show

Look In
[ Pat V||JSMLDM v|
Filter By | Al v|
Marme Type Walue Designate | Access Saurce Description’ Restricted  Unit
AUTOR
C_HMOTNAST
CISLO_SEST Stiing O E'Et,'-Full - UserDefi..
CISLO_ vk String E',ﬁ'FU" - UserDefi..
CSM String E'@Full - UserDefi..
HR_HMOTMOST  Shing E'@Full - UserDefi..
MAT_KOM Stiing E‘.ﬁ-Full - UserDefi..
MAT_WCH Stiing E'Et,'-Full - UserDefi.. Y
NAZEY String O E',ﬁ'FU" - User-Defi...
POZMAMES String O E'@Full - User-Defi...
PUWVODMI_MAZEY  Shing puvodni nazew O E'@Full - User-Defi...
ROZMER Stiing E‘.ﬁ-Full - UserDefi..
TECH_CISLO Stiing O E'Et,'-Full w UserDefi..
TYP String O E',ﬁ'FU" o User-Defi..
T_00P String E'@Full - UserDefi..

|Main V| Froperties... @
Ok [ Reset ][ Cancel ]I
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Krok ¢.7 Ulozeni Sablony

>  Sablonu uloZime jako bé&Znou soudast tj. do souboru sablona_solid.prt.

> Je vyhodné ulozit Sablonu do slozky, ktera je uvedena v nastaveni systému ProEngineer. Tento postup si nyni ukazeme.
81.V nabidce File spust'te pfikaz Save a Copy...

82. Vyberte adresar se Sablonama (napf.Skolni nastaveni na disku c:
c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\)

> Pokud nevite ve kterém adresafi mate ulozeny $ablony, kouknéte se do kroku ¢.8, kde je popsana cesta k témto soubortim
v nastaveni systému ProEngineer.

> Mdzete si také vytvofit vlastni adresai s nastavenim ProEngineera a do né&j $ablonu ulozit.

83. Do kolonky New Name napiste SABLONA_SOLID .
84. Potvrd'te vybér adresare kliknutim na Lok,

B Save a Copy

X)

e

- |I:| « [C:] ¥ ptc » pro_cz_Wildfire ® uni-nastaveni ® template_uni k v|¢j‘| |Search... |

- :/. .\:- A

.JJ' Organize w S "T'r Tonls
Commaon Folders CJad
:ﬂ Dezktop [ start_part_sheetmetal prt
75 My Documerts [ 1 uni_solid_template. prt

|°j wharking Directany
Metwork Meighborbood

MNew Mame | SaBLOMA_SOLID

@ Favarites

Folder Tree -

Model Name |S4BLONA.PRT |
|

Tupe | Part [*.prt) w |




Krok ¢.8 Nastaveni vychozi Sablony

85. V nabidce Tools spust'te piikaz Options.

86. V levém sloupci najdéte template_solidpart a kliknéte na tento fadek (viz obr.).

> V kolonce Value najdete soucasnou vychozi Sablonu, kterd je nastavena v systému ProEngineer.
87. Kliknéte na tlacitko [Browse...],

88. Vyberte Sablonu sablona_solid.prt a potvrdte [ Open T,

89. Potvrd'te provedeni zmén a poté Cox ],

Options g|
Shiowing: Sark:
C:\Pragram Files\Ptchproghwildfire 4.0%exthvconfig. pra b Alphabetical w
W alue Status  Description
f/’ sypzter_edge_high_color o1o0i00 F: Defines default edae highlight color. The thiee #
f/’ tangent_edage_display dirmmed & Determines how edges between tangent surfac
f/’ template_designazm c:hptchpro_cz_Wwildfirehuni-nastavenisterplate_unibuni_soli.. & Specifies the designated template azsembly. L:
2 template_drawing chvptehpro_cz_Wildfirehuni-nastavenivtemplate_unituni_ad... Specify the drawing uged az the default drawin
f// template_mfgcast chptehpro_cz_wildfireuni-nastavenitkemplate_uniunitool... g Specify the model uzed as the default manufac
f/’ template_mfgmold c:hptchpro_cz_Wildfirehuni-nastavenisternplate_unibunimmn... g Specify the model uzed as the default manufac
f/’ template_sheetmetalpart chptehpro_cz_Wildfireuni-nastavenitkemplate_unisanimme,.. g
wfildfireun enittemplateunitunisoli_J 3 | | L

f/’ thermio_poszition_hint no_window_overlap F: Enables wou to pogition the thermometer-type @
f// tiff_compression hone & TIFF exports are done without compression,
f/’ Hiff_type mano & Determities the type of Liff iterms are exported to
Z tol_display yes & Dizplays dimengions with or without tolerances.
f// tol_mode naninal & Sets the tolerance mode of newly created dime
25 telerance standard iz0 E- Sets the tolerance standard uzed when creatin ™

< PR >

Option: alue:

ternplate_solidpart chptehpro_cz_Wildfire\uni-nastavenibternplate_unisuni_solid_template.prt.

Krok ¢.8 Nastaveni jednotek a hustoty

90. Kliknéte v menu Edit na prikaz Setup.
» Zobrazi se Menu manager s nastavenim modelu.

Menu Manager

91. Vyberte polozku Units. w PART SETUP
92. Vyberte mérnou soustavu milimeter Kilogram Second a potvrdte LX) Material
93. Zavrete dialogové okno Units Manager. Accuracy
> Pii zméné systému jednotek se nas ProEngineer zepta, (N Manager x|
zdali chceme stavajici rozméry prepocitat nebo — Mame
zachovat Cislice a zménit jen jednotky. (obr. vlevo) st Unit -
petems of nits | Units Mass Props
Centimeter Gram Second [CGS) Dim Bound
Foot Pound Second [FPS) )
B Changing Model Units @ Inch Ibm Second [Pro/E Default) Shrinkage
Inch Pound Second [IPS) Grid
Model | Parameters Meter Kilogram Second [MES]
millirmet gram [ ] Tal Setup
millimeter Mewton Secol
Interchange
! 3 Changing model units Ref Control
Designake
(®) Convert dimensions [for example 1" becomes 25.4mm) Flesdhil
) Interpret dimensions [for example 1" becomes 1mm)] Diesenptian Y
\@millimeter Kiloaram Sec [mmk.s) Done
Length: mm. Mass: kg, Time: zec, Temperature: C

Standardné se pouziva soustava mmKs. MlZete pouZit i jinou, ale je dileZité védét v jaké soustavé pracujete zejména
pfi zadavani hustoty nebo napfiklad pfi pocitani FEM analyzy.
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94, Kliknéte v Menu Manageru na Mass Props.

95. V dialogu do polozky Density napiste hustotu 0.0000078500 dle obrazku. Menu Manager
96. Potvrdte tlatitkem a poté Done. ¥ FART SETLR
Material
Accuracy
B Setup Mass Properties E| Linits
Source Mame
Geometry
Origin Dirn Bound
[IH Default V| Shrinkage
arid
Drensity Tol Setup
0.000007E500 | Interchangs
Achons Ref Control
Designake
Flexibility
Done

a POZOR! Zalezi na zvolenych jednotkach. Hustota oceli 7850kg/m? = 0,0000078500kg/mm?, ale bude se Fadové lisit

L8N pouzivate-li jiny systém jednotek (napf pro mmNs je tato hodnota desetkrat vyssi).

> To je vSe, pokud nyni vytvorite novy Part a nechate zaskrtnutou volbu Use default template, pouzije se tato vychozi
Sablona, kterou jsme vytvorili.

» Tuto Sablonu budeme pouZivat v nasledujicich tutorialech.

B New le

Type Sub-tppe
O i Sketch ® Salid
) Composite
Part
o () Sheetmetal
O O] Assembly O Bulk
O i, Manufactuing
O Diawing
@) F ] Fomat
O [ Repart
(O =E Diagram
C E| Lapout
O @ b arkup
Hame prt0ooT
Comman Mame
Idge default ternplate
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PRILOHA  Vypis konfigurac¢niho souboru config.pro

>  Prilozeny vypis souboru config.pro, ktery najdete nize, mizete zkopirovat jako Cisty text, vlozit jej do prazdného souboru,
soubor pojmenovat config.pro a nahradit stavajici soubor config.pro Tools spustite prikaz Options , ktery je obvykle
uloZzeny v C:\Program Files\Ptc|proeWildfire 4.0\config.pro.

Pdvodni soubor config.pro si pred prepsanim pro jistotu zalohujte.
: ]

> Vzhledem k rozsahlosti konfigura¢niho souboru neni u kazdé rfadky pfipsana napovéda. Tuto napoveédu naleznete pfimo v
systému ProEngineer, pokud provedete nasledujici kroky.

97. Spust'te v menu Tools spustite prikaz Options.

98. V nabidce Sort vyberte moznost As Set.

> V menu Description pak najdete podrobnou napovédu ke kazdému radku konfiguracniho souboru.

Options E|
Showing: Sart;
C:\Program Files\Ptchprogiwildfire 4. 04exthconfig.pro W Az Set W
v alue Statuz | Description
C:\Program Fi etafildfing 4.1 i
‘é‘f start_madel_dir chptchpro_. g Frovides the complete path to the directon containing start parts and assemblies.
2 intf3d_out_default_option zolid i Controlz the type of 3-00 data output through Pro/BATCH to an IGES or STER file.
E comment |
@ comment == EOMFIGURACKI SOUBOR COMFIG.FRO i
@ comment I == 5K0TOOLS ZCU PLEEM - KES i
@5 comment =18 2/05 Hynek created + klavesove zkratky - font ™
E comment |
E comment |
@ comment | s LOMFIGURACE Pro/ENGIMEERU
E comment |
@ comment | =*PROSTREDI™*
54 bell nao ® & Yz - Tums on the keyboard bell that rings after each prarpt. Mo - Turns off the kevba
% grid_snap nio* & res - Makes pick points shap to a grid. Mo - Tums the grid snap off o that any locatior
54 clock yes @ Yesz - Displays the clack while Pro/EMGIMEER iz warking.
@5 comment !
9¢ pro_unit_length unik_mm & Sets the default units for new objects.
9¢ pro_unit_mass unit_kilogram g Sets the default units for mazs for new objects.
9¢ pro_unit_sps TAMNS & Specifies the default spstem of units for new models.
@5 comment !
% accuracy_lower_bound 1.0e-B @ Enter an accuracy value to averride the default lower limit. The minimum value for relat
5:( linear_tal 0.om & An alternate format far setting default near tolerance dimensions. First value sets the m
54 clr_print_plus_minusz nio* & Setz the display of the spztem accuracy when caloulating clearances bebween bwa parl
54 default_dec_places 2 & Sets the default number of decimal places [0-14] ta display in all model modes for non-a
< € >
Optian: Walue:
| v




start_model_dir c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\
intf3d_out_default_option SOLID

| RRRRRRRRRRRRR KONFIGURACE Pro/ENGINEERU
!

| ¥**pPROSTREDI***

bell NO

grid_snap NO

clock YES

|

I Nastaveni jednotek systemu
pro_unit_length unit_mm
pro_unit_mass unit_kilogram
pro_unit_sys MMNS

|

IPresnost vypoctu geometrie
accuracy_lower_bound 1.0e-6
linear_tol 0.01
clr_print_plus_minus NO
IPocet desetinnych mist u kot
default_dec_places 2
sketcher_dec_places 3
parenthesize_ref_dim yes
tolerance_standard ISO
tol_display yes

tol_mode nominal
visible_message_lines 3
kbd_cmd_abbreviation OFF

I INFORMATION_WINDOWS BLOCKING
keep_info_datums NO
summary_help YES

|

create_numbered_layers NO
provide_pick_message_always yes
button_name_in_help YES

!

axis_display YES
ISET_MENU_WIDTH 17

| *HXPRVKY***
feature_create_auto_ok YES
feature_create_auto_begin YES

| ***ZOBRAZENI***
orientation user_default

spin_control drag

I

display shade

thermo_position_hint no_window_overlap
color_windows ALL_WINDOWS
shade_windows ALL_WINDOWS

!

number_user_colors 30
system_curves_color 0 100 0
system_edge_high_color 0 100 100
I

shade_with curves
show_shaded_edges NO
spin_center_display no

I

dim_offscreen_limit 1.1
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ISAVE_TRIANGLES_FLAG YES

| FXKVYKRES***
allow_move_attach_in_dtl_move YES
selection_of_removed_entities yes
switch_dims_for_notes NO

plotter_command print

Iplotter_command pro WIN s celou cestou: print /D:(cesta na plotr)
Iplotter_command pro UNIX " Ip

delete_after_plotting YES

plotter Standard

| ¥*x*DATABAZE**
menu_show_instances no
intf_in_blanked_entities NO
intf_out_blanked_entities NO

I

rename_drawings_with_assem YES
rename_drawings_with_object BOTH
save_display no

save_objects changed
save_object_in_current YES
override_store_back YES

I

relation_file_editor PROTAB
drawing_file_editor PROTAB

I

company_name ZCU v Plzni

| ®kxdokokxokkkk Konfiguracni soubory

drawing_setup_file c:\ptc\pro_cz_Wildfire\uni-nastaveni\config\set.dtl

train_file_path c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\

trail_dir d:\Tmp

pro_texture_library c:\ptc\graphiclib\graphic-library\

pro_format_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni\formaty

pro_group_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni\udf

pro_symbol_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni\symboly

pro_library_dir c:\ptc\

pro_material_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni\material

pro_surface_finish_dir c:\ptc\pro_cz_Wildfire\uni-nastaveni\symboly\drsnosti\
symbol_instance_palette_file C:\ptc\pro_cz_Wildfire\uni-nastaveni\symboly\paleta_symbolu.drw
I

| Fpkrokkrokkkkk startovaci soubory s nastavenimi

template_designasm c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\uni_solid_template.asm
template_drawing c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\uni_a4_det.drw
template_mfgcast c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\unitoolmmns_mfg_cast.asm
template_mfgmold c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\unimmns_mfg_mold.asm
template_sheetmetalpart c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\unimmns_part_sheetmetal.prt
template_solidpart c:\ptc\pro_cz_Wildfire\uni-nastaveni\template_uni\uni_solid_template.prt

bom_format c:\ptc\pro_cz_Wildfire\uni-nastaveni\config\kusovnik.fmt
pro_note_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni\poznamky

browser_favorite d:

penl_line_weight 4

pen2_line_weight 2.

pen3_line_weight 2.

pend_line_weight 2.

pen5_line_weight 2.

sim_pp_background_color proe

pro_colormap_path C:\ptc\graphiclib\graphic-library\color_maps\plastic.map
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search_path d:\Tmp

system_colors_file C:\ptc\pro_cz_Wildfire\uni-nastaveni\syscol.scl
mass_property_calculate automatic
max_animation_time 0.2

mdI_tree_cfg_file C:\ptc\pro_cz_Wildfire\config\model_tree.cfg
menu_font helvetica,bold,10

menu_translation yes

model_tree_start yes

modelcheck_enabled no

msg_translation yes

multiple_skeletons_allowed yes
new_parameter_ui yes

new_relation_ui yes
open_simplified_rep_by_default no
open_window_maximized no

plot_names yes

popuphelp_font helvetica,bold, 10
pro_dtl_setup_dir C:\ptc\pro_cz_Wildfire\config
pro_font_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni
pro_plot_config_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni
ps_output_with_pagesize no

query_bin_start yes

raster_plot_dpi 300

reserved_menu_space 1
save_drawing_picture_file embed
save_model_display shading_low
show_geom_checks_on_creation yes
show_preview_default keep
sketcher_animated_modify no
spin_with_part_entities yes

step_export_format AP214_CD
tangent_edge_display dimmed

tiff_compression none

tiff_type mono

tolerance_table_dir C:\ptc\pro_cz_Wildfire\uni-nastaveni\tol_tables\iso
variable_plots_in_inches no

vrml_explode_lines no

web_browser_homepage http://www.kks.zcu.cz
web_enable_javascript on
www_export_geometry_as jpg_vrml

x_angle -120

y_angle 200
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CVICENI I

Osvojit si zaklady tvorby komponentt v systému PRO/ENGINEER na ukazkovém pfikladu tvorby jednoduché soucasti
sita mlynku na maso.

e znalost zaklad( systému pospsanych v tutorialu UVOD
e Pfipravena Sablona ze cviCeni 0.

Protazeni (Extrude)

Dira (Hole)

Pole typu Fill (Pattern)
Srazeni hran (Edge Chamfer)

AN




Krok ¢.1 Vytvorit novou soucast

1. V néstrojové 2 Kiiknéte na tiaditko L. )
2. Vyberte Part v otevieném dialogu (viz obr.). Tupe Subtype
. . v . O i Sketch ® Solid
3. Zadejte nazev soucasti: SITKO. ®0 Pat © Composie
4. Zkontrolujte, zdali je zapnuta volba Use default template. _ 9 SieEmet
’ Y :! Azzembly O Buk
5- POtVI‘d'te t|aCItkem . O ﬂ I anufacturing
Y Drawing
‘ V nézvech soubord nepouzivejte diakritiku ani specialni znaky. O [ Fomat
{ e ) Potfebujete-li v nazvu souboru mit mezeru, pouZijte podtrzitko “_". O [@ Repot
O -C Diagram
Y E| Layout
Y @ Markup
Marne sitko
Caommon Mame
oy
w V systému PRO/ENGINEER lIze k potvrzeni pouZivat prostfedni tla¢itko mysi. Use default template
Krok ¢.2 Protazeni obrysu sitka (Extrude)
i . v .| v . vy
6. Kliknéte na ikonu protazeni ™ Extrude v boCni nastrojové listé.
> Nejprve vytvorime skicu (sketch).
7. Zacneme kliknutim na Placement a [_oefre. ],
Sketch
| = Select 1 item |[ Define... ]
E[T] Flacement  Optionz  Properties
O[3 |4k~ (285 ] % C 1 X

8. Vyberte rovinu (napf.PUDORYS) klepnutim levym tlacitkem mysi v hlavnim okné nebo ve stromé.
> Na této roviné bude lezet skica (sketch), kterou vytvorime.
9. Kliknutim na tlacitko se prepnete do rezimu skicare (sketcher).
o V dialogovém okné Sketch Ize zménit smér pohledu na skicu, ktery je zobrazen Zlutou Sipkou, kliknutim na Flip

1 Kliknutim do pole Reference, oznacenim roviny a jeji orientace v rozbalovacim seznamu Orientation vyberete
referencni rovinu, ktera slouzi k natoceni skici do poZadované polohy.

Placement

Sketch Plane
Plane | PUDORYS:H

Sketch Orientation ‘
Sketch view direction
Reference | BOKORYS:F1(DATUM... |

Orientation | Right v | \




10. Pro lepsi prehlednost ve skicafi vypnéte zobrazeni pomocnych prvk( deaktivovanim téchto ikon v horni nastrojové
listes: L3 /e % ¥ TR

11.V bocni nastrojové listé vyberte o) pro vytvoreni kruznic a vytvoite dvé kruZnice s poCatkem ve stfedu souradnic.

12. Upravte automaticky vytvorené koty proimérd kruznic na 53mm a 8mm.

13. Rezim skicare ukondite kliknutim na ikonu ¥ v boéni ndstrojové listé.

.
\1) Potvrzeni vytvoreni kruznice vzdy levym tlacitkem mysi. Ukonceni pfikazu prostfednim tlacitkem mysi.

S
|
|
|
I
|
|
I
|
|
I
|
_CES LS

> Velikost protazeni Ize nastavit upravenim kéty v hlavnim okné nebo prepsanim rozméru v dialogové listé.
14, Prepiste velikost protazeni na 5mm.

E[’T’J

B

Flacement  Options  Properties

[=] 7= S e A N Fso [v]

V systému PRO/ENGINEER obvykle nelze pouZivat tla&itko ZPET, proto svou praci pravidelné ukladejte, abyste se
pfipadné mohli vratit k drivéjsi verzi souboru.

Jak MANIPULOVAT S MODELEM se dozvite v dokumentu UVOD.

@ Vice informaci o prvku PROTAZENI viz dokument PROTAZENI.




15. Kliknéte na ikonu protazeni @' Extrude.
16. Umistime budouci skicu (Sketch) kliknutim na Placement a [ e ],

17. Vyberte rovinnou plochu pravé vytvoreného télesa a kliknéte na tlacitko pro prepnuti do skicare.

PUDORYS

Sketch Plane

Plane | Su FR(EXTS [.Use Previous |
Sketch Orentation
Sketch view direction [ Fiip |

Reference | BOKORYS:F1(DATUM...|
Orientation | Right .
[Sketch ] [(Cancel ]

18. Kliknutim na ikonu ©, vybranim vnéjsi hrany modelu (p@lkruznice, na obrazku modre) docilime promitnutim této
hrany do skicare.

. Hrana promitnuta pomoci pfikazu Use se automaticky modifikuje, paklize se zméni rozméry plvodniho té&lesa. Funguje
Q) zde vztah RODIC-POTOMEK (PARRENT-CHILD), kdy promitnutad hrana a tudiz i cely prvek protazeni, ktery pravé
vytvafime je potomkem plvodniho prvku protaZeni, ktery jsme vytvareli v kroku ¢&.2

19. Kliknéte na © a vytvorte kruznici o prdméru 3.5mm se stfedem na svislé ose se vzdalenosti od stfedu soufadnic
25.5mm

-

& V systému PRO/ENGINEER se nepouzivaji desetinné ¢arky, Cili ¢islo 25,5 je nutno zapsat 25.5
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20. Pro lepéi prehlednost ve skicafi prepneme zobrazeni modelu na dratovy model, klepnéte na ikonu = a ujistime
. , , o o N J M % O o,
se, zda mame vypnuto zobrazeni pomocnych prvku tj. zda jsou ikony L3 fax% 7% & deaktivovany.
21. Priblizte pohled na kruznici, kterou jste pravé vytvofili pomoci pfikazu “ Zoom In.

22, P¥ikazem  Line vytvorime dvé Usecky nasledujicim postupem:

o Prvni bod usecky (viz obr. vlevo) vytvofime tak, aby se zobrazily dvé ¢ervené vodorovné carky znacici

geometrickou vazbu , ktera zajisti, aby dva body byly ve stejné vysce ve vertikalnim sméru.
o Druhy bod Usecky (viz obr. vpravo) vytvorime tak, aby se zobrazilo pismeno T znacici geometrickou vazbu

tecnosti kruznice a nové vytvarené Usecky.
o Druhou usec¢ku vytvorime obdobnym zplsobem jako prvni Gsecku.

/ 3.500 / 3.500

Geometrické vazby Ize dodat také dodatecné po vytvoreni geometrie, pfistup k geometrickym vazbam je pod ikonou H

PFi vytvareni skic je Casto vyzadovano, aby skica byla tvofena uzavienou smyckou, pro zjednoduseni hledani
nespojenych bod{ je vyhodné aktivovat ptikazy Shade Closed Loops a Highlight Open Ends v nabidce
Sketch->Diagnosis. Tyto piikazy po aktivovani zlstavaiji spustény aZ do ukonéeni systému PRO/ENGINEER.

© <

23. Pomoci prikazu ¥ Delete segment |ze jednoduse odstranit Casti Usecek, kruznic apod. tak, aby zlstala ve

skicarfi pouze jedna uzaviena smycka (viz obr. vpravo).

i Na obrazku vlevo je vidét funkce pfikazu Highlight Open Ends, ktery v problémovych mistech zobrazi Cervené tecky.
' Na obrazku vpravo je pak vidét funkce pfikazu Shade Closed Loops, ktery vybarvi uzavienou smycku Sedivou barvou.

o 0]
\l/ Pomoci tlacitka "&  natocite pohled kolmo na skicu.

3.500
P

»_

-@T Tam - -—l_ - |

™

3.500 —/ ! 25500




24, Rezim skicare ukonéite kliknutim na ikonu ¥ v boéni ndstrojové listé.

25.V dialogové listé kliknéte na 7% pro obraceni sméru protaZeni materidlu a 4 pro odebirani materialu.
Smér odebirani materialu je zobrazen dvéma zlutymi Sipkami.

26. Viyberte z nabidky ukonéeni protazeni ikonu # £ Extrude to intersect with all surfaces.

*x
=
s
Wl

27. Prepnéte zobrazeni modelu zpét na stl'novaﬁikonou o), zapnéte zobrazeni pomocnych os: 4
28. Potvrd'te provedeni protazeni kliknutim na

nebo prostiednim tlacitkem mysi.

E Pravidelné ukladejte (CTRL+S)

=l

k@I

E[j Ec:ement 2Lz Properties _
[O]a [Z-ee =% (4 C % n Foo 7] X

Krok ¢.4 Vytvoreni pripravné skici pro prvek PATTERN

31. Spustte piikaz " Use.

32.V dialogovém okné zvolte smycku(Loop) a kliknéte na libovolnou vnéjsi hranu télesa.

33. V nabidce Menu Manageru zvolte Next a poté co se zvyrazni smycka okolo vnéjSiho okraje télesa Accept.
34. Tentyz postup zopakuijte i pro vnitfni hrany télesa.

35. Rezim skicare ukondite kliknutim na ikonu .

L3
A ) Neni nutné volit pokazdé smycku, stejného efektu dosdhneme i volbou Single a postupnym vybranim vsech hran.télesa

Select Use Edge

() Single
() Chain

(© Loop




Krok ¢.5 Vytvoreni diry pro pole dér (Hole)

> Nyni vytvofime diru, ze které pak nasledné pomoci funkce PATTERN vytvofime pole dér.
36. Spust'te piikaz dira " Hole kliknutim na ikonu v bo¢ni nastrojové listé.

37. Diru umistite na predni rovinnou plochu kliknutim levym tlacitkem mysi na tuto plochu (viz obr. vievo).
38. Diru vystredime s osou OSA_Z pridrzenim tlacitka CTRL a kliknutim levym tlacitkem na osu Z (viz obr. vpravo).

39. Priimér diry zadejte 4mm.
40. Diru nastavte jako prtichozi pomoci ikony 1 E Drill to intersect with all surfaces.
41, Potvrd'te provedeni prvku dira kliknutim na . nebo prostrednim tlacitkem mysi.

Flacemert Shape [lote  Properties

.% (U i Plam (4 - [T n Heo [v] X

> Dira, kterou jsme vytvorili je umisténa mimo téleso, neodebird material, coz je neobvyklé, nicméné tato dira je potfeba pro
vytvoreni pole dér, které si ukaZzeme v dalsim kroku.




Krok ¢.6 Vytvoreni pole dér (Pattern)

42, Vyberte diru, kterou jste pravé vytvorili tim, Ze na ni kliknete ve stromé.

Prvky Ize také vybirat v hlavnim okné kliknutim levym tlacitkem mysi, nicméné u tohoto
prvku to neni vhodné.

w Vice informaci o zplsobech vybéru entit viz dokument UVOD.

("] SITKO.PRT
£ BOKORYS
£ PUDORYS
L7 NARYS

C50
7 osaY
7 0sAX
# 05A_Z
+- ) Extrude 1
+- ) Extrude 2

% Sketch 1
& Insert|.gre
> Vybranim diry se aktivuje ikona pro vytvareni pole )
43. Kliknéte na ikonu ! pattern.
44,V dialogové listé vyberte nasleduiji:
e  Fill — vyplfi dirami (nebo jinymi prvky pole) oblast urcenou skicou
e Sketch 1 - zvolte skicu, kterou jsme si pfipravili v kroku ¢.4
e Triangle — typ pole dle vzhledu
e 6mm - vzdalenost sousednich dvou prvk{ pole
e 4mm — minimalni vzdalenost krajnich prvk{ pole od okraje skici
e 30° - thel natoceni pole
.
£
¢ &
|
.
j References Optiu::-ns‘ Properties
Al [l m%| Sketo <[ Trange [w] iii6000 [w] #3a000 [v] 430000 [v] 3 T X

Pravidelné ukladejte (CTRL+S)

-
-

w Vice informaci o prvku PATTERN viz dokument ZNASOBENI.




Krok ¢.7 Srazeni hran (Edge Chamfer)

45, Spust'te prikaz S Edge Chamfer.
46. Velikost sra¥eni nastavte (00 | 0[050 H|
47.Drzte CTRL a vyberte hrany, které chcete srazit (viz obr.) a potvrd'te .

48. Spust'te prikaz S Edge Chamfer.
49. Velikost sra%eni nastavte (0#0 | [0 I
50. Oznacte hranu, kterou chcete srazit (viz obr.) a potvrdte .




Krok ¢.8 Skryti nepotiebnych os pomoci vrstev (Layers)

51. Zobrazte pomocné osy aktivovani tlacitka fa,

)

»  Zobrazi se vSechny pomocné osy automaticky vytvorené znasobenim prvku p

TR Y
{9 r
e
)
(%)
(=]

< °7_35
protazeni. Takovéto mnozstvi os zna¢né zneprehledfiuje model a je velmi p THA 37 g e ;_’*—3
nezadouci zejména pfi vkladani modelu do sestavy. PRt ;é -~ ":?—]Q_L 14
> Nyt:n’ si ulféierllqg jakymi zplsoby Ize pomoci vrstev (layers) efektivné spravovat ,-"/“‘xﬁ S ";ir—‘?:",_@a_g_ \-'“;’j"'_\ogl\_z
zobrazeni prvku. y - -—:3_‘211}_7 U ;-.jk_ﬁo
=~ 7 ! N L
\.A'_'z’ §_8| 1 4 ;3_?\ 49
g in l EEA

.waJ

52. Pfepnéte strom modelu do zobrazeni vrstev (layer tree), toto Ize provést nasledujicimi zplsoby:

o Aktivaci tladitka =2 . = Lavyers
o  Kliknutim ve stromé na tlacitko a poté na Layer Tree. Hidden Ttems
o V menu View piikazem Layers...
> Ve stromé mate jiZz predvytvorené vrstvy, ty se vytvari automaticky a jsou < DATUM_C5Y3 :
dény nastavenim systému PRO ENGINEER. < DATUM_PLANME Hide
» Smazeme vrstvu AXIS (pFipadné jinak pojmenovanou vrstvu, ktera by méla ]
. Ackivake
obsahovat pomocné osy.
53. Smazat vrstvu AXIS mUzete tak, Ze na ni kliknete pravym tlacitkem a
zvolite Delete Layer. New Layer...

» Smazanim vrstev nesmazete prvky obsazené ve vrstvach. M
Rename

54, Vytvorte novou vrstvu kliknutim pravym tlacitkem ve stromé a vybranim New Layer.. z kontextové nabidky.
55. Do kolonky Name napiste OSY.

56. Nastavte ve filtru pro vybé&r entit volbu Feature, | =3 .
57. Vyberte v hlavnim okné postupné osy OSA_X, OSA_Y a OSA_Z, ¢imz je pridate do vrstvy OSY.

B | ayer Properties ﬁl

Mame: |05Y
Layer Id: |

Contents | Riules || Motes

[tern Status
FEIOSA_Y] +
FE[OSA_Z) =F
F4[054_x) =F

[ Inclhude... |[ Exclude...

FPauze ]S Cancel

w Vice informaci o FILTRU PRO VYBER ENTIT viz dokument UVOD.




58. Schovejte prvky vrstvy OSY skrytim této vrstvy tim, Ze na ni kliknete pravym tlacitkem a vyberete Hide.

> Nyni vytvorime dalsi vrstvu a do ni umistime vSechny osy, které nejsou umistény ve vrstvé OSY. Vytvofime tedy ve vrstvé
pravidlo, které bude zarucovat, Ze vSechny osy modelu, které nejsou umisténé ve vrstvé OSY, budou umistény do této nové
vrstvy. = . &|
59, Vytvorte novou vrstvu a nazvéte ji OSY_POMOCNE. Sl Bt a3
60. Na zaloZce Rules kliknéte na tlacitko . Laak far: Laak in:
61. Zaskrtnéte polozku Associative. s v|
> Tim urcite, Ze budou do vrstvy pridany i jiz existujici prvky, ne Look by: Include submodels
jen nové& vytvorené. Feature v
62- Kliknéte na t|aé|,tk0 Edit Aules... . Attributes His[gr_y| Status |
63. Objevi se okno Rule Editor, Fuie .
64. Vyplnte Gdaje v tomto okné dle obrazku. Or ; S
egensration amparzon;
65. Pfidejte novou podminku tlaitkem [AddMew | @ Laper [ Mot inchuded v
- Dizplay Walle:
> Kliknutim na tlacitko a poté na (2 Parert/Chid [o5 v|
zobrazite vSechny osy, které budou pridany do této vrstvy. ) Copied Refs
66. Potvrdte .
Cuerm Builder

Add Hew lHemove Update

I Preview Results ] [ Hew Rule ] [ Options = ]

>

Nyni méme vée definovéno a uZ jen pouze skryjeme vrstvu OSY_POMOCNE a odkryjeme vrstvu OSY.

67. Skrtyjte vrstvu OSY_POMOCNE kliknutim pravym tlacitkem na vrstvu a vybranim Hide z nabidky.
68. Odkrtyjte vrstvu OSY kliknutim pravym tlacitkem na vrstvu a vybranim Unhide z nabidky.

69. Ve stromé kliknéte na a vyberte Save status.

>

Tim ulozite stav vrstev, pfi pFistim otevieni modelu bude vrstva OSY_POMOCNE skryta.

70. Prepnéte strom modelu do zobrazeni model tree, toto Ize provést nasledujicimi zplsoby:

o Deaktivaci tlacitka £ .

o  Kliknutim ve stromé na tlacitko a poté na Model Tree.
o V menu View piikazem Layers...

Kdyz nyni aktivujeme zobrazeni os, zobrazi se pouze osy z vrstvy OSY, model je tak mnohem prehlednéjsi.




CVICENI 11

CiL

Ukazka funkce B&JSwept Blend, procviCeni vytvareni pomocnych skic a dalSich prvk( na ukazkovém prikladu
jednoduché soucasti rukojeti kliky mlynku na maso.

PREDPOKLADY

e Pripravena Sablona ze cviceni 0.

PROBIRANE PRVKY, FUNKCE A POSTUPY

Swept Blend

Dira (Hole)

Zaobleni (Round)

Pomocné prvky

Alternativni postupy vytvareni rukojeti

AN NN
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Krok ¢.1 Vytvorit novou soucast

1. Kliknéte na [ .

2. Vyberte Part a nazvéte ji: RUKOJET.

3. Zkontrolujte, zdali je zapnuta volba Use default template.
4.

Potvrd'te tlagitkem L_2K_J,

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Pfiprava pomocnych prvk{ a skic pro prikaz Swept Blend

» Umistime novou pomocnou rovinu do vzdalenosti 7Z3mm od roviny PUDORYS.
5. Kliknéte na /' a oznacte rovinu PUDORYS.

6. V dialogu v zalozce Placement vyberte Offset a vzdalenost v Translation nastavte na 7Z3mm (viz. obr).
7. V zalozce Properties prejmenujte rovinu na HORNI a potvrdte Lok,

Placement | Display | Properties
References

FUDORYS:F2(DATU... Offset

Offset
Translation |73.000 ||

' Je vyhodné umistovat pomocné prvky(roviny,osy apod.) na zadatek stromu jelikoZ by nemély byt vazany na konstrukéni
' prvky(rotace,protaZeni apod.) ale naopak by mély tvofit zaklad pro tvorbu konstruké&nich prvkd.

] Pokud potiebujeme vytvoFit pomocnou geometrii v prib&hu vytvareni konstrukéni geometrie, je mozno ji dodate¢né
w presunout na zacatek stromu pretazenim ve stromé pomoci levého tlacitka mysi (viz. obr).

1 Predpokladem Uspésného pretazeni na zaCatek stromu je, Ze jsme pfi vytvareni pomocného prvku nepouzili jako
\2 referenci néktery z konstrukénich prvka.

(] PRTO0OL.PRT
£ BOKORYS
£ PUDORYS
MARYS r-—
cso Ty -
7 osAY
7 0sAX
# 0SA_Z
#% Sketch 1
S (gl —
¥ Sketch 2
% Sketch 3
& Insert Here
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>  Vytvoiime skicu na roviné PUDORYS, kterd bude slouzit jako 1.prifez prvku Swept Blend.

8. Kliknéte na %, vyberte rovinu PUDORYS a klepnéte na [ Sketch ],

9. Ve skicafi vytvorte kruZnici Oo priiméru 20mm se stfedem v pocatku souradnic.

10. Ukoncete skicar ¥ . ARYS

UDCRYS

OKORYS

> Dalsi skicu vytvofime na roviné HORNI, ktera bude slouzit jako 2.prifez prvku Swept Blend.
Je vyhodné, aby obé skici byly identické, pouze kruZnice budou mit jiny primér a budou leZet na jinych rovinach.
11. Oznacte pravé vytvorenou skicu kruznice (ve stromé nebo v hlavnim okné)

12. Kliknéte na = Copy nebo pouzijte zkratku CTRL+C ( Paste Specia p.9|

13. Kliknéte na 2 paste Special
14.V otevieném dialogu zaskrtnéte pouze posledni moznost (viz. obr)

[] Dependert copy

15. Potvrd'te LOK].
= Volba Advanced reference configuration umoznuje jednoduse vymeénit [ Ay Mo/ Pt iremsfommaions o copies

1 jeden referencni prvek za jiny, v nasem pfipadé rovinu PUDORYS za

rovinu HORNI, na tuto rovinu pak bude zkopirovana plvodni skica.
Advanced reference configuration

16. V otevieném dialogu vyberte rovinu PUDORYS. B Advanced Reference Configuration m

17. Ve stromé nebo hlavnim okné vyberte rovinu HORNI. Paste

»  Tim jste vyménili plivodni rovinu PUDORYS za rovinu HORNI. References of Original Features

18. Potvrd'te a ) PUDORYS:F2(DATUM PLANE) References of Pasted Features
BOKORYS:F1{DATUM PLANE) [] Use Original Reference

NARYS:F3DATUM PLANE)
PUDORYS5:F2[DATUM FLAME)

Q Pravidelné ukladejte (CTRL+S) Used By:
Sketch 1

v )l x]

>  Nyni upravime primér kruznice na nové vytvorené skice
19. Kliknéte ve stromé pravym tlacitkem na pravé zkopirovanou skicu a z kontextové nabidky vyberte Edit.
20. Poklepejte mysi na hodnotu priiméru 20 a prepiste ji na 13mm.

-~ ge y . Y Ly .
21. Kliknéte na == Regenerate, coz zregeneruje model, zmény v modelu se projevi az po regeneraci.




> Poloha obou kruznic je vidét na obrazku.

23. Ve skicari spust'te v nabidce Sketch->References
>  Pridame referen¢ni prvek rovinu HORNI.
24. Kliknéte na rovinu HORNI bud’ v hlavnim okné nebo ve stromé.

25. Zavrete dialog [(Close ],
26. VVypnéte zobrazeni pomocnych prvk( deaktivovanim téchto ikon v horni nastrojové listé:

3

"

i 3
LZ;:I:":::::I‘: %

y Rovina HORNI se do skici promitne jako pfimka.

w Tladitko Solve slouZi k pfevazbeni automaticky vytvarenych kot k nové pridanym referenc¢nim prvkim.

W "References E @ E
Analysis  Info F1{BOKORYS)

v Intent Manager Ei:EBE%EYS}

Sketch Setup...

@ Select | Use Edge/Offset v

E References
|
Specify references which the section will be dimensioned and constrained to. Reference status

Unsolved sketch

Close

27. Naskicujte Usecku N podél osy OSA_Z mezi dvéma pfimkami, které reprezentuji roviny PUDORYS a HORNI.
28. Ukoncete skicar v . !' '

OsA’ X

Jak je vidét na obrédzku, tato skica neobsahuje zadné kéty. Je to z toho dlivodu, Ze je vazbend na obé& pomocné roviny.
Budeme li potfebovat prodlouzit Usecku, upravime vzdalenost Translation roviny HORNI.

Zménu orientace skici je mozné provést v nabidce Sketch->Sketch setup pod polozkou Orientation.

Vzajemna poloha skic je vidét na obrazku, oba konce Usecky jsou ve stfedech

{.:.. «) {'

BOKORYS

Q Pravidelné& ukladejte (CTRL+S)

PUDORYS
HORNI
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>  Umistime na pfimku étyFfi pomocné body, v t&chto bodech budou Fizeny priifezy té&lesa

29. Kliknéte na ikonu ** Point.
30. Umistéte prvni bod PNTO na Usecku tim, Ze na ni kliknete.
31.V otevieném dialogovém okné piepiste Offset na 0.8.

1 0.8 neni rozmér v milimetrech, ale relativni vzdalenost na Usecce, pficemz 0 je na jednom konci Usecky a 1 na druhém
konci Usecky. Je mozné také zadavat rozmér v milimetrech pfepnutim volby Ratio na Real.

32, Kliknéte na ¥ New Poirt pro pridani dal$iho bodu.

33. Pridejte druhy bod PNT1 na Usecku, offset: 0.616.

34. Pridejte treti bod PNT2 na usecku, offset: 0.233.

35. Pridejte Ctvrty bod PNT3 na Usecku, offset: 0.082.

36. Potvrd'te Lok,

= DATUM POINT X

Placement | Properties
EY 1o References
FNT1 CurvetF11[SKETCH_3)  0On

PNTZ
PNT3

Wew Foint Offset  |0.800 v|[Ratic v

Oiffzet reference

(® End of curve

() Reference

Krok ¢.3 Prikaz Swept Blend

> Pomoci prikazu Swept Blend nyni protdhneme kruznici podél trajektorie, kterou tvori Usecka, pficemz je ndm umoznéno
v pripravenych bodech na Usecce upravovat priiezy télesa zadanim obsahl prirezu.

|
37. Spustte prikaz Swept Blend v nabidce Insert> = Swept Blend...

38. V dialogové liété kliknéte na | /Create a solid, tim urcite, Ze se bude vytvaiet objemové t&leso (solid)
39. Kliknéte levym tlacitkem na Usecku, tim ji vyberete jako trajektorii.

\l/' Kliknutim na Zlutou Sipku lze zménit poCatek a smér vytvareni prvku.

T-0.00
T 0.00 /7 Origin [
40.V menu Sections vyberte & Selected Sections pro vybrani pripravenych skic.
41. Vyberte jednu kruznici.
42. Kliknéte na a vyberte druhou kruznici.
PUDORYS

N MBOKORYS
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43,V dialogové listé kliknéte na Options ->Set Cross-section area control
44, Zobrazte pomocné body < % AR

[ Section 2

;/7 Section 1

45.V hlavnim nastrojovém okné vyberte postupné vSechny ctyfi pomocné body (CTRL+levé tlacitko mysi).

> U t&chto bodd nyni upravime velikost plochy prifezu budouciho télesa, pri¢emz tvar télesa se dynamicky méni p¥i zadavani
hodnot prirezl jak ukazuji nasledujici obrazky.

> V bod& PNT3 mé byt prdmér télesa 25mm, plocha prifezu tedy bude 490.87mm?
46. Zadejte hodnotu 490.87mm? do kolonky Area pro bod PNT3 (viz. obr).

Section 2
Cap ends /

() Mo blend contral
() Set perimeter contral
(%) Set cross-section area control

Section 1

Location Area
Section 1

PNTZFIZ2[DATUM .. 49087 |=
PHNTZFIZDATUM ... 27863

PHTTR12ZIDATUM ... 22485 &)
2] 1l ] =

>

>  V bodé& PNT2 ma byt primér télesa 17.7mm, plocha priifezu tedy bude 246.06mm?
47. Zadejte hodnotu 246.06mm? do kolonky Area pro bod PNT2 (viz. obr).

Cap ends Section 2
) No blend control J’
() Set perimeter contral
(%) Set cross-zection area contral

Sedion 1

Location Area
PNTZF1ZIDATUM .. 43087
PHTZF12[DATUM
PMT1TF12IDATUM .. 22485
PNTOF12DATUM .. 201,06 &

5] 1l ] =

» V bodé& PNT1 ma byt primér t&lesa 31mm, plocha priFezu tedy bude 754.77mm?
48. Zadejte hodnotu 754.77mm? do kolonky Area pro bod PNT1 (viz. obr).

Cap ends — Section 2
) No blend contral

) Set perimeter contral
(%) Set cross-section area contral

Section 1

Location Area
PNTZFIZDATUM .. 49087 ~
PMTZ:F12[DATUM ... 24505
PNT1F12[DATUM (75477 )
PNTOF12DATUM .. 20105 ~ |

< il ] |
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> V bodé& PNTO mé byt primér télesa 26.5mm, plocha prifezu tedy bude 550mm?.
49. Zadejte hodnotu 550mm? do kolonky Area pro bod PNTO (viz. obr).

50. Potvrdte prikaz .

Cap ends — Section 2
) Mo blend control

) Set perimeter contral
(%) Set cross-section area control

Section 1

Location Area
PHNTZF1Z[DATUM ... 430,87 »
PNTZF12[DATUM . 24606
FHT1:F12[DATUM . 7R4.77 3
PHNTO:F1Z2DATUM ... [ 550.00)

£ | Ly ] ¥

E Pravidelné ukladejte (CTRL+S)

Krok ¢.4 Vytvoreni diry pro osicku (Hole)

51. Zobrazte pomocné osy AN ES S

52. Spustte piikaz ' Hole v boéni nastrojové liste.
53. Priimér diry zadejte 6mm.

54, Diru nastavte jako prlichozi 1E prill to intersect with all surfaces.
55. Diru umistéte na predni rovinnou plochu kliknutim levym tlacitkem mysi na tuto plochu.

II-7




56. Diru nym’astFedl'me s osou Z pridrZzenim tlacitka CTRL a kliknutim levym tlacitkem na osu Z.
57. Potvrdte .

Krok ¢.5 Srazeni hrany (Edge Chamfer)

58. Spust'te prikaz S Edge Chamfer.
59. Velikost srazeni nastavte (D#P | D [1.00 v,

60. Oznacte hranu, kterou chcete srazit (viz obr. vlevo) a potvrdte .
61. Drzte CTRL a oznacte hranu na opa¢ném konci diry (viz obr. vpravo).
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Krok ¢.6

Zaobleni hran télesa (Round)

62. Spust'te prikaz “VRound.
63. Nastavte polomér zaobleni 1mm.
64. Vyberte hranu (viz obr.).

65. Vyberte hranu na opac¢ném konci diry (viz obr.) a potvrd'te .

Timto zplsobem Ize v jednom prvku vytvofit zaobleni o rozdilnych polomérech,
. toto se bézné nevyuziva. Obvykle se pro zaobleni kazdé hrany pouzije novy
\1) prvek zaobleni (Round), pfipadné se pouZije jeden prvek zaobleni pro hrany se
stejnym polomérem zaobleni, kazda hrana se pak vybirda pomoci CTRL+levé
tlacitko mysi.
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ALTERNATIVNI POSTUPY VYTVARENI RUKOJETI

Postup ¢.1 Rotace profilu rukojeti (Revolve).

n
> Naskicujeme zékladni profil rukojeti pomoci piikazu - ¥ Spline. Priméry jednotlivych bod{ kiivky vhodné zakétujeme jak je
vidét na obrazku. Vytvorime tak skicu se véemi potiebnymi parametry pro pripadnou zménu primérd & vzdalenosti. Skicu
jednoduse orotujeme o 360°.

25.00 ; =

45.00

58.40

31.00 =¥ s
26.50 —
_____________________ .C:}_‘L—f; e e e e e e e e e e m e mmm o - -

¥" Vyhodou tohoto postupu je jednoduchost a rychla zména rozmérd, které jsou véechny umistény v jedné skice.

X Nevyhodnym se tento postup stane, paklize budeme chtit upravit celkovy tvar rukojeti napfiklad prodlouzenim kfivky Spline
o daldi bod. Budeme muset smazat plvodni Spline a naskicovat novou, &mz pfijdeme o v3echny vytvofené kéty.

OSA_Z

df@ Flacement Option:  Properties

3 (213 [ IntemalcL 4k~ (300 v A C I [¥se X
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Postup €.2  Swept Blend s predpripravenymi skicami.

>  PFi predchozim pouZiti prikazu Swept Blend jsme zadali pouze dva priiezy a tvar télesa jsme Fidili pomoci velikosti ploch
priFezd ve vybranych bodech. V pfikazu Swept Blend Ize oviem zadat i trajektorii a vice prifez{ pro dosaZeni vysledného
tvaru télesa.

>

Vyhodné je pFipravit si pfedem roviny a na pipravenych rovinach vytvofit skici priFezl télesa (viz obrazky).

] PRTOOOL.PRT
BOKORYS
MARYS

FF PLUDORYS

£7 OTM3

£7 OTMz

£7 0TML

£7 OTMI

£F HORMI
50

7 0sAy

/ 0SAK

4 05AZ

¥h Shekch 1

¥4 Sketch 2

i Shetch 3 DTM1

¥ Sketch 4

¥4 Sketch 5 DTM2

¥ Sketch 6 DTM3

= Insert Here FUDORYS

LOSAY

OSA_X

w Vice informaci o vytvareni pomocné geometrie viz dokument POMOCNE GEOMETRICKE PRVKY.

>  Po spusténi prikazu nejprve zaddme trajektorii (Use¢ka na obrazku cervené) a poté v menu Sections zaskrtneme Selected

Sections a zadame postupné pFipravené prirezy.

¥" Vyhodou tohoto postupu je snadné pfidani nebo odebrani nékterého z prifezd.

% Nevyhodou je obtizn&ji modifikace rozmé&rd, jeliko? rozméry télesa jsou v Sesti skicach a $esti pomocnych rovinach.

() Sketched Sections

(®) Selected Sections T=0.00

Sections # .
-Insert Section 6
Section 3 2\~
Section 4 2 -
Remove
Section & 2 r
iﬁnhnn [ }? .

Add Blend Vertex
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Postup ¢.3  Vysunuti valce (Extrude) a odebrani negativu profilu pomoci rotace (Revolve).

>  Pro priklad je zde uveden také postup vytvoreni rukojeti pomoci vysunuti valce a naslednym vyfiznutim negativu profilu
rukojeti do valce.

17.70

26.50

|
L 13,00

A

%X Nevyhodou tohoto postupu je pouziti dvou prvk{, ackoliv by dana sou¢ast miZe byt vytvorena jednim prvkem.

¥" Vyhodou tohoto postupu je snadné vytvoreni negativu (formy) rukojeti kliknutim na u prvku rotace.

S Placement  Optiong  Properties

| [O)ao D[ e ¥ x (4 C % n @ss [v] X
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Postup ¢.4  Blend Protrusion

> Tento prikaz naleznete v nabidce Insert->Blend->Protrusion...

> VSechny prifezy se naskicuji do jedné skici, pfi¢emz kazdou oddé&lime pomoci Sketch->Feature Tools>Toggle Section.
Néasledné se zadaji vzdalenosti jednotlivych priiezli a smér tazeni.

20.00 —

26.50 \h, v

17.70/ LS | e
: ul

25.00 = S

S | .\
: y
31.00 ~

v Vyhodou tohoto postupu je jednoduchost

X Nevyhodou tohoto postupu je znaéna nepiehlednost pii vytvareni vétdiho poctu priiezd.
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CVICENI 111

CiL

Procviceni zakladnich typl prvk( pro modelovani soucasti, ukazka prace ve skicafi, vytvareni skic, kot a geometrickych
vazeb, vysvétleni funkce a poufZiti pfikazu Family Table, vytvareni zavitu na vnéjsi valcové plose. To vse na
ukazkovém prikladu tvorby Sroubu u mlynku na maso.

o’

PREDPOKLADY

e Pfipravena Sablona ze cviceni 0.
e Zaklady Swept Blend z predchoziho cviceni

PROBIRANE PRVKY, FUNKCE A POSTUPY

Rotace (Revolve)

Protazeni (Extrude)

Tazeni s proménnymi prifezy (Variable Section Sweep)
Swept Blend

Zavit (Cosmetic Thread)

Family table

Vytvareni a kétovani skic

Funkce Potlaceni (Suppress)

Seskupeni prvkt (Group)

AN N N N N NN
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Krok ¢.1 Vytvoreni nové soucasti

PWNE

Kliknéte na U

Vyberte Part a nazvéte ji SROUB.

Zkontrolujte, zdali je zapnuta volba Use default template.
Potvrdte tlagitkem (2],

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢€.3 Priprava pomocnych rovin

Nown v

Umistime novou pomocnou rovinu do vzdalenosti 5mm od roviny PUDORYS.

Kliknéte na “/ a oznacte rovinu PUDORYS.
V dialogu v zalozce Placement vyberte Offset, vzdalenost v Translation nastavte na 5mm.

V zaloZce Properties prejmenuijte rovinu na HORNI a potvrd'te Lok,

\‘) Rovinu mUzete pfejmenovat i pozdé&ji po vytvoreni stejné jako kazdy jiny prvek kliknutim pravym tlaéitkem na rovinu ve

stromé a vybérem Rename z kontextové nabidky.
HORNI

PUDCRYS

NARYS

Q Pravidelné ukladejte (CTRL+S)

L

BOKORYS

>

8.
9.
10.

Umistime novou pomocnou rovinu do vzdalenosti 56mm od roviny PUDORYS.

Kliknéte na 7 a oznacte rovinu PUDORYS.
V dialogu v zaloZce Placement vyberte Offset, vzdalenost v Translation nastavte na 56mm.

V zZélozce Properties prejmenujte rovinu na ROV_PODLOZKA a potvrdte

I DATUM PLANE %]

Flacement | Display | Properties

NARYS

References

PUDORYS:FADATU... Offset

= % L
w Offset
Translation |56.00 w

.

BOKORYS
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> Umistime novou pomocnou rovinu do vzdalenosti 5mm od roviny ROV_PODLOZKA.

11. Kliknéte na &/ a oznacte rovinu ROV_PODLOZKA.

12.V dialogu v zaloZce Placement vyberte Offset, vzdalenost v Translation nastavte na 5mm.
> Vytvarena rovina je umisténa nad rovinou ROV_PODLOZKA ve vzdalenosti 5mm.

13.V zdloZce Properties prejmenujte rovinu na ROV_STOLU a potvrdte Lok,

Flacement | Display | Properties
Feferences

OV PODLOSKA

- ROY_PODLOZKAFS... Offzet

HORENYyS
Offzet
Tranzlation |5.00 w

BOKORYS
Krok ¢.2 Priprava pomocné skici pro prikaz Variable Section Sweep

>  Vytvorime skicu na roviné PUDORYS, ktera bude slouZit jako trajektorie prvku Variable Section Sweep.

14. Klikn&te na “*, vyberte rovinu NARYS a klepnéte na [Sketeh |,

v ;o , : = N ;v
15. Vypnéte zobrazeni vSech pomocnych prvkl £ a2 % 4 3 zapnéte zobrazeni mrizky

16. Ve skicari nejprve vytvorte svislou osu kliknutim na N EI a | , 0su ved'te podél svislé pfimky, ktera ve skicafi
znazornuje pomocnou rovinu BOKORYS(viz obr.).
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17. Vytvorte t¥i UseCky bez geometrickych vazeb, pouze prostredni Usecka bude horizontalni (viz obr.).

» Zobrazeni mfizky je zde zapnuté proto, abyste nacrtek od ruky meéli priblizné ve stejnych velikostech jako je tento nacrtek

ukdzkovy. VSimnéte si, ze Usecky zde skicované jsou umistény jen ve dvou ¢tvereécich mrizky a jsou tedy pomérné malych
v O
rozméru.

] Pokud se vam pfi vytvaieni jakéhokoliv prvku ve skicafi zobrazuje geometrickd vazba, kterou nechcete(¥ /1, =, +),
w kliknéte pravym tlacitkem mysi, vazba se zobrazi preskrtnutd(¥ , /1, », #) a nebude se vam jiZ nabizet.

Omylem vytvofenou geometrickou vazbu lze smazat umisténim kurzoru nad znacku vazby a pravym tlacitkem klikat tak
dlouho, neZ se vybere pravé znacka vazby, potvrdit vybér vazby levym tlacitkem a smazat ji kldvesou DELETE.

i Sedé koéty, které vidite na obrazku jsou vytvareny automaticky tak, aby byla sou¢ast pIné zakétovéna. Nelze je smazat,
\) Ize prepsat jejich hodnoty a tim z nich udélat standardni koty nebo zadat vlastni kdty a geometrické vazby.

Hotova skica by neméla obsahovat zadné Sedivé automatické kéty, tyto kéty znadi, Ze soucast neni zcela zakoétovana.

» Zaoblime dva vzniklé rohy.

18.Klknéte na > a vyberte dvé prilehlé Gsecky pro vytvoreni zaobleni.
19. Totéz provedte u druhého rohu, vysledkem by méla byt skica na obrazku.
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> Nyni je tfeba doplnit geometrické vazby, jedina vazba, kterou pfidame je symetri¢nost stfedll zaobleni k ose.
20. Kliknéte na Constrain pro pridani geometrické vazby.

21. Vyberte vazbu symetri¢nosti .
22. Kliknéte postupné na jeden stfed zaobleni, druhy stfed zaobleni a na osu.

\l/ Vazba symetrie je na skice zobrazena dvéma Sipkami smérujicimi proti sobé.

> Doplnime do skici kéty dvojim zplisobem: vyuZijeme automaticky vytvorené Sedé kéty nebo vytvofime vlastni.
23. Zakétuijte nejprve ty kéty, které jsou na obrazku zobrazeny cerné.

-

_ H _
s . Koty lze uzamykat(lock) a to tak, ze oznacime koty, které chceme zamknout a zvolime v menu Edit prikaz Toggle
\l/ Lock. Uzamcené koty nelze ménit tazenim geometrie, pouze tim, ze prepiSeme hodnotu koty.

>  Vytvorime kdtu vzdalenosti stiedl zaobleni.

24. Kliknéte na "™ pro vytvoreni kéty.

25. Kliknéte na oba stfedy zaobleni.

26. Kétu vytvorite kliknutim prostredniho tlacitka mysSi a to na pozici pod kurzorem.

27. Dalsi kétu vytvorite obdobné kliknutim na pfimku a na koncovy bod Usecky (viz obr.).
28. Vytvorte kotu prostiednim tlacitkem mysi.

29. Ukoncete prikaz nebo prostfednim tlacitkem mysi.

30. Piepiste hodnoty obou kot dle obrazku na 30mm a 5mm.

v

31. UkoncCete rezim skicare

\l.) Hodnoty kot Ize prepisovat az po ukonceni prikazu vytvareni kot.
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e 30.00 ———

Krok ¢.4 Variable Section Sweep

» Pomoci pfikazu Variable Section Sweep protahneme elipsu podél trajektorie, kterou jsme pravé vytvorili.
32. Spust'te piikaz ! Variable Section Sweep.

33.V dialogové listé kliknéte na “icreate a solid, tim urcite, 7e se bude vytvaret objemové téleso (solid)
34. Kliknéte levym tlacitkem na Usecku, tim ji vyberete jako trajektorii.

' \
\ /jm

BOKORYS

35. Kliknéte na & &m3 se prepnete do skicare.

36. Kliknéte na OEI a © pro vytvoreni elipsy.
37. Vytvorte elipsu se stfedem v pocatku soufadnic a zakétuite ji (viz obr.).

38. Potvrdte ¥ .
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39. Potvrdte prikaz .

Krok ¢.5 Protazeni valcového profilu pro zavit (Extrude)

> Na predem pfipravené roviné HORNI vytvofime kruznici, kterou protdhneme pomoci pfikazu Extrude.
I . 5

40. Kliknéte na ikonu =" Extrude.

41. Vytvorime skicu kliknutim na Placement a [ 0sf=. ],

42, Vyberte rovinu HORNI a kliknéte na pro prepnuti do skicare.
43, Vypnéte zobrazeni pomocnych prvkd £# /= % %
44. Vytvorte kruznici © o priméru 10mm.

45. Potvrdte v . ......... ......... ......... ......... ......... ......... ......... ......... ......... ......... ......... .....

46. Délku protazeni nastavte na 50mm.
47. Potvrd'te prikaz .

50.00

@ Vice informaci o prvku PROTAZENTI viz dokument PROTAZENI.
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Krok ¢.6 Priprava pomocnych skic pro prikaz Swept Blend

> Vytvoiime dvé priiezové skici a jednu skicu, kterd bude slouzit jako trajektorie

48. Kliknéte na , vyberte rovinnou plochu valce (viz obr.) a klepnéte na [Sketeh J,

49, Spust'te piikaz " Use.
50. V dialogovém okné zvolte smycku(Loop) a kliknéte na hranu valce.

» Tim se promitne valcova plocha do kruznice.

51. Potvrdte ¥ .

> Totéz provedeme u jednoho z koncl té&lesa vytvoreného prikazem Variable Section Sweep.

52. Kliknéte na “*, vyberte plochu oznatenou na obrazku a klepnéte na [Sketeh ],

>  PFi vstupu do skicare se objevi dialogové okno References s hlasenim Reference Status - Partialy Placed. To znamena,

Ze systém potrebuje zadat dalsi referencéni rovinu nebo osu, aby mohl umistit skicu. & References QE
53. Vyberte OSA_Y a kliknéte na (Clase ], FaNARYE]

54, Spustte piikaz " Use.
55. V dialogovém okné zvolte smycku(Loop) a kliknéte na hranu télesa.

» Tim se promitne obvodova plocha télesa do elipsy.

56. POtVrd’te v . E] - elect | Use Edge/Difzet v I
Replace Delete Sokve

Reference status
Partially Placed

Close
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58. Pridejte reference v nabidce Sketch->References a vyberte reference, které vidite na obrazcich.
59. klikn&te na [ Elese].

F1EOKORYS)
Curve:F[SKETCH_1]
Surf:F11EXTRUDE_1)

@ Select | Use Edge/OFffset v
Replace Delete

Reference status

Unszolved sketch

Close

> Nyni vytvofime tecny oblouk, ktery bude slouZzit jakozto trajektorie pro pfikaz Swept Blend.

60. Kliknéte na * pro vytvoreni oblouku.
61. Kliknéte na oba koncové body tak, aby u obou bod( byla zobrazena vazba koincidence @ a pfipadné I vazba
te¢nosti | (viz obr.)

(1 U kazdého koncového bodu by mély byt zobrazeny dvé vazby, vazba tecnosti T a koincidence @, nékteré z téchto vazeb
\) vam budou nabidnuty p¥i vytvareni oblouku, ostatni musite doplnit.

+
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> Na predchozim obrazku chybi jiz jen jedna geometricka vazba tecnosti, tu ted pfiddme nasledovné
62. Kliknéte na pro pridani geometrické vazby.

63. Kliknéte na ikonu vazby teCnosti .
64. Oznacte oblouk a osu a potvrd'te vytvoreni vazby prostfednim tlacitkem.
65. Pokud jiz nepotfebujete pridat dalsi vazbu, ukoncete ptikaz prostfednim tlacitkem nebo (LClose ]

________ | I

I
- |
| N
T h
i \\
&
/ | )
, | N
N
4 | \ A

66. Kliknéte na > a naskicujte Usecku (na obrazku vyznacenou Cervené).
67. Ukoncete reZim skicare ¥ .

E Pravidelné& ukladejte (CTRL+S)

Krok ¢.7 Prikaz Swept Blend

» Pomoci ptikazu Swept Blend nyni navaZzeme elipsovity priifez télesa vytvoreného pomoci Variable Section Sweep
s kruhovym priifezem druhého protazeného télesa.

el
68. Spust'te prikaz Swept Blend v nabidce Insert-> = Swept Blend...

69. V dialogové listé kliknéte na |E|Create a solid.

> Tim urcite, Ze se bude vytvaret objemové téleso (solid).

70. Kliknéte levym tlacitkem na kfivku, kterou jsme pravé vytvorili (nemusi byt vidét, ale pokud najedete kurzorem do
mist, kde jsme kfivku vytvofili, zobrazi se)
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71.V menu Sections vyberte @ Selected Sections pro yybrani pripravenych skic.
72. Vyberte nacrtnutou elipsu (opét neni vidét,paklize na ni nenajedete).

73. Kliknéte na a vyberte nacrtnutou kruznici.

/— Section 1

£ .

MUZe se stat, Ze jsou obalové kiivky vytvareného télesa prekiizeny, je to zplsobeno tim, Ze kruZnice i elipsa jsou rozd&leny
na dva pllkruhy a konce téchto ptlkruhd jsou spojeny obalovymi kfivkami. JelikoZ jsou konce ptlkruhd spojeny nahodné,

& ¢asto se stava, ze jsou kFivky prekfizeny, tento problém se da jednodude napravit propojenim spravnych koncti. Postup je
popsan v nasledujicich dvou bodech a zobrazen na obrazcich.

74. Klepnéte a drzte levym tlaCitkem mysi bily kruh u Zluté Sipky (viz obr. vlevo).
75. Tahnéte kruh s Sipkou po kruznici o 180° tj. o pllkruh (viz obr. vpravo).

>  Pro zaruceni plynulého piechodu mezi ob&éma soucastmi je nutno nastavit te¢né napojeni povrchl
76. V dialogové listé kliknéte na Tangency nastavte Start Section na Tangent.

77. Jako Entity 1 vyberte jednu polovinu povrchu télesa s eliptickym prlifezem (viz obr.).
78. Jako Entity 2 vyberte druhou polovinu povrchu tohoto télesa.

B oundary Condition
Tangent
End Section Free
[BrfiF10(vaR_secT ) < il =

Entitiez | Surfaces

Suif.F100V&R_SECT_SW...
Entitp 2 Undefined
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79. Nastavte End Section na Tangent.
80. Jako Entity 1 vyberte jednu polovinu povrchu télesa s kruhovym prdfezem (viz obr.).
81. Jako Entity 2 vyberte druhou polovinu povrchu tohoto télesa.

82, Potvrd'te provedeni piikazu .

Boundary Condition
Start Section Tangent
End Secti Tangent
£ [ >

Entitiez  Surfaces

Suf-F11[EXTRUDE_1]

Entity 2 Swik:FT1[EXTRUDE_1)

Surf:F11(EXTRUDE_1)}

Vv.vrs

Krok ¢.8 Zavit na vnéjsi valcovou plochu télesa (Cosmetic Thread)

> Vyfizneme vnéjsi zavit do valcové Casti télesa.
.

1 V softwaru PRO/ENGINEER se zavit nevyobrazuje vérng, ale pouze zjednodusené jako valcova plocha v materidlu

Diru se zavitem lze vytvofit najednou pfrikazem 2% Hole, pokud potiebujeme umistit zavit na vnéjsi valcovou plochu,
pouzijeme pfikaz Thread v nabidce Insert->Cosmetic>Thread...

83. V nabidce Insert->Cosmetic spustte prikaz Thread...

> Objevi se dialog, ktery vidite na obrazku, postupné budeme zadavat informace, které jsou pozadovany, pravé pozadovana
informace je oznacena znaménkem >, sledujte také stavovy radek, kde se zobrazuje vyzva k zadani urcité reference, rozméru

apod. —
B COSMETIC: Thread  [X|
Element It
» Thread Surf Drefining
Start St Required
Drirection R equired
ThreadLength  Required
M ajor Ciarn Required
Mate Params Required
[Define] [ Refs ] [ Info ]I
Ok Cancel Presiew

84. Vyberte plochu, do niz budeme vyrezavat zavit (viz obr.).

= COSMETIC: Thread  [X|

Elemnent Infa
» Thread Surf Drefining .
Stark Surf Required Ny T .
Diirection Required - e
ThreadLength  Required
Major Diam Required
Mote Params Fiequired
[Define] [ Refs ] [ Info ]
Ok Cancel Preview

-

Select 1 item.
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85. Vyberte povrch, kde bude zavit zacinat (viz obr.).

H COSMETIC: Thread X

Element Info
Thread Surf Defined
> Start Surf Defining
Direction Fequired =
ThreadLength Required
M ajor Diam Required
Mate Params Fequired
[ Define ] [ Refs ] [ Info ]

B Select

Select 1 item.

86. Potvrd'te smér vyrezavani zavitu kliknutim na Okay.

® COSMETIC: Thread  [X]

Element Infa
Thread Surf Defined
Start Surf Defined
» Direction Defining
ThreadLength  Required
M ajor Diam Required
Mote Params Required
[ Define ] [ Refs ] [ Info ]
ﬁ 0k J Cancel Previgw

Menu Manager

w DIRECTION

87. Délku zavitu zvolte Blind a potvrdte Done.
88. Délku zavitu zvolte 45mm a potvrd'te E

% Enter depth 45 E

E Pravideln& ukladejte (CTRL+S)

& COSMETIC: Thread  [X|

Element Infio
Thread Surf Defined
Start Suf Diefined
Direction Defined
» Threadlength  Defining
Major Diam Required
Mote Params Fequired

[Define] [ Refz ] [ Info

]

Freview

Menu Manager

w SPEC TO

Elind
UpTo Prkfvt:
UpTo Curwe

UpTo Surface
Done

Quit

> Vytvoiime zavit M10x1, ktery mé dle ISO prdmér ds=8,773mm.
89. Zadejte primér zavitu 8.773 a potvrdte E

@ Enter DIAMETER 8.773

X
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Krok ¢.9 prvek Rotace (Revolve)

90. Kliknéte na “° Revolve.
91, Vytvoite skicu, zaénéte kliknutim na Placement a [_0efre. ],
92. Umistéte skicu na rovinu NARYS, jako referencni rovinu vyberte plochu (viz obr.), orientaci nastavte Top a

Kliknéte na [Sketeh ],

Surf:F11{EXTRUDE_1)

93. Ve skicafi nejprve vytvorte svislou osu kliknutim na N EI a i, osu vedte podél svislé primky, ktera ve skicafi
znazornuje pomocnou rovinu BOKORYS.

94. Kliknéte na > Line, naértnéte 5 dseek jako na obrazku a potvrd'te prostfednim tlacitkem mysi.

B R

>  Pridejte do skici geometrické vazby (na obrazku znazornény pismeny V=vertikalni, H=horizontalni).
95. Geomtrické vazby pridate kliknutim na = Constrain, objevi se dialogové okno Constrains (obr. vpravo).

>  Kliknutim na pozadovanou vazbu a vybranim pfisluSné geometrie se vazba vytvofi a znadzorni se ve skice symbolem.

96. Pro pridani geometrické vazby Horizontal kliknéte na a poté kliknéte na horni Gsecku, tim pridate vazbu k

této Usecce a odeberete ji stupné volnosti.
97. Obdobné pridejte dalsi vazby ostatnim Useckam dle obrazku vievo.

s

[t~ ]1]
V
' o]~ =]
et =1

i
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98. Okétujte skicu dle obrazku.
5.00
= 2po
| Y
V300

71+I1IH i v

4.00 vV

oy
| _B

99, Vytvorte zaobleni kliknutim na ~ dle obrazku a prepiste hodnotu kéty zaobleni na 0.5mm.

1|)0
b

| V| 300
v
[ Rt $
1 0.50
4.00v il
_ L¢, Vi
- | @—-
5

100. SmaZte Cast Usecky (viz obr. vlevo) pomoci prikazu * Delete Segment.
101. Pomoci  Line uzaviete smycku (viz obr. vpravo).

102. Ukoncete rezim skicare ¥ .

5.00 5.00

’-= 2. .|30 =-‘ |

.
3.00 v
i 3.00 v
?. | S |

4.

[=]

0

[

0.50
| /
i
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103. Potvrdte provedeni ptikazu rotace .

E Pravidelné ukladejte (CTRL+S)

Krok ¢.10 Zaobleni

104. Pomoci ptikazu “VRound vytvorte zaobleni o poloméru 0.5mm.

Krok ¢.11 Odfriznuti (Solidify)

105. Vytvofime pomocnou rovinu ve vzdalenosti 3mm od roviny ROV_PODLOZKA.
106. Nazvéte tuto rovinu ROV_ODRIZNUTI.

ROV _PODLOZEKA
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107. Vyberte v okné nebo ve stromé rovinu ROV_PODLOZKA.
108. V menu Edit vyberte piikaz Solidify.

109. Potvrdte provedeni prikazu .
» Tim ofiznete téleso vybranou rovinou.

Krok ¢.12 Prvek Rotace (Revolve)

110. Kliknéte na “° Revolve.
111. Vytvorte skicu, zatnéte kliknutim na Placement a [__osf=. ],

112. Jako referencni rovinu vyberte ROV_PODLOZKA, orientaci nastavte na Top a kliknéte na [Sketch J,

® Skeich %]

Placement |

Sketch Plane

Plane NﬁHYSiF“[Dﬂ |Jze Previous

Sketch Orientation

Sketch view direction
Reference | ROY_PODLOZEAFED... |

Orientation | Top w

113. V menu Sketch spust'te prikaz References.
> Jako reference pouzijte ROV_STOLU, BOKORYS a bod (vSe znazornéno na obrazku Cervengé).
114. Upravte tabulku referenci tak, aby odpovidala obrazku vpravo.

> Tlacitkem pridédme reference, tlacitkem reference odstranime nezddané referencni prvky.

B References |Z| |E| El

F1[BOEORYS)
Wertew: Edge:F23(SOLIDIFY_1]
FEROYW_STOLU)

Selectl lze Edge/Offzet A

| Reference status
Fully Placed

Cloze

n-17




115. Ve skicafi nejprve vytvorte svislou osu kliknutim na > EI a | , osu ved'te podél svislé primky, ktera ve skicafi
znazorfiuje pomocnou rovinu BOKORYS.
116. Naskicujte Ctyri UseCky Cervené vyznacené (viz obr.).

117. Pridejte geometrické vazby do skici (viz obr.).

ez

1

118. Pridejte do skici kéty (viz obr.).

0.60

| 35400 /74

7z
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119. Potvrd'te provedeni ptikazu Revolve .

Krok ¢.13 Seskupeni prvkd (Group)

120. Dr7te CTRL a vyberte ve stromé tfi posledni prvky (viz obr. vievo).
121. Kliknéte pravym tlacitkem na jeden z nich a z kontextové nabidky vyberte Group.
122. Vytvorenou skupinu prejmenujte na ROZTEPANI.

1 Cosmebic id 627 sha Revalve 2
cv'»b Revalve 2 ) Round 1 I Cosmetic id 627
;PI Fiound 1 [+ cﬁh Revolve 2

LIZMUTI

i Delete
o :PI Round 1
| W oErLREE
Uppress

Insert Here
Edit *

Create Driving Dirnension AE

l} Insert Here

Edit Parameters

Krok ¢.13 Potlaceni prvku rotace (Suppress)

> Potlacenim (SUPPRESS) prvku Group ROZTEPANI, ktery jsme praveé vytvorili, ziskdme neroztepany Sroub. Pozdé&ji pomoci
funkce FAMILY TABLE dame uzivateli na vybér, kterou verzi Sroubu chce otevfit pokazdé, kdyz otevie soucast Sroub.

> Nejprve povolime zobrazovani potlacenych soucasti ve stromé, toto je standardné vypnuto.

123. Kliknéte v okn& NAVIGATORU na tladitko g s TreeFilers.

124. V dialogovém okné zaskrtnéte polozku Suppressed ObJects a potvrd te LOK ],

HE Model Tree ltems [g|
Dizplay Feature Types
Features General | Cabling || Piping | MFG | Mecharism
Placement folder | | — .
0 i £7 Daturn Plane ¥ Sketch
[ Annatations o
P . :
MFG Duner £ Dratum Asis  Used Sketch

uppressed Objects o Curve
[

complete Objects xxx Datum Paint
Excluded Objects

Blanked Objects
[] Errvelope Components
[ Copied References

5{% Coordinate System
?c Round
il R?u Auto Round Member

P Cosmetic

—
L
(e
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> Nyni si ndzorné ukaZeme funkci POTLACENI (SUPPRESS).
125. Ve stromé kliknéte pravym tlacitkem na prvek Group ROZTEPANI a z kontextové nabidky vyberte Suppress.
126. Zobrazi se upozornéni, které potvrdte

g,‘/‘_" Swepk Blend 1 “ ‘ ‘

1 Cosmetic id 627
cv;h: Rewalve 2
“ Round 1
Fd Group ROETEPANI
& Insert Here

Delete
Ungroup
Group
Rename !
Edit

Edit Definition

/a\ Prvek, ktery méa déti, bude potlacen i se svymi détmi, ty budou pted potlaéenim zvyraznény ve stromé& a vyskodi hlaska

g’ -4 "‘) s upozornénim. Ulozte si soucast pomoci CTRL+S a zkuste si pro pfiklad potlacit prvek Var Sect Sweep 1.

> Potlaceny prvek se ve stromé zobrazi se znackou cerného Ctverecku . &7 Swept Blend 1
AT Cosmetic id 627
ha Revalve 2
“ Round 1
(% 59 "Group ROZTERAN
& Insert Here

>  Potlaceny prvek Ize obnovit kliknutim pravym tlacitkem mysi a volbou Resume z kontextové nabidky.

1 Cosmetic id 627

cv}?:r Revolve 2
4 Round 1

= Group ROZTEPANI
& Insert Here

Delete
Ungroup
roup

Fename !

Krok ¢.12 Vytvoreni dvou instanci modelu pomoci funkce Family Table

> Nyni dame uZivateli na vybér, které zakonceni Sroubu bude chtit pouzit pokazdé, kdyz otevie soucast Sroub. Pomoci funkce
Family Table toho dosahneme tim, Ze podle potieby potlatime nebo nepotlacime prvek Group ROZTEPANI.

127. Spustte prikaz Tools->Family Table.
>  Vytvorime dvé instance modelu Sroubu.

[=x]
]

V otevieném dialogu dvakrat klepnéte na ikonu = .

B Family Table :SROUB
File Edit Insert Tools

B % +
Lookln:| v| 1% Eﬂg:[\ﬁj N & @E,I-. @j m
’ 1
Tvpe stancelliang Eononliang |Insert a new instance at the selected row, |
SROUE | sroub. prt
SROUE_INST sroub.prt_IMST

- SROUE_INST1 | sroub.prt INST
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» Pridéme do tabulky sloupce
128. Kliknéte na I a v dialogu vyberte Feature. Iteris Filker
129. Ve stromé oznacte prvek Group ROZTEPANI. F1388, ROZTERANI
130. Vybér potvrdte tladitkem Done a [_2&_J,
Feature
rE=EE [
Add [tem
Menu Manager
— ag () Dimension () Group
~ SHELECT [REAT (%) Feature () Parameter (") Pattern T able
) Merge Part () Ref Model () Other
Done
it

V tabulce pfibyl novy sloupec reprezentujici prvek Group ROZTEPANI.
Bunky v téchto sloupcich mohou nabyvat hodnot:

Y (=YES) - znadi, Ze prvek je soucasti modelu (neni potlaceny)
N (=NO) - znadi, ze prvek neni soucasti modelu (je potlaceny)

Y

131. Prejmenujte instance modelu dle obrazku. SRR AEE
132. Nastavte hodnoty bunek dle obrazku. p———
'
133. Potvrdte : Look Inj SROUB_FINAL v| ¥ (% 7% % 05 g oo 8 B0 M
Type Instance Mame Common Mame EDBZSTEEF'ANI
SROUB_FINAL |soubpt v
SROUE_ROZTEPANY staubptINST 7
SROUB_NEROZTEPANY staubupr_INST1
Krok ¢.13 Otevreni instance modelu
134. Ulozte stavajici model kliknutim na & nebo File->[H 5= nebo CTRL+S.
v . , - . By M arameter
135. Zaviete model kliknutim na = nebo File [ ces vindon o Im
> I kdyz zaviete okno s modelem, tento model z{stava v paméti dale a pokud jej chceme znovu gggﬂg—ﬁgggg’;ﬁzw
otevrit z ulozeného souboru, musime nejprve model z paméti odstranit. h
136. Odstrarite model z paméti pfikazem File>Erase->| ¢ Mot Displayed...
137. Oteviete model z uloZzeného souboru = .
138. V otevieném dialogovém okné poklepejte na pozadovanou instanci modelu.
: o
1 ) The generic je puvodni instance modelu tak, jak jsme jej ulozili
,-’f\\ Zmeény procyédéjte pouze v instanci The generic, zmény provedené v jiné instanci nelze
/ & ' uloZit do puvodniho modelu. Instance [The generic |
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CVICENI IV

CiL

Zaklady vytvareni svarll v systému PRO/ENGINEER, procviCeni kopirovani a vkladani skic, ukazka funkce Sweep
Protrusion a zopakovani jiz dfive procviCenych prvkl vytazeni, rotace, zaobleni a dalSich na jednoduchém prikladu
tvorby sestavicky svarku sloZzeného ze dvou soucasti.

PREDPOKLADY

e Pfipravena Sablona ze cviCeni 0.
e Zaklady skicovani a vytvareni geometrickych vazeb ze 3.cviceni

PROBIRANE PRVKY, FUNKCE A POSTUPY

Vytvoreni sestavy

Modul Svarovani (Welding)

Kopirovani a vkladani skic (Paste Special)
Rotace (Revolve)

Vytazeni (Extrude)

Tazeni (Sweep Protrusion)

Zaobleni (Round)

Srazeni hran (Edge Chamfer)

Zavit (Cosmetic Thread)

AN N N N NENEN
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Krok ¢.1 Vytvoreni nové soucasti téla Sroubu kliky

Kliknéte na =

Vyberte Part a nazvéte ji SROUB_KLIKY_TELO.
Zkontrolujte, zdali je zapnuta volba Use default template.
Potvrdte tladitkem L2&_J,

PWNE

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Rotace hlavy Sroubu (Revolve)

5. Kliknéte na “°Revolve,
6. Vytvoite skicu, zaénéte kliknutim na Placement a [_feine ],
7. Umistéte skicu na rovinu NARYS a kliknéte na [(Sketeh |,

v ;v , o £ By, O
8. Vypnéte zobrazeni véech pomocnych prvkdl = 24 /= *& F& 4

9. Aktivujte ikony ‘| “"'Shade Closed Loops a HighligEI|1t Open Ends.
10. Ve skicafi nejprve vytvorte svislou osu kliknutim na Ma i, osu vedte podél
svislé pfimky, ktera ve skicafi znazorfiuje pomocnou rovinu BOKORYS(viz obr.). .
11. Vytvote tfi Usetky > (viz obr.). ;
— 2.00
5.00
| vl
v H AQ—L ______________________________
20.00 |
12. Vytvorte oblouk ¥ mezi koncem Usetky a osou (viz obr.).
13. Okétuijte oblouk a pridejte geometrické vazby dle obrazku.
14. Ukoncete reZim skicare ¥ . i
- 2.00 '
Y| 5.00
—
. L H @—L _______________________
20.00 ~

15. Potvrd'te provedeni pfikazu rotace .

w Vice informaci o prvku ROTACE viz dokument ROTACE
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Krok ¢.3 Protazeni téla Sroubu (Extrude)

16. Zobrazte pomocné roviny | §| AR Di.

17. Kliknéte na ikonu  Extrude.

18. Vytvofime skicu kliknutim na Placement a [__0sire. |,

19. Vyberte rovinu PUDORYS.

20. Kliknéte na Zlutou Sipku pro zménu jejiho sméru tak, aby ukazovala stejny smér jako na obrazku.
21. Kliknéte na pro prepnuti do skicare.

22. Vypnéte zobrazeni pomocnych prvkl  Z4 /= *x ¥ E
23. Nacrtnéte a okdtujte kruznici se stfedem v pocatku (viz obr.).

24. Ukoncete rezim skicare ¥ .

6.00

25. Nastavte velikost protazeni na 15mm
26. Potvrd'te provedeni pF|’kazu.

E Pravidelné ukladejte (CTRL+S)

@ Vice informaci o prvku PROTAZENI viz dokument PROTAZENI.
15.00
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Krok ¢.4 Vytvoreni zavitu Sroubu (Cosmetic Thread)

27. Vytvorte rovinu DTM_ZAVIT ve vzdalenosti 2mm od roviny PUDORYS (viz obr.).
28. Tuto rovinu posurite ve stromé za zakladni roviny (NARYS, PUDORYS, BOKORYS).

29. V nabidce Insert->Cosmetic spustte prikaz Thread...
30. Vyberte plochu, do niz budeme vyrezavat zavit (viz obr.).

B COSMETIC: Thread  [X|

Element [yl
» Thread Surf Drefining
Start Surf Required
Direction Reguired
ThreadLength  Reguired
M ajor Diam Required
Mate Params Required
[Define] [ Fefs ] [ Info ]
]S Cancel Prewigw

31. Jako StartSurf vyberte rovinu DTM_ZAVIT.

B COSMETIC: Thread

Element I
Thread Surf Defined
» Start Surf Defining
Direction Required
ThreadLength  Required
b ajor Diamn Required
Mate Params Required
[Define] [ Refs ] [ Infa ]I
Ok Cancel Fresigwm

32. Vyberte smér vyfezavani zavitu. o
COSMETIC: Thread
33. Potvrd'te Okay. rea

3

Element Info
Thread Surf Defined
Start Surf Defined
» Direction Defining
ThreadLength  Reguired
h ajor Diam Required
Mote Params Required

[Define] [ Refs ] [ Inf ]

0k, Cancel Preswiew




34. Ukonceni zavitu zvolte Upto Surface.

35. Vyberte povrch zobrazeny na obr. vpravo zelené.
36. Potvrdte Done.

37. Zadejte prdmér zavitu 5.4mm.

38. Potvrd'te Done/Return.

@ Enter DIAMETER 5.4000] ¥

Krok ¢.5 Srazeni hrany (Edge Chamfer)

39. Spust'te prikaz S Edge Chamfer.
e [D#D  v| D[0sD v

40. Velikost sraZzeni nastavt
41, Oznacte hranu, kterou chcete srazit (viz obr.) a potvrd'te .

Krok ¢.6 Zaobleni hran (Round)

42, Spust'te prikaz ¥ Round.

43, Nastavte polomér zaobleni 0.5mm.

44. \/yberte prvni hranu (viz obr.).

45, Drzte CTRL a vyberte druhou hranu (viz obr.)

46. potvrdte .

47. Spust'te pfikaz “VRound.
48. Nastavte polomér zaobleni 2mm.
49. Vyberte hranu (viz obr.).

50. potvrdte .
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51. Hotovou soucast ulozte = .

Q Pravidelné ukladejte (CTRL+S)

Krok ¢.7 Vytvoreni nové soucasti oka Sroubu kliky

52.Klknéte na 1 .

53. Vyberte Part a nazvéte ji SROUB_KLIKY_OKO.

54, Zkontrolujte, zdali je zapnuta volba Use default template.
55. Potvrdte tladitkem L2,

Krok ¢.8 Priprava pomocné skici TRAJEKTORIE

56. Vytvorte pomocnou skicu na roviné NARYS.
57. Jako reference vyberte roviny BOKORYS a PUDORYS.

58. Naskicujte a okétuite elipsu dle obr. kliknutim na © H.o.

Rx 10.00

[ S

)

10.

00

» Vytvofime dvé pomocné (construction) Usecky.

59. Nacrtnéte a zakdtujte dvé usecky (viz obr.).

60. Oznacte jednu z Usecek a kliknéte na ni pravym
tlacitkem, pfidrzte chvili pravé tlacitko.

61. Z kontextové nabidky vyberte Construction.

> Uselka se zobrazi ¢arkované, co? znadi, Ze je pomocnd.

62. TotéZ proved'te u druhé usecky.

Rx 10.00 @

10.

00
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63. Ofezte Cast elipsy ohrani¢enou dvéma Useckami(viz obr.) pomoci

64. Ukoncete rezim skicare ¥ .
65. Tuto skicu poklepanim ve stromé pojmenujte TRAJEKTORIE.

Ry 4,50

.

Rx 10.00

10.00

Krok ¢.9 Tazeni oka Sroubu (Sweep Protrusion)

66. Spust'te prikaz Tazeni (Sweep Protrusion) v nabidce Insert->Sweep-> Protrusion...

> Objevi se dialogové okno pfikazu Sweep Protrusion, nejprve se nas
ptd na definovani trajektorie.

» Menu Manager ndm nabizi, zdali chceme definovat trajektorii pomoci
predem pFipravené skici nebo naskicovat trajektorii nyni.

67. Vyberte v Menu Manageru volbu Select Traj.

PFedem pFipravenou skicu je vyhodné pouzit, jestlize skicu budeme i
po provedeni tohoto piikazu dale vyuZivat, takovato skica zOstava i
nadale ve stromé a lze ji pouzit pro dalsi prvek (vytazeni,rotaci
apod.) narozdil od skici interni, kterou definujeme uvnitf prikazu
(volbou Sketch Traj). Pfedem pfipravena skica je vyhodna i z toho
ddvodu, Ze ji Ize promitnout do vykresu a vyuzivat ji pii kétovani
vykresu.

()

& PROTRUSION: Sweep [X]

Elerent Info
> Trajectony Defining
Section Required
Menu Manager
w S\WEEP TRAJ
[ Define ] [ Refs H Info ]

(] Cancel

Select Traj

68. Vyberte skicu TRAJEKTORIE.
69. Potvrdte Done.

MNARYS

EOKORYS

Menu Manager

w CHAIN

One By One

Tangnt Chain
Curve Chain
Bndry Chain
Surf Chain
Intent Chain

FUDORYS

Done

Cuit
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> Nyni nas systém pFepnul do skicife a poZaduje po nas naskicovat priFez budouciho télesa.

70. Naskicujte kruznici O dle obrazku. . ® PROTRUSION: Sweep &|
71. Ukonéete reZim skicare Y . e .
Trajectary Sketched Trajectany
» Section Drefining
< | [
[ Define ] [ Refs ] [ Infa ]
QK Cancel Preswview

72. Kliknutim na potvrdite prikaz.
73. Hotovou sou&ast ulozte =

E Pravidelné ukladejte (CTRL+S)

Krok ¢.10 Vytvoreni sestavy Sroubu

> Nejprve vytvofime sestavu, poté do ni vloZzime obé dvé vytvorena télesa. /\
74. Kliknéte na U . SEST_PUDORYS
75. Vyberte Assembly a nazvéte ji SROUB_KLIKY. SEST_NARYS/

76. Zkontrolujte, zdali je zapnuta volba Use default template.
77. Potvrdte tlacitkem (3£,

;

VEST_BOKORYS

> Vlozime do sestavy obé vytvorena télesa.

- v f KD v r
78. Kliknéte na = Assemble pro vloZeni komponentu.
79. Vyberte soucast telo a kliknéte na i

>  Soucast jsme vlozili do sestavy na nahodnou pozici, nyni musime soucast v sestavé zavazbit.

SEST_NARYS

SEST_PUDORYS

SEST_BOKORY

BOKORYS
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»

81. Potvrd'te .

:KD

Placement  Mowe  Flesbility  Properties

Autarmatic

:'E Mate

3 Align

@ Ingert

J—. Coord Syz
g’ Targent
/ Prt On Line
[o| Prit O Sif

(&4 Edge On 5if

g Fiw

Nyni upfesnime polohu této soucasti v sestavé, to udélame tak, ze vybereme typ vazby Default, tim budou pomocné roviny
soucasti telo leZzet na pomocnych rovinach sestavy (NARYS bude leZet na roviné SEST_NARYS apod.).

80. V dialogové listé vyberte Default (viz obr.).

EST_PUDORYS

Automatic ! v |fv NOTDEFINE | 7 STATUS: NoConstraints E,_'||| ||)(

@( |'|:I|:| T_\,‘ Uszer Defined v ‘

82. Kliknéte na = Assemble pro vloz
83. Vyberte soucast oko a kliknéte na

eni komponentu.
i.

84.V dialogové listé vyberte Default (viz obr.).

85. Potvrd'te .

SEST_BOKORYS
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Krok ¢.11 Skicovani pomocné skici pro vytvoreni svaru

> Potfebujeme upravit komponent OKO, musime se pfepnout do rezimu PART.
86. Ve stromeé kliknéte pravym tlacitkem mysi na komponent OKO.

87. Z kontextové nabidky vyberte Open.

> Tim se v novém okné otevie soucCast OKO.

_;"'\ Pozor, zmény v takto otevieném okné nelze zrusit, vzdy se automaticky promitnou do sestavy, ze které jste okno otevfreli.
I N . 7 v . ~v 7 ’ v e - w7, v s o) o ’ v
e Jedina moznost jak se vyhnout nezadoucim zmenam sestavy je sestavu zavrit bez ulozeni a vratit se k puvodni sestavé.

Takto oteviené okno neni tfeba po dokonceni Uprav ukladat, zmény se po uzavieni okna promitnou do oteviené sestavy,
poté je pouze nutné ulozit celou sestavu.
=IElE)

[ Shaw ][ Settings * ]

[T Asmon01. A5mM
[J TELCLPRT

Regenerate

Representation

Delete

88. Kliknéte na ", vyberte rovinnou plochu valce (viz obr.) a klepnéte na

tladitko m

surf:Fa(PROTRUSION)|

> Kolmy pohled na skicovaci rovinu neni v tomto pfripadé vhodny, jelikoZ neni prehledny, je nutno upravit zobrazem

89. Prepnéte zobrazeni na dratovy model se zobrazenim skrytych hran 5| @| 50,
90. Natocte si pohled priblizné tak, jak jej vidite na obrazku.

>  Pri vstupu do skicare se objevi dialogové okno References s hlasenim Reference Status - Partialy Placed. To znamena,
Ze systém potiebuje zadat dalsi referencni rovinu nebo osu, aby mohl umistit skicu.

Y , , AR =
91. Zapnéte zobrazeni pomocnych os = £% /=% s 7L

92. Vyberte osu OSA_Y a kliknéte na
(oo ],

93, Zaviete dialog References.
>  Status se zméni na Fully Placed, coz znamena,
Ze skica je jiz umisténa

F3MARYS)

Select| Uss Ecge/Oifost ]

Reference status
Partially Placed

Close




94, Pomoci pfikazu i Centerline naskicujte svislou osu (viz obr.)
95. Promitnéte hrany (viz obr.) pomoci prikazu “ Use.

96. Nyni kliknéte na ikonu & pro nastaveni pohledu kolmo na skicovaci rovinu.
97. Naskicujte, zavazbéte a okotuijte tfi Usecky dle obrazku.

w Podrobnéjsi postup vytvareni skic, kdtovani a vytvareni geom. vazeb naleznete ve 3.cviceni.

98. Aktivujte ikony &
99, Ofiznéte pomoci prikazu

“‘/Shade Closed Loops a Highlight Open Ends.

T Delete Segment Cast kruznice tak, aby vznikla uzaviena skica na obrazku.

&

e’ i,
r:._; | i ot
I
|
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100. Kliknéte pravym tlacitkem mysi na spodni vodorovnou Usecku a v kontextovém menu vyberte Construction.

101. Ukoncete rezim skicare ¥ .

Yy
%

—

L 6.00 =

E Pravideln& ukladejte (CTRL+S)

Krok ¢.12 Zkopirovani pomocné skici pro vytvoreni svaru

> Nyni jsme vytvofili skicu na jednom konci télesa, stejnym postupem lze vytvofit i skicu na druhém konci télesa, nicméné je
mozné tuto skicu zkopirovat se zménou referenénich prvkd a tim si zkratit praci. Tento postup si nyni ukaZeme.

102. Oznacte ve stromé skicu, kterou jsme pravé vytvorili. o ——
103. Skicu zkopirujte pomoci ikony %= 2 Copy nebo CTRL+C.

104. Kliknéte na ikonu (& ZIpaste Special a v dialogu zaskrtnéte pouze
moznost Advanced reference Conflguratlon. Fully Diependent with options bo wary

Dimenzions and Annotation Element Details Only

[] Dependent copy

[] &pply Move/Rotate transformations to copies

Advanced reference configuration
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»

Nyni budeme projizdét jednotlivé referenéni prvky, nékteré z nich zmé&nime a nékteré ponechame ptvodni.
105. Jako skicovaci rovinu vyberte rovinnou plochu na opacném konci télesa (viz obr.).

R
Advanced Reference Config

Paste |

References of Original Features Fieferences of Pasted Features

Use Original Fek
5wk FPROTRUSION] [ Use Diiginal Rforsnce

MARYS:FIDATUM PLANE]
Edge:FB[PROTRUSION)
Edge:FB[PROTRUSION)

| SuifFEPROTRUSION)

Used By
Sketch 1

v ) x ]

106. Kliknéte na polozku v seznamu NARYS:F3(DATUM
PLANE).

> Tato reference zUstava stejnd jako u plvodni skici.
107. Zaskrtnéte Use Original Reference (viz obr.).

@ Advanced Reference Configuration
Paste |

£y

Feferences of Pasted Features

References of Onginal Features Use Original Reference

Surf:FAPROTRUSION]

FIDATUM FLANE] |

Edge:FEPROTRUSION] Used By:

Edge:FE[PROTRUSION] Sketch 1

108. Kliknéte na polozku v seznamu Edge:F8(PROTRUSION).

109. Jako referencni hranu vyberte hranu na opacném konci télesa (viz obr.).

B Advanced Reference Configuration
Paste |

X

References of Original Features Feferences of Pasted Features

SukFEPROTRUSION] [] Use Original R eference
NARYS:FIDATUM PLANE) .
Edge:FEFROTAUSION) [ Bl FETAUSION

Edae:FAPROTRUSION]

Uged By

Sketch
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110. Kliknéte na dalsi polozku v seznamu Edge:F8(PROTRUSION).

i V tomto pfipadé jsou v seznamu dvé stejné polozky, které znazorfiuji dvé poloviny promitnuté hrany. V systému
PRO/ENGINEER je vzdy kruznice rozdélend na dvé polokruznice a je nutno tedy obé tyto reference zadavat zvlast.

111. Jako referencni hranu vyberte hranu na opacném konci télesa (viz obr.).
112. Potvrd'te zadani referenci tlacitkem

B Advanced Reference Configuration

K3

Paste |

Fieferences of Original Features o T YT Lo

SwlFEPROTRUSION] [] Use Original Reference
NARYS:FADATUM PLANE)
Edge:FEIPROTRUSION]

| Edge:FEPROTRUSION)

Uszed By:

/ Sketch 1

v X

> Skica by méla mit stejnou orientaci, jako ma skica plivodni. Nasledujici nahled tedy nevyhovuje.

113. Kliknéte na a zobrazte nahled .

B Preview [g|

Orientation [tems Description

Section Orientatio .ETCH 3 Click Flip to change the Rightward
direction for section orientation.

» Nasledujici nahled jiz vyhovuje nasim poZadavkim.

114. Potvrd'te vloZeni skici dle danych referenci .

H Preview [$__<

Onentation lkems Description

Click. Flip to change the Rightward
direction for section arientation.
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115. Zavrete okno soucasti OKO a vrat'te se do otevieného okna se sestavou sroub_kliky.

Krok ¢.13 Srazeni hran oka - pfiprava pro svar

> Nyni si pfedvedeme, jakym zplsobem Ize jednoduse v ProEngineeru modifikovat sou¢ast v sestavé s vyuzitim promitnuté
geometrie jiné soucasti.
116. Vyberte soucast OKO, kliknéte na ni pravym tlacitkem a v menu vyberte Activate (viz obr.).

Regenerate
Open
Representation 3
Delete

Sroup

Suppress

Edit Definition

Make Flexible

> Nyni si pfedvedeme, jakym zplsobem Ize jednodu$e v ProEngineeru modifikovat sou¢ast v sestavé s vyuzitim promitnuté
geometrie jiné soucasti.

117. Vyberte soucast oka, kliknéte na ni pravym tlacitkem a z nabidky vyberte Activate (viz obr.).

> Tim jsme se prepli do rezZimu modelovani soucasti a zaroveri vidime i ostatni sou¢asti a mtizeme promitat jejich hrany a
vyuzivat je.

118. Vytvorte skicu na roviné NARYS.

119. Jako reference pro skicu promitnéte rovinu BOKORYS, obé rovinné plochy oka a oblouk téla (Cervené na obr.).
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120. Naskicujte lichobéZnik a okétujte dle obrazku.

H R

s

Lo
i

SRR s e o e SRR e
T

i

R R

(71,863)

S e i
R
kS

(71.86%)

s s s e
L R L
e AL M LD SR AL TR O
R AL LD S LR AR R
FERd: A L AT LS L
L
L R L R
R i s S S o

121. Spustte prikaz Extrude.

122, Protahnéte tuto skicu na obé strany (v Options nastavte 2x Through All) a zapnéte odebirani materialu 4,
> Tim jsme ofizli konce oka tak, aby jej bylo mozno pfiloZit k télu Sroubu a nasledné svafrit k sobé&, coz si ukazeme dale.

L AEME A
R e
EE g

it
B s
B T
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Krok ¢.14

Vytvoreni svaru

> Nejprve se pfepneme do rezimu svareni.
123. V sestavé sroub_kliky v menu Applications kliknéte na Welding.

3 ) Svary jsou v systému PRO/ENGINEER pouze kosmetické prvky a obdobné jako zavity

se nezobrazuji vérné, ale pouze zjednodusené.

Analysis  Info BEEEElGEN Tools  Window
®  Standard

Cabling

Fiping

Legacy !

Mechanica

Mechanism

Animation

Flaskic Adwisor

Mold Layout
> Prepnutim do rezimu svareni se zméni ikony v bocni nastrojové listé. = WELD DEFINITION fg|
124. Kliknéte na ikonu = Weld v boni nés’ao'ové li$te. Elez;”'ep @Ezr.”bira“m
ige Frep Ingle:
125. V otevreném dialogu kliknéte na ikonu a potvrdte [ox . ] wield ) Symmetiical
[ Natch ) Unsymmetrical

} Erviranment
Weld Feature

NN 5 i T )
Preparation fngle

N

HAN

Preparation Depth

0
0

Penetration
Root Opening 0.250 —
} Optional and User Defined Parameters

126. V Menu Manageru v CHAIN zvolte Feat Curves.

Element Infa
Edge Prep Optional
YWelding FRod Optional
“weld Process Optional
Parameters Defined
Groove Type Defined
Geom Type Defined
» Groove Refs Defining
Cne By Cne Face Offzet Optional
Tangrt Chain Penetration Defined
. Sym Attachment  Optional
Suree Gt Measurements  Defined
Bndry Chain #-5ec Plane Optional
Surf Chain

Define
Ok, Cancel

’ IE Select @

Select 1 item.

Infa

Intent Chain
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127.
128.
129,
130.

131.

Kurzorem najed’te do mist, ve kterych jsme skicovali pomocnou skicu a
poté co se skica zobrazi ji vyberte kliknutim.

Stisknéte prostiedni tlacitko pro potvrzeni.

V Menu Manageru v CHAIN zvolte Feat Curves.

Kurzorem najed’te do mist, ve kterych jsme skicovali druhou pomocnou
skicu a poté co se skica zobrazi ji vyberte kliknutim.

Stisknéte prostiedni tlacitko pro potvrzeni.

132. Smér nastavte dle obrazku pomoci Flip.
133. Potvrd'te provedeni ptikazu .
134. Zruste vytvareni dalSich svart .

B Pravidelné ukladejte (CTRL+S)
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CVICENI V

V'

CIL

Vytvoreni soucasti noze do sestavy mlynku na maso s pouZitim probranych pikazd a nové probranych prvkd Boundary
Blend a Draft.

PREDPOKLADY

e Pfipravena Sablona ze cviceni 0.
e Zaklady modelovani z predchozich cviceni.

NOVE PROBIRANE PRVKY, FUNKCE A POSTUPY

v" Boundary Blend
v Zkoseni (Draft)
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Krok ¢.1 Vytvoreni nové soucasti

1. Y > part >NUZ> [,

@ V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Vytvoreni zakladniho bloku (extrude).

2. Prikazem © Extrude vytvorte kvadr.

= 15,00 ——

15.00

LY
L

L s
++

L)
L

Krok ¢.3 Pfiprava pomocné geometrie

3. Vytvorte pomocnou rovinu ROVINA_1.

M DATUM PLANE

Flacement | Display " Properties |

References
EdgeFE[EXTRUDE_1] Through
Edae:FEEXTRUDE_1] Through

Offzet

Translation

@ Vice informaci o VYTVARENI POMOCNYCH ROVIN se dozvite v POMOCNE GEOMETRICKE PRVKY na strané 2-4
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4. Vytvorte pomocnou rovinu ROVINA_2.

B DATUM PLANE

Flacement | Dizplay " F'ropertiesl

References

ROVIMNA_T:FFDATU... Offset

Offget

Tranzlation

2z.00

»  Vytvofime pomocnou rovinu ROVINA_3.
5. Vytvorte rovinu ROVINA_3 ve vzdalenosti 0.5mm smérem ke spodni hrané kvadru.
>  Cili z tohoto pohledu bude rovina ROVINA_3 lezet pod rovinou PUDORYS.

B DATUM PLANE

Placement | Display || Properties|

References

PUDORYS:F2[DATU... Offset

Offzet

Tranzlation

Ve skice nalrtnéte pouze jednu tse¢ku  Line (viz obr.).
Tato Usecka bude slouzit jako trajektorie pro prvek Swept Blend.

. Ukoncete reZim nacrtu ¥ .

® VN O

ROVINA_T

ROVINA_2




10. Jako reference této skici vyberte osu OSA_Z a rovinu PUDORYS (viz obr. vpravo).
11. Ve skice nacrtnéte a zakoétujte trojuhelnik (viz obr. vievo).
> Tato skica bude slouzit jako prvni prifez pro prvek Swept Blend.

12. Ukondete rezim nacrtu v .
OSA 7 B References g@g
F2[PUDORYS]
05A_Z:FADATUM £5]
45:
v 7.00
) Select | Use Edge/Offset A
9500
Reference statuzs
| I PUDORYS | | Ful Placed
> Vytvorime dalsi skicu, kterd bude slouzit jako druhy priitez pro prvek Swept Blend.
13. Vytvorte samostatnou skicu " Sketch na roviné ROVINA_2.
14. Jako reference této skici vyberte osu OSA_Z a rovinu PUDORYS (viz obr. vpravo).
15. Ve skice nacrtnéte a zakdtujte cerveny trojuhelnik (viz obr. vievo)
> Modry trojuhelnik je zde zobrazen pouze pro urceni orientace a nemusite jej v nacrtu mit.
OSA Z B References Ej@g|
F2[PUDORYS]
054 _Z:FADATLUM &15]
Select | Usze Edge/Offzet v
Reference status
 PUDORYS | Fully Placed

Close

P=— 3 B0 —i=

>  VSechny tfi skici budou v modelu umistény, jak je zobrazeno na tomto obrazku.

ROVINA 1

ROVINA_2
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Krok ¢.4 Prikaz Swept Blend

16. Piikazem Swept Blend vytvoite z pfipravenych skic objemové téleso.

Section 2

ROVINA 2
w Vice informaci o prvku SWEPT BLEND se dozvite ve cviceni 2 (krok ¢.3)

Krok ¢.5 Znasobeni prvku (pattern)

17. Znasobte ( & Pattern) pravé vytvoreny prvek Swept Blend kolem osy OSA_Z.

Krok ¢.6 Odfriznuti spodni ¢asti modelu

>  Vytvorime plochu, pomoci které ofizneme model y
18. Kliknéte na ”~ Curve, vyberte volbu Thru Points a kliknéte na Done.

Fram File

Use ¥sec
From Equation

Done

Quik
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»

19. Kliknéte na dva vrcholy (viz obr.) — =
20. Potvrd'te Done. Attributes Free
» Curve Points Defining
Tangency Optional
Tweak Optional

Na obrazovce se objevilo nasledujici menu, nyni oznacime dva body, mezi kterymi
kfivka povede

® CURVE: Through Points [X]

[Define] [ Refs ] [ Infar ]I

0k Cancel Freview

Menu Manager

CT THRE

Spline
Single Rad
Multiple Rad

Single Point

add Point

Deleke Poink

Insert Paint

Done
Quik
21. Oznacte v menu Tangency. ® CURVE: Through Points [X|
22, Kliknéte na Define. —
Elernent Info
Aftributes Free
Curve Points Defined

Tangency Optional
Tweak Optional

[Define] [ Refs ] [ Info ]

0F. Cancel Prewview

23. Oznacte prvni hranu, ke které bude kfivka tec¢na.
24, Kliknéte v menu na tlacitko.




25. Oznacte prvni hranu, ke které bude krivka te¢na.
26. Kliknéte na tlacitko Flip v menu pro obraceni sméru tecnosti a potvrdte Okay.

27. Potvrd'te Done a Ok.

28. Znasobime tuto kFivku kolem osy OSA_Z.




29. Spust'te piikaz & Boundary Blend.
30. Vyberte jednu z vytvorenych kfivek (obr. vlevo).
31. Pravym tlacitkem dlouze kliknéte na bily ¢tverecek na konci kfivky a z menu zvolte Extend To... (obr. vpravo).

L1

Trim At.‘%

32. Oznacte hranu (obr vlevo).
> Krivka se prodlouzila k hrané (obr. vpravo).

33. TentyZ postup zopakujte na druhém konci kfivky, dostanete kfivku na obrazku dole.




> Timto postupem jsme vytvorili jednu prodlouzenou kfivku, v dialogové listé je napsany 1 Chain.
> Tentyz postupem na protilehlé sténé vytvofime druhy Chain.

’»_‘% Curves  Constraintz  Control Fointz Options Properties

2| 1 Chain | 7| Click here to additem |

34. Podrzte tlacitko CTRL a oznacte protilehlou kfivku.

& POZOR! Pokud nepfidrzite CTRL nahradi nova kfivka kfivku praveé nadefinovanou.

35. Stejnym postupem, ktery je popsan v bodech 27 az 29 prodluzte i tuto kfivku.

¢
i
Trim AE... !

> Nyni mame definovany dvé kfivky, v dialogové listé je uvedeno 2 Chain.
36. Klikneme do druhého pole pro definovani dalSich dvou kfivek ve druhém sméru.

Curves  Congtraintz  Control Points - Options  Properties

;ﬁ? Curvezr  Congtraintz  Control Pointe Options Propertiez ,ﬁ?
A2 [ 2Chains | /% | Click here to add tem | — 2 [ 2Chains | (| Selectiems s

37. Opakujeme postup uvedeny v bodech 26 az 31 pro kfivky ve druhém sméru (viz obr.).




» Nyni méme definovany 2 kFivki kazdém sméru, tento pfikaz Boundary Blend vytvofi plochu ohranic¢enou témito kfivkami.
38. Potvrd'te provedeni prikazu .

£ | 2Chains | #& [ 2Chains |

ﬂ‘ Curves  Constraints  Control Points Options Properties

> Plocha je zobrazena Cervené na obrazku, pomoci této plochy ofizneme objemové téleso.

39. Ve stromé oznacte pravé vytvoreny prvek Boundary Blend.

40.V menu Edit vyberte piikaz T solidify...
41, Ujistéte se, zda Zluta Sipka ukazuje smérem, ktery je zobrazen na obrazku.

42, Potvrd'te provedeni piikazu .

Krok ¢.7 Kruhové zahloubeni (extrude - cut)

43. Pikazem 7 Extrude odFiznéte z télesa diru kruhového prdfezu (viz obr.).

15.00

.00
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Krok ¢.8 Vyfiznuti diry ¢tvercového prifezu (extrude — cut)

44. Vyfiznéte diru ¢tvercového prirezu.

Krok ¢.9 Vytvoreni Uskost (draft)

> Je potreba vytvofit Ukosy pro snadné vyjmuti odlitku z formy pfi slévani.

45, Spust'te prikaz “ Draft.
46. Kliknéte na tlacitko References.
47. Stisknéte a drzte CTRL a vyberte plochy dle obrazku.

ividual Surfaces

Draft surfaces

& Select items

Details...

Draft hinges

® Click here to add item

Details...

Pull direction

| ® Click here to add item

| | Fip

References

> Nyni vybereme neutrélni hrany (hrany, které pti zkoseni stén zlstanou na svém mist&)

48. Kliknéte do kolonky Draft hinges.
49. Kliknéte na tlaitko [Detas.. ]

Diraft zurfaces

|ndividual Surfaces

Details...

Diraft hinges
Pull direction
|# Click here toaddtem | Flin
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50. Drzte CTRL a postupné vyberte hrany dle obrazku.
51. Potvrdte tlacitkem H

1 One-by-One Chain
References | Options
(%) Standard
() Rule-bazed
References

EdgeF27[DRAFT_1)
EdgeF27[DRAFT_1)
EdgeF27([DRAFT_1)
EdgeF27[DRAFT_1)
Dyharmic validation

52, Kliknéte do treti kolonky Pull Direction.

Diraft surfaces

[ndividual Surfaces Details...

Diraft hinges

Pull direction
| EdoeF27[0RAFT_1) | [ Fip |

53. Vyberte hranu zobrazenou na obrazku.
54. Nastavte uhel zkoseni na 1.5°.

>  Z obrazku to neni jasné patrné, Ctvercovy profil diry se ve sméru zluté Sipky zuzuje.

55. Potvrd'te provedeni prikazu E

1.50
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56. TentyZ postup zopakuijte i u vnéjsich ploch.

Krok ¢.10 Zaobleni hran (round)

57. Zaoblete hrany prikazem “VRound (viz obrazky).
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Krok ¢.11 Vytvoreni ostfi noze

> Nejprve vytvorfime spodni ¢ast ostfi a to tak, ze ji ofizneme rovinou ROVINA_3.

58. Vybereme rovinu ROVINA_3.

59.V menu Edit vyberte prikaz
T solidify. ..
60. Nastavte Sipku dle obrazku.

61. Potvrdte provedeni prikazu .
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>  Vrchni ¢ast ostfi vytvofime pomoci protazeni (Extrude — cut) a nasledného znasobeni (pattern).
62. Prikazem protaZeni ofiznéte model dle nasledujicich obrazka.
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63. Oznacte pravé vytvoreny prvek protazeni.
64. Pomoci prikazu Pattern vytvorte prvek znasobeni, pouZijte znasobeni kolem osy OSA_Z.

i ) Jestlize jste ofiznuti vytvofili u vedouciho prvku plvodniho znasobeni prvku Swept Blend (Pattern 1 of Swept
Blend 1), m{Zete nyni vyuZit moZnosti Reference u volby typu znasobeni.
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65. Kliknéte v menu View na Color and Appearance.

» Objevi se okno Appearance Editor.

66. Stisknéte tlatitko * pro pFidani nového materilu.

67. Kliknéte na tlacitko Color a vyberte zelenou barvu.

68. Pod zalozkou Assigment vyberte Surfaces.

69. Drzte CTRL a vyberte obrobené plochy.

70. Po vybrani vSech ploch kliknéte na tlacitko OK v dialogu Select.

71. Poté kliknéte na tlacitko .

»  Po kliknuti na tlacitko Apply se oznacené plochy obarvi vybranou barvou.

B Select E'

Select 1 or more ikems.

aF. Cancel

B Appearance Editor |Z||E|P5__(|
File Material Options

‘e +

copy of <ref_color 3|

w Azzighment

Ma Selection

Clear

From todel

Clazs | Generic »

Basic |Map Advanced | Phatolus

Calor
Calar
i Intensity Bright
—— 0
Dirn Ambient Bright
———O
Highlight
Colar
Dim Shine Bright
| J
Diirn Intensity Bright
| ]
[ Ciose ]




CVICENI VI

CiL

Vytvoreni soucasti Sneku do sestavy mlynku na maso. Soucast prvku na maso je vytvofena pomoci Sroubovice.
Sroubovice je fizena grafem stoupani.

PREDPOKLADY

e Pfipravena Sablona ze cviCeni 0.
e Zaklady modelovani z predchozich cviceni.

NOVE PROBIRANE PRVKY, FUNKCE A POSTUPY

Wrap

Offset

Intersect

zobrazeni dle vrstev (layers)
Graph

SNENENENEN
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Krok ¢.1

Vytvoreni nové soucasti
1.

U S part >SNEK~> [,

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Pomocna geometrie
2. Vytvorte pomocnou rovinu HORNI.
88.00
I DATUM PLANE X
/ \ PLIDORYS Placement | Dizplay | Properties
MJf"""tR"r"SnAIr ,"'[ ,n’r \\ References
\ J/ PUDORYS:F2DATU...

Offzet

Offzet
/

Tranzlation [88.00

b

-
v

Vice informaci o vytvareni pomocnych rovin najdete v dokumentu POMOCNE GEOMETRICKE PRVKY
3. Vytvoite pomocnou rovinu ZADNI.

Kazda rovina ma dvé strany, které jsou barevné odliSeny - Cervena/Cerna (a pokud pouzivate jiné barevné schéma bude
to jina kombinace barev). Berte toto v Uvahu pfi definovani téchto pomocnych rovin, abyste umistili roviny tak, jak jsou
umistény v tomto cviceni.

& DATUM PLANE X
Flacement | Display | Properties
T
hi HORNI References
I|
]

MARYS:FIDATUM P... Offzet
PUDOEYS
. 5 '\V 4
AL WA

Offzet

Tranzlation |150.00

b

BOKORYS
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4. Vytvorte prvek rotace (viz obr.) a nazvéte jej KUZEL.
> Jako skicovaci rovinu pouzijte rovinu NARYS, jako osu rotace pouzijte osu OSA_Z.

a

pro vytvoreni plochy.

> Pred vstupem do skicare v dialogové listé zapnéte ikonku

L NARYS.

..... 5 : HORNL___

— '1 2UDORYS.
10.00

T 2.50°

5. Vytvorte prvek rotace (viz obr.) a nazvéte jej VALEC.
> Jako skicovaci rovinu pouzijte rovinu NARYS, jako osu rotace pouzijte osu OSA_Z.

]

> Pred vstupem do skicare v dialogové listé zapnéte ikonku pro vytvoreni plochy.

f=—y 48/00 Aa-‘
r
zui_ 00 NARYS_
HORNI
fp PLIDORYS.
20.00
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6. Vytvorte skicu na roviné ZADNI.

7. Dllezité je vytvorit a umistit soufadny systém kliknutim na El a®.
> Tento soufadny systém je potieba vytvorit kvili definovani prvku OVINUTI (viz dali krok).

8. Poté vytvorte Spline kfivku ™ vedenou osmi body a zakétujte (viz horni obrazek).

r 52600 r 67.600 - FRO00

- 42.200 I

12.300 a.om8 r—f—“‘:!?_r/‘
[
i A
70.600 o]

e 147.900 ——5=

255.600

347.600

439.000

527,000

600.000

ZADNI

Krok ¢.3 Vytvoreni prvku WRAP

9. Vyberte ve stromé skicu vytvorenou v bodé 6.

10. Vyberte v nabidce Edit piikaz Wrap.

>  Skica, ktera bude tvofit ovinuti je jiz zadana tim, Ze jsme ji vybrali ve stromé.

> Plochu, na kterou se bude kfivka ovijet Ize zadat v kolonce destination nebo v kolonce oznacené na obrazku Cervené.
11. Kliknéte do pole Destination a v hlavnim okné vyberte plochu prvku VALEC (vytvofeného v bodé 5).

Sketch
| Sketchz | [ Uniirik |

Drestination

GuilF12

= Feferences  Options  Properties

.
[Ejl 1 item(s] |]@ | Sketcher C5v5 1+ I ¥ax X
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12.V dalSim poli (¢ervené vyznaceném na obrazku) nastavte Sketcher CSYS.

Optionz  Properties

[ 1 temis) © [oketcherC5YS w0

13. Potvrd'te provedeni prikazu .
ZADNI

Krok ¢.4 Nastaveni zobrazeni

>  Pro trvalé zobrazeni pravé vytvorené krivky v grafickém okné je nutné v nastaveni zapnout zobrazovani pomocnych krivek.
14.V menu View --> Display Setting --> zvolte Model Display.

15. V otevieném okné Model Display se prepnéte na zalozku Shade.

16. Zaskrtnéte volbu With datum curves a zavrete dialogové okno tlacitkem OK.

Krok ¢.5 Variable Section Sweep

17. Spust'te prikaz “variable Section Sweep. L 9/7 T-0.00

18. Zvolte volbu Sweep as surface pro ploSny model.
19. Vyberte Sroubovici (viz obr.).

Origin
=0.00

20.V menu References v dialogové listé vyberte v Section Plane Control moznost Normal To Projection.

Section plane control
MHarmal To Projection b

Direction reference

HORMI:FE(DATUM PLANE)
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21. Jako referenci vyberte rovinu HORNI a smér nastavte dle obr. RNI

=

22. Kliknéte na ikonu , CimZ se prepnete do skicare.
23. Nacrtnéte prifez, ktery tvori jedna Usecka (viz obr.).

24, Potvrd'te provedeni prikazu .

VI-6




Krok ¢.6 Prvek OFFSET

25. Vyberte ve stromé praveé vytvoreny prvek Variable Section Sweep.
26. Vyberte v nabidce Edit prikaz Offset.

27. Nastavte vzdalenost na 2mm. o EX I 4
28. Zkontrolujte smér Offsetu dle obrazku a potvrdte .

Krok ¢.7 Prvek INTERSECT

29. Vlyberte ve stromé prvek Variable Section Sweep vytvoreny v kroce €.5.
30. Pridrzte CTRL a vyberte prvek KUZEL vytvoreny v bodé ¢.4.
31. Vyberte v nabidce Edit piikaz Intersect.

>  Prikazem Intersect se vytvori kfivka, ve které se protinaji dva vybrané prvky.
32, Potvrdte .

33. Vyberte ve stromé prvek Offset vytvoreny v kroce €.6.
34. Pridrzte CTRL a vyberte prvek KUZEL vytvoreny v bodé ¢.4.
35. Vyberte v nabidce Edit prikaz Intersect.

36. Potvrdte .
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Krok ¢.8 Vytvoreni vnitfniho kuzelu (revolve)

37. Vytvorte prvek rotace dle obrazku se skicovaci rovinou NARYS.

25.00

Krok ¢.9 Skryti pomocnych ploch pomoci vrstev (layers)

38. Kliknéte na tlacitko umisténé nad stromem.

39. Z nabidky vyberte polozku Layer Tree.

> Tim prepnete strom do zobrazeni dle vrstev.

40. Kliknéte ve stromé pravym tlacitkem mysi a z kontextové nabidky

vyberte New Layer...

[ Show * ][ Laper * ][ Setting: ™

=i Lavers
Hidden Ikems
£ Anls

< CIIRVE
<7 DATUM_Z5YS
< DATUM_PLAME

& DATUM_POINT

41. Nazev nové vrstvy zvolte POMOCNE_PLOCHY.

42, Vyberte ve stromé prvky KUZEL, VALEC, Var Cect Sweep 1, Offset 1.

43. Potvrd'te vytvoreni nové vrstvy OK.

] SMEE3.PRT
£ BOKORYS
£ PUDORYS
7 MARYS

250
F OSAY
;: CI5A_%
J 05A_7
£F HORMI
£7 ZADNI

o
s
% Sketch 2

%Wrap 1

OFfset 1
"l Inkersect 2
" Intersect 1

& Layer Properties fz|
TR [P OMOCHE PLOCHY |
Layer Id: | |

Contents |F|ules || Notes|
Item Statuz
F11[KUZEL) +
FlamiaLEC) L
F15MaR_SECT_SWEEP 1] e
F1B[0FFSET_1) +
| Include. .. |[ Exciude... Remone
[ Fauze ] [ Cancel ]
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44, Pravym tlacitkem kliknéte na nové vytvorenou vrstvu a vyberte Hide z kontextového menu.

45. Kliknéte na tlacitko umisténé nad stromem.

46. Z nabidky vyberte polozku Model Tree.

Layers
Hidden Ikems
<7 ARIS
< CLIRNVE

<=2 DA TUM_CSYS .
£ DATUM_PLANE ‘ g™

&= DATUM_POINT

el P OMOICHE PLOCHY

Krok €.10 Prvek GRAPH

47.V menu Insert -> Model Datum spustte pfikaz Graph...
48. Potvrd'te zadani nazvu grafu GRAPH1.

49, Nacrtnéte skicu dle obrazku.

50. Potvrdte.

> Cerchované jsou zakresleny osy, vytvorite je pomoci ikony = .

J—-).

> Nezapomernte vloZit souradny systém do mista, které je zobrazeno na obrazku (pomoci ikony

25.00

|
|
|
|
|
|
|
|
|
|
|
!
! 20.00
|
|
|
|
|
|
|
|
|
|
|
|
|




Krok ¢.11 Vytvoreni parametrli

51. Vytvorte parametr W1 a jeho hodnotu nastavte 20mm.
52. Vytvorte parametr W2 a jeho hodnotu nastavte 25mm.

B Parameters
File Edit Parameters Tools Show

Lok In

CIEX

[ Pan v | (ISNEK3

Fiter By | 41 ]

Mame Tepe Walue
FOZICE Integer

Designate | Access

Source Description Fes

v| Froperties... H

I

Ok

H Reszet ][ Cancel ]

@ VICE INFORMACICH O PARAMETRECH SE DOZVITE V DOKUMENTU RELACE A PARAMETRY

Krok ¢.12 Pridani relaci do modelu

53.V menu Tools -> prikaz Relations, otevie se okno Relations.
54. Pri otevieném okné Relations vyberte ve stromé prvek GRAPH1.

> Tento prvek se zo brazi v modelu (viz obr.)

@ VICE INFORMACICH O RELACICH SE DOZVITE V DOKUMENTU RELACE A PARAMETRY

55. Kliknéte na koétu Cervené zobrazenou na obrazku vlevo (tim se nazev kéty zobrazi v okné Relations).
56. Kliknéte na kotu Cervené zobrazenou na obrazku vpravo (tim se nazev koty zobrazi v okné Relations).

A

E POZOR! nazvy kot ve vasem modelu se nemusi shodovat s nazvy kot zde uvedenymi, jsou pfidélovany automaticky.
.

d99
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57. Dopiste relace dle obrazku.

w Relations

O o BB X B2 S ()Y B
+ |C_HMOTHOST=CEILIMP_MASS[™].3)
— | Mmaterial=ratenial_param"'COMDITION"]
: 8=t
3=

1]
]

Iritial w

Krok ¢.13 Pomocné body

>  Vytvorte pomocny bod PNTO jako prisecik Sroubovice s rovinou BOKORYS.

58. Spust'te prikaz “* Datum Point.

59. Vyberte st vrchni Sroubovice (viz obr.)

60. Pridrzte CTRL a vyberte rovinu BOKORYS (ve stromé nebo v grafickém okné)
61. Kliknéte na napis New Point v seznamu bod( pro vytvoreni dalSiho bodu.

B DATUM POINT,

Placement | Properties

Mew Paint CurvecF18[IMTERSELCT... On
BOKORYS:F1[DATUM .. On

1) Pro prehlednost skryjte pomocné roviny kromé roviny BOKORYS, takté? vypnéte zobrazeni ostatnich pomocnych prvkd.
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> Nyni vytvorte dal& body stejnym postupem. Vytvoite &est bodi PNT1+PNT6 (viz obr.).
62. Opakujte predchozi postup: vyberte dalsi ¢ast vrchni Sroubovice, pfidrzte CTRL a vyberte rovinu BOKORYS.
63. Kliknéte na napis New Point.

B DATUM POINT

Placerment | Properties |

PNTO References

+ =R Curve:F18[IMTERSECT... On

Wew Paint BOKORYS:FI[DATUM ... On

Mest Intersection

[ Ok H Cancel

» Uvedenym postupem vytvorte prvnich sedm bodd zobrazenych na obrézku (PNTO=PNT6)
64. Potvrdte vytvoreni bodd kliknutim na [ox ],
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65. Postupem uvedenym v bodech 4855 vytvoite pomocné body na spodni Sroubovici
>  Vytvorte sedm bodl PNTZ+PNT13 (viz obr.).

>  Vytvorte koncové body dolnich ¢asti Sroubovic (body PNT14 a PNT15)

66. Spust'te prikaz * Datum Point.

67. Vyberte spodni konec vrchni Sroubovice (viz obr.).

68. Kliknéte na napis New Point v seznamu bod( pro vytvoreni dalsiho bodu.
69. Vyberte spodni konec spodni Sroubovice.

70. Potvrd'te vytvoreni bod@ kliknutim na ok ],

B DATUM POINT E]
Placement | Properties
W Feferences
Mew Paint End:Curve:F18 On
[ )8 ” Cancel ]
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>  Vytvorte koncové body hornich ¢asti Sroubovic (body PNT16 a PNT17).

71. Spust'te prikaz * Datum Point.

72. Vyberte horni konec vrchni Sroubovice.

73. Kliknéte na napis New Point v seznamu bod( pro vytvoreni dalsiho bodu.
74. Vyberte horni konec vrchni Sroubovice (viz obr.).

75. Potvrdte vytvoreni bodd kliknutim na

< DMTag
DATUM POIN
Placement | Properties
PHNT1G References
('S End: Curve:F17 On
Mew Paint
Krok ¢.14 Variable Section Sweep
76. Spust'te prikaz “variable Section Sweep. Trajectories x N T
Select tems

77. Zvolte volbu -’ Sweep as solid pro objemovy model.
78. Kliknéte na References a na tladitko (22t

» Otevre se okno Chain.

Section plahe contral

Huorizontal Aertical contral

References
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79. Po otevieni okna Chain vyberte vrchni Sroubovici (viz obr. vlevo)
80. Piepnéte se do zalozky Options.

»  Zkontrolujte, zdali je End2 na dolnim konci Sroubovice, paklize ne, stisknéte (Fie],
81.V kolonce End 2 nastavte Trim at Reference.
82. Jako referenci vyberte bod PNTO (viz obr. vpravo)

8/ Chain X & Chain
Add
Remaove Remove
References | Options | Heferences| Optiong |
(%) Standard Length Adjustmant
O Rt
References 0.00 b
Curve:F18(INTERSECT_1) -
PHTOF21[DATURM PO
Excluded
Click here to
£ | =
Start Point
Direction:
Dynamic walidation Dynamic validation
Cancel

83. Kliknéte na tlaitko 23],
84. Vyberte spodni Sroubovici.

>  Zkontrolujte, zdali je End2 na dolnim konci Sroubovice, paklize ne, stisknéte .
85. V kolonce End 2 nastavte Trim at Reference.
86. Jako referenci vyberte bod PNT7 (viz obr.).
87. Potvrdte tlagitkem (2],
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88. Nastavte Section plane control na Normal To Projection.
89. Jako Direction reference nastavte rovinu HORNI.

> Smér nastavte dle obrazku pomoci tlacitka .
90. Kliknéte na = pro prepnuti do skicare.

Trajectones * T
Origit = O aod
O O OO
Section plane control
| Marmal Ta Projection “ |

Direction reference
| HORNIFSDATUMPLEME] || Fip |

Harizontal " ertical contral

References

91. Nacrtnéte prifez (viz obr.).
92, Potvrdte zadani prirezu ¥

93.V menu Tools -> Relations zapiste rovnice uvedené na obrazku.

w Belations ‘
di |

nnéé'a%?f B8 = [ Sfx |

sdB=evalgraph["GRAPH1", 20" ajpar) ‘
— | zd9=evalgraph"'GRAPHT ", 20%rajpar) sd9

vV
!
]
[ s¢ld
= sd’ l
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>  Tyto relace urcuji, ze kéty zde uvedené budou fizeny grafem GRAPH1.

/o
74 AN
/ \

_ POZOR, nazvy kot sd8 a sd9 v rovnicich zaménte za ty ve vasem modelu, nemusi byt stejné.
: [ ] )]

File Edit Insert Parameters Utilities  Show
Lok In

b B B X % =2 1 [ fx B2
+ | edB4evalgraph] 'GRAPHT" 20%trajpar) i
— | zd99evalgraphl ' GRAPHT" 20" rajpar)

p Local Parameters

94. Potvrd'te provedeni prikazu .

PNTO
7. PNTZ
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Krok ¢.15 Kopirovani prvkd

» Dalsi prvky Variable Section Sweep Ize manualné vytvaret, nicméné je to ¢asové narocné. Pouzitim funkce Copy a Paste
Special Ize usSetrit ¢as a pritom Ize kopirovany prvek editovat stejné jako prvek manualné vytvoreny, neni zavisly na jiném
prvku.

i Kopirovani prvk{ bylo probiréano ve 2.cviéeni na strané 3.

95. Oznacte pravé vytvoreny prvek Var Sect Sweep.

96. Kliknéte na = Copy a poté na “El Paste Special.

97.V okné Paste Special zaskrtnéte pouze posledni polozku (viz obr.).

98. V otevieném okné postupné klikejte na cervené vyznacené polozky a nahrazujte je nasledovné:
e PNT16 nahradte bodem PNTO
e PNTO nahradte bodem PNT4
. PNT17 nahradte bodem PNT?7

x)

@ Advanced Reference Configuration

+  PNT7 nahradte bodem PNT11 Paste |
) References of Onginal Features
99. Potvrdte LY, n o e
"-""3F1 H”'E iSECT 1] References of Pasted Features
: Nd.LUNVE: [] Use Driginal R eference
el EiSpaal ) PNT1EF24[DATUM POINT])
End:Curve:F18 | Curve:F18[INTERSECT_1) |
] Dependent capy (PHTO.FZT[DATUM POINT]
Curve:F17[IMTERSECT _2)
Fully Dependent with options ta wary End:.Curve:F17
Dimengions and Annotation Element D etailzs Only PNT17:F24[DATUM POINT]) Uszed By:
End:Curve:F17
] ool Moverk o _ PHT7.F22[DATUM FOINT] Var Sect Sweep 3
pply Move/Ratate transformations to copies PUDDRYS:F2[DATUM PLANE]
Advanced reference configuration
Lv L x |

>  Stejnym zplsobem nakopirujte dalsich Sest prvkd tak, aby pokryly celou Sroubovici.

> Jediné, co musite pfi kopirovani ménit jsou body, které urcuji zacatek a konec trajektorie
Variable Section Sweepu.

> Napriklad pro treti dalsi kopirovany prvek nahradte body nasledovné:
e PNT16 (nebo PNTO) nahradte bodem PNT4
e PNTO (nebo PNT4) nahradte bodem PNT1
e PNT17 (nebo PNT7) nahradte bodem PNT11
e PNT7 (nebo PNT11) nahradte bodem PNT8

i Hodnoty pred zavorkou plati pro ptvodni Var Sect Sweep, hodnoty v z&vorce pro
\) zkopirovany Var Sec Sweep.
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Krok ¢.16 Odriznuti

» Vytvorte rovinu DTM1 dle obrazku.

— 91.00
I DATUM PLANE 3
Placement |Displa_l,J Praperties
References
D(_____——'i' PUDORYS:F2DATUM P... Dffset
f
|
|
|
|
: Offset
Tranzlation
DORYS

> PoutZijte prikaz Solidify k odFiznuti ¢asti kuzelového télesa.

w Pouziti pfikazu Solidify viz 5.cvi¢eni na strané 10 a 16.
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Krok ¢.17 Vysunuti zakonceni

100. Vytvorte protazeni dle obrazkad.

Krok ¢.18 Vytvoreni Ukosu (draft)

101. Spustte piikaz “ Draft.
102. Kliknéte na tlacitko References.

> Nejprve vybereme plochy, na kterych se bude zkoseni provadét.

103. Stisknéte a drzte CTRL a vyberte Ctyfi obvodové plochy kvadru dle obrazku.

Draft surfaces

& Select items Details...

]

Draft hinges
® Click here to add item Dietails,
Pull direction
| ® Click here to add item | Flip
Fieferences
> Nyni vybereme neutralni hrany. Diraft surfaces
104. Kliknéte do kolonky Draft hinges. Individual Surfaces .
- Details...
105. Kliknéte na tlagitko [Detais..], (Dot
Diraft hinges
Full direction
| Click here to additem | Flip
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106.
107.

Drzte a postupné vyberte hrany dle obrazku.
Potvrdte tlacitkem L_2%_J,

108.
109.
110.
111.

112,

Kliknéte do treti kolonky Pull Direction.

Vyberte hranu zobrazenou na obrazku.

Nastavte Uhel zkoseni na 1.5°.

Ujistéte se, Ze smér zkoseni '@stejn{/ jako na obrazku(nahoru se z0zuje).

Potvrd'te provedeni pfikazu (.
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Krok ¢.19 Vysunuti zakoncéeni

Krok ¢.20 Zaobleni

113. Vytvorte zaobleni dle obrazkd.
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Krok ¢.21 Rotace

114. Vytvorte prvek rotace kolem osy OSA_Z se skicovaci rovinou na prvku VAR SECT SWEEP.

Krok ¢.22 Zaobleni

115. Vytvorte zaobleni dle obrazkd.
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> Polomérem 2mm zaoblete hrany zobrazené na obrazku.
116. Pridrzte tlacitko CTRL a klikejte zhruba do mist oznacenych na obrazku Cervené.

117. Pokud se vam zobrazi nahled zaobleni totozny se zobrazenym obrazkem, potvrdte .
>

118. Vytvorte zaobleni dle obrazkd.

Krok ¢.23 Odfiznuti

119. Vytvorte pomocnou rovinu lezici na ploSe Cervené zndzornéné na obrazku.
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120. Pouzijte prikaz Solidify k odfiznuti ¢asti kuzelového télesa.

Krok ¢.24 Zakonceni

121. Vytvorte rotaci kolem osy OZA_Z.
|

Krok ¢.25 Zaobleni

122. Vytvorte zaobleni dle obrazkd.
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Krok ¢.26 Protazeni

123. Vytvorte protazeni dle obrazkad.

Krok ¢.27 Vytvoreni Ukosu (draft)

124. Spustte piikaz * Draft.
125. Kliknéte na tlacitko References.
> Nejprve vybereme plochy, na kterych se bude zkoseni provadét.

Drraft zurfaces

® Select items

Drraft hinges

Details. .

® Click here to add item

Pull direction

| ® Click here to add item

References

126. Stisknéte a drzte CTRL a vyberte plochy dle obrazku.

Details. ..

Flip
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»  Nyni vybereme neutralni hrany Diraft surfaces

127. Kliknéte do kolonky Draft hinges. Individual Surfaces .
- Details. .
128. Kliknéte na tlagitko [Detals.. ]
Diraft hinges
2 Select 1 item
Pull direchion

# Click here to add item

129. Dr7te CTRL a postupné vyberte hrany dle obrazku.
130. Potvrd'te tlacitkem

131. Kliknéte do tieti kolonky Pull Direction.

132. Vyberte hranu zobrazenou na obrazku.

133. Nastavte Uhel zkoseni na 1.5°.

134. Ujistéte se, Ze smér zkoseni 'ﬁstejn;'l jako na obrazku(nahoru se z0zuje).
o

135. Potvrd'te provedeni prikazu .




Krok ¢.28 Zaobleni

136. Vytvorte zaobleni dle obrazkd.

Krok ¢.29 Dira (hole)

137. Vytvoite diru (Hole) se zavitem M6x1 (dle ISO) o délce 14.5mm.

(45,000

@ Prikaz Hole byl podrobnéji vysvétlen ve 2.cviceni na strané 17.
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138. Vytvorte zkoseni 1x45° dle obr.

Krok ¢.30 Obarveni obrabénych ploch
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CVICENI VII

V'

CIL

Vytvoreni soucasti kliky do sestavy mlynku na maso. Tato soucast je tvorena prvkem Swept Blend, nékolika
protaZzenimi a zkosenimi.

PREDPOKLADY

e Pfipravena Sablona ze cviCeni 0.
e Znalost vytvareni pomocné geometrie
e Znalost prvk( ProtaZeni(Extrude), Dira(Hole), Zaobleni(Round), SraZeni hrany(Edge Chamfer)

NOVE PROBIRANE PRVKY, FUNKCE A POSTUPY

v Oboustranné zkoseni (Draft)
v Kfivka (Curve)
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Krok ¢.1 Vytvoreni nové soucasti

1. Y > part SKLIKA> o<,

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Pomocna geometrie

2. Vytvorte pomocnou rovinu DTM1 prochazejici osou OSA_Z a pootocenou vici roviné NARYS o 40°.

ARYS = DATUM PLANE X

Flacement | Display | Properties
:: *’ﬂ"t_z References
054a_ZFFDATUM A... Through
w MARYS:FADATUM P... Offset

' PUDORYS

Q ! Offset
:: - gt
:.5 % /’ Fotation | 40.00 W

~

BOKORYS

w Vice informaci o vytvareni pomocnych rovin najdete v dokumentu POMOCNE GEOMETRICKE PRVKY

3. Vytvorte pomocnou rovinu HORNI ve vzdalenosti 148mm od roviny NARYS.

— @ DATUM PLANE E3

Flacement | Display | Properties

_,_od-"'F'_FFFFF

References

MARYS:FIDATUM P... Offset
_,.o-'-"""'_FFFFF
>.PLJ DORYS
_o-'"_'-'-'-'-'-ﬂ-’

B " 148.00

Offzet

] Tranzlation | 143.00 w

BOKORY

AVAT )




4. Vytvorte pomocnou osu OSA_1 jako prisecnici rovin BOKORYS a HORNI.

® DATUM AXIS 3
Flacement |I:ili$|:ula_1,I Properties
References
BOKORYS:F1[DATU...  Thiough
HORMEFSDATUM P...  Through
>PUDDRYS
Offzet references
I

Pl
.

4/ Vice informaci o vytvareni pomocnych os najdete v dokumentu POMOCNE GEOMETRICKE PRVKY

5. Vytvorte pomocnou rovinu DTM2 rovnobéznou s rovinou DTM1 a prochazejici osou OSA_1.

= DATUM PLANE %]

Flacement |Displa_l,l Properties
References
DTHM1:FADATUM PL... Offzet
054_1:F10[DATUM ... Through
PUDORYS
Offset
Rotation  |{0.00 A
6. Vytvorte pomocny bod PNTO leZici v priseciku roviny NARYS a osy OSA_Y.
ARYS & DATUM POINT X
Flacement | Froperties
Tm References
i Mew Point 054 _Y:FSDATUM AxIS) On
:' MaRYS FIADATUM PL.. On
PUDORYS
=OSA_X
I Ok H Cancel

I.' k!

i/ Vice informaci o vytvareni pomocnych bod{ najdete v dokumentu POMOCNE GEOMETRICKE PRVKY
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7. Vytvorte pomocnou osu OSA_2 kolmou na rovinu DTM1 a prochazejici bodem PNTO.

B DATUM AXIS

Flacement |Displa_l,l Praperties

References
; PHNTO:FIZ2[DATUM P Through
\;PUDDR‘I"S DTHT:FACATUM PL... Mormal
e RA X Offzet references

8. Vytvorte pomocny bod PNT2 lezZici v priseciku os OSA_Y a OSA_1.

OSA_T

HORNI |

B DATUM POINT

Flacement | Properties

x)

References

gr: B

Hew Point

0SA_T:F10[DaTUM A On
0SA_ Y FRDATUM 2<I5] On

I Ok, H Cancel

9. Vytvorte pomocnou osu OSA_3 kolmou na rovinu DTM_2 a prochazejici bodem PNT2.

NARYS

OSA_Z

HOR

D

.

PN

Z

T2

-

e

PUDORYS
[O8A_2

B DATUM AXIS

Placemnent ‘

3

Dizplay | Properties

References

PHTZ:F14(DATUM P...
DTMZF11DATUM P...

Thraugh

Marrnal

Offzet references
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10. Vytvorte pomocny bod PNT1 lezici na ose OSA_Y ve vzdalenosti 74mm od roviny NARYS.

HORNI

= DATUM POINT 3

Placement | Properties

+ ENE Referances

\ Mew Paint 054 5 FRIDATUM A On
 TSRPNT2

PUDORYS Oifset  |-7400 | »
_‘_‘_/—‘_'—/

Qffset reference

(%) Reference MNARYS:F3[DA. .
—

OKORTS

Krok ¢.3 Krivka (Curve)

> VytvoFime kiivku pomoci t¥ bodd a dvou os ke kterym bude kFivka teéna.

11. Kliknéte na ikonu .

12. Vyberte volbu Thru Points z nabidky a potvrdte Done. From File

Llse xsec

From Equation
Done

it

13. Vyberte postupné body PNTO, PNT1 a PNT2 v tomto poradi a potvrdte Done.

OSA_1

CPNT2 w CONMECT TYPE

Single R.ad
Mulkiple F.ad

Single Point

hiole Array

OsA 2 )

LT Delete Poink

Insert Point

Done

Qi
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14.V zobrazeném okné vyberte Tangency a kliknéte na .

® CURVE: Through Points [X]

Element Info

Aftributes Free

Curve Points Defined

T angency Optional

Tweak Ophianal
lDefine] [ Refz ] [ Info ]

(] Cancel Preview

15. Nejprve vyberte osu OSA_2.
16. Tlacitkem Flip nastavte smér tecnosti dle obrazku a potvrd'te Okay.
OSA_T
\ _OSA3

w DEF TAN

Skart

CrvfEdge/Axis

Creake Axis
Surface
Srf Mrm Edge
Clear
Tangenk
[ ] Mormal

Done/Feturn

w DIRECTION

Flip
Okay

17. Vyberte osu OSA_3.
18. Tlacitkem Flip nastavte smér tecnosti dle obrazku a potvrdte Okay.

w DEF TAN

Skart

Creakte Axis

Surface
Srf Mrm Edge
Clear
Tangenk
[ Marmal

Done/Return

w DIRECTICHN

Flip
Okay
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19. Kliknéte na Done/Return a .
20. Prejmenuijte kiivku na KRIVKA_1.

22. Na roviné DTM2 vytvoite skicu SKICA_2, a nacrtnéte elipsu (viz obr.). OSA_]
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Krok ¢.4 Prvek SWEPT BLEND

23. V menu Insert spust’te pfikaz Swept Blend.

24. Kliknéte na ! Create a Solid.
25.V menu References vyberte jako trajektorii kfivku KRIVKA_1 (viz krok ¢€.3).

T=0.00

26. Kliknéte na menu Sections.
27. Zaskrtnéte volbu Selected Sections.

28. Vyberte skicu SKICA_1. ) Sketched Sections
29. Kliknéte na tlacitko pro viozeni dalsi skici. (® Selected Sections
L e —

Add Blend Yertex

30. Vyberte skicu SKICA_2.

> V pfipadé, Ze se dojde ke kfiZeni obalovych kFivek jako na obrazku, chytte mysi bilé kole¢ko a pFesurite ho na opacnou
stranu elipsy tazenim mysi.

Section 2
¢ <enfz

() Sketched Sections
(#) Selected Sections

Sections #

Section 1 2

Section & 2
( ,
Add Blend Vertex

BT
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Krok ¢.5 Prvek SWEPT BLEND - CUT

31. Na roviné DTM1 vytvorte skicu SKICA_3 dle obrazku.
» Jako svislou referenci vyuZzijeme ve skicafi osu OSA_Z a jako vodorovnou referenci rovinu PUDORYS.

32. Na roviné DTM2 vytvoite skicu SKICA_4 dle obrazku.
33. Jako svislou referenci vyuZijeme ve skicafi osu OSA_1 a jako vodorovnou referenci rovinu PUDORYS.

34. Spust'te prikaz Swept Blend.
35. Kliknéte na - Create a Solid.

36. Kliknéte na 2/ Remove material.
37.V menu References vyberte jako trajektorii kiivku KRIVKA_1.

T=0.00

Origin
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38. Kliknéte na menu Sections.
39, Kliknéte na Selected Sections.
40. Vyberte skicu SKICA_3 (Cervené na obr.).

() Sketched Sections
Q (®) Selected Sections
action 1
——
41, Kliknéte na tladitko pro vioZeni dal3i skici
42, Vyberte skicu SKICA_4 (Cervené na obr.).
f Section 2
() Sketched Sections
(%) Selected Sections
Sections #
| t
Section 1 2
Sechion 2 2
< 1l 5
43, Potvrdte . O
Krok ¢.6 ProtaZeni zakonceni (extrude)

44. \/ytvorte protazeni dle obrazku se skicovaci rovinou PUDORYS.
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Krok ¢.7 Zkoseni (draft)

45, Spust'te prikaz “ Draft.
46. Kliknéte na tlacitko References.
> Nejprve vybereme plochy, na kterych se bude zkoseni provadét.

47. Stisknéte a drzte CTRL a vyberte plochy dle obrazku.

Drraft surfaces

® Select tems

Drraft hinges

Dretailz. .

® Click here to add item

Pull direction

| # Click here to add item

Feferences

Details. .

Flip

>  Nyni vybereme neutralni hrany
48, Kliknéte do kolonky Draft hinges.
49. Vyberte rovinu PUDORYS.

MNARYS
1.

Draft zurfaces

Individual Surfaces

Drraft hinges

PUCORYS:F2DATUM ..

Dretails...

Pull direction

Details...

| PUDORYS:FZDATUMF | Fiip

]

50. Kliknéte na tlacitko Split.
51. Z nabidky Split options vyberte Split by draft hinge.

52.V nabidce Side options vyberte Draft sides independently.

Split options

| Split by draft hinge v
Split object

| | Defire...
Side ophiohs

| Diraft zides dependently w
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53. V dialogové listé nastavte Ghel zkoseni na 10°.

> Volime zdmérné vysokou hodnotu, abychom rozpoznali smér zkoseni pFi nahledu.
54. Zméfite smér zkoseni dle obrazku 7.

55. Nastavte Uhel zkoseni na 1.5°.

56. Potvrd'te provedeni prikazu .

ﬁ) References Splt Angles  Options Properties

=, [ 1Plane | o[ 1 Plane N AVIETIE 4R &:ﬂ)(

Krok ¢.8 Vyfiznuti protazeni (extrude - cut)

57. Vytvorte diru protaZzenim dle obrazkd.
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Krok ¢.9 Zkoseni diry (draft)

58. Spust'te prikaz “ Draft.
59, Kliknéte na tlacitko References.

> Nejprve vybereme plochy, na kterych se bude zkoseni provadét.

60. Stisknéte a drzte CTRL a vyberte plochy dle obrazku.

Diraft zurfaces

® Select items | Details...

Diraft hinges

® Click here to add item | Details. .
Pull direction
| Click here to additem | Flip
References

> Nyni vybereme neutralni hrany

61. Kliknéte do kolonky Draft hinges.

62. Kliknéte na tlagitko [Detais...]

63. Drzte CTRL a postupné vyberte hrany dle obrazku.
64. Potvrdte tlacitkem

Diraft zurfaces
Individual Surfaces Details. .

e

Diraft hinges

e
Full direction
| ® Click here to add item | Flip

65. Kliknéte do treti kolonky Pull Direction.

66. Vyberte hranu zobrazenou na obrazku.

67. Nastavte Uhel zkoseni na 1.5°.

68. Ujistéte se, Ze smér zkoseni 'ﬁstejny'/ jako na obrazku.
ol

69. Potvrd'te provedeni prikazu .
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Krok ¢.10 Protazeni druhého zakonceni (extrude)

70. Vytvorte protazeni dle obrazku se skicovaci rovinou PUDORYS.

7.00

6.00

Krok ¢.11 Zkoseni (draft)

71. Spust'te prikaz “ Draft.
72. Kliknéte na tlacitko References.

> Nejprve vybereme plochy, na kterych se bude zkoseni provadét.
73. Stisknéte a drzte CTRL a vyberte plochy dle obrazku.

Drraft surfaces

® Select items Details. ..

Draft hinges

® Click here to add item Details. ..
Pull direction
| ® Click here to add item | Flip
References

> Vybereme neutrdini hrany
74. Kliknéte do kolonky Draft hinges.
75. Vyberte rovinu PUDORYS.

1.

Diraft surfaces

Individual Surfaces Details. ..

Diraft hinges

PUDOR: Z Details. ..

Pull direction

| PUDORYS:F2DATUMF | Fip |

VII-14



76. Kliknéte na tlacitko Split. o
77.Z nabidky Split options vyberte Split by draft hinge. Zplit aptions

78.V nabidce Side options vyberte Draft sides independently. | St by draft hinge b
| | Define...
Side optiohz
| Diraft zidez dependentiy w

79.V dialogové listé nastavte Uhel zkoseni na 10°.
>  Volime zamérné vysokou hodnotu, abychom rozpoznali smér zkoseni pfi nahledu.

80. Zméfite smér zkoseni dle obrazku 7% .
81. Nastavte Uhel zkoseni na 1.5°.

82. Potvrd'te provedeni prikazu .

j} References  Split Angles  Options  Properties

=\ [ 1Plane | o[ 1 Flane | A\ v XN Mo [v] X

Krok ¢.12 Dira (Hole)

83. Vytvorte diru (Hole) o prliméru 5mm skrz cely objem télesa.
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84. Proved'te zaobleni zobrazena na obrazcich.

85. Proved'te zaobleni zobrazena na obrazcich.
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86. Proved'te srazeni 1x45° viz obr.
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CVICENI VIII

CIL

Vytvoreni soucasti osicky, podlozky a tycky do sestavy mlynku na maso.

R—

PREDPOKLADY

e Pfipravena Sablona ze cviCeni 0.
e Znalost prikazd:

o Protazeni(Extrude)
Rotace(Revolve)
Zaobleni(Round)

Srazeni hrany(Edge Chamfer)
Zavit (Cosmetic Thread)

O O O O

NOVE PROBIRANE PRVKY, FUNKCE A POSTUPY

v" Rotace tenkosténného télesa
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Krok ¢.1 Vytvoreni nové soucasti

1. Y > part >0sIcKA> [,

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Rotace (revolve)

2. Prikazem Revolve vytvorte rotacni téleso (viz obr.) se skicovaci rovinou NARYS.

- 11.00 ————=

w Vytvareni skic a vytvareni geometrickych vazeb bylo podrobné&ji probrano v 1.cviceni

Krok ¢.3 Protazeni (extrude)

3. Vytvorte protazeni dle obrazkd.

OSA_Y

5.00

SA_L (O8A X

86.00

VIIT-Z




Krok ¢.4 Zaobleni hlavy (round)

4. Zaoblete dle obrazkd.

Krok ¢.5 Srazeni hran (edge chamfer)

5. Proved'te srazeni hran dle obrazkg.

U
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Krok ¢.7 Ulozeni soucasti

6. Ulozte vytvorenou soucast.
7. Zavrete okno.

Krok ¢.8 Vytvoreni nové soucasti

8. U > part >PODLOZKA > 35,

> Jestlize nemate ve stromé modelu pfipraveny pomocné osy OSA_X, OSA_Y a OSA_2Z, nyni je nadefinujte.

w Nadefinovani os OSA_X, OSA_Y a OSA_Z bylo podrobné popsano v 1.cviceni (KROK 2). Postup je zde stejny.

Krok ¢.9 Rotace (revolve)

10. Prikazem Revolve vytvorte rotacni téleso se skicovaci rovinou NARYS a osou rotace OSA_Z.
>  VytvoFime tenkosténné téleso o tloustce 1mm.

> Pred vytvofenim vlastni skici je dlleZité aktivovat ikonu C , ¢imz date systému najevo, ze budete vytvaret tenkosténné
téleso a systém tudiz nebude ve skicafi vyzadovat zadani uzaviené smycky.

11. Pfed vstupem do skicare nastavte v dialogové listé |£ Z .

_-IIJD / k) Ve g7 7 .7 7 . . s V.
12. Po vytvoreni skici nastavte pomoci tlacitka L% pridani materialu tak, aby ndami naskicovana kfivka
tvofila vnitfni hranu miskovitého tvaru podlozky (viz obr. vpravo dole).

2.00
T H
i T 1
8,170
” | +
Ifl E.Q0
| T 45400 l

| L ]

_\.ﬁ-"_

2.00

w Vice informaci o nastaveni pfikazu REVOLVE najdete v tutoridlu ROTACE.
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13. Vyfiznéte kruhovy otvor pfikazem extrude dle obrazku.

14. O > part >Tycka> o,

> Jestlize nemate ve stromé modelu pfipraveny pomocné osy OSA_X, OSA_Y a OSA_Z, nyni je nadefinujte.

@ Nadefinovani os OSA_X, OSA_Y a OSA_Z bylo podrobné popsano v 1.cviceni (KROK 2). Postup je zde stejny.

16. Prikazem Extrude protahnéte kruhovy prifez do vzdalenosti 25mm.

2.50
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CVICENI IX

CiL

Vytvoreni soucasti vicka do sestavy mlynku na maso. Tato soucast je tvorena nékolika rotacemi, zdkosovanim
nékterych stén a nékolika zaoblenimi.

PREDPOKLADY

e Pfipravena Sablona ze cviCeni 0.
e Znalost vytvareni pomocné geometrie
e Znalost prvkd Protazeni(Extrude), Zaobleni(Round), Srazeni hrany(Edge Chamfer), Zavit (Thread)

NOVE PROBIRANE PRVKY, FUNKCE A POSTUPY

v Vytvareni fezu
v" Obarveni télesa
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Krok ¢.1 Vytvoreni nové soucasti

1. 2 > part >vicko~> [,

w V tomto cviCeni je jako default template pouzita Sablona ze cviceni ¢.0

Krok ¢.2 Pomocna geometrie

2. Vytvorte pomocnou rovinu DIAG_1 prochazejici osou OSA_X a pootoCenou vici roviné NARYS o 150°,

ARYS

& DATUM PLANE X

Flacement | Display | Properties

References
MARYS:FIADATUM P Offset
054 _#:FRIDATUM A . Through

PUDORYS

Offzet
Rotation | 150.00 L

w Vice informaci o vytvareni pomocnych rovin najdete v dokumentu POMOCNE GEOMETRICKE PRVKY

3. Vytvorte pomocnou rovinu DIAG_2 prochazejici osou OSA_X a pootocenou vici roviné NARYS o 30°.

Flacemert | Display | Propertiss

ARYS
S :
e

References
058 < FRDATUM A . Through
HNARYS:FIDATUM P... Offset

PUDORYS

Offzet
Fatation 30.00 w

BOKORYS | =]

30.Q0

1X=2




4. Vytvorte pomocnou rovinu ROV_STRED ve vzdalenosti 7.5mm od roviny BOKORYS (viz obr.).

& DATUM PLANE X]

Flacement | Display | Properties

References

BOKORYS:F1[DATU... Offset

>PUDORV5

X

Offzet

Translation | 7.50 w

S

& DATUM AXIS B
Flacemert | Display | Properties

References

BOKORYS:FI[DATU...  Through
DIAG_T:FADATUM P... Through

Offget references

w Vice informaci o vytvareni pomocnych os najdete v dokumentu POMOCNE GEOMETRICKE PRVKY

6. Vytvorte pomocnou osu OSA_2 jako prisecnici rovin BOKORYS a DIAG_2.

& DATUM AXIS 3

Placement | Dizplay | Properties

References

BOKORYS:FIDATU...  Through
DIAG_Z:FIDATUM P... Through

Offzet references
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Na roviné NARYS vytvorte skicu (viz obr.) a pojmenujte ji SKELET.
Jako referencni roviny vyberte BOKORYS a PUDORYS.

> Tato skica bude slouzit jako kostra celé ¢asti modelu (SKELETON), obsahuje nejdtlezitéj$i rozméry modelu a budeme k ni
vazbit prvky tvofici model.

» N

15.00 —————&=]
BOKORYS
v
N\ A H
|30.W Y
! v
|
2,500

I H
|
|
|
| = 5.00 —=
|
|
|
|
|
|
|
| +
|
|
| |
|
|

60.500 |
|
: PUDORYS
|

58.376 I 4840 6500 63800
|
|
|
|
..... | e AL
Krok ¢.3 Rotace zakladniho tvaru (Revolve)

9. Vytvorte prvek rotace se skicovaci rovinou NARYS.
10. Jako reference vyuzijte pét kfivek ze skici SKELET (na obrazku Cervené).

B! References EJ@E|
/—9\ Curve:F13[CURVE)
Curve:F13[CURVE]

Curve:F13[CURWVE]
Curve:F13[CURWVE]
{ 1.00 | v Curve:F13[CURVE]

} J Select | Use Edge/Offzet A

b 260

\ Reference status
Fully Placed

—] J1.00 200
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11. Vytvorte skicu dle obrazku.

12, Jako osu rotace vyberte osu OSA_X.

Krok ¢.4 Rotace a znasobeni vystupku 1

13. Vytvorte prvek rotace se skicovaci rovinou NARYS.
14. Jako reference vyuzijte pét kiivek ze skici SKELET (na obrazku cervené).

65.00

F1BOKORYS)
F2(FUDORYS)
SurkF14(REVOLYE_T)

Select | Uze Edge/Offzet

L

Fieplace Delete

Fieference statuz
Fully Placed

Solve

Cloze
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15. Vytvorte skicu dle obrazku (pouzijte Spline).
16. Jako osu rotace vyberte osu OSA_X.

17. Proved'te rotaci o 22° |ﬂ ( v obou smérech od roviny NARYS o 11°).
18. Prvek pojmenujte VYSTUPEK_1.

4.05 —= |

65.00

19. Proved'te znasobeni prvku VYSTUPEK_1 kolem osy OSA_X dle obrazku.

2
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Krok ¢.5 Rotace a znasobeni vystupku 2

20. Vytvorte prvek rotace se skicovaci rovinou DIAG_2.
21. Jako reference vyuzijte: OSA_X, BOKORYS a dva povrchy rotacniho télesa (na obrazku Cervené).

B References E]EJ

F1([BOKORYS)

054 5 FEDATUM 2215
Surf:F14(REYOLVE_1)
SurfF14(REYOLYVE_1)

Selec:t| Jze Edge/Offzet »

Feplace Delete Salve

Reference status
Fully Placed

Cloze

22, Vytvorte skicu dle obrazku.
23. Jako osu rotace vyberte osu OSA_X.

24, Proved'te rotaci 0 22° |ﬂ ( v obou smérech od roviny DIAG_2 o 11°).
25. Prvek pojmenujte VYSTUPEK_2.
| .

|.=. 466 r>| ’.:4-40 i

3.26 'l% [=— 077 ~
g )
1168
8.85
3.40
¥ ] )
"""" d

' 2.46
: |
| :
: |
| :
: |
| :
: |
| :
1 |
| :
| |
65.00 |
|
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26. Proved'te znasobeni prvku VYSTUPEK_2 kolem osy OSA_X dle obrazku.
2

Krok ¢.6 Rotace a znasobeni vystupku 3

27. Vlytvorte prvek rotace se skicovaci rovinou DIAG_1.
28. Jako reference vyuzijte: OSA_X, BOKORYS a rovinny povrch rotacniho télesa (na obrazku cervené).

B References

F1[BOEORYS)
054 =< FRIOATUM A=IS)
Surk:F14[REVOLVE_1)

Select | |Jze Edge/Offzet w

Replace Delete Solve

Reference status
Fully Placed

Cloze

IX-8




29. Vytvorte skicu dle obrazku.
30. Jako osu rotace vyberte osu OSA_X.

31. Provedte rotaci 0 22° |ﬂ ( v obou smérech od roviny DIAG_1 o 11°).
32. Prvek pojmenujte VYSTUPEK_3.

= 6.41 6.60 =
232 —=— = —= = 1.90

N

6.95 T
& 3.{?0-

65.00 | |

R . -

33. Proved'te znasobeni prvku VYSTUPEK_3 kolem osy OSA_X dle obrazku.
2
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Krok ¢.7 Zkoseni (Draft)

> Zkosime dvé stény u kazdého ze ¥ prvkd VYSTUPEK_3 (vytvorenych znasobenim prvku VYSTUPEK_3).
34. Piikazem Draft vytvorte zkoseni prvni stény prvniho prvku VYSTUPEK_3 dle obrazkd.

> Na obrazku vlevo je vidét plocha, na které se bude provadét zkoseni (Draft surface).
> Na obrazku vpravo je vybrana neutraini hrana zkoseni (Draft hinge).

'1*‘ ‘1

/7 e

> Na obrazku vlevo je Cervené oznaceny smér zkoseni (Pull direction), je to osa OSA_1, OSA_2 nebo OSA_Y, podle toho,
ktery z prvkl pravé zaoblujete.
b

35. Prikazem Draft vytvorte zkoseni druhé stény prvniho prvku VYSTUPEK_3 dle obrazkd.

dividual Surfaces
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36. Proved'te stejné zkoseni i u dalSich dvou prvki VYSTUPEK_3.

OSA_2
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Krok ¢.8 Zkoseni (Draft)

> Zkosime stény véech ostatnich vystupkd.
37. Spust'te prikaz Draft a jako Draft Surfaces vyberte plochy ¢ervené oznacené na obrazku.

OSA_2

38. Jako Draft hinge vyberte rovinu ROV_STRED.

39. Jako Pull direction vyberte rovinu ROV_STRED (jeji normalovy vektor tak bude smérem zkoseni).

40. V menu Split vyberte Split by draft hinge a v nab idce Side option s nastavte Draft sides dependently.
41. Velikost zkoseni nastavte 2°.

Draft zurfaces

Individual Surfaces Details... Split options

| Split by draft hinge |

Draft hinges |5|:|Iit object | Wi %

ROV_STRED:FI0DAT.] Dol Define...

— Side options
Pull direction | Draft sides dependently w |
| ROV_STRED:F1ODATU | Fip |
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Krok ¢.9 Zaobleni (Round)
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Krok ¢.10 Vytvoreni fezu

42, Vytvorte fez télesem vicka rovinou NARYS.

> Rez télesem vytvotite tak, Ze kliknete na ikonu gy , na zalozce Xsec kliknéte na tlacitko New , nazev fezu:REZ1, kliknéte

na Done, kliknéte na Plane, vyberte rovinu (v nasem pfipadé NARYS) a pak jiz dvojklikem na nazev fezu fez aktivujete.

View Manager,

| Simp F|e|:|| Haec |Drient "Hl

5 Sl
SETUR PLAR
st w SETUP PLAMNE
o Zone Pla
One Side Make Dakum
Both Sides Quit Flane
Patkern Select 1 iten.
ik

Cloze
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Krok ¢.11 Rotace - vyFiznuti

43, Pomoci rotace vyfiznéte naskicovany profil od télesa.
44, Jako reference urCete BOKORYS, NARYS a Ctyri Usecky ze skici SKELET (viz obr.).

F1EOKORYS]
FEPUDORYS)
CurvesF13[CURVE)
CurvesF13[CURVE)
Curve:F13[CURVE)
CurvenF13[CURVE)

Select| Jze Edge/Offzet Vl

Replace [relete Solve

Fieference status
Fullp Placed

Cloze

Krok ¢.12 Zavit (Cosmetic Thread)

45, Vytvorte zavit funkci Cosmetic Thread.

46. Jako Thread Surf vyberte povrch ¢ervené oznaceny na obrazku vlevo.
47. Jako Start Surface vyberte rovinu BOKORYS.

48. Vyberte volbu Blind a oznacte nastavte délku zavitu 7.5mm.

49. Major Diam nastavte 60mm.
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Krok ¢.13 Zaobleni

50. Pfepnéte se do fezu REZ1.
51. Vytvorte dvé zaobleni R 0.8mm dle obrazku.

Krok ¢.14 Zkoseni

. . s opevew Angle x D % | Angle| 20.00 | D 0&Dn v | 5
52. Vyberte hranu (viz obr.) a nastavte v dialogové liste: [Ange | Andle R | A.
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53. Vytvorte zkoseni dle obr.

Krok ¢.15 Family table

> Vytvofime dvé instance Family table

Vytvareni Family table je podrobné&ji popsano ve cviceni ¢.3

54. Spust'te prikaz Tools->Family Table.
55. Pridejte do tabulky dva radky instanci.
56. Instance modelu pojmenujte ODLITEK a OBROBEK (viz obr.).

B Family Table :VICKD
File Edit Insert Tools

Loak Ir/YICK( v‘ ¥ (2 % 2 0§ s 5o 8 B 0T
Type Instance Mare Comrman Marme

VICKD | vicko_new. prt

ODLITEE wicko_new.prt_[MST

OBROBEK wicko_new.prt_[MST1

Cancel

>  Priddme do tabulky sloupce

57. Kliknéte na T8 a v dialogu vyberte Feature.

58. Vyberte Ctyfi posledni prvky ve stromé(prvky obrabéni).

B Family ltems, Generic : VICKO

Items

F13260, [ROUMD_8]
F13823, [COSMETIC)
F18303, [REVOLVE_E]
F13373, [CHAMFER_1]
F20366, [CHAMFER_Z]

M E]S]

o=

Add [tem
(*) Dimension Component
() Feature ) Parameter
() Merge Part ) Ref Modsl

Filter

Dimension
Parameter
Feature
Camponent
terge Fart
Ref Model
Group

ﬁ‘xf"\

) Group
() Pattern Table

) Other
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59. Nastavte zapnuti/vypnuti prvkd u jednotlivych instanci dle obr.
60. Potvrdte a ulozte model.

> Tim jsme vytvofili dvé instance modelu, z téchto dvou instanci budeme v jednom z dalSich cvieni vytvaret vyrobni

vykresy.

B Family Table :¥ICKO

File Edit Insert Tools
. } - [=a] 4
Laak In{¥ICKD v‘ ¥ ¢ e [ Wy oo B B OF
F13350 F13829 F18303 F13373 F20366
Type | Instance Hame LommenMame | \oninp g) [COSMETIC) [REVOLVE 5] [CHAMFER_1]  [CHAMFER 2]
VICKD |vicko_newptt ¥ v ¥ Y Y
ODLITEK vicko_newprt | M M M M M
OBROBEK. vicko_newprt_l.. ¢ * * " "

Cancel

Krok ¢.16

Obarveni povrch( télesa.

61.

> Objevi se okno Appearance Editor.

62.
63.
64.
65.
66.

67.

Kliknéte v menu View na Color and Appearance.

Stisknéte tlacitko ¥ pro pridani nového materialu.
Kliknéte na tlacitko Color a vyberte zelenou barvu.
Pod zalozkou Assigment vyberte Surfaces.

Drzte CTRL a vyberte obrobené plochy.
Po vybrani vSech ploch kliknéte na tlacitko OK v dialogu Select.

Poté kliknéte na tlacitko .

>  Po kliknuti na tlacitko Apply se oznacené plochy obarvi vybranou barvou.

B Select

Select 1 ar

X

more ikems.

]S

Cancel

EoX

B Appearance Editor
File Material Options

‘e

|copy of <ref_colarlz| |

Mo Selection

Clear

From Modsl

Basic | Map| advanced | Protols|
Color
Eolor-
Diirn Intensity Bright
0
Dvirni Ambignt Bright
0
Highlight
Colar
Diim Shine Bright
| J
Dviri Intensity Bright
| ]
[ Cloge ]
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CVICENI X

CiL

Vytvoreni téla mlynku na maso. Mlynek je odlévany a zelené vyznacené plochy jsou po odliti obrobené plochy.

PREDPOKLADY

e Pfipravena Sablona ze cviCeni 0.
e Nutna znalost zakladl modelovani soucasti z predchozich cviceni.

NOVE PROBIRANE PRVKY, FUNKCE A POSTUPY

Tvorba kfivek (Curve)

prace s plochami - pfikazy merge, copy, solidify, thicken, extend
Protrusion Sweep

Mirror

Zaobleni typu Full Round

SNENENENEN




Krok ¢.1 Vytvoreni nové soucasti

1. 5 > part >TELO-> (2],

w V tomto cviceni je jako default template pouzita Sablona ze cviceni ¢€.0

Krok ¢.2 Pomocna geometrie

2. Vytvorte pomocnou rovinu ROV_NOHA ve vzdalenosti 3mm od roviny BOKORYS.
3. Stisknéte CTRL+D pro standardni zobrazeni, nova rovina bude umisténa vpravo od roviny BOKORYS ve
vzdalenosti 3mm.

& DATUM PLANE 3
PUDORYS Flacement | Display | Properties

References

BOKORYS:F1[DATU... Offset

OSA_X

Offzet
Tranglation | ST w

OKORYS

w Vice informaci o vytvareni pomocnych rovin najdete v dokumentu POMOCNE GEOMETRICKE PRVKY

4. Vytvorte pomocnou rovinu HORNI ve vzdalenosti 62mm od roviny PUDORYS.

& DATUM PLANE X

Flacement | Display | Properties
References

FUDORYS:F2DATU... Offset

Offzet
Tranglation |62.00 A
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5. Vytvorte pomocnou osu OSA_NOHY jako prlisecnici rovin NARYS a ROV_NOHA.

ARYS

PUDIDRYS

& DATUM AXIS X

Flacement | Display | Properties
References

ROW_MOHAF4HDAT...  Through
NARYS:FADATUM P... Through

Offzet references

w Vice informaci o vytvareni pomocnych os najdete v dokumentu POMOCNE GEOMETRICKE PRVKY

Krok ¢.3

Nastaveni zobrazeni

>

7. V otevieném okné Model Display se prepnéte na zalozku Shade.

Pro trvalé zobrazeni skic v grafickém okné je nutné v nastaveni zapnout zobrazovani pomocnych kfivek.
6. V menu View --> Display Setting --> zvolte Model Display.

8. Zaskrtnéte volbu With datum curves a zavrete dialogové okno tlacitkem OK.

Krok ¢.4

Skelety - skici

9. Na roviné NARYS vytvorte skicu (viz obr.) a pojmenuite ji: SKELET_TELO.
10. Jako referencni roviny vyberte BOKORYS a PUDORYS.

» Tato skica bude slouzit jako kostra celé ¢&sti modelu (SKELETON), obsahuje nejdtleZit&j&i rozméry této ¢asti modelu a
budeme k ni vazbit prvky tvofici model.
> Jednoduchou zménou rozméru této skici pak budeme schopni zménit rozmér celého modelu a navic vazbenim prvkd na tuto
skicu predejdeme nezadoucimu vazbeni prvkd mezi sebou.
105.00
H
1.00 ANV
\.I
10.00 H
= 18.00 —= “éb‘ __________
ol Y
— i
TV 2 40,00
36.00 ? H 60.00
54.00
16.00 25 00 —
.50
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HORNI

11. Vytvorte druhou skicu SKELET_NOHA_1 na roviné NARYS. .
12. Jako referencni roviny pouzijte ROV_NOHA a PUDORYS. NEPOUZIVEJTE ROVINU BOKORYS!
13. Dale jako reference vyuzijte dva koncové body Usecky ze skici SLELET_TELO (na obr. oznaceny zelené).

30.00
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14. Vytvorte pomocny bod PNT6 jako prisecik osy OSA_NOHY a Usecky ze skici SKELET_TELO.

B DATUM POINT

X

Placement | Froperties

m References

0OSA NOHY New Paint 0SA_MWOHY:F10[DATU... On
j —

Curve:F11[CURVE) On

15. Vytvoite pomocny bod PNT7Z jako prisecik osy OSA_NOHY a Usecky ze skici SKELET_NOHA.

]

B DATUM POINT

Flacement | Froperties

Hew Paint Curve:F12[CURYVE] On
ROY_MOHA:FA[DATU... On

[ OF. H Cancel

16. Vytvorte druhou skicu SKELET_NOHA_2 na roviné ROV_NOHA . Pouzijte reference dle obrazku.

e NT6
- e
Vs ™.
i i !
. ||I_ ............. ~pr } B References E]E]
| 5.50ﬁ / F2(PUDORYS)
_ : Fa[NARYS]
? | %/ PNTEF12[DAT UM POINT]
.- 'é?‘”"// PNT7-F14[DAT UM POINT]
%
I I E] Select | Usze Edge/Offset hd
5.00 77.00
[ NN —

Feference status
T Fully Flaced

24.00 7

42.00




17. Na roviné HORNI naskicujte elipsu (viz obr.). Jako referencni roviny pouzijte BOKORYS a NARYS.
18. Skicu pojmenujte ELIPSA_VRCHNI

Ry 43.50

Rx 31.50

19. Na roviné PUDORYS naskicujte elipsu (viz obr.). Jako referencni roviny pouZijte BOKORYS a NARYS.
20. Skicu pojmenujte ELIPSA_SPODNI.

Ry 19.00

Rx 13.00
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21. Vytvoite skicu na roviné BOKORYS. Jako reference vyberte rovinu NARYS, PUDORYS a HORNI.

Krok ¢.5 Pomocné skici

22, Na roviné NARYS vytvorte skicu dle obrazku a nazvéte ji PRUREZ_1.
> Na obrazcich vpravo jsou Cervené vyznaceny pouzité reference, vlevo je pak profil, ktery je vazan na tyto reference.

L F"“*\x_,,._L ¢

3.00

—
!
?

B References | g@@
]

FRIROYW_NOHA,
CurverF12[CURYE]
PHT7:F14(DATUM POINT]

Select | Usze Edge/Offzet w

Reference status
Fully Placed

Cloze
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23. Vytvorte pomocny bod PNT8 (viz obr.)

B DATUM POINT

Placemnent | Properties

X

N B

* New Poirt

References

End:Curve:F19 On

[ O, ” Cancel

24. Na roviné NARYS vytvorte skicu dle obrazku a nazvéte ji PRUREZ_2.

B References

B=1E3

F3[M&RYS)
PNT7F14[DATURM POINT)
PHMTEFZO0[DATUM POINT)
Curve:F15[CURVE)

Select| |Jze Edge/Offset

W

Feference status
Fully Flaced

Cloze

25. Na roviné ROV_NOHA vytvorte skicu dle obrazku a nazvéte ji PRUREZ_3.

8.00

B References

F3MNARYS]
End:CuryeF12

Selectl Uze Edge/Offzet w

Reference statuz
Fully Placed

Cloze




Krok ¢.6 Pomocna geometrie

26. Vytvorte rovinu BOCNI rovnobéznou s rovinou NARYS a prochazejici bodem (viz obr.).

& DATUM PLANE X
Flacement | Display | Properties
References

End:Curve:F15 Thraough

MARYS:FIADATUM P... Parallel

27. Vytvorte rovinu DOLNI ve vzdalenosti 120mm od roviny PUDORYS (viz obr.).

& DATUM PLANE X

Placement |Di$pla_l,l Properties

References

FUDORYS:F2DATU... Offzet

Offzet

Tranzlation

&

120.00

28. Vytvorte rovinu PREDNI rovnobéZznou s rovinou BOKORYS a prochazejici bodem (viz obr.).

-

& DATUM PLANE X]

s a Flacement |Di$|:ula_1,I Properties

References

BOKORYS:F1[DATU... Parallel
End. Curve:F11 Through

[l ==




29. Vytvorte

rovnobéznou P

a prochazejici QE_LJ

® DATUM PLANE X

Flacement |Display Fropeties

References

End:Curve:F11 Thraugh
BOKORYS:F1[DATU... Parallel

rovinu ZADNI_1
s rovinou BOKORYS
bodem (viz obr.).

30. Vytvorte rovinu ZADNI_2 ve vzdalenosti 6mm od roviny ZADNI_1 (ZADNI_2 je vlevo od roviny ZADNI_1).

6.00

N

= DATUM PLANE X

Flacement |Displa}I Properties

References

ZEDMI_T:F26(0ATU...  Offset

Offzet

Tranzlation

31. Vytvorte pomocny bod PNT5 jako prisecik roviny ZADNI_2 a prodlouzené
Usecky ze skici SKELET_TELO.
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32. Vytvorte pomocny bod PNT1 jako prlisecik elipsy ELIPSA_VRCHNI a roviny NARYS (viz obr.).
33. Vytvorte pomocny bod PNT2 jako prisecik elipsy ELIPSA_SPODNI a roviny NARYS (vi z obr.).

B DATUM POINT

X

Placement | Properties
PNT1 References
+ N CurveF1F[CURVE) On
Mew Paint MARYS:FADATUM PL... On
[ OF. H Cancel ]

34. Vytvorte pomocny bod PNT3 jako prisecik elipsy ELIPSA_VRCHNI a roviny BOKORYS (viz obr.).
35. Vytvorte pomocny bod PNT4 jako prisecik elipsy ELIPSA_SPODNI a roviny BOKORYS (vi z obr.).

B DATUM POINT

X

Placement | Properties
— PNT3 Feferences
+ BN Curve:F17[CURVE) On
Mew Point BOKORYS:F1[DATUM .. On
[ 1]8 H Cancel




Krok ¢.7 Vytvareni krivek (Curve)

> PouZijeme kfivky pro upfesnéni tvaru plochy trychtyre, kterou vytvofime v kroku ¢.11.

36. Spust'te piikaz © Curve.

37.V menu zvolte Thru Points a potvrdte Done.
38. Kliknéte na bod PNT1 a poté na PNT2.

39. Potvrdte Done.

w CRY OPTIONS

Frarm File

Use Xsec

Frorm Equation

Done

Quit

40. V nabidce CURVE vyberte Tweak a kliknéte na [[Defive |,

41. Objevi se dialog Modify Curve (viz obr.).

42, Pomoci posunovani bod{ vytvorte profil kfivky (viz obr.).

>  Profil kFivky timto zplsobem zadédme pouze pfiblizny, neni svéazan kétami ani vazbami.

43. Potvrdte [ v ] a [L0K_].
44. Tuto kfivku nazvéte KRIVKA_1.

B Modify Curve E|
Movement Plane | Curve Plane w |

Firzt Direction
Second Direction
[ Mormal Direction | |

p Region

45, Zkopirujte vytvorenou kivku Copy.

46. Vlozte kfivku pomoci % paste Special. — . ['5_(|
47. Zaskrtnéte prvni dvé volby v dialogu Paste Special. Faotz dpae J

,
48. Potvrdte ' t ake Fully Dependent copies with options to vary

Apply Move/Rotate transformations to copies
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49, Nastavte rotaci o 180° a jako osu vyberte Usecku ze skici OSA_TRYCHTYRE.
50. Tuto kfivku nazvéte KRIVKA_2.

e [G5)| [ 1Edge || [1eamn

51. Spustte piikaz ~ Curve.

52.V menu zvolte Thru Points a potvrdte Done.
53. Kliknéte na bod PNT3 a poté na PNT4.

54, Potvrdte Done.

w CRY OPTICNS

Thru Painks

From File
se xsec

From Equation

55. V nabidce CURVE vyberte Tweak a kliknéte na [(Defive ],
56. Objevi se dialog Modify Curve (viz obr.).
57. Pomoci posunovani bodl vytvorte profil kfivky (viz obr.).

58. Potvrd'te a .
59, Tuto kfivku nazvéte KRIVKA_3.

B Modify Curve @
Movement Flane | Curve Plane w |

First Direction
Second Direction
[] Marmal Direction | |

p Dizagnostics

X-13




60. Zkopirujte vytvorenou kfivku Copy.

61. Vlozte kfivku pomoci & paste Special.
62. Zaskrtnéte prvni dvé volby v dialogu Paste Special.

63. Potvrdte .

B Paste Special g
Make Fully Dependent copies with options to vary

Apply Move/Rotate ransfarmations to copigs

64. Nastavte rotaci o 180° a jako osu vyberte Usecku ze skici OSA_TRYCHTYRE.

65. Tuto krivku nazvéte KRIVKA_4.

e (7)) [ 1Edae 18000 v

Krok ¢.8 Pomocna skica PREDNI_PROFIL

66. Na roviné PREDNI vytvorte skicu.

67. Skicu pojmenujte PREDNI_PROFIL

68. Jako reference vyuzijte PUDORYS,NARYS a koncovy bod
Usecky ze skici SKELET_TELO
(na obrazku Cervené).

69. Naskicuijte dvé kruznice, na vnitfni kruznici lezi referencni
bod. Vnéjsi kruznice je o 2mm vétsi.

B References

FZPUDORYS)
FIMARYS)
End:Curve:F11

E] Select | Use Edge/Offzet W

Feference statuz
Fully Flaced

Cloze
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70. Naskicujte oblouk a Usecku, vSe okétujte dle obrazku.

rovina NARYS

Krok ¢.9 Pomocna skica ZADNI_PROFIL

>  Tuto skicu Ize vytvorit obdobné jako skicu predchozi s tim rozdilem, Ze pouzijeme misto koncového bodu Usecky jako
referenéni bod PNT5 a misto roviny PREDNI pouzijeme rovinu ZADNI_2.

>  Rychlejsim zplisobem jak vytvofit tuto skicu je zkopirovani této skici a Paste special s moZnosti Advanced reference
configuration.

71. Oznacte ve stromé skicu PREDNI_PROFIL. B Paste Special ]
72, Stisknéte CTRL+C nebo kliknéte na Copy.

73. Vlozte k¥ivku pomoci % paste Special.
74. Zaskrtnéte posledni volbu v dialogu Paste Special.

75. Potvrdte [_2K_],

[] Dependent copy

[] &pply MovesRatate hansformations to copies

[w]:Advanced reference configuration:

76. V nabidce References of Original Features

. 2 i @ Advanced Reference Configuration §|
vyberte rovinu PREDNI a poté kliknéte na rovinu —

Fast
ZADNI_2. e
» tim nahradite plvodni rovinu rovinou ZADNI_2. Reterences of Original Features
PREDMI:F25(DATLIM PLANE] References of Pasted Features
FUDORYS:F2DAT M PLANE] [] Use Original Refersnce
MARYS:FADATUM PLANE]
End:CurvecF11 FRECMI:F25(DATIUM FLAME)
Ugzed By:

FREDHI_PROFIL
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77.Vyberte End:Curve:F11 a nahrad'te jej bodem
PNTS5. B Advanced Reference Configuration

78. Potvrdte a . Paste

References of Original Features

PREDMI:FZ5[DATUM PLANE] Feferences of Pasted Features
FUDORYS:F2(DAT LK PLANE) ] Use Driginal Feference
MARYS:FADATUM PLAME]

End: CurvecF11 End:Curve:F11

Ugzed By:
PREDMI_PROFIL

Krok ¢.10 PROFIL_PLOCHA (Swept Blend a pattern)

79. Spust'te prikaz Swept Blend.
80. Jako trajektorii vyberte Usecku zobrazenou na obrazku.

» Tato zvolena Usecka nepropojuje oba profily, proto ji prodlouzime
k profilu PROFIL_ZADNI.

81. Kliknéte pravym tlacitkem na koncovy bod u profilu
PROFIL_ZADNI.

82. Z nabidky vyberte Extend To...

83. Vyberte PROFIL_ZADNI a potvrdte.

84.V menu sections vyberte PREDNI_PROFIL, stisknéte
a vyberte ZADNI_PROFIL.

85. Potvrd'te .

Section 2
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86. Pomoci pfikazu =’ Pattern vytvorte znasobeni vytvofeného
Swept Blendu kolem osy OSA_Z, 8 prvk{ po 45°.
87. Vysledny prvek pfejmenujte na PROFIL_PLOCHA.

> Tato vysledna plocha nam bude slouzit jako zaklad pro vytvoreni
objemového télesa.

»  Mohli bychom pfimo vytvaret objemové téleso, nicméné
potifebujeme tuto plochu, abychom mohli pozdéji vytvorené téleso
touto plochou ofiznout.

Krok ¢.11 Prace s plochami

88. Ve filtru pro vybér entit vyberte Quilts.

89. Drzte CTRL a vyberte vSechny pravé vytvorené plochy (viz obr.).
90. V nabidce Edit spustte ptikaz Merge.

> Prikaz Merge spoji plochy do jedné.

91, Potvrd'te provedeni prikazu Merge.

@ Vice informaci o o filtru pro vybér entit naleznete v tutorialu UVOD

92, Ve filtru pro vybér entit vyberte Quilts.

93, Kliknéte na Sedou plochu, méla by se zbarvit cela
Cervené. (obr. vlevo)

94, Stisknéte CTRL+C pro zkopirovani Quiltd.

95. Stisknéte CTRL+V pro viozeni Quiltd.

96. Potvrdte [V .

Ouilt Surfaces
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97. Spust'te prikaz & Boundary Blend.

98. Drzte CTRL a vyberte nejprve vrchni elipsu a poté spodni elipsu.

99, Kliknéte do Cervené vyznaceného policka.

100. Drzte CTRL a postupné vyberte v grafickém okné vSechny Ctyfi kfivky viz (krok €.7).
101. Pojmenujte tento prvek TRYCHTYR_PLOCHA.

£ [ 2Chains | [ﬁ_’z?| Click here to add fem |

102. Ve filtru pro vybér entit nastavte Quilts.

103. Vyberte plochu trychtyre, zbarvi se ¢ervené (viz obr.).
104. Stisknéte CTRL+C pro zkopirovani Quiltd.

105. Stisknéte CTRL+V pro vioZeni QuiltQ.

106. Potvrdte [,

107. Vyberte zkopirovanou plochu (viz obr. vievo) .
108. V menu Edit zvolte prikaz Thicken a nastavte smér a velikost dle obr. vpravo.

5.00
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109. Nyni ve stromé vyberte rovinu ZADNI_2.
110. V menu Edit zvolte piikaz Solidify...

111. Zapnéte odebirani materidlu .
112. Smér orezévani nastavte dle obr.
> Timto pfikazem jsme zarovnali konec télesa rovinou ZADNI_2.

113. Vyberte zkopirovanou plochu (viz obr. vlevo) .
114. V menu Edit zvolte prikaz Thicken a nastavte smér a velikost dle obr. vpravo.

> Jak vidite na obrazku, objemova télesa se protinaji, coZ je nezadouci. V dalsich dvou krocich tedy ofezeme nepotfebné ¢asti
télesa plochami, které jsme si dfive pripravili, abychom dostali zadany tvar télesa.
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115.
116.

117.
118.

Vyberte zkopirovanou plochu (viz obr. vievo) .

V menu Edit zvolte ptikaz Solidify...

Zapnéte odebirani materialu )
Smér ofezavani nastavte dle obr.

119.
120.

121,
122,

Vyberte zkopirovanou plochu (viz obr. vievo) .

V menu Edit zvolte prikaz Solidify...

Zapnéte odebirani materialu 4],
Smér ofezavani nastavte dle obrazku
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Krok ¢.12 Rotace zadni Casti

>  PFi vytvareni této skici se drzime skeletu ze skici SKELET_TELO, pouze je k nému ptidan pfidavek na obrabéni a tkos kvili
odlévani.
> Na obrazku jsou C¢ervené vyznaceny pouzité reference, které jsou také uvedeny v tabulce.
123. Vytvorte prvek rotace se skicou na roviné NARYS, jako referencni prvky pouZijte dvé Usecky ze skici
SKELET_TELO, jejich koncové body a rovinu ZADNI_2.
124. Osa rotace je OSA_X.

B References E@

Curve:F11[CURWE]
F2viZabml_2)
Curve:F11[CURWE]
End:CurveF11
End:Curve:F11

E Select | |Jze Edge/Offzet w

Feference status
Fully Flaced

Cloze
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Krok ¢.13 Rotace predni Casti

> Na obrazku jsou Cervené vyznaceny pouzité reference, které jsou dole uvedeny v tabulce.

125. Vytvorte prvek rotace se skicou na roviné NARYS, jako referencni prvky pouZijte Usecku ze skici
SKELET_TELO a jeji koncové body.

126. Osa rotace je OSA_X.

References

Curve:F11[CURYE]
End:Curve:F11
End:Curve:F11

Select | e Edges/Offzet w

Feplace Delete Salve

Reference status
Fully Placed

LCloze

> Nyni rotaci odfizneme vnitfek predni ¢asti modelu.
127. Vytvorte prvek rotace se skicovaci rovinou NARYS a referencemi dle obrazku.
128. Orezte model touto skicou

> Na obrazku jsou Cervené vyznaceny pouZité reference.

F2[FUDORYS]
Curve:F11[CURYE]
Curve:F11[CURYE]
End:Curve:F11

Select| |Jze Edge/Offzet 4

Feplace Delete Solve

Reference status
Fully Placed

Cloze
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Krok ¢.14 Protazeni nohy (extrude)

129. Ve stromé vyberte skicu SKELET_NOHA_1.

130. Spustte prikaz & Extrude.
131. Nastavte protazeni dle obrazku.

I:[’_:] Placement  Optionz  Properties

Ola[e-tm  ¥x A C

Krok ¢.15 Protrusion Sweep

132. Spusttte v nabidce Inset--> Sweep prikaz Protrusion.
133. Vyberte Select Traj.

134. Vyberte oblouk (viz obr.).

135. Kliknéte na moznost Select v Menu Manageru.

Unselect
TrimExtend
Skart Poink
Done

Quit

136. Kliknéte na Trim/Extend.
137. Pomoci tlacitka Next vyberte bod vyznaceny na obrazku.
138. Potvrd'te vybér Accept.

Select

Unselect w CHOOSE

Trim/Extend Accept
Skart Paoink Mt
Done ik
ik
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139. V nasledujici nabidce zvolte Trim At.
140. Vyberte moznost Curve.
141. Oznacte skicu (viz obr.).

w TRIM AT
w TRIM/EATEMD

Paink
Enter Length —
Drag Surface
Trim Ak || it

142. Vyberte volbu Start Point.
143. Pomoci tlacitka Next vyberte bod vyznaceny na obrazku a potvrdte Accept.

-
Select

Unselect

Trim/Extend Accept

Start Paink Mext

Done it

Qi

144. Kliknéte na Done.
145. V dalsim menu vyberte Free Ends a potvrdte Done.

. . ‘Y N v Merge Ends
» Systém vas prepne do skicare a bude pozadovat naskicovani tazeného profilu.

Free Ends

Done

Quit

146. Ve skicati pomoci tladitka = Use promitnéte tsecky naskicované ve skice PRUREZ_1.
147. Potvrdte Y.
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148. Vytvorte skicu dle obrazku a nazvéte ji PRUREZ_4.
149. Referencni geometrie: NARYS, dvé hrany a jeden promitnuty bod (na obrazku Cervené).

150. Spust'te piikaz Protrusion Sweep.

152. Start Point vyberte stejny jako na obrazku vpravo.
> Postup provadéni pfikazu Protrusion Sweep je podrobné popsan v kroku €.15

8| References

Wertew Edge:FET[PROTRUSION]
Edge:FE1[PROTRUSION)
F3[MARYS]
Edge:FE1[PROTRUSION)

E Select | Uge Edge/Offzet

o

| Replace | | Delete | | Salve

- Reference status
Fully Placed

Close

151. Jako trajektorii vyberte Cast skici SKELET_NOHA_1 zobrazenou na obrazku vlevo.
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> skica je definovana v po¢ate¢nim bodé (viz obr. vpravo).
153. Po piepnuti do skicare nacrtnéte skicu dle obrazku vlevo.

Krok ¢.18 Swept Blend

154. V menu Insert spust'te prikaz Swept Blend.

155. Kliknéte na -’ Create a Solid.
156. V menu References kliknéte na .
157. Drzte CTRL a postupné vyberte trajektorii (viz obr. vpravo).

> Pokud se vam pfi vybéru nabizi celd kfivka,drzte CTRL a kliknéte na ni pravym tlacitkem,
tim se vdm nabidne dal$i mozny vybér (jednotlivé ¢asti krivky).
158. V zdloZce Options pod polozkou End 2 vyberte Trim at Reference a vyberte
rovinu ROV_NOHA.

» Zaménu pocatku a konce kfivky provedete kliknutim na Zlutou Sipku nebo na tIa<”:|’tko.

-
\

& Chain

Origit &dd

References | Options

Length Adjustraent
End 2
ROW_MOHAFB[DAT
Start Paint
Direction:
Diynamic validation
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159. Kliknéte na menu Sections.
160. Zaskrtnéte volbu Selected Sections.
161. Vyberte skicu PRUREZ_3.
162. Kliknéte na tlacitko pro vioZeni dalsi skici.

(") Sketched Sections
(%) Selected Sections

Sections |

< il ] |

Add Blend ertex

Inzert

Remowve

/7 Section 1

163. Vyberte skicu PRUREZ_4.
164. Kliknéte na tlacitko pro vloZeni dalsi skici.

) Sketched Sections

Sections i
Section 1 4

Sechon 2

= il ] =
Add Blend Wertes

Inzert
R emove
Details. .

Section 1

> V pripadé, ze se dojde ke k¥izeni
obalovych kfivek, chytte mysi bilé
kolecko a presunte ho na trajektorii,
poté si zkontrolujte, zdali Zluté
Sipky u jednotlivych prifezd ukazuji

tentyz smér.

Section 1

X-27




165. Vyberte skicu PRUREZ_2.
166. Potvrdte [V ].

() Sketched Sections
(%) Selected Sections

Sections #
Inzert
Section 1 4
Section 2 4
Remove
Section 3 4
&dd Blend Wertex

Krok ¢.19 Protazeni nozicky (Extrude)

167. Spust'te prikaz Protazeni, jako skicovaci rovinu zadejte rovinu BOCNI.
168. Referencni geometrie: hrana(viz obr.) a rovina ROV_NOHA (na obrazku jsou vyznaceny Cervené).

FEROY_MNOHA]
Edge:FE1PROTRUSION]

Select | Uze Edge/Offset

w

Beplace Delete

Feference statuz
Fully Placed

Solve

Cloge
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169. V dialogové listé nastavte protaZzeni az po plochu vyznacenou na obrazku cervené.

[[j Placement  Options  Properties

Ola [&-[Fes ] X A C

Krok ¢.20 Variable Section Sweep

170. Spustte prikaz Wvariable Section Sweep.
171. Zvolte volbu - Sweep as solid pro objemovy model.

172. Kliknéte na References a na tlacitko .

> Otevre se okno Chain.

173. Podrzte CTRL a vyberte trajektorii dle obrazku vpravo. (ze skici
SKELET_NOHA_2)

Trajectones ks M T
Select items

oo

Section plane contral
Mormal Tao Trajectony

Horizontal Aertical contral

References

174. Kiiknéte na & pro prepnuti do skicare.
175. Ve skicafi vytvorte skicu dle obrazku.
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> Tato skica je zamérné oteviena. Systém pfi vytvareni tohoto prvku s otevienou skicou automaticky ofizne prvek tak, aby
nepresahoval objemové téleso, které protina.

>  Zde jsou nazorné uvedeny vyhody pouziti oteviené skici v tomto pripadé:

UZAVRENA SMYCKA

2.00

OTEVRENA SMYCKA

[ Qrigin

NEPROTINA SE S TELESEM
VE VSECH MISTECH

PRESAHUJE TELESO NA
NEKOLIKA MISTECH

AUTOMATICKY OREZE
PRESAH
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Krok ¢.21

Rotace (Revolve)

176. Vytvorte prvek rotace kolem osy OSA_NOHY se skicovaci rovinou ROV_NOHA.

177. Reference vyuzijte rovinu NARYS a Usecku ze skici PRUREZ_3.

Optionz  Properties

oie| |
@ (21 G8 [ 1 amis | Ev [120.00

X% A C

References

Curve:F22[CURVE)
FAMaR5]

Select| Uze Edge/Offzet

b

Beplace LDelete Salve
Reference status
Fuilly Placed

Krok ¢.22

Zrcadleni (Mirror)

> Nyni ozrcadlime nasledujici prvky:

Protrusion Sweep z kroku €.15
Protrusion Sweep z kroku €.17
Swept Blend z kroku ¢€.18

Extrude z kroku €.19

Varible Section Sweep z kroku €.20
Rotace z kroku ¢.21

178. Vyberte vypsané prvky (ve stromé Ci v
grafickém okné).

179. Spustte prikaz -I”Mirror.
180. Vyberte rovinu zrcadleni NARYS.

181. Potvrdte Y.
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Krok ¢.23 Prodlouzeni plochy a odfiznuti (Extend, Solidify)

182. Ve filtru pro vybér entit nastavte Geometry.
183. Vyberte dvé plosky Cervené oznaCené na obrazku.
184. Stisknéte CTRL+C pro zkopirovani ploch.

185. Stisknéte CTRL+V pro vlozZeni ploch.

186. Vyberte hranu pravé zkopirované plochy zobrazenou na obrazku.

187. V nabidce Edit spust'te prikaz Extend.

>  Pokud neni mozné spustit pfikaz Extend v nabidce Edit, je to zfejmé proto, Ze jste vybrali Spatnou hranu, zkuste ji vybrat
Znovu.

@ Vice informaci o0 moznostech vybé&ru entit naleznete v tutorialu UVOD v kapitole VYBER ENTIT.

188. Nastavte délku prodlouzeni na 15mm.

189. V menu References kliknéte na Details.

190. Pridrzte CTRL a vyberte i druhou hranu (viz obr.).

191. V menu Options vyberte v rozbalovacim seznamu Method moZnost Tangent.

Extenzion side 1

[#org (8] [EdaeF78(COPY 2|
Extenzion side 2

[Along M| |EdaeF75(COPY

15.00
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192. Ve filtru pro vybér entit nastavte Geometry.
193. Vyberte pravé vytvorenou plochu.
194. V menu Edit zvolte pfikaz Solidify...

195. Zapnéte odebirani materialu |§|
196. Smér ofezavani nastavte dle obrazku.

197. Potvrdte [,

Krok ¢.24 Vytvoreni pomocné roviny

198. Vytvoite rovinu POMOCNA ve vzdalenosti 45mm od roviny BOKORYS.

| Dizplay || Properties

& DATUM PLANE X

References

BOKORYS:FIDATU... Offget

Offset

Tranzlation |45.00 ~

45.00

199. Rovinu POMOCNA presurite ve stromé na pocatek modelu (napf. pod rovinu HORNI).
> Jakykoliv prvek je mozné prenést pretazenim ve stromé pomoci levého tlacitka mysi (viz. ukazkovy obr.).

a Je vyhodné umistovat pomocné prvky(roviny,osy apod.) na zadatek stromu jelikoZ
/¥ by nemély byt vazany na konstrukéni prvky(rotace,protazeni apod.) ale naopak by
mély tvorit zaklad pro tvorbu konstrukénich prvka.

o Pfedpokladem Uspésného pretazeni na zaCatek stromu je, Ze jsme pfi vytvareni
.1 ) pomocného prvku nepouzili jako referenci néktery z konstrukénich prvka.
Potomek totiz nemUze byt ve stromé vy$, ne? je jeho rodié.

[] PRTOOOL.PRT
/7 BOKORYS
/7 PUDORYS

NARYS r—
cso
4 OsAY
/ OsAX
7 05A_Z
# Sketch 1
foi-onu
¥ Sketch 2
% Sketch 3
& Insert Here
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Krok €.25

Zvétseni tloustky materialu v mistech vyvrtani diry

200. Vytvorte skicu na Cervené vyznacené plose (viz obr. vlevo).
201. Promitnéte do skici dva body a dvé hrany a rovinu NARYS (Cervené vyznacené na prostfednim obr.).
202. Vytvorte oblouk prochazejici dvéma krajnimi body a se stfedem leZicim na roviné NARYS.

203. Vytvorte skicu dle obr. vpravo, pojmenujte ji SKICA_VYPLN_1 a potvrdte V¥ .

204. Vytvorte dva body PNT9 a PNT10 jako priseciky vyznacenych hran s rovinou POMOCNA.

POMOCNA
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205.

Vytvoite skicu na roviné POMOCNA.

206. Promitnéte do skici body PNT9 a PNT10 a rovinu NARYS.
207. Pomoci tlacitka promitnéte plochy Cervené zobrazené na obrazku vlevo.

> Tlacitko promitne plochu v fezu, ktery tvofi skicovaci rovina.
208. Vytvorte skicu s vyuzitim vySe popsanych referencnich prvkd(obr. vpravo).

209. Skicu pojmenujte SKICA_VYPLN_2 a potvrdte ¥ .

210.
211.

212,
213.

214,

Spust'te prikaz Swept Blend.
Jako trajektorii vyberte hranu (viz horni obrazek).

V menu References kliknéte na .

V okné Chain na zalozce Options u polozk y End 2 vyberte moznost

Trim at Reference.
Vyberte oblouk ze skici SKICA_VYPLN_2.

Add

Femove

References | Options

Length Adjustrent
End1: |Value v|

|0.00 |

| CurveFB1CURVE] |

Start Paint

Direction:

Dynamic validation
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215. Potvrdte L% .
216. V menu Sections vyberte postupné oblouk ze skici SKICA_VYPLN_1 a oblouk ze skici SKICA_VYPLN_2.

217. Potvrdte [ ],

Krok ¢.26 Zkoseni pro odlévani (Draft)

> Vytvorené téleso je symetrické dle roviny NARYS, proto i zaobleni budou provadéna symetricky tj. na obou stranach budou
vzdy vytvarena stejnd zaobleni stejnym zplsobem.

218. Pomoci prikazu Draft vytvorte zkoseni dle obrazku (zelenou Sipkou je zna¢en smér zkoseni).

219. Jako Draft Hinge zvolte rovinu NARYS.

@ Podrobnéjsi postup vytvoreni zkoseni naleznete ve cviceni 6(Snek) a ve cviceni 7(klika)

220. Jako Draft hinges urete hranu oznacenou na obrazku zelené.
221. Pull direction zvolte rovinu NARYS.
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222. Pomoci prikazu Draft vytvorte zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
223. Jako Draft Hinge zvolte rovinu NARYS.

224. Pomoci prikazu Draft vytvorte zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
225. Jako Draft Hinge zvolte rovinu NARYS.

Inclividual Surfaces
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226. Pomoci piikazu Draft vytvorte zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
227. Jako Draft Hinge zvolte hranu zobrazenou na obrazku vpravo.
228. Pull direction zvolte rovinu NARYS.

229. Pomoci prikazu Draft vytvorte zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
230. Jako Draft Hinge zvolte hranu zobrazenou na obrazku vpravo.
231. Pull direction zvolte rovinu NARYS.
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232. Pomoci piikazu Draft vytvoite zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
233. Jako Draft Hinge zvolte rovinu NARYS.

ndividual Surfaces

234. Pomoci piikazu Draft vytvoite zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
235. Jako Draft Hinge vyberte hranu (viz obr. vpravo dole).
236. Jako Pull Direction vyberte rovinu BOKORYS.
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237. Pomoci ptikazu Draft vytvorte zkoseni dle obrazku (zelenou Sipkou je znacen smér zkoseni).
238. Jako Draft Hinge vyberte hranu (viz obr. vpravo dole).
239. Jako Pull Direction vyberte rovinu BOKORYS.

Krok ¢.26 Zaobleni (Round)

240. Vytvorte prvky zaobleni dle obrazkd.
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Krok ¢.27 Zaobleni typu Full Round

>  Full Round zaobleni je zaobleni mezi dvéma plochami, které se vzajemné neprotinaji.

241. Spustte piikaz "V Round.
242. Vyberte prvni plochu (obr. vievo).
243. Vyberte druhou plochu (obr. vpravo).

AR

244. V menu Sets stisknéte tlagitko [ Fulliound ],
> Systém nas poté vyzve k zadani fidici plochy.
245. Ridici plochu zadejte plochu zvyraznénou na obrazku zelenym obdélnikem.

g
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246. Kliknéte na *New Set

> Vytvofi se Set 2.
247. Nyni stejni'm postupem vytvorte zaobleni u druhé nohy (viz obr. vievo)

248. Potvrdte [V |,

Krok ¢.28 Zaobleni (Round)

249. Vytvorte zaobleni dle obrazkd.
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250 Vytvorte Full Round zaobleni na koncich noZzicek.
Postup je stejny jako u kroku €.27. Pro kazdou nozicku vytvorte set.

i
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2.00
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Krok ¢.29 Vytvoreni fezu (Xsec)

> Rez télesem vytvofite tak, Ze kliknete na ikonu“E, na zalozce Xsec kliknéte na tladitko New , nazev rfezu: A, kliknéte na

Done, kliknéte na Plane, vyberte rovinu (v nasem pripadé NARYS) a pak jiz dvojklikem na nazev fezu fez aktivujete.

B View Manager
| simp Rep | %sec | arient | 1] w %SEC CREATE
o) ) T
SETLIP PLAM

OifFset w SETUP PLAME
One Side Make Dakum
Bath Sides Quit Flane
Patkern Select 1 item.
Done
it

Cloze

Krok ¢.30 Zaobleni (Round)
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251. Vytvorte zaobleni podélnych vnéjsich hran (viz obr.).

252. Vynechejte pouze tfi hrany vyznacené zelené na obrazku dole.

r—

253. Pridrzte CTRL a vyberte dvé plochy (na obr. vlevo Cervené).
254. V menu Sets stisknéte tlacitko h

255. Vyberte hranu (viz obr. vpravo) a potvrdte.
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Krok ¢.31 Dira se zavitem (Hole)

> Nyni mame vytvoreny odlitek a domodelujeme obrabéné ¢asti modelu. Tyto Casti nasledné barevné odliSime pro nazornost.

256. Vyberte rovinu DOLNI.

257. Spustte prikaz “ Hole.

258. Drzte CTRL a vyberte osu OSA_NOHY.
» Tim je definovana poloha diry.

259. Dira ma parametry M10x1 dle ISO, zavit skrz cell prirez télesa.
260. Prvek pojmenujte DIRA_ZAVIT_M10x1.

Krok ¢.32 Rotace - odfiznuti

261. Prepnéte se do fezu.

262. Vytvorte prvek rotace se skicovaci rovinou NARYS.

263. Promitnéte si tfi Usecky ze skici SKELET_TELO (na obr. Cervené).
264. Dokoncete skicu dle obrazku a orotujte ji dle osy OSA_X.

265. Ofriznéte timto prvkem plvodni téleso.
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Krok ¢.33 Rotace - odriznuti

266.
267.
268.
269.
270.

Pfepnéte se do fezu.

Vytvorte prvek rotace se skicovaci rovinou NARYS.

Promitnéte si dvé usecky ze skici SKELET_TELO (na obr. Cervené).
Dokoncete skicu dle obrazku a orotujte ji dle osy OSA_X.

Ofiznéte timto prvkem plivodni téleso.

Krok ¢.34 Rotace - odfiznuti

271.
272,
273.
274,
275.

Prepnéte se do fezu.
Vytvoite prvek rotace se skicovaci rovinou NARYS.

Promitnéte si Usecku ze skici SKELET_TELO (na obr. Cervené).
Dokoncete skicu dle obrazku a orotujte ji dle osy OSA_X.
Oriznéte timto prvkem plvodni téleso.
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Krok ¢.35 Vnéjsi zavit

276.
277.
278.
279.
280.
281.

V nabidce Insert->Cosmetic spust'te piikaz Thread...

Thread Surf dle obrazku vlevo.

Start Surf dle obrazku vpravo.

Thread Length zvolte Blind - 11mm.

Do kolonky Major Diam zadejte 58.16, coz je dle tabulek d3 pro zavit M60x1.5.
Prvek pojmenujte ZAVIT_M60x1_5.

Krok ¢.36 Dira (Hole)

282,

283.
284,
285.
286.
287.
288.

Vyberte rovinu PREDNI.

Spustte prikaz "' Hole.

Chytnéte jeden zeleny Uchyt a pfipnéte ho k roviné NARYS.
Chytnéte druhy zeleny Gchyt a pfipnéte ho k roviné PUDORYS.
Nastavte vzdalenost stfedu diry od roviny NARYS na 8mm.
Nastavte vzdalenost stfedu diry od roviny NARYS na 23.50mm.
PrGimér diry nastavte 2.5mm a délka diry 25mm.

X-565




Krok ¢.37 Ofiznuti nozicek

289. Vytvoite pomocnou rovinu rovnobéznou s rovinou PUDORYS prochazejici bodem (viz obr.).
290. Pojmenujte rovinu ROV_STOLU.

291. Vytvorte prvek Protazeni se skicovaci rovinou ROV_STOLU.
292. Jako reference urcete rovinu NARYS a rovinu ROV_NOHA.
293. Vysunte nacrtnuty obdélnik a ofiznéte jim konce noZzicek.
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Krok ¢.38 Srazeni hran (Edge Chamfer)

1.00

» Srazte hrany dle obrazku.

Krok ¢.39 Obarveni obrabénych ploch modelu

294. Kliknéte v menu View na Color and Appearance. & Appearance Editor

> Objevi se okno Appearance Editor. File Material Options

295, Stisknéte tladitko * pro pfidani nového materialu. ¢ . +
296. Kliknéte na tlacitko Color a vyberte zelenou barvu.

297. Pod zalozkou Assigment vyberte Surfaces.
298. Drzte CTRL a vyberte obrobené plochy
(tj. plochy obrobené v krocich 31-37).
299. Po vybrani vsech ploch kliknéte na tlacitko OK v dialogu Select.
300. Poté kliknéte na tlatitko (4ot ],

»  Po kliknuti na tladitko Apply se oznaéené plochy obarvi vybranou barvou. polcclection

Clear

copy of <ref_calorl 3|

From todel

-
Basic M_ap" Advanced " Photoluxl

Calar

Calar -
[Dvimn Intenzity Bright
0
LCvirn Ambient Bright
O
Highlight

Caolar

Dim Shine Bright

B Select |X| ' J
_— Dim Intensity Bright

Select 1 or mare items. | ]

[ Ok ] [ Cancel ]

s Cloze
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Krok ¢.40 Family table

» Vytvofime dvé instance Family table

w Vytvareni Family table je podrobnéji popsano ve cviceni ¢.3

301. Spustte piikaz Tools->Family Table.
302. Pridejte do tabulky dva radky instanci.
303. Instance modelu pojmenujte ODLITEK a OBROBEK.

304. Kliknéte na I a v dialogu vyberte Feature.

305. Vyberte prvky obrabéni ve stromé (probirané pocinaje krokem ¢.31).
306. Nastavte zapnuti/vypnuti prvkd u jednotlivych instanci dle obr.

307. Potvrdte a ulozte model.

B Family Table : TELQ
File Edit Insert Tools

Laok Iri| TELD v‘ ¥ [ 7% @ 08 4y 50 8 B0 T
F22430 F22653 F22742 F22885 F23058 F23033  F30104 F30423 F36533
Instanice M... | Cormman Name DIRA_ZAWIT... [REVWOLYE_B] [REVOLVE_B] [REVOLVE_7]  ZAWIT_MED<1_5 [HOLE_2] [CHAMFER_1] [CHAMFER_Z2] [EXTRUDE_3]
TELD ‘ telo-tutariakopra... Y b A iy b A b A N
ODLITEK telo-tutonial-opra... M M M M M M M M M
OBROBEK | telo-tutorial-opra.. ™
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CVICENI X1

CIL

Vytvoreni sestavy mlynku na maso vlozenim jednotlivych komponent do sestavy a jejich zavazbenim.

PREDPOKLADY

e Vymodelované nebo staZzené modely soucasti sestavy.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Vlozeni komponenty (Assemble)
v Tvorba fezdl (Xsec, Extrude-cut)
v" Rozpad sestavy (Explode)
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Krok ¢.1 Pfiprava soubord komponent

1. Posledni verze vSech komponent nyni pfesurite do jednoho adresare.

2. AdreséF pojmenujte SESTAVA MLYNEK.

novéjsi soubor). Do adreséare SESTAVA MLYNEK tedy presunte pouze posledni verze kazdé komponenty.

3. Nyni nastavte tento adresar jako WORKING DIRECTORY pomoci = Set working directory.

w Vice informaci o typech souborl v systému PROE viz dokument UVOD.

D

a vy budete vyzvani k vyhledani komponenty rucné.

Vice informaci o zplsobech nastaveni pracovniho adresare viz dokument UVOD.

Soubor sestavy *.asm obsahuje pouze odkazy na jednotlivé komponenty, nikoliv jejich geometrii. Proto je dlilezité mit
vSechny komponenty sestavy v jednom adresafi a neprejmenovavat je mimo systém ProEngineer, jinak se odkaz ztrati

4. Kazdou ze soucasti oteviete a zménte jeji barvu.
> To usnadni orientaci v sestavé, zvlaste ma-li sestava vétsi mnoZstvi komponent.

>  Postup zmény barvy komponenty naleznete v predchozich tutorialech (TELO a VICKO) vzdy na konci, tentokrat vSak obarvéte
celé soucasti (Part), ne jen jejich povrchy (Surface).

Krok ¢.2 Vytvoreni nové sestavy
5. Kiiknutim na tlatitko | se otevfe dialog New. B New X
6. Zvolte Assembly, nazvéte ji SESTAVA_MLYNEK. Tope. Subyype
7. Ostatni volby zachovejte dle obrazku. O i Skeich © Desian
O Pa O Interchangs
® [ Assonti O Verity
1 szembly
e . Vsimnéte si, Ze po uloZeni je ndzev souboru psany malymi pismeny, Pro ) # Fiezs Py
1 . MNP . Lo o L O B, Manufacturing () NC Model
Engineer nepouziva pri pojmenovavani souboru velka pismena.
O Drawing () Maold Layout
o m - () Ext. Simp.Fep.
O [ Repart
O =L Diagram
O £] Lapout
[ @ Markup
Name SEGTAMS_MLYNEK]

Camman Mame

Use default template

x
Y




Krok ¢.3 Vlozeni komponenty TELO

>  Po kliknuti na tlacitko se ocitnete v mdédu assembly. V boéni nastrojové listé se objevily dvé nové ikony:
F K_"l
o % Assemble - pro vlozeni nové komponenty do sestavy
o & Create - pro vytvoreni komponenty pfimo v sestavé

o
8. Kliknéte na ikonu > Assemble a vyberte soucast telo.prt.

> Tim jste vlozili tuto soucast do sestavy, nicméné jste neurdili jeji polohu v sestavé. Uréeni polohy jednotlivych komponent
vli¢i sobé je nas hlavni Gkol pfi vytvaieni sestav.

> K urceni polohy komponent v sestaveé slozi v ProEngineeru Wildfire 4 dialogova lista.

> Tuto litu mGzete kdykoliv zaviit tlagitkem a zanechat tak komponentu "zamrzlou" ve své soucasné pozici, nicméné
paklize neméate dlvod neurit polohu, je tfeba polohu komponenty ur¢it.

> Tlacitkem X zrusSite vkladani komponenty do sestavy. Sestava pak nebude komponentu obsahovat.

'_'Iz_‘? Placement  bMove Propertiesz

User Define % | | | Automatic |I - STATUS : Mo Constraints EI_-I || ]| x

9. Aktivujte ikonu % Csys display pro zobrazeni souradnych systémd.

> Nyni miZeme vidét, Ze soufadny systém téla mlynku a soufadny systém sestavy nejsou totozné. U prvni komponenty tedy
obvykle byva pravidlem sjednoceni t&chto soufadnych systéml pomoci vazby (nebo vazeb).

10. V dialogové listé kliknéte na menu Placement.

11.V rozbalovacim menu Constraint Type vyberte Coord Sys.

12. Postupné vyberte oba soufadné systémy (CS0 a SEST_CSO0), ¢imZ dojde k sjednoceni soufadnych systémd.

= Set? [User Defined | Constraint Enabled

Canstraint Type

ﬁéjl TELO_FIMAL:CSO:F4[CS
/T—« Coord Sys A

% SEST_CSO:F4[CEYS)

Mew Canstraint Offzet

Statuz
Fully Conztrained

Mew Set

> Uprostied dialogové listy je nyni zobrazen napis Fully Constrained, coz znadi, Ze jsme jednoznac¢né definovali polohu
v e O v . 7 v v 7 r v Vo v o7 ’
komponenty v prostoru, t€lo se nyni nemuze posouvat ani otacen v zadném smeéru, coz je zadosuci stav.

13. Potvrd'te vlozeni komponenty .
JoCoadfys v STATUS : Fully Constrained T E N X

[;) Pokud budete potfebovat dodatec¢né zménit definovani polohy komponenty v sestavé, provedete to kliknutim pravym
w tlacitkem na komponentu ve stromé a vybranim Edit Definition z kontextového menu.
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Krok ¢.4 Vytvoreni fezu sestavou

14. Vytvorte fez sestavou pomoci roviny SEST_NARYS.

> Rez télesem vytvotite tak, Ze kliknete na ikonu &, na zaloZce Xsec kliknéte na tladitko , nazev fezu: A, kliknéte na
Done, kliknéte na Plane, vyberte rovinu SEST_NARYS a pak jiZz dvojklikem na nazev fezu rez aktivujete.

15. Aktivuijte fez sestavou.

B View Manager @

Simp Fiep | Xsec | Orient | Al

o) e o)
w SETLP PLAME

Offset

Zone Plane
Make Daturn
Quit: Plane

Pakttern Select 1 item.

Done

it

Cloze

Krok &.5 Vlozeni komponenty SNEK

e
16. Kliknéte na ikonu > Assemble a vyberte soucast snek.prt.
Jelikoz méme zaply Fez sestavou, mlZe se ndm stat, Ze pravé vlozena komponenta nebude v hlavnim grafickém okné vibec

>
zobrazend, nebo bude zobrazena jen ¢astecné, coz ndm znesnadni zavazbeni této komponenty.

3
Je tedy vhodné zapnout v dialogové listé ikonku =] , tim se zobrazi zvlastni okno s komponentou, v tomto okné Ize pak
snadno vybrat plochy nebo pomocnou geometrii pro zavazbeni této komponenty.
%) [ HRCFTAAQ S e R

AT

go90waBEs a

Sl 1=
Show Settings ~ \\

[] SESTAWA_MLYNEK . ASM
A7 SEST_BOKORYS

-

B SMEK_FIMAL - COMPONENT WINDOW

£7 SEST_PUDORYS Fle Edit Yiew Insert Analysis Info Tools ‘Window
A7 SEST_NARYS
SEST €50 30xProENGINEER  Help
[0 TELO_FIMAL.PRT
P Insert Here

& Select any reference for auto type constraining,

a2 Placement  Mowe  Flexbility  Properties
User Defined v| |Autnmat\c v| |I - STATUS : No Constraints |E|j| | ] X
S S -~
o Select any reference for auto bype conskraining, -
Al -
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17. Vyberte osu OSA_Z komponenty SNEK v okné Component Window.
18. Vyberte osu OSA_X komponenty TELO v hlavnim okné.

> Systém ProEngineer pouZije automatické vyhodnoceni vazby, protoze jste vybrali dvé osy, je zde jedind moznost vazby -
vazba ALIGN (OSA NA OSU). Systém tedy tuto vazbu pouZzije.
19. Kliknéte na Placement.

>V oteviené nabidce mizete vidét vytvorenou vazbu Align a pod ni jsou popsany dvé entity (v tomto pfipadé osy), které ji
definuji. Pokud chcete vybrat jinou osu npfiklad misto osy OSA_Z, stadi kliknou do policka s osou OSA_Z a nasledné vybrat

jinou osu, ktera ji nahradi. = SetZ [IUzer Defined | Canstraint Enabled

0 SNEK_FINAL:OSA Z2F7 | ComshaintType

% TELO_FIMAL:OS4_=F&

& Wew Constraint Offget
[T Caincident NOT DEF

Status
Partially Constrained

MHew Set

.....

20. Kliknéte na tlacitko FLIP pro otoceni Sneku (aby byl orientovan tak jako na obrazku vpravo).

> Nyni je komponenta zavazbena pouze Castecné, v dialogové listé je napsano Partially Constrained. To znamen3, se stale v
v ’ v O v v
nékterych smérech muze posouvat nebo se otacet.

NOTOEFINE | 4 STATUS : Patialy Constrained |37 (3] 1N X

> Posuv a rotaci komponenty ve smérech, ve kterych komponenta neni omezena v pohybu vazbou, Ize provadét v menu Move.
21. Kliknéte na Move.

» V oteviené nabidce Ize vybrat, zda chcete s komponentu posunout (translate), otoCit (Rotate) a dalsi.
22. Uchopte mysi model Sneku a pohnéte s nim, model se bude pohybovat ve sméru osy OSA_Z.

> Timto zplsobem Ize nastavit pfibliznou polohu komponenty v sestaveé.

o Type

(%) Relative in view plane
() Motion Reference

| |
Translatinn

Relaive] 0000 | 0000 |




23.V menu Placement kliknéte na ¥ New Constraint pro pFidani dalsi vazby.
24, Vyberte v Constraint Type vazbu Mate.

25. Vyberte plosku Cervené oznacenou na obrazku vlevo.

26. Vyberte ploSku modre oznacenou na obrazku vpravo.

> Nyni je v dialogové listé vypsano Fully Constrained. Jaka vazba vsak kontroluje otaceni Sneku, kdyz ani jedna z vazeb
nem{zZe mit na rotaci $neku vliv? Odpovéd se skryva v zaskrtnutém policku Allow Assumption.

> Paklize je toto poli¢ko zaskrtnuto, Ize rotaéni soucasti zavazbit jednoduchym zptisobem uvedenym v predchozich bodech (osa
na osu a plocha k plose), systém automaticky predpoklada treti vazbu, kterad kontroluje rotaci komponentu a komponent
takto zavazbeny se jevi jako Fully Constrained(piné zavazbeny).

>  Odskrtnete-li vSak toto poli¢ko, systém hlasi, Ze komponenta neni pIné zavazbena (Partially Constrained) a je vyzadovana
dalSi vazba a to pravé vazba kontrolujici nato¢eni komponenty.

27. Snek se bude otacet a proto nechte pro tuto komponentu policko Allow Assumption zaskrtnuté.

28. Potvrdte ¥,

Constraint Enabled Constraint Enabled

Canztraint Type Constraint Type

Offset Offzet

| T Coincident ~l|[HOT DEF | T Coincident )| [MOT DEF
Status Status

Allow Assumplions _Jisllows Azzumptions

Fully Constrained Partially Constrained

Mate I
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Krok ¢.6 VloZeni komponenty KLIKA

29. Vypnéte zobrazeni fezu kliknutim na a poté na zaloZce Xsec poklepejte na No Cross Section.

]
30. Kliknéte na ikonu = Assemble a vyberte soucast klika.prt.
31. Vyberte plochu zobrazenou Cervené na obrazku vlevo.
32. Vyberte plochu zobrazenou zelené na obrazku vpravo.
> Automaticky se vytvori vazba Insert(viozeni), ktera slouzi pro vkladani valcovych soucasti do valcovych dér, ale Ize pouzit i

pro vkladani kulzelovych sou&asti do kuZzelovych dér jako v nasem ptipadé, aviak je dlleZité, aby kuZelovitost diry
odpovidala kuzelovitosti hridele.

Automatic

33.V menu Placement kliknéte na % Mew Constiairt pro pridani dalsi vazby.

34. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.

35. Vyberte plosku na obrazku vlevo oznacenou Cervené.

36. Vyberte plosku na obrazku vlevo oznacenou zelené.

> Dojde k vytvoreni vaby Mate, viz obr. vpravo.

> VSimnéte si, ze doslo ke zméné sméru vilozeni kliky (poznate to dle vybrani, které je nyni umisténo smérem k télu mlynku).

> K této zméné doslo bez naseho zasahu. Systém vyhodnotil dvé zadané vazby a urcil jedinou moznou pozici kliky splfiujici obé
vazebni podminky.

37. Potvrdte .
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Krok &.7 Vlozeni komponenty SROUB_KLIKY

I KD -
38. Kliknéte na ikonu > Assemble a vyberte podsestavu sroub_kliky.prt.
> S podsestavami pracujeme stejnym zplisobem jako s jednotlivymi komponentami, tj. musime je zavazbit.

39. Vyberte osu OSA_Z komponenty SROUB_KLIKY_TELO zobrazenou na obrazku Cervené.
40. Vyberte osu OSA_Z komponenty SNEK zobrazenou na obrazku zelené.

Automatic

41.V menu Placement kliknéte na ¥ Mew Constraint pro pidani dal$i vazby.
42. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.
43, Vyberte plosku na obrazku vlevo oznacenou Cervené.

44, Vyberte plosku na obrazku vlevo oznacenou zelené.

45, Potvrd'te .

Pokud budete potifebovat dodatecné zménit definovani polohy komponenty v sestavé, provedete to kliknutim pravym
tlacitkem na komponentu ve stromé a vybranim Edit Definition z kontextového menu.
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Krok &.8 Vlozeni komponenty NUZ

=il

46. Zapnéte zobrazeni fezu kliknutim na “& a poté na zalozce Xsec poklepejte na nazev fezu.

]
47. Kliknéte na ikonu = Assemble a vyberte soucast nuz.prt.
48, Vyberte osu OSA_Z komponenty NUZ zobrazenou na obrazku Cervené,
49, Vyberte osu OSA_Z komponenty SNEK zobrazenou na obrazku zelené.

Automatic

50. Kliknéte na ¥ New Constraint pro p¥idani daléi vazby.

51. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.
52, Vyberte plosku na obrazku vlevo oznacenou Cervené.

53. Viyberte plosku na obrazku vlevo oznacenou zelené.

> Timto jsme komponentu plné zavazbili.

54, Potvrdte .

Autom atic
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Krok &.9 VloZeni komponenty RUKOJET

55. Vypnéte zobrazeni fezu.

o ]
56. Kliknéte na ikonu = Assemble a vyberte soucast rukojet.prt.
57. Vyberte osu OSA_Z komponenty RUKOJET zobrazenou na obrazku Cervené.
58. Vyberte osu A_8 komponenty KLIKA zobrazenou na obrazku zelené.

B RUKOJET_FINAL - COMPONENT WINDOW
File Edit View Insert Analysis Info Tools Window
3DxProENGINEER Help

OSA_X

P Select any reference for auto type constraining.

e

59, Kliknéte na ¥ New Constraint pro p¥idani dalsi vazby.

60. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.
61. Viyberte plosku na obrazku vlevo oznacenou Cervené.

62. Vyberte plosku na obrazku vlevo oznacenou zelené.

63. Potvrdte .
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Krok &10  VloZzeni komponenty OSICKA

]
64. Kliknéte na ikonu = Assemble a vyberte soucast osicka.prt.
65. Vyberte osu OSA_Z komponenty OSICKA zobrazenou na obrazku Cervené.
66. Vyberte osu OSA_Z komponenty RUKOJET zobrazenou na obrazku zelené.

67. Kliknéte na # New Constraint pro p¥idani dalsi vazby.

68. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.
69. Vyberte plosku na obrazku oznacenou Cervené.

70. Vyberte plosku na obrazku oznacenou zelené.

71. Potvrdte .
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Krok &11  Vlozeni komponenty TYCKA

]
72. Kliknéte na ikonu = Assemble a vyberte soucast tycka.prt.
73. Vyberte osu OSA_Y komponenty TYCKA zobrazenou na obrazku Cervené.
74. Vyberte osu komponenty TELO zobrazenou na obrazku zelené,

75. Kliknéte na ¥ New Constraint pro p¥idani dalsi vazby.

76. Vyberte v Constraint Type vazbu Align a Offset nastavte 2mm.
77. \lyberte plosku na obrazku vlevo oznacenou Cervené.

78. Vyberte plosku na obrazku vlevo oznacenou zelené.

79. Potvrd'te .

2.00
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Krok &12  VloZeni komponenty SITKO

]
80. Kliknéte na ikonu = Assemble a vyberte soucast sitko.prt.
81. Vyberte osu OSA_X komponenty SITKO zobrazenou na obrazku Cervene.
82. Vyberte osu OSA_Z komponenty SNEK zobrazenou na obrazku zelené.

83. Kliknéte na ¥ New Constrairt pro p¥idani dalsi vazby.

84. Vyberte rovinu PUDORYS komponenty SITKO.

85. Vyberte rovinu SEST_PUDORYS.

86. Constraint Type nastavte Mate.

87. Offset nastavte Angle Offset a 71° nebo 251° (tak, aby tycka pasovala do vybrani na obvodu sitka).
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88. Kliknéte na ¥ New Constrairt pro pridani dalsi vazby.
89. Vyberte plosku na obrazku vlevo oznacenou Cervené.
90. Vyberte plosku na obrazku vlevo oznacenou zelené.

91. Potvrd'te .

Automatic

| A S Mate Angle
Align |
%

Krok &13  Vlozeni komponenty VICKO

]
92. Kliknéte na ikonu = Assemble a vyberte soucast vicko.prt.
93. Vyberte osu OSA_X komponenty VICKO zobrazenou na obrazku Cervené.
94, Vyberte osu OSA_X komponenty TELO zobrazenou na obrazku zelené.
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95, Kliknéte na ¥ New Constrairt pro pridani dalsi vazby.

96. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.
97. Vyberte plosku na obrazku vlevo oznacenou Cervené.

98. Vyberte plosku na obrazku vlevo oznacenou zelené.

99, Potvrd'te .

Krok &.14  Vlozeni komponenty SROUB

i}
100. Kliknéte na ikonu = Assemble a vyberte soucast sroub.prt.
101. Vyberte osu OSA_Z komponenty SROUB zobrazenou na obrazku cervené.
102. Vyberte osu OSA_NOHY komponenty TELO zobrazenou na obrazku zelené.
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103. Kliknéte na ¥ New Corstraint pro pFidani dalsi vazby.

104. Vyberte v Constraint Type vazbu Align.

105. Vyberte rovinu ROV_STOLU komponenty SROUB (na obrazku je to ta spodni rovina).
106. Vyberte rovinu ROV_STOLU komponenty TELO (na obrazku je to ta horni rovina).
107. Nastavte v Offset polozku Offset a 30mm.

108. Potvrdte . '

TELO:ROV_STOLU

SROUB:ROV_STOLU

30.00

Krok &.15  Vlozeni komponenty PODLOZKA

o
109. Kliknéte na ikonu > Assemble a vyberte soucast podlozka.prt.
110. Vyberte osu OSA_Z komponenty PODLOZKA zobrazenou na obrazku vlevo Cervené.
111. Vyberte osu OSA_Z komponenty SROUB zobrazenou na obrazku vlevo zelené.
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112, Kliknéte na ¥ New Corstraint pro pFidani dalsi vazby.

113. Vyberte v Constraint Type vazbu Mate a Offset nastavte Coincident.
114. Vyberte plosku komponenty PODLOZKA na obrazku zobrazenou Cervené.
115. Vyberte ploSku komponenty SROUB na obrazku zobrazenou zelené.

116. Potvrdte .

Mate

Krok ¢.16 Vytvoreni fezu sestavou pomoci funkce Extrude - Cut

> Uz jsme si ukazali, jakym zplsobem se daji vytvaret fezy Xsec (viz krok &.4). Nyni si ukdzeme dal$i zplisob vytvareni fezl v
sestavach pomoci Extrude, timto zplsobem Ize vybrat, které komponenty sestavy budou fezény a které nebudou.

117. V rezimu sestavy spustte prikaz 7’ Extrude.
118. Jako skicovaci rovinu vyberte rovinu SEST_NARYS a vstupte do skicare.
119. Ve skicafi nacrtnéte obdélnik (viz obr.).

120. Ukoncete rezim skicare ¥ .

200! 00 =

~=—— 100.00 ——=

.00




121. Nastavte smér a velikost vysunuti dle obrazku.

122, Kliknéte na v dialogové listé na Intersect.
123. Odskrtnéte polozku Automatic Update.

» Polozka Automatic Update zajistuje, aby Fez byl veden vidy skrze vSechny komponenty sestavy (dokonce i skrze
komponenty umisténé ve stromé nize, nez prvek Extrude).

124. CQOdstrante ze seznamu vsechny komponenty kromé komponent KLIKA,TELO a VICKO (viz obr.).
>  Kliknutim pravym tlacitkem na nazev komponenty v seznamu a vybérem Remove odstranite komponentu ze seznamu.
125. Tento prvek pojmenujte REZ.

126. Potvd'te provedeni piikazu V.

[] Automatic Update

Intersected Models

kdodel Display

KLIEA Top Level
WICKD Top Lewvel

< 1§ | >

[ Add Intersected Modelz ]

Settings:

Drefault display level: | Top Level v

Show Feature Properties In Sub-Models

f i Pokud chcete vypnout zobrazeni fezu, ktery byl vytvofen pomoci prvku Extrude, jednoduse tento prvek potlacte
(Suppress) a pokud jej budete chtit zase zapnout, obnovte potlateny prvek (Resume).
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Krok ¢.17 Rozpad sestavy

127. V menu View --> Explode spust'te prikaz [ Explode View

> Zobrazi se rozpadla sestava, rozpad sestavy je do znacné miry fizen vazbami jednotlivych komponent, nicméné je nutné
zménit vzdalenost jednotlivych komponent od sebe. Sméry rozpadu by vsak mély byt spravné.

&

//7 "

4/

. v s Ed ki .
128. V menu View --> Explode spustte prikaz % Edit Position I= Explode Position X
> Otevre se dialog Explode Position Selected Component
129. Kliknéte na tlatitko a vyberte Move Many.
o Move One - pohyb jednoho komponentu _
o Move Many - pohyb vice komponent najednou @t‘?t'm ITl':pe
o Move With Children - pohyb komponenty a komponent na ni zavislych o Er:pr;s;;
() Default Expld
[ Preferences @ © Reset
Maove Dptions Motion Feference
) Move One Entitw/Edge A
() Move Mary
() Move With Children
tation Increments
Tranzlation | Smoath ~
Pozition
Relative
[ Undo ] [ Redo ] [F'leferences]

> Budeme urcovat smér posunu komponenty dany normalou roviny.

130. V motion reference nastavte Plane Normal a kliknéte pod touto volbou na .
131. Vyberte rovinu SEST_BOKORYS (ve stromé nebo grafickém okné).

132. Nahote pod napisem Selected Component kliknéte na E

133. Drzte CTRL a vyberte komponenty: KLIKA, SROUB_KLIKY, RUKOJET, OSICKA.

> Tyto komponenty se oznaci v grafickém okné Cervené.

134. Potvrdte tlatitkem [2< ],

135. Nyni kliknéte na jakoukoliv z vybranych komponent a pohybem mysi vSechny komponenty posurite.
136. Kliknéte levym tlacitkem v misté, kde chcete komponenty ponechat.

Select 1 item.

[ 1]4 ] [Eancel]
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> Nyni se vas systém pta, zdali chcete znovu hybat s pravé vybranymi komponentami (Use Previous) nebo zdali chcete
vybrat dalsi komponenty pro pohyb v tomtéz sméru (Select).

137. Vyberte Select.

138. Drzte CTRL a oznacte VICKO, SITKO a NUZ.
139. Potvrdte tlatitkem [ 2¢ ],

140. Nyni kliknéte na jakoukoliv z vybranych komponent a pohybem mysi vSechny komponenty posurite.
141. Kliknéte levym tlacitkem v mist&, kde chcete komponenty ponechat.

142, Stejnym postupem umistéte SNEK a TYCKU.

Use Prewvious

Pokud omylem umistite nékterou komponentu jinam, nez jste chtéli, pfepnéte v Motion Type prepina¢ na Reset a vyberte
komponent. Ten se tim vrati do plvodni polohy.

143. V motion reference vyberte rovinu SEST_PUDORYS (ve stromé nebo grafickém okné).
144. V tomto sméru umistéte komponenty SROUB a PODLOZKA.

> Vysledny rozpad sestavy by mél vypadat podobné jako na obrazku.
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> K rozpadu sestavy lze pfidat vodici linky pro jednotlivé komponenty. Tyto linky znazorfiuji postupné skladani sestavy.
145. Pridejte vodici linku (Offset line) tak, Ze v menu View --> Explode Offset lines spustite ptikaz Create.
> Nyni se nas systém ptd, ¢im definujeme oba konce vodici linky

146. Vyberte Axis a oznacte osu OSA_Z Sneku (na obrazku Cervené) a osu OSA_X téla (na obr. zeleng).

Surface Morm
EdgefCurve

it

147. Stejnym postupem pridejte dalsi vodici linky.
> Pak miZete posunout komponenty a stale bude patrné sklddani modelu (viz obr.).

XI-21




148.
149.
150.

Spustte View Manager e,
Na zaloZce Explode kliknéte na tlaCitko New.
Sytém se vas zepta, zdali chcete aktualizovat Default Explode, zvolte Yes.

| SimpRep | Siyle Haeo
Explode Orient Al

[Mew ][ Edit~ ][ Display v ]

Mamesz
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CVICENI XII

CIL

Tvorba vyrobniho vykresu soucasti sitka mlynku na maso.

1 2 | 3 [ | 5 6 7 8 9
——
A : A
LA S
=3 |
LY
«y o4 =
& E — o
B J © B
° w N o T—I
S 2, slo 7
9 S 0.5x45°
3 s 4 0.5x45° M1
C R C
VYSTRUZENO o
495 Ral.§ %
S
¢c§’a'° ..é
0 1 195 ? Rul,ei 5
\N'/ 0.5x45°
B S 0.5x45
5:3.7
@) KALENA PLOCHA £7]0.05
3 TVRDOST: min. 650 HV 10 B-B
POCET DER @4 = 48, Ra3.2
.
] SITKO 2
w e CISI0 VYKRESU ZURAW ING O, \’;;-y
KKS $1TKO L MS-CAE-01-01 ] 3
1 7 T 3 4 T 5 — .
PREDPOKLADY

¢ Vymodelovany nebo stazeny model soucasti sitka mlynku na maso.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v’ Zaklady tvorby vykres(:

o

O O O O

Vytvareni pohledd
Koétovani

Tolerance, drsnosti
Srafovani

Vyplhovani razitka a dalsi...
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Krok ¢.1 Otevieni prazdného naformatovaného vykresu

1. Otevfete soucast sitko.prt. rm Now 1
2. Kiknéte na tlatitko - , otevie se dialog New. T P
» Doporucuje se pojmenovavat vykres soucasti/sestavy stejné jako Sketch
soucast/sestavu, ktera je na vykresu zobrazena. Part
3. Vyberte Dravwing z nabidky. et
4. Vykres nazvéte SITKO.
Manufacturing
Drawing
Format
Report
Diagram
Layout
¥ @ Markup
Name sitko

Common Name

Use default template

>  Pokud byste neméli otevienou soucast SITKO.PRT (viz bod 1), museli byste zde zadat cestu k modelu, ze kterého chcete

délat vykres.

® No u

B New Drawing

Default Model

Potvrdte vytvoreni vykresu (|__Cpen

V dialogu New Drawing vyberte Empty with format.

Kliknéte na v kolonce Format.

Vyberte a3_v1_vyrobak-uni.frm ze seznamu.

Jal 0K

.

B

|sITKO.PRT

| [ Browse. .. ]

Specify Template
(3 Use template
(#) Empty with format
() Empty

Farrmat

[rone

V| Browse. .. ]

Canhicel

.JJJ Organize

Caommon Folders

Iil In Seszion

m Desktop

@ by Documents

ﬂ Wworking Directory
Metwork Meighborhood
Templates

ﬁ KMNIHOWNY-STANDARDS
System Formats

User Formats

13 Favorites

Folder Tree -

by

ETRIETRTET R IR TR RT O

S 1A b User Fomats » v |44 | |5earch..

Fo al_zcu_asm_bom.frm Fo] a3_zcu_asm.frm
all_wl_sestava-new. frm [;1 al_zcu_detfrm [;1 a3_zcu_asm_bom. frm
all_v1_sestava-uni.frm [;j a2_vw1_sestava-new.fim [;j a3 zcu_detfm
all_w1_wyobak-newfim [ a2_v1_sestava-unifim Fo ad_bom.fim
all_w1_wprabak-uni frm [;1 a2_w1_wprobak-new frm [;1 ad_w1_kusownik-new frm
all_zcu_azm.frm [;j a2_+1_wyrobak-uni.frm [;j ad_w1_kuzovnik-unifrm
all_zcu_asm_borm.frm Fo a2_zcu_asm.fim Fo ad_wl_sestava-new.fim
all_zoudet frrn [;1 a2_zcu_asm_born.frm [;1 ad_v1_sestava-uni.frm
al_w1_sestava-new. frm [;j a2_zou_det frm [;j ad_w1_wyrobak-new.frm
al_w1_sestava-uni.frm Fo] ai_wi_sestavanewfim [ ad_w1_vyrobak-unifim
al_wl_wprabak-new frm [;1 a3 wl_sestava-unifrm [;1 ad_zcu_asm. frm
a1_w1_vwyrobak-uni.frm m a3_v1_vyrobak-new. frm m ad_zcu_asm_bom.frm
al_zcu_asm.frm e E i Fo ad_zcu_detfim

File name: a3_w1_vyrobak-unifrm Date modified: TE-Sep-09 05:36:44 PM Preview «
File name; |a3_v1_v_l,lrobak-uni.frm | Type| All Filez 7] w |
[ Open '][ Cancel ]

1) Tento tutorial pfedpokladéa nastaveni systému PRO/ENGINEER totoZné s nastavenim ve $kolnich CAD uéebnach.

i Je dlleZité mit k dispozici knihovny vykresovych znadek, $ablon vykres a mit v systému PRO/ENGINEER nastavené
£ \

{'.)
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>  PFi otevirani vykresu nas systém vyzve k vyplfiovani parametri razitka, zatim tyto vyzvy miZeme odentrovat.
> Nyni mame otevny prazdny a naformatovany vykres formatu A3 (viz obr.).
9. Vykres ulozte do stejné slozky, ve které mate umistén model sitko.prt.

T [ 2 [ 3 [ A [ H I [ I 7 ] 9
A A
B =]
L L
D o]
3 E
| a.000 | ---- 0|
et Wizes - romr Falatgvar waterinl kenscnrivicheat [loodo | € onmar foome ] TR Ty
:‘?:Y Tile - site Blank Lind #adnyvo | #Batnn 1ol Wi ghl _ET:M D wrirg osn. Ho.|Pos.
E Datun | renchiane | Dafun e E
TesLil] Techno-|
Imy.:.'}"'"'“" S ugein
Preh, Frazk
Tk AHE
chual Ty .
Lilid) PR rder INdicararining. Bepis mERpichange tatun | Padpi sikome
] Methae 1 PrgnareaMie:
YSEDBECNE TOERANLE 150 RS 150 2705
15018 £ LR B e 105 B0k 145 Patee
Tk meddl A THE 51T Mel'-'nin T et
x Rl - . —
3 S0 -ares IRM - e s &
Mazes 2 ine I 1k WD Farnat
CAE
KKS ist 1 Ll 1 3
1 7 E] A S I [3 T

Krok ¢.2 Vytvoreni zékladniho pohledu

11. Klepnéte kdekoliv na vykrese pro umisténi .
P Y P Categories Yiew display options

pohledu. Yiew Type
> Pohled se vloZi do vykresu a zobrazi se okno Visible drea | :
Drawing View s nastavenimi pohledu. Srale Display style | (7] No Hidden v

Sections

12. Kliknéte vlevo v nabidce Categories na

View Display Tangent edges display style ﬁ Mone W

13. Zménte Display style na No Hidden. Hidden line remarval for quilts Calors come fram

14. Zménte Tangent edges display style na Alignment | () es @ The drawing
None. © Ho O The model

15. Potvrd'te provedeni zmén . Skeleton model display

> VSimnéte si jak se zménilo vykresleni pohledu ® Hide weldment xzection display
(viz obr. vlevo). O Shaw

Hidden line remaoval for shatches

() Yes
) Mo

[ 0k, ] [ Cancel ] [ Apply ]
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16. Potvrd'te vytvoreni pohledu tlacitkem .

» Nyni vytvofime novy pohled v modelu sitka.

17.V menu Window kliknéte na SITKO.PRT.

» Tim se prepnete do rezimu objemového modelare.

Y

18. Spust'te prikaz ‘* Reorient.

19.V dialogovém okné Orientation vyberte Orient by reference.

> Nyni se vas systém pta na zadani dvou referenci pro orientovani modelu.

20. Reference 1: vyberte Front (predni) a vyberte plochu ( na obr. vlevo Cervené).
21. Reference 2: vyberte Top (horni) a vyberte rovinu NARYS.

22. Novy pohled ulozte tladitkem L_22¥¢ | (viz obr. vpravo).

> Nové definovany pohled je na obrazku uprostred.

Okno musi byt aktivni, abyste v ném mohli provadét zmény, postupem uvedenym
vySe se okno aktivuje automaticky. Pokud prepnete mezi okny v hlavnim panelu je

nutné stisknout iknou Activate. pro aktivaci okna.

@ Orientation

Tupe

| Orient by reference

Optiohs

Feference 1
| Fromt “ |

[ & ||5utFEEXTRUDE_1] |

Reference 2
| Top v
[ & | NARYS:F3DATUM PLANE] |
w SavedViews
Standard Onientation -~
Default Orientation “
Mame |Z4KL_POHLED |
,_ Set ] ,_ Save ] ,_Delete]
L ]S J I_Eancel] I_ Unda ]

23.V menu Window kliknéte na SITKO.DRW.

24, Dvakrat kliknéte na vytvoreny pohled.

> Otevre se dialogové okno Drawing View.

25. Pojmenujte pohled, do kolonky View name napiSte ZAKLADNI.

26. V nabidce Model view names vyberte nové vytvoreny pohled ZAKL_POHLED.
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Krok ¢.3 Zmeéna mefitka vykresu

> Zménime méritko vykresu na 2:1.

> Povsimnéte si v levém dolnim rohu grafického okna textu SCALE:... TYPE:... NAME:... SIZE:... (viz obr. nahofe). Tyto udaje
zobrazuji zékladni informace o vykrese a nékteré z nich (SCALE a SIZE) Ize zménit poklepanim na tento text.

27. Poklepejte na text SCALE.
28. Prepiste méritko vykresu na 2(viz obr. dole).

SCALE : 241

g Enter value for soale 2

_ Polozku Custom scale (v dialogovém okné Drawing View) pro zménu méfitka pouzivejte jen v pfipadé, Ze chcete mit
", U tohoto pohledu odlisné méfitko, neZ mate v ostatnich pohledech. V opagném pfipadé pouZivejte postup popsany vyse.

v vrs

e . Méfitko vykresu Ize také ménit poklepanim na kolonku MéFitko v razitku vykresu. Tento postup je rovnocenny s
y postupem uvedenym vvyse

\l‘) Témito zplsoby se méni méfitko celého vykresu, zmé&na méfitka u pohledu je popséna v kroku &.5 (bod 54-55).

Krok ¢.4 Vytvoreni pohledu rozvinutého rezu

29. Kliknéte pravym tlacitkem na pohled a z nabidky vyberte Insert Projection View...

Texk
Previaus
Pick From List

Delete

Show Dimensions

Wiew Info

Inserk Prajection Yiew. .. k

Use Model in Tree

30. Kliknutim mysi umistite promitnuty pohled.

31. Kliknéte pravym tlacitkem na promitnuty pohled a vyberte z nabidky Properties.
32. Nazvéte pohled PROMITNUTY.
33. Opét ve View Display nastavte No Hidden a None.

XII-5




34. Prepnéte se do rezimu modelare.

35, Kliknéte na @,

36. V zalozce kliknéte na [Hen],

37. Pojmenujte fez: B.

38. Zvolte typ fezu Offset a potvrdte Done.

B View Manager fg|

Simp Rep | #set | Orient | Al

MNames
& Mo Crozs Section

N

w x5EC OPTS

Model

Flanar

ZONE
Cne Side
Both Sides

Single

Done

it

39. Vyberte skicovaci rovinu BOKORYS.
40. Nastavte smér skicovani dle obr.vlevo a potvrdte.

41, Jako referenci oznacte Top a vyberte rovinu NARYS.

w SETUFR 5K PLM

se Prew

Top

Biokkom
Right
Left
Default

it

42. Ve skicafi naskicujte lomenou Caru fezu dle obr.
43. Ukoncete reZim skicare ¥ .
44. Vrat'te se do rezimu tvorby vykresu.

20.000

L* 15.000 ==
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> Nyni zobrazime promitnuty pohled v rozvinutém fezu B, ktery

jsme si pravé pripravili.
45,V Categories vyberte poloZku Sections.
46. Vyberte polozku 2D cross-section.

47. Kliknéte na tlacitko .

. Drawing View

Categaries
Wiew Type
Yisible Area

Wiew Dizplay
Origin
Alignment

Section optionz
() Mo zection
(%) 20 cross-section

() Single part surface

+

Mame Sectioned Area

Model edge vizibility &) Tatal O Area

Reference

Cancel

48. Vyberte z nabidky Name rez B.

o Kliknéte na a prohlidnéte si fez. Je zobrazen jako klasicky fez, pokud chcete zobrazit rozvinuty fez, je nutno
prepnout kolonku Sectioned Area na Full(Aligned) a referencni osu rozvinu fezu.

49. V nabidce Sectioned Area vyberte moznost Full(Aligned).
50. Jako referencni osu vyberte osu OSA_X (nejjednoduseji ve stromé).

51. Kliknéte na alox ],

Full Full (Aligned)

52. Poklepejte na Srafovanou plochu, objevi se menu manager.

53. Kliknéte na Spacing a poté na Half.
54. Kliknéte na Angle a vyberte 45°.
55. Potvrd'te Done.

NENESEENEENY

(W
1
(e}

N RY R N
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Krok ¢€.5 Vytvoreni detailniho pohledu

56. Z nabidky Insert --> Drawing View vyberte pohled typu Detailed...

Dimension 3
Reference Dimension »

Coordinate Dimension. ..

Geometric Tolerance. ..

Drawing Wiew General...
Sheet Projection. .
Arrows... i

Auxiliary. .. L
Iog... Revolved,., | Detailed
Break. ..

<&Detailed. .. >Create a detailed view

Mate. ..
Ballren —_—

> Nyni se nas systém pta na vlozeni stfredového bodu (CENTER POINT). Stfedovym bodem se rozumi bod, ktery lezi uvnit¥
oblasti detailniho pohledu. Tento bod nemusite nijak definovat, staci kliknout na libovolnou hranu télesa.

57. Kliknéte kdekoliv po obvodu zahloubeni (viz obr.).

™ ~

> Poté co jsme zvolili stfedovy bod, systém ocekava zvoleni dalsich bodl, které vytvoii kruznici kolem stfedového bodu a tim
definuji oblast, ktera bude zvétSena na detailnim pohledu.

58. Levym tlacitkem postupné definujte nékolik bod@ okolo stfedového bodu, které vytvori uzavienou kfivku.
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59. Poté, co vytvorite uzavienou smycku kliknéte prostfednim tlacitkem, ¢imz potvrdite vybér.
» Potvrzenim vybéru se objevi znacka detailniho pohledu a nyni levym kliknutim kdekoliv na vykresu umistite vykres.

\/ Jestlize stfedovy bod nelezi uvnitf smycky, systém pfi potvrzeni pravym tlacitkem automaticky smycku smaze a ocekava
nové zadani.

60. Kliknéte levym tlacitkem v misté, do kterého chcete umistit detailni pohled.
61. Kliknéte pravym tlacitkem na detailni pohled a zvolte Properties.

X

[ | Drawing View

Categories Scale and perspective options
Yiew Type

Yigible Area

() Custom scale 5.000

Section:

Wiew States
Wiew Digplay

Origin ‘iew diameter MM
Alignrent

Eve point distance b4

[ QK ] [ Catwcel ] [ Apply ]

Vv,

62. Nastavte méritko tohoto pohledu na 5:1 (viz obr. vpravo).

&
> Abyste mohli posouvat pohledy libovolné po vykrese, musite deaktivovat ikonku b5~
63. Posunte modely do pozice zobrazené na obrazku.

a2

JI

=
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Krok ¢.6 Promitnuti os do vykresu

>  Zakladni myslenkou vytvareni vykresd v systému PRO/ENGINEER je maximalni vyuZiti informaci uloZenych v modelu soucasti
pfi vytvareni vykresu. Daji se promitat koty, pomocné prvky, tolerance, parametry modelu se promitnou v razitku atd.

» Nyni promitneme osy z modelu do vykresu. alety
0w . T

64. Kliknéte na ikonu + Show and Erase. !_

> Objevi se okno Show/Erase. Ry

65. Vyberte promitani os —*', nastavte Show By: View. 3 S
66. Kliknéte na pohled PROMITNUTY. ] gy i

|
» Zobrazi se vSechny osy modelu zobrazené v tomto pohledu. H—1

>  Zkontrolujte, zdali je aktivni tlacitko , CO0Z znamena, ze ! 7//

vybrané osy budou promitnuty z modelu do tohoto pohledu.. !
67. Drzte CTRL a vyberte 5 os na obrazku zobrazenych Cervené. |

68. Kiiknéte na |__0K_Jal Close |

Show / Erase @

Tupe

Shiow By

Options | Preview

T

[ Selto Keep ] [ Accept Al ]
[ Sel to Remove ] [ Eraze all ]

|
|
I—

o —-—
|
—a

69. Kliknéte na ikonu ¥ Show and Erase.

70. Vyberte pohled ZAKLADNI.

71. Drzte CTRL a vyberte osy na obrazku zobrazené cervené.
72. Potvrd'te promitnuti os.
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73. Vyberte jednu stfedovou znacku (viz obr. vlevo ).
74. Kliknéte na ni pravym tlacitkem a vyberte z nabidky Edit Attachment.

»  Pomoci tohoto pfikazu je mozné stfedovou znacku natodit.

Mexk

OO
OO
OO0

©®®¢©©©
o
o
OOO00OO0

OO

B

OO0 0O

OO0
_____@@_

OO0

Previous
Pick Fram List
Erase %

Edqge Display... !

Properties

olo)e

| /

00

75.Z nabidk}' vyberte Enter Angle. g Enter angle in degrees of highlighted line with respect to »_asis; [Guit] 30
76. Zadejte uhel 30°.
77. Kliknéte dvakrat stfednim tlacitkem pro ukonceni prikazu.

» Tim natocime osu o 30° proti sméru hodinovych rucicek.

w ROTATE &XI5

Through Geom
Pick. Piirk
Parallel

Horizonkal
Enter Angle
Done/Return

78. Roztahnéte osy v jednom sméru a minimalizujte je ve druhém
sméru (dle obrazku).
> To provedete taZzenim za Cervené ctverecky na koncich os.
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79. TentyZ postup opakujte u dalSich osmi stfedovych znacek, dokud nedostanete vysledek dle obrazku.

> Nyni opét promitneme dalsi stfedové znacky, nato¢ime je a vytdhneme ve druhém sméru

80. Kliknéte na ikonu * Show and Erase.

81. Vyberte pohled ZAKLADNI.

82. Drzte CTRL a vyberte osy na obrazku zobrazené cervené.
83. Potvrd'te promitnuti os.
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84. Vyberte jednu stfedovou znacku (viz obr. vlevo ).
85. Kliknéte na ni pravym tlaCitkem a vyberte z nabidky Edit Attachment.
»  Pomoci tohoto pfikazu je mozné stfedovou znacku natodit.

=0 Ga !

Texk
Previous L

Pick. From Lisk E

Erase -
- M

/’
. Edge Display... -
/
-~

Properties
7 —

86. Z nabidky vyberte Enter Angle. g3 Enter angle in degrees of highlighted line with respect to 2_axiz: [Quit] 60

87. Zadejte Uhel 60°.
88. Kliknéte dvakrat stfednim tlacitkem pro ukonceni pfikazu.
>  Tim nato¢ime osu o 30° proti sméru hodinovych rucicek.

w ROTATE AXIS

Through Geom
Fick Point

Parallel
Hotizontal
Enter Angle
Done/Return

89. Roztahnéte osy v jednom sméru a minimalizujte je ve druhém
sméru (dle obrazku).
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90. TentyZ postup opakujte u dalSich osmi stfedovych znacek, dokud nedostanete vysledek dle obrazku.

> Nyni bychom méli mit promitnuty vSechny osy, nicméné si mizete viimnout, Ze jedna osa ndm ve vykrese chybi.
» Chybi nam osa v oblasti detailniho pohledu, tuto osu nelze z modelu promitnout jednoduse proto, Zze neni v modelu.
Doplnime tuto osu do modelu a nasledné ji promitneme do viech pohledd.

91.V menu Window kliknéte na SITKO.PRT.

> Tim se prepnete do reZzimu objemového modelaie a mizZete pridat do modelu osu.

\Window

92. Vytvorte osu dle obrazku. . el

=
El Close

Zipen Swstem Window

Mazimize

Default Size:

LSOty

® 2 SITKO.DRW:1

“ i\
e
“ o

= DATUM AXIS x)
SA 7 Placement |Display Properties

cce
ccececec
cccecceccee

References

Suf:FENEXTRUDE_2)  Through

ccc

Offzet references

cccoecco

CCcCeCecCe

cce
ceCc
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>  Nyni se vratime zpé&t do reZimu tvorby vykrest.

93. V menu Window kliknéte na SITKO.DRW.

>  Promitneme nové vytvorenou osu do v$ech pohledd.

94, Kliknéte na ikonu > Show and Erase.

95. V dialogu Show/Erase zaskrtneme pod poloZzkou Show By moznost Feature.

> Tim urdime, Ze osy ndmi vybraného prvku budou promitnuty do vech pohledd.

96. Vyberte prvek (viz obr.).

Showw By

(%) Feature () Feature and View

) Part
) Wiew

() Part and Wiew
Show &l

Fa{EXTRUDE_2}

501
> Ve vSech pohledech se zobrazi osy daného prvku.
97. Potvrdte tlacitkem
98. Nyni oznacte tyto osy ve vSech pohledech a potvrdte ok .
99, Zavrete dialog Show/Erase.
> Ve vykrese mame nyni promitnuté vSechny potfebné kéty (nové pridané jsou znazornény cervené).
EEEE-E [T —
7
501 ' 7—__“
7

[}
I
o

Krok ¢.7 Vysrafovani plochy pro kaleni

> Dalsim nasim Ukolem je vysSrafovani plochy, kterd bude zakalena.
100. V menu Window kliknéte na SITKO.PRT.

101. Pfepnéte se do zobrazeni No Hidden & &I

102. Kliknéte na * Reorient a v poloZce Type vyberte Dynamic orient.
103. Otocte model dle obrazku.

xJe 1 (a0 2

—RE
_!,.

Standard Orientatio
Drefault Orientation
BOKORYS

DOLMI

M&RYS  [BOKORYS]
PRAWY
PUDORYS

ZADMI

< ¥
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104. Vytvorte skicu na plose dle

obrézku. M Sketch X

Placement | Properties
Sketch Plane

Plane

(88 | Use Previous

Sketch Orientation
Sketch view direction

Reference | PUDORYS:F2DATURM PL...

Orientation | Left v

105. PouZijte ve skice reference dle obrazkd (v menu Sketch-->References).

B References g@@|

F2PUDORYS)
Fa(MARYS]

SufF21(HOLE_1_17)
SufF1S(HOLE_1_15)
SufFEIHOLE_1_53)
SuF54(HOLE_1_55)
SurkF2T(HOLE_1_23)
SufF44(HOLE_1_41)
SukF45(HOLE_1_43)
SurfF4(HOLE_1_44)
SuF47(HOLE_1_45)
SurkF30(HOLE_1_26)
SutF48(HOLE_1_47)
SutF49(HOLE_1_48)
SurfFS0HOLE_1_49)
SufFI3HOLE_1_29)
SukF51(HOLE_1_51)
SutFSEHOLE_1_57)
SuFST(HOLE_1_59)
SurfFEIHOLE_1_R1)
SufF42(HOLE_1_39)
SukF17(HOLE_1_13)

[I] Select | Use Edge/Offset -

OO

OO®

HDO000
0000000
000D0O0O

DO O

©O®

____6_6___
HH0066

Reference status
Fully Placed

©O®

Cloze

106. Nacrtnéte Ctyfi diagonaly (viz obr.)

£
- 00®
000POO®
OD@

OO®
\o8008a
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107. Nyni nacrtnéte skicu dle obrazku s vyuzitim referenci a diagonal definovanych v predchozich krocich.

1.000

> Nyni zkopirujeme predni plochu télesa.

108. Ve filtru entit nastavte | Geometry |,
109. Oznacte predni plochu télesa (viz obr.).

110. Stisknéte kombinaci CTRL+C a poté CTRL+V.

» Tim vlozime zkopirovanou plochu.

111. Potvrdte .
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> Ve stromé se objevil prvek [(ZiCapy 1 |

112. Vyberte tento prvek a v nabidce Edit spust'te prikaz Trim...
113. Vyberte vnéjsi uzavienou kfivku skici (viz obr.) a potvdte.

> Tim jsme ofizli plochu Copy 1.

114. Vyberte prvek Trim 1 ve stromé a v nabidce Edit spust'te ptikaz Trim...
115. Vyberte vnitfni uzavienou kfivku skici (viz obr. vlevo) a potvdte.

> Tim jsme opét ofizli plochu a tim ziskdame plochu znazornénou ¢ervené na obrazku vpravo.

116. Vytvorte druhou skicu na stejné plose jako byla skica predchozi
> MdzZete vyuzit tlacitko pro urceni posledni skicovaci roviny jako aktualni skicovaci rovinu.

Placement | Properties

Sketch Plane

Plane l Usze Previous |

Sketch Onentation

Sketch view direction

Reference | |

Orientation

Cancel
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117. Promitnéte vnitfni hranu diry
118. Vytvorte kruznici vzdalenou od a okétujte dle obrazku.

119. Potvrd'te vytvoreni skici M

120. Oznacte pravé vytvorenou skicu.
121. V menu Edit vyberte piikaz Fill.

> Vytvofi se plocha mezi dvéma naskicovanymi kruznicemi znazornéna na obrazku cervené.
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>  Nyni se vratime zpé&t do reZimu tvorby vykrest.

122. V menu Window kliknéte na SITKO.DRW.

123. Ve filtru entit nastavte | =4tace .|
124. Vyberte oblast (viz obr.).

125. Kliknéte na oblast pravym tlacitkem a vyberte Hatch/Fill.

: N ] : i
Fick From List . L b
Edge Display...

126. Potvrdte nazev fezu.

127. Kliknéte na Spacing a poté na Double, ¢imZ snizite hustotu Srafovani.
128. Potvrdte Done.

A,
SN
7 s~
). s
RS 7 T 7 )
S A
o 2 %//,W,, R —
s N %
Cetovac s,

| , .--.I :// 7.

22 s s

fieisis
,

i )
S

Loz &
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129. Stejnym zplsobem vytvorte dle obrazk{ druhou Srafovanou oblast.

Mexk

Previous

Pick Frorm Lisk

Edge Display. ..

Hakch/Fill
="
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Krok ¢.8

Kotovani

> Koty Ize do vykresu vlozit dvéma zplsoby:

o

o

Promitnutim kot z modelu
Vytvorenim kot

>  Abychom mohli ve vykresu vyuzit jiz vytvorenych két modelu, musime se snazit jiz pfi modelovani zadavat koéty s védomim,

Ze je budeme promitat do vykresu.

> Nejprve tedy promitneme vyhovujici koty a poté vykres ru¢né dokétujeme.

130. Spustte prikaz ¥ Show and Erase.
131. Zapnéte promitani kdt a vypnéte promitani os (viz obr.).

Type

A [ R

132. V nabidce Show By vyberte Part.

Show By
() Feature () Feature and Wiew

(®) Pat () Part and View
O View | Show &l
133. Kliknéte na jakykoliv pohled.
»  Zobrazi se koty modelu.
134. Drzte CTRL a vyberte kéty zobrazené na obrazku cervené.
L
i
e s i
Py i s
"o s s
H— | - i P L e
\.j{\\\ 1 ; ( :
: 4 ' e
J |
OCG‘
%)
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135. Chytnutim mysi vytahejte Cervené oznacené kéty na pozice dle obrazku.

_¢'
o e iy
°y ,.ll!!%iigég!lliﬁﬁr‘*
S ‘

Pl Y W

1 st ‘1fi%gyghb
W o
I W‘
oy |

a30°,

7
g
7 7 oo ot

-

Ao

52 5.

AN

ki

> Nyni si ukdzeme, jak Ize jednoduse promitnuté kéty prehodit z jednoho pohledu do druhého.
136. Oznacte kotu na obrazku zobrazenou Cervené.

137. Kliknéte na ni pravym tlacitkem a z nabidky vyberte Move Item to View.

138. Kliknéte levym tlacitkem na detailni pohled A.

> Kota se presune z pohledu ZAKLADNI do pohledu A.

reviaus

Edge Display...
Madify Mominal Yalue
Flip Arrows

Properties
e
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139. Stejnym zplsobem presunte kétu priméru stfedové diry z pohledu do pohledu PROMITNUTY.

5

25,

>  Nyni ruéné vytvofime zbyvajici kéty. - ATTACH TYRE

140. Kliknéte na ikonku o . On Entity

» Zobrazi se Menu Manager. on Surface

141. Kliknéte na prvni osu (na obrazku vlevo zelené). Midpoint

142. Kliknéte na druhou osu (na obrazku vlevo Cervené). Centter

143. Prostifednim tlacitkem umistéte kotu. Intersect

> Nyni mizete bud vytvaret dalsi kétu nebo dvakrét kliknout prostfednim tlacitkem a tim ukonit Make: Line
vytvareni kot. R

25.5
255

L4 \
l/ PFi vytvaFeni kot ve vykresech se systém chova stejnym zplsobem jako v reZimu skicare.
Rs
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144. Stejnym zplsobem vytvorte dalsi koty (na obrazcich Cervené vyznacené).

30°
OQ%

LY

O
X
W RSANEASZ A AT A A

iy

@8

______ o]
oL
; i
¥ d |
of) . 5o
o) Ho ’

145. Vytvorte dle obrazku tfi koty poloméru.

> Kota poloméru vyzaduje zadat jen jednu referenci (namisto dvou) a tou jest oblouk, poté jiz miZete umistit kotu.
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> V tomto pripadé potiebujeme, aby kéty poloméru nemély u znacky poloméru R zadnou dislici, provedeme to takto:
146. Kliknéte pravym tlacCitkem na hodnotu kéty poloméru R3.

147. Z nabidky vyberte Properties.

148. Prepnéte se na zaloZzku Dimension Text, kde miZete editovat text koty.

' Pokud nechceme zobrazit hodnotu kdty, nelze v Pro/Engineeru pouze smazat text v poli Dimension Text, protoze
[ & ' systém automaticky hodnotu kéty dopini. @D je tfeba pFepsat na @O a pak dopsat libovolny text i Cislici.

149. Prepiste text v textovém poli na tento: R@O.
150. Potvrd'te a provedte tento postup i u ostatnich kot poloméru.
> Vysledek Ize vidét na obrazku.

5

25,

> Nyni ptiddme do két tolerance, znacky primérd a provedeme dalsi Upravy két.
151. Kliknéte pravym tlacitkem na hodnotu kéty vyznacené na obrazku (viz obr.).
152. Z nabidky vyberte Properties. 1

ek
Previous
Pick. Fram List

Erasze

Show as linear

Edit Attachment

Clip Witness Lines
Maove Tkem bo Wiew
Edge Display...
rMadify Mominal Yalue

Flip Arrows

ETE—
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153. Tolerance mode nastavte Plus-Minus.
154. Tolerance table nastavte None.

155. Upper tolerance nastavte 0.

156. Lower tolerance nastavte 0.20.

\1/ VSimnéte si, Ze nastavenim Lower tolerance na 0.20 se v koté zobrazi tolerance -0.2.

157. Pridejte tolerance k dalSim kétam zobrazenym cervené na obrazku.

,,XQ
D
D
\\y
2505

o !
SN, . N J l"'\‘
T TN 73 N T T B i
\:x\ MM AVNNERN W
; v Y 4o

i
0.5 ]

0

5

0.5

&

i

< U

5

=5y
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158.

Upravte text u Cervené zvyraznénych két podle obrazku.

8.3

L2
\l.) Specialni znaky jako napf. @ Ize do kéty pridat pomoci tlacitka (Test Symbel.. ],

o). 5 x45%

\i/ Kliknutim pravym tlacitkem na kdtu a zvolenim Flip Arrows prohodite Sipky u koty.

0.5 x45°%

Krok ¢.9

Geometrické tolerance

159.
160.

161.
162.

163.

Kliknéte na tlacitko ™.

Vyberte druh geometrické tolerance souosost: .
Kiiknéte na |_Select Eniity... |

Vyberte osu prostfedni diry (Cervené na obr. vlevo).

Umistéte toleranéni znatku na kétu (viz obr. vievo) pomoci [_Flace Gtal... |

05045
0,545 I
s
0.5x45 _
L 0.5x45
543.T

B84

= 1l
=
0545
0.5¢45" 10
]
0.5x45
L 0.5x45”
544
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164. Vytvoite druhou geometrickou toleranci stejnym zplsobem dle obr.

=©
i 0.5x45
\ 0.5445 I
i m
0. 5245
05445
507
b b 17710 05

Krok ¢.10

Drsnosti

»  Znacky drsnosti jsou ulozeny v knihovnach a je proto nutné mit tyto knihovny k dispozici.

165. Kliknéte na ikonu

 From Palette.

> Otevie se okno s paletou symboltl, jednoduchym kliknutim na symbol a kliknutim do vykresu umistite znac¢ku. My nicméné

tuto paletu v tomto vykrese pouzivat nebudeme, zvolime druhou moznost vlozeni znacek drsnosti.

166. Zaviete Paletu .

[ Symbol Instance Palette: paleta_symbolu g|
Volnd umistdné symboly Symboly umistdné na entity [(Move in Paite
rpt.index [ 0.0 i 100 [ ]
Y o rpt . gl et T4
JO )
CEMENTOVAKD
TYRDE CHRONGVANO £r20
HALENG
HITR 1 DOVANG 60,04 |
YROUBKOWANL 0.8 CSH 014932
RYHOVAND 0.5 CSN 014930 i ¢
3] 2 ‘i
;u.s ;f
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167. Kliknéte na ikonu '1‘.

» Zobrazi se dialog Custom Drawing Symbol. V tomto dialogu Ize nadefinovat novou vykresovou znacku nebo otevfit znacku
nadefinovanou dFive.

168. Kliknéte na tlacitko .

169. Vyberte z knihovny soubor drsnost_praporek.sym.

> Tato drsnost Ize umistit na odkazovou caru.

170. Vyberte levym tlacitkem hranu dle obrazku.

171. Vyberte umisténi znacky a potvrd'te prostrednim tlacitkem.

172. Vyberte dalsi hranu (obr. vlevo), umistéte znacku a potvrd'te prostfednim tlacitkem.
173. Vyberte dalsi hranu (obr. vpravo), umistéte znacku a potvrdte prostfednim tlacitkem.

*0.5145'*

=3 g | 0.5 x45° _ || _
g Tl 0.5 w45t

+ ____|_ 0.5x45° 5%

174. Vyberte dalsi hranu (viz obr.ii umistéte znacku a potvrd'te prostfednim tlacitkem.

175. Potvrd'te provedeni pfikazu .
|

3

|

L 0.5545°
0. 5545 ]

S =

0.5 x45°

14
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176. Pridejte zalomeni kliknutim pravym tlacitkem na Sipku a vybranim Insert Jog.
> Zalomeni mGZete odebrat tim, Ze na néj kliknete pravym tlacitkem a vyberete z menu .

0.5x45°

Mext

Previous

Pick From List
Delete

Edit Attachment

Edge Display. ..

0.5x45°

177. Dvoijité poklepejte na znacku drsnosti.
> Zobrazi se dialog Custom Drawing Symbol.

178. Vyberte zdlozku Grouping.
179. Vypliite dle obrazku.

Custom Drawing Symbol

General | Grouping | Wariable Text

Preview

DRSMOST_PRAPOREK
=-[+] POVRCH
) OBROBEMY
O NEDBROBENY
- [*]HODNOTA_DRSNOSTI
& R4
O RZ
O RY
O BEZ
[1SMER_OBRABEMI
- [¥] UPRANA_POVRCHU
[JZ&ROvMNAND
[JEROUSEND
[ LaPOvAND
[#]JIMa,
[]FO_OBvODU
[ | PRODAVEE_MA,_OBROBENI
CIwLMITOST

E

othodnota_dranestit

fuprava povrohu
R f

Move ][

)8 ][ Cancel
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180. Klepnéte na zalozku Variagle Text. -
181. Nastavte hodnotu drsnosti: 1.6. i i o0.5x45
182. Nastavte Upravu povrchu: VYSTRUZENO. 0 5445 .
183. Potvrd'te Upravy znacky . P — -
VYSTRUZENG ]
gRal. & o o
184. Obdobnym zplisobem upravte zbylé tfi znacky drsnosti
R i
ofal . 8 o
/}s—a ]
''''' ' I
|
oo
e
1 | o0 545
 0.5x45" T
VYSTRUZENO |-
Fal .6
{' ghal. .6/ 4
0.5:45
0. 5y 45
51
- 70,05
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> Nyni pfiddme jednu odkazovou ¢aru ke znacce zobrazené nize.

185.
186.

187.
188.

Potv

N

BROUS ENG

oRal. g

2 4

o

—>

r

Dvakrat kliknéte na znacku zobrazenou na obrazku.
Drzte CTRL a vyberte hranu dle obrazku veprostred.

Pridejte zalomeni druhé odkazové Cary (viz obr. vpravo)

BROUS ENO

aRal. 8 o

>

& 4

BROUS ENO

oRa0. 8/ a

24

o

Krok ¢.11

Sipky oznacuijici fez

189.
190.
191.

Ral.B

|
0.5x45°

0.5x45

.|

|

YYSTRUZEND

0.5x45 _

1
|
|
I
|

M- — - — = — = — - —

0-0

Pick Fram List
Delete

Show Dimensions
Wigw Info

Cleanup Dimensions
Use Model in Tree
Edge Display...

Lock Yiew Mo

Properties

ent

Del

Kliknéte pravym tlacitkem na fez B-B a z kontextové nabidky vyberte Add Arrows (viz obr.).
Kliknéte na pohled ZAKLADNI.
Vytvorené Sipky upravte tak, aby vypadaly jako na obrazku vpravo.

Cal
s -
N ~1 L/ |
o e >
S F "
Y e > ] v
Se o o
L]
3 > < 2
™ g X e e
I >
i y
o~ e
N ST
S TR
&2 \.
R ! 57 C ke
", - ]
> "ol
T .
- - 40,
- L | H 5
® ‘
C—;J b-'l' e -+
GP : =
; I
{ '
A,
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Krok ¢.12

VypInéni razitka

> Razitko, které je k dispozici v CAD ucebnach a které je soucasti tohoto tutorialu je propojené s parametry modelu. Lze jej

editovat bud’ pfimo poklepanim mysi do jednotlivych poli razitka nebo zmé&nou parametrd modelu. Nyni si ukédZeme obé
moznosti editace razitka.

192. Poklepejte do pole CISLO VYKRESU.

193. Zadejte &islo vykresu: ® Enter value for CISLO_WWK KKS-CAE-0101 [ ][]

N

> Cislo vykresu se zobrazi v razitku.

150 128 £ 45

YSEORECHE TOLERANCE 150 80015
GEMERAL TOLERAMCES 150 80015

150 2768mk
150 2T7468mK

o oo 0061 | e 0

Focet Nazey - rozmer Polodovar Material konecny/vychozi [Toodp. C.hmet Hr . hmaot C.ovyhr. Poz

kusu 1ivy ) ) ) ) ) A seslavy

Buan- ) L . . } R aw .

Fity Tidle - size Blank End mater ial/Material Weight weithDraw'“g asm. No |Pos.
Datum ImenaName Oatum Name

KresLil| | .. _ . Techno-

L Log/isH

Prezk | Prezk.

ATHR ACHEK

Schval Sthval .

SAPP /APP index iHoSchval il thppr. popis imgnylchange Dadum | Podpis s Name

Methode 1 PornamkasMote:

Soubor -model/ASM-File

KKS

lList/shem 1

Merithn / 5cdle | C.sestavy #
SITKO . Assambly Mo.
Soubor-vykress0RW -file 2 - I
—
CAE Nazev / Titla CISL0 VYKRESU /DRAW ING MO, F;]T?Ea;

KKS-CAE-01-01

pocel Listus no.sheeis
— —

] 3
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>

194. V menu Window kliknéte na SITKO.PRT.
195. V menu Tools vyberte Parameters.
196. Zapiste do hodnoty parametru MAT_KON hodnotu X46Cr13.

197. Zapiste do hodnoty parametru CIS_SESTAVY hodnotu KKS-CAE-01-00.

B Parameters

Nyni si ukédZeme druhy zplsob editace razitka skrze parametry modelu.

B

File Edit Parameters Tools  Show
Look In

Part v|||jSITKIII vl

Filter By | Al v
Mame Type Yalue Designate  Access

Sting BoFul .
Shring ¥ E?f?FuH .

MAT _VYCH Shiing BoFul ..
M&T KON Sting 4BCI 3 EoFul ..
T_0DP Sting BoFul .
HR_HMOTHOST Sting BoFul
AUTOR Shing EoFull ..
CISLO_WYK String KE5-CAE-01-01 ol .
C_HMOTHOST  RealNumber  0.051000 O @ocke. | T
POZICE Integer 1 C &orul .
POZMAMES  Shing O &ofu ..
NAZEY String SITKD O Sk ..
TECH_CISLO Sting O &aFu .
CISLO_SEST  Sting KK5-CAE-01-00 O @
TvP Shing l O &aFun ..
< | >

E Fain A |[ Properties. . ]@

Ok Reszet Cance

198. Potvrdte L_0K_J.
199. V menu Window kliknéte na SITKO.DRW.
>V razitku miZete vid&t vyplnéna poli¢ka hodnotami parametrl modelu.

Hrubou hmotnost je nutné ru¢né napoditat z rozmérl polotovaru a hustoty materiélu.

Cistd hmotnost modelu je pocitdna automaticky, repektive je déana vztahem v relacich c_hmotnost=ceil(mp_mass(""),3)
Pfedpokladem pro spravny vypocet Cisté hmotnosti je zadana hustota materialu

Hustota materidlu se zadava v menu Edit --> Setup -->Mass Props.

YV V V V

_x"\\ Pozor, hustotu je nutné zadavat ve spravnych jednotkach, napfiklad pouzivdme-li milimetry a kilogramy je nutno

/ &\ zadavat v jednotkach ka/mm?3. Pouzivané iednotky Ize nastavit v menu Edit --> Setup --> Units.
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200. Doplrite zbyvajici udaje do razitka dle obrazku libovolnym zplsobem.

¥ |
| PRUMER 50 - 7 CSN EN 10088 46Lr 13 | 0081 013 kkS-CAE-01-00] |
Pf;;; Nazew - roimer Palotovar Material konecnyfefchozi |Toedp.| < himet. Hr hmod ] Cse;i}rcl;':r Paz
Bugn- . L . . . Raw .
tity Title - size Blank End maferial/Maoterial Weight weighi Drawing asm, No.|Pos,
Datum JmenoSHame Oalum Nama
kreshil] | . . Technn-
T H. [3-Nav-0%] NOVAK Jan Log/ist
Preazk. Prezk.
JLHK SLHE
Srhval Cchval -
“APP sAPP e HESchval i 1/ dppr. pepis menyichange Dadium | Padp1sfHame
Metnade 1 Poznamhka Mote:
YSEOBECHE TOLERANCE 150 80015 150 2T6AmK
150 124 Eﬂ@‘ GENERAL TOLERANCES 150 BOOTS 150 2768MK
- 7 _fi - -
Soubor-model 2ASH-file S| Tk | Meritho S Srale E«ssseeﬁ'lfgl? N':j_ KES-CAE-G1-00
Sougor-vykres/DRW -file 2 I
SITHO X
Mazev 7 Tille IS0 YYRRESL <DRAW NG HO. Formail
CAE S1TKO KKS-CAE-01-01 |
KKS Liztseneer | pocel Llistus no.sheais 1 3

-l,) Pocet kus a Datum nejsou vazany na parametry modelu a je potfeba je zadat do razitka pfimo ve vykrese.
<

Krok ¢.13

Technické pozadavky

>

201. Kliknéte na ikonu

Nad razitko umistime tfi Fadky textu s technickymi pozadavky.

Note.

202. V menu manageru ponechte vsechna defaultni nastaveni a kliknéte na Make Note.
203. Kliknéte levym tlacitkem na pozici nad razitkem (viz obr.).

1 FRUMER 50 - 7 C5HOEN 1004 “_B_L_’_H D061 0. 13 [KeE-cal-ol-o0 1 [ |
Fotel X " - - - T, apkr-
[ Lo Wizev - raimen Peitdoeor Nateriol benscnpingiheri|l.edp.| C.hnad. -Ir'.}nrlﬂ ol oz
ar- il g
:i:v Title - zire Blank End matariol fMolerran Weighd s ign [I1A%ing an W [Paz
Oalun s dhaTe Oatun Hane F
restitf o . Tethrg-|
mwh.| e 0df GRS e |
FTeah. Preze.
/T HE ALHE
ndl Schuat,
<APF L indes sRafichwal 112 hppr nopis amenyichange Dalan | Padpis! Ko
Hetrede 1 Paznameadole 1
VSEDEECHE TOUERARCE 150 S00TS 150 (T&ank
s s £ R R T L
S D0r= okl SN File 51 The| Heriko & Side i;ﬁ:ﬁr“’o. KRS-CAE 21-09
FmDor -yt s ORW - i
L 51T = G
MNazew A Tile L15L0 WTERESL TRAW ING NI, Farmal
CAE SITKO KKS-CAE-D1-111 -
KKS li:l-f'sl'ul“1 el Lisiu’ ra.sheels 1 3
| & I T

204. Napiste text: POCET DER g4 = 48, Ra3.2

>
205. Potvrdte a ],

x|
K5 =l 2 N
(oo )w =]
Za]o ] /]
A=) A
(@ ])g]) o @]
loje]@]o]
MEAEI S|

|
<> ]
N
1]
¢
L
Gl

Cloze

Pro vloZeni znacky priméru g pouzijte dialog Text Symbol, ktery se automaticky otevie pfi psani textu.
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206. Kliknéte na Make Note.

207. Kliknéte levym tlacitkem na pozici nad prvni poznamkou.
208. Napiste text: TVRDOST: min. 650 HV 10

209. Potvrdte ] a [,

210. Kliknéte na Make Note.

211. Kliknéte levym tlacitkem na pozici nad druhou poznamkou.
212, Napiste text: KALENA PLOCHA

213. Potvrdte ] a [,

214. Ukoncete vytvareni poznamky kliknutim na Done/Return.

KALENA PLOCHA
TVRDOST: min. 650 HV [0

POCET DER @4 = 48, Ra3.Z

| PRUMER 55 - 7 CSN EN 10088 KAELr 13 0061 | 0,13 jKS-CAE-01-00 |
Foce Nézev - rozimer Paletavar Wateriol konecny/wychozi T od C . hmod Hr _hemod G wghr. Paz
kusu Yoy OCR- : - - | sestavy
I:II(:?\;' Title - size Blank End material Material Weight 'E?:M Drawing asm, Mo, |Pos.
Dalum ImenosName Datum Hame
resLilf ;. R Terhno-
Erm 13-Mow-99] NWAK Jan log/ist
Prezk. Frezk.
#CHE AHK
“rhwval Srhwal .
SRR ~APP i ndex FMaSchval 1] fAppr. pepis Tmeny/change Batum | Padpie/Mame
Matpade 1 Poznamkahata:
YSEDRECME TOLERANCE 150 BOO15 150 2768mk
150 128 €710 (REbar TOIRACES 190 800" 193 Z3ehnm
Soubor-model AASM-tile Meritko # Srale |C.zesfavy ¢
SITHG . ASSEI‘I‘II]LY Ho. HKS'CAE'UI-OU
Soubor- vykres DR - File 2. I
SITKD NS
— -
CAE Narevw # Tile CI5L0 WYWRESU /DRAW IMG NO, FSO:?SI
Licrgneet 1 pocel lislus no.Sheets 1 3

> Nyni jesté pfiddme pred napis KALENA PLOCHA znacku Srafu.

215. Kliknéte na ikonu ©.

216. Naskicuijte kruznici pred napis KALENA PLOCHA (viz obr. vievo).

217. Vyberte kruznici a kliknéte na ni pravym tlacitkem.

218. Z menu vyberte Hatch/Fill.

219. Potvrdte libovolny nazev.

220. Kliknéte na Spacing.

221. Pomoci tlacitek Half a Double nastavte hustotu Srafovani stejnou jako v zakladnim pohledu.
222, Potvrd'te Done.

>  Vysledek miZete vidét na obrazku vpravo.

() KALENA PLOCHA ) KALENA PLOCHA
TYRDOST: min. 650 HY [0 [——> TVRDOST: min. 650 HV |0
POCET DER @4 = 48, Ra3.2 POCET DER @4 = 48, Ra3.2
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| 0.5x45°
/ 0.5x45°
2
2,
&7
VYSTRUZENO |—d
Ral .mw

& xo_.mm

ol 0.5x45°
5
Q) KALENA PLOCHA ——=—{/7]0.05

TVRDOST: min. 650 HV 10 @ r_w
POCET DER @4 = 48, Ra3.2

0.5x45

XI1-38

ittr 13 .
, PRUMER 55 - 7 CSN EN 10088 bl 0.061 | 0.13 KKS-CAE-01-00
d Polo- 5 i I hm Cu vk
Nazev rocmer Polo-ovar Mg-¢rial sonecny/vychosl [.odp. | C.hmot. Hr.hmet | sestevy Poc,
Tit ¢ - size Blark End material /Material Weight swﬂ_.“Zo,:,S asm. ho_|Pos
Jmeno/Nerre Jatum Name
Krestill - no o -gg| Novak Jon [TeNTO-
Mrezk.
/L HK
Schval.
/APP index/NgSchealil!Appr pepis zmery/change Datum | Podpiz:/Name
Metrode 1 Poznamka/Note
0 Sazech ‘M/ VSEOBECNE TOLERANCE IS0 80015 I1SD 2768mk
1018 ~— ¥ DBENERAL TOLERANCES ISO 80215 (SO 2768nK
I i zle [ C. vy /
ile SITKO| Meriko / Scale ﬁpmwmﬂm%za. <KS CAC 31 0C
SoLbor-vyk es/ZORW -file Nu _
SITKO et
CISLD VYKRES.J /DRAW INC NO ma
Nazav / Title 3 RES.) /DRA 0. Format
O_aaﬁ SITKO KKS-CAE-01-01 |
list/sreet 1 Docet Listu/ no.shests | N/

2 [ 3 L 5 [ 6 | q 8 [ 9




CVICENI XIII

CIL

Tvorba vyrobniho vykresu soucasti podlozky sestavy mlynku na maso.

| 67!0.3
- 0
¢ ol
.
T
> [Fe)
- & %
o
0 o
(a4
i=d
¢ (= -4
P1 - 500 x 1500 CSN 425301 11500.0 001 0.005 [0.006 |[KKS-CAE-01-00| 2
Racel NG Polol Materi vgchoz( [Toodp.| C.hmol.  [irhmot.| VIO Poz
i izey - rozmer olotovar aterial konecny/vychoz .odp. mot . r.hmot . e o0z.
“Lﬂj, Title - size Blank End material/Material Weight fji‘;h, Drawing asm. No. [Pos.
Daium | Jmeno/Name Datum Name
Kresiit Techio-
[0 | 2-Fen-10 | NOVAK Jan ||
Prezk Prezk.
/CHK /CHK
Schal Schval
/AP 7hPP ndex/No[ Schvalil/Anpr popis_zmeny/chenge Datun_| Podpis/Name
Methade 1 Poznamka/Note:
128 (@) VSTOBECNE TOLERANCE 150 80075 1S0_2766mK
1507128 \7VP/' GENERAL TOLERANCES S0 80015 1SO 2768mK
Soubor-madel /ASM-file Meritka / Stale | C.sestavy / < 80
PODLOZKA te [Coustamyr KKS-CAE-01-00
Soutor-vykres /DRW -file 11
PODLOZKA e
—_—
Nazev / Title C1SLO VYKRESU /ORAW ING NO. Farmat
CAE PODLOZKA KKS-CAE-01-02 | °
KKS /
List/cheet 1 oot Listu/ no.shieote H

PREDPOKLADY

e Vymodelovany nebo stazeny model souc¢asti PODLOZKA mlynku na maso.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v’ Zaklady tvorby vykres(:

o Vytvareni pohledd
o Koétovani

o Tolerance, drsnosti
o Vyplhovani razitka
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Krok ¢.1

Otevieni prazdného naformatovaného vykresu

1. Oteviete soucast podlozka.prt.

v N

Kliknéte na tlacitko

03

, otevre se dialog New.
Doporucuje se pojmenovavat vykres soucasti/sestavy stejné jako

soucast/sestavu, ktera je na vykresu zobrazena.

W

Vyberte Drawing z nabidky.
Vykres nazvéte podlozka.

Sketch
Fart

Azzembly

Drawing
Farmat
Fepart

Diagram

O &]
i @ Markup

Layout

M anufactuning

Sub-type

M ame

podiozkd

Common Marme

Usze default termplate

Cancel

> Pokud byste neméli otevirenou soucast SITKO.PRT (viz bod 1), museli byste zde zadat cestu k modelu, ze kterého chcete

délat vykres.

® No w

B New Drawing

Default bodel

Potvrdte vytvoreni vykresu ([

X

|PODLOZKA PRT

| [ Browse... ]

Specify Template
() Usze template
(%) Empty with format
) Empty

Farmat

[rone

Vl Browse... ]

Caticel

V dialogu New Drawing vyberte Empty with format.

Kliknéte na .

Vyberte a4_v1_vyrobak-uni.frm ze seznamu.

Open

Jal ok

Comman Folders

IE| In Session

m Desktop

5 My Documents

ﬂ ‘wharking Directary
Netwark Neighborhood
Templates

ﬁ EMIHOWNY-STANDARDS
System Formats

User Formats

@ Favorites

Folder Tree &

T Todls ~
1 bmw

Fd all w1 _sestava-unifim
Fd al_zcu_asmfm
Fd all_zcu_asm_bom. fm
o al_zcu_det frm
Fod al_wl_sestava-unifim
o al_zcu_asmfm

Fd al_zcu_asm_bom. fim
Fd al_zcu_detfim

P a2 wl_sestavanewfm [ ad_w1_kusownik-new frm
o] al vl _sestavanewfm |3 a2 w1_sestava-unifim ol ad w1 _kusovnik-uni fim
o a2 wl_wwobak-newfm [ a4_v1_sestava-new fim
g al vl _vprobak-newfrm |3 a2 w1_wprobak-unifm 7 ad v1_sestava-unifrm
g al vl _wprobak-unifn [ a2_zou_azm fim Fo ad_w1_wprobak-new. frm
Fd a2 zcu_asm_bom fim = E
Fd a2_zcu_det frm F ad_zou_asmfim
Fd a3 wl_sestavanewfm [ a4_zou_asm_bom frm
o] al_wl_sestavanewhm |3 a3 w1_sestava-unifim o ad_zou_detfim
Fod a3 w1 _wwobak-new frm
g al_wl_vwrobak-newfrm [ a3 w1_wprobak-uni fim
g al_wl_wwobak-unifn [ a3 zou_asm fim
Fd a3 zcu_asm_bom fim
Fd a3 zcu_detfim
Fd a4 bom fim
File name: a4_w1_vyrobak-unifrm D ate modified: 16-5ep-09 05:39:32 PM Freview «
File name: | ad_+1_wprobak-uni.frm | T_l,lpe|A|| Filez [*] v|
[ Open '” Cancel ]

1) Tento tutorial pfedpokladéa nastaveni systému PRO/ENGINEER totoZné s nastavenim ve $kolnich CAD u&ebnach.

N

{J‘ 4 M

XIlI-2

Je dlleZité mit k dispozici knihovny vykresovych znadek, $ablon vykres a mit v systému PRO/ENGINEER nastavené
cesty k témto Sablonédm a znackam. Tento tutorial nefesi moznosti nastaveni systému PRO/ENGINEER.




>  PFi otevirani vykresu nas systém vyzve k vyplfiovani parametri razitka, zatim tyto vyzvy miZeme odentrovat.
> Nyni mame otevny prazdny a naformatovany vykres formatu A4 (viz obr.).
9. Vykres ulozte do stejné slozky, ve které mate umistén model podlozka.prt.

B 1 500 x 1500 560 001 | o005 i

p.?;:: Higer - roamer Polatavar Haterial honectysjchoai  [T.ocp.| Cohmol.  Heamor. L Pea.

puan- Tille - aize Blark Erd materia Haterial weart | P [urawing asm, Ho- [Fos.
Datun | Meriorhane | Datun Hane

Fresbll 12-reo-10 | hoaw an {100
PRETH
J

LHE

Schval Sifnd,
HFF SEP rdas | Somatd Ao popis ey rhange Dt | Porkis Mame
Hetnage 1 Prznankadioe

VIEDBECHE TOLERAMCE 150 BOOE 150 ZTeSrk.
[ Sl Nl A R

Squbor-model A3 H-Five POOLDZEA. Peritka £ Sedle E‘S&g:ﬂ[s.l;ﬂ’n
Soutor-vres DN - le — T
CAE PODLOZKA KKS-CAE-01-02 | "
KKS b 1 o v e 1 | &
Krok ¢.2 Vytvoreni zékladniho pohledu

10. Vytvorte zakladni pohled ** General.
11. Klepnéte kdekoliv na vykrese pro umisténi pohledu.
> Pohled se vlozi do vykresu a zobrazi se okno Drawing View s nastavenimi pohledu.

13. Zmért bisplay styie s No Hiddem,
13. Zmé&fite Display style na No Hidden. - Uity = X

14. Tangent edges display zmérite na None. Cateqories  viw display options
" ’ v Wiew Type
15. Potvrd'te provedeni zmén |_#rely |, Vioile e
> VSimnéte si jak se zménilo vykresleni pohledu (viz Scals Display stle | (7] Mo Hidden A
obr. vlevo). Sections
Miew States | T apoent cdnes display style :ﬂ Mone w

Il'l'lll :E: El
[rigin Hidden line remaval for quilts Colors come fram
Aligrment ) Yes (%) The diawing

j () No ) The model

Skeleton model dizplay

®) Hide Weldment kzection display
() Show

Hidden line remowal for =hatches

(®) Yes
) Mo

l ] ] [ Eancel] [ Apply ]
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16. Potvrd'te vytvoreni pohledu tlacitkem . B Orientation

» Nyni vytvofime novy pohled v modelu podlozky. Type
17.V menu Window kliknéte na PODLOZKA.PRT. [ Drient by reference
> Tim se prepnete do rezimu objemového modelare. Dlers
Okno musi byt aktivni, abyste v ném mohli provadét zmény, postupem uvedenym Reference 1
i ) vySe se okno aktivuje automaticky. Pokud prepnete mezi okny v hlavnim panelu je |Tc-|:- v|
nutné stisknout iknou Activate. pro aktivaci okna. E“Surr:FB[HEVDLVE_H |
v, + . Ref 2
18. Spust'te prikaz “* Reorient. |Fr;te Ll 5

19. V dialogovém okné Orientation vyberte Orient by reference.

> Nyni se vas systém pta na zadani dvou referenci pro orientovani modelu.

20. Reference 1: vyberte Top a vyberte plochu (na obr. vlevo Cervené).

21. Reference 2: vyberte Front a vyberte rovinu NARYS.

22. Novy pohled uloZte tlacitkem (viz obr. vpravo). -
Standard Orientation

> Nové definovany pohled je na obrazku dole . Default Drientation

[ & | [NARYSF3DATUM PLANE) |

Name | Z&KL_POHLED |
[ Set ] [Sa\-'e] [Delete]

I_ ]S ] [Cancel] [Undu:u]

FLDORYS

ECQOKORYS

23. Vytvoite fez A (“® ), ktery bude definovan rovinou NARYS (viz obr.). B View Manager

| Simp Hep| Heec |Drient ||H|

[NEWJ[ Edit'” Displa_uv]

Mames
& Mo Cross Section

Cloge
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24.V menu Window kliknéte na PODLOZKA.DRW.
25. Dvakrat kliknéte na vytvoreny pohled.

» Otevre se dialogové okno Drawing View.

26. Pojmenujte pohled, do kolonky View name napiste ZAKLADNI.
27.V nabidce Model view names vyberte nové vytvoreny pohled ZAKL_POHLED.

Drawing View

Cateqgories Yiew type

Wiew Type

) Angles
tModel view names

ZAKL_POHLED

Standard Orientation

B

Visihle frea | View name | ZAKLADNI

Scaln_e Type

Sectiohs

Wiew States Wiew orientation

E'?W Display Select orientation method (%) Wiews names from the model
nan () Geometry references

Alignment

Default orientation
Uzer Defined A

* angle |-120.00

Default Orientation
Y angle | 200.00

.L_POHLED

[ 0k, ] [ Cancel ] [ Apply ]

Polozku Custom scale v dialogovém okné Drawing View na zaloZce Scale primarné NEPOUZIVEITE pro zménu

i % mé&fitka. Pouze pokud chcete mit u tohoto pohledu odligné métitko, neZ méte v ostatnich pohledech. Vice viz krok &.3.

28. Kliknéte vlevo v nabidce na Sections.

29. Vyberte 2D cross-section a kliknéte na .
30. V nabidce Name vyberte fez ¥ 4.
31.V nabidce Selectioned Area ponechte Full a kliknéte na (et ],

— N/

A-A

> Vzhledem k tomu, Ze tento fez je hlavnim pohledem vykresu, neni nutny popisek fezu, odstranime tedy popisek A-A.
32. Oznacte pole popisku A-A levym tlacitkem mysi.
33. Kliknéte pravym tlacitkem do tohoto pole a vyberte prikaz Erase.

A=A

Save Moke !

Edge Display...
Properties
Add Hyperlink.
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Krok ¢.3 Zmeéna mefitka vykresu

> Zménime méritko vykresu na 5:1.

> Povsimnéte si v levém dolnim rohu grafického okna textu SCALE:... TYPE:... NAME:... SIZE:... (viz obr. nahofe). Tyto udaje
zobrazuji zékladni informace o vykrese a nékteré z nich (SCALE a SIZE) Ize zménit poklepanim na tento text.

34. Poklepejte na text SCALE.
35. Prepiste meéritko vykresu na 5(viz obr. dole).

SCALE: 241

B> Enter value for scale 5

" Polozku Custom scale (v dialogovém okné Drawing View) pro zménu mérfitka pouzivejte jen v pfipadé, ze chcete mit
/ e % U tohoto pohledu odliSné mérfitko, nez mate v ostatnich pohledech. V opacném pfipadé pouZivejte postup popsany vyse.

e . Méfitko vykresu Ize také meénit poklepanim na kolonku MéFitko v razitku vykresu. Tento postup je rovnocenny s

1 postupem uvedenym vvyse

Krok ¢.4 Promitnuti os do vykresu

> Nyni promitneme osu z modelu do vykresu.
0w . fpem

36. Kliknéte na ikonu * Show and Erase.

> Objevi se okno Show/Erase.

37. Vyberte promitani os ~——*', nastavte Show By: View. Show [ Erase @
38. Kliknéte na pohled ZAKLADNI.

>  Zobrazi se vSechny osy modelu zobrazené v tomto pohledu.

»  Zkontrolujte, zdali je aktivni tlacitko , C0Z znamena, ze vybrané osy _

budou promitnuty z modelu do tohoto pohledu..

39. Vyberte osu rotace télesa. Type
40. Kliknéte na [ ok | a I Closs |
=
# i A
!
I
i Show By
|
g i V.
m

Optiors | Preview

[ Sel to Keep ] [ Accept Al ]
[ Sel to Remove ] [ Eraze all ]
(.
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Krok ¢.5

Kotovani

> Koty Ize do vykresu vlozit dvéma zpUsoby:

Promitnutim két z modelu

[e]

o VytvorFenim két
> Systém ProEngineer umoziuje prevzit vykresové koty z jednotlivych skic z modelu.
>  Promitani kot z modelu ma nékolik vyhod: rychlost vytvareni vykresu, stabilnéjsi koty, které se automaticky aktualizuji.
» .

Abychom mohli ve vykresu vyuzit jiz vytvorenych kot modelu, musime se snazit jiz pfi modelovani zadavat ve

skicafi kéty s védomim, ze je budeme promitat do vykresu.

\i‘) Napriklad automobilky vyzaduji u vykresové dokumentace, aby minimalné 80% kot bylo prejatych z modelu.

> Nejprve tedy promitneme vyhovujici koty a poté vykres ru¢né dokdtujeme. Tupe
v b=
41. Spustte prikaz * Show and Erase. —
v PN v sy . 1.2 1.2
42. Zapnéte promitani kot a vypnéte promitani os (viz obr.). ||"_ _'|| |+': :'"|
R ) R Al
N
43. V nabidce Show By vyberte Part. Show By
() Feature () Feature and View
&) Part () Part and Wiew
O View | Show al
44. Kliknéte kamkoliv do pohledu. e
>  Zobrazi se koty modelu. .
45. Drzte CTRL a vyberte kdty zobrazené i ]
na obrazku ¢ervené. : Do
' L™
|
Wo 1
!
g X
)
e il
. EQj g7
=
]
46. Poklepejte levym tlacitkem na kotu @25.  |RelUtEEIIEN IS X
47. Vyplite nastaveni toleranci dle obrazku. Propetties | Dimension Test | Test Stle
Walue and tolerance Format
Talerance mode + Summetric (&) Decimal

Tolerance table

Mominal value | 25.000

nong

“ () Fractional

Mumber of decimal places
3

Tolerance 0.500
Angular dimension units
Displ
@ 2 5:|: |:] 5 |spa_y - Dual dimension
. O b
) Inspection
() Neither
Text orientation
witnessline dizplay
Chamfer style Ordinate Style [ Show ] [ e ] [ Dot ]
[ Move... ] [ Move Text... ] [ Edit Attach... ] Text Symbol...
ok J[ Cancel ]
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> Vytvofime dalsi koty.

p Menu Manager
48. Z nabidky Menu Manageru vyberte Intersect. ATTACH TP
49, Drzte CTRL a oznacte dvé plochy ¢ervené zobrazené na obrézku. halalilacady
50. Pustte tlacitko CTRL a vyberte jednu z ploSek oznaCenych zelené na obrazku. ©n Entity
51. Opét drzte CTRL a oznacte druhou zelenou plosku. o Surfare
52. Potvrdte prostfednim tlacitkem. X’% Midpoint
. Center
i | Inktersect
! Make Line
|
i ’ﬁ_—; f}“a ol Return
% il
E B/ r
i
-6
B2540.5
53. Z nabidky Menu Manageru vyberte moznost Horizontal. ‘\fo
! |
Menu Manager : — -
- = | ’/{‘ij [
w DIM CORIEMT |
Hotizonkal ! /
Wertical I
Slanted @ 5
Parallel ——
Narmal - al {a —
@254+0.5
»  Priddme k nové vytvorené kété 10 zna¢ku priméru d.
54. Poklepejte na kétu 10. H=R A E
55. Kliknéte na zalozku Dimension Text. D w | )
56. Kliknéte na tlagitko [Tes Symbal.. ] —Zal o]
57. Vyberte symbol @ a zavrete dialogové okno. [ =e o) L]
58. Potvrdte o€ ], ® o J[@®&] ¢
o o ®
MEEIESE
59. Dle obrazku dopliite dvé kéty a upravte tolerance.
— —t °l 61“3'3” Eee
-2
] 1
! |
| !
! = w
s e et
|
i |
i

. @6
@10
B25+0.5
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Krok ¢.9 Geometrické tolerance

60.
61.
62.
63.

64.
65.

66.
67.

'y

Kliknéte na tladitko .

Vyberte druh geometrické tolerance souosost: Vard}

Kliknéte na zalozku TolValue a vypliite Overall Tolerance: 0.05.
Kliknéte na zalozku Model Refs.

Kliknéte na [SeetEniy_],

Vyberte plochu ¢ervené oznacenou na obr. dole.
V kolonce To be Placed vyberte moZznost Normal Leader a kliknéte na ([Place Gtol. |,
Nyni vyberte tutéz plochu pro umisténi znacky geometrické tolerance a potvrdtte prostfednim tlacitkem mysi.

Geometric Tolerance

EHE‘ Model Refs |Datum Refs | TolWalue | Symbols | Additional Text | Dependencies gk
Cancel

)= —
Copy From
Reference: Selected Flacement: Placed

Type Surface Type | Mormal Leader vl

0]=] EZEEDN [Feceto] e

x]

STATUS: complete.

Geometric Tolerance

X]

EH E ‘ Model Refs || Datum F!efs| Tal Value |Symhnl& Additional Text | Dependencies
@ Tolerance Y alue
Ovwerall Tolerance I 0.05 l New Gtol

Y =y e p [evu
[] Per Uriit Tolerance |
E Material Condition RS

[no gymbal] A" |

Nl Vilal

STATUS; complete.

| 673
]' - \:;. /7 10.05F
i
]
£ = K

B
@10
PD2540.5

Vkladdénim geom. toleranci timto zplisobem se tyto tolerance promitnou i do modelu sou&asti, zobrazite je v modelu jako

O
poznamku g. Jiny zplsob vkladani geom. toleranci si ukazeme v nékterém z nasledujicich cviceni.
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Krok ¢.10 Drsnosti

»  Znacky drsnosti jsou uloZeny v knihovnach a je proto nutné mit tyto knihovny k dispozici.
68. Kliknéte na ikonu = “ From Palette.

» Otevie se okno s paletou symbold, jednoduchym kliknutim na symbol a kliknutim do vykresu umistite znacku.

69. Kliknéte na znatku =& v paleté a umistéte tuto znacku levym kliknutim na vynaseci ¢aru koty (dle obr.).
70. Systém Vas vyzve k zadani drsnosti, zadejte 6.3.

71. Poté opét levym kliknutim na dalsi vynaseci ¢aru umistéte druhou znacku a zadejte opét 6.3 .

16770
T \”\f's 7~ [0.05
r . f!
a ]
| .
N 2, e |
P 1
R 7 i T

1
— '@“:l -
@205

1

[ |

» Znacku typu drsnosti (Ra, Ry, Rz) zobrazime nasledovné:
72. Poklepejte na znacku drsnosti.

73. V dialogovém okné na zalozce Grouping zaskrtnéte v HODNOTA_DRSNOSTI volbu RA.

Custom Drawing Symbol E|

General | Grouping | % ariable Test .
Presvigw

DRSMOST

[¥] POVRCH

- [¥] HODMOTA_DRSMOSTI
© R
ORZ
O Ry

O BEZ
[ ]SMER_OBRABEN) SR
[ ] UPRAVA_POVRACHU iy ]
C]ro_oBvODU =
[ ] PRID&VEK,_M&_OBRDBENI
o
.

helg 1 LR i ‘:\-_l::‘
DVLN”DST Ibadieig d i 1R 319\/

[ Ok ][ Cancel
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Krok ¢.11 VypInéni razitka

> Razitko, které je k dispozici v CAD ucebnach a které je soucasti tohoto tutorialu je propojené s parametry modelu. Lze jej
editovat bud’ pfimo poklepanim mysi do jednotlivych poli razitka nebo zménou parametrd modelu. Nyni si ukédZeme obé
moznosti editace razitka.

74. Poklepejte do pole CISLO VYKRESU.
75. Zadejte &islo vykresu: ,"J‘> Enter value for CISLO_VYk KKS-CAE 0102

> Cislo vykresu se zobrazi v razitku.

0.000 0
Pocet . : , . C.owykr.
kLSl Mazew - rozmer Polotovar Material konecny/vychozi  [T.odp.| C.hmot.  Hr.hmot. sesiavy Poz.
Duan- . ; . . . Raw )
ity Title - size Blank End material/Material W eight weight Drawing asm. No. |Pos.
Datum JmenosName Datum Hame
kraslil Techno-
) 12-Fen-10 log/ist
Prezk Prezk.
ACHE ALHK
Schval Schval .
sHPR SAPP indexsMa| Schvalil/Appr. popis zmeny/change Datum Podpis/Mame
Methode 1 Poznamka Mote;
VSEOBECNE TOLERANCE 150 80015 150 2768mK
150 128 g GEMERAL TOLERAMWCES 150 BOCO1S 150 2763mK
Soubor-model AASM-File Meritko # Scale | C.sestavy /
PODLOZKA Assembly Mo,
Soubar-vykres/DRW -file i1
PODLOZKA S
CI5L0 YYKRESL ~DRAW ING NO. Format

CAE Nazev - Tifle T
KKS KKS-CAE-01-02 A

lList/sheeT 1 pocet Listys no.sheels I

> Nyni si ukdZeme druhy zplsob editace razitka skrze B Parameters g@g|

parametry moE:IeIu. 0w File Edit Parameters Tools Show
76. V menu Window kliknete na PODLOZKA.PRT. Lok I
77. V menu Tools vyberte Parameters.
. L ) . Part v [C1PODLOZEA v
» Zde jsou zobrazeny parametry, které jsme definovali v
Sabloné. _
78. Zapiste do hodnoty parametru MAT_KON jilteri Ll g
hodnotu 11500.0 MHame Type Walue Designate | Access
v T . &
79. Zapiste do hodnoty parametru CIS_SESTAVY Integer 0 O Egul
hodnotu KKS-CAE-01-00. AUTOR String Bl
C_HMOTNOST Feal Mu..  0.000000 O E'g,'-Full
CISLO_SEST Stiing KKS-CAE-01-00 O E'g,'-Full
CISLO_WYE Sting KKS-CAE-01-02 E'@Full
CSM Stiing E'g,'-Full
HR_HMOTHOST  Shing E'@Full
MAT_KOM Stiing 11500.0 %-Full
MAT WrCH Sting E'g,'-Full ¥
MAZEY Stiing O %-Full
POZNAME Stiing O Beru
PLWVODMI_MAZEY  Sting puvadni nazey O %-Full
ROZMER Stiing E'g,'-Full
TECH_CISLO Stiing O E'g,'-Full
TYP Shing O Beru
T_ODP Sting BoFul
£ »
[+]=] 3
Ol [ Reset ] [ Cancel L
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80. Potvrdte L_0K_J
81. V menu Window kliknéte na PODLOZKA.DRW.
>V razitku mizete vidét vyplnéna poli¢ka hodnotami parametrli modelu.

>  Hrubou hmotnost je nutné ru¢né napoditat z rozmért polotovaru a hustoty materialu.

> Cistd hmotnost modelu je poditdna automaticky, repektive je dana vztahem v relacich c_hmotnost=ceil(mp_mass(""),3)
> Predpokladem pro spravny vypocet Cisté hmotnosti je zadana hustota materialu

> Hustota materidlu se zadava v menu Edit --> Setup -->Mass Props.

Pozor, hustotu je nutné zadavat ve spravnych jednotkach, naptiklad pouzivame-li milimetry a kilogramy je nutno
zaddvat v jednotkach kg/mm?3. Pouzivané jednotky Ize nastavit v menu Edit --> Setup --> Units.

82. Doplitte zbyvajici Udaje do razitka dle obrazku libovolnym zptsobem.

P1 - 600 x 1500 C5N 425301 115000 o0 0.005 0.006 |KKS-CAE-O1-00| 2
Focet . . . . C.owikr.
Kiusu Mdzew - rozmer Poloiowar Material konecnysvychozi |T.odp.| <.hmot.  |Hr.hmaot. sestavy Foz.
[luan- ) ) ) ) ) Eaw )
Fity Title - sife Blank End material Material W eignt weiant Orawing asm. Mo, [Pos.
Oatum JmenaMame Daium Mame
foresLil) Techno-
0w o 12-Feb-10 | HNOVAK Jan log/ist
Prezh. Prezk.
SLHE SLHK
SChwal Schval.
SAPP /AFP indesNo | SchvalilsAppr. QOpis Zmeny change Dalum | Podpis/Name
Methode 1 FoznamhasNote;
YSEOBECNE TOLERAMCE 150 80015 150 2768mK
150 128 £ Ghtbar TOLERANEES 1S5 B 1S3 Zheonn
Saubar- madel ~AEM-File Meritko « Scale | O .=estavy «
PODLDZKA 1 fscembly Mo, KES-CAE-01-00
Soubar-vyhres/DRW -file :
PODLDZKA S
.
Mazey # Title CISL0 WYKRESD <OR&W ING WO. Farmat
CAE PODLOZKA KKS-CAE-01-02 | "
KKS biistsheat 1 poret Lisius no.sheeic 1 L
__ I

_l/ Datum neni vazan na parametr modelu a je tedy tfeba jej zadat do razitka rucné.
<
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| .67

Iy

£7]0.05]

1
|
|
b2l o
. : @, oo
)
. [ !
/ ! g
o %
© >D
o ©
o
o
¢ = =
P1 - 500 x 1500 CSN 425301 11500.0 001 0.005 0.006 |[KKS-CAE-01-00] 2
Focet Nézev - rozmer Polotovar Material konecny/vychoz{ |[T.od C.hmot Hr.hmot €. vikr, Poz
kusu Yoy <00 i . . i sesfavy :
Quﬁ]{]\/_ Title - size Blank End material/Material Weight \Seaiﬁhr Drawing asm. No. |Pos.
Datum Jmeno/Name Datum Name
Kreslil Techno-
DwWN. 12-Feb-10 | NOVAK Jan log/ist
Prezk. Prezk.
/CHK /CHK
Schval Schval.
/APP /APP index/Na| Schvalil/Appr. popis zmeny/change Datum | Podpis/Name
Methode 1 Poznamka/Nofe:
VSEOBECNE TOLERANCE 1S0 800715 1SQ 2768mK
150128 El@ GENERAL TOLERANCES IS0 80015 IS0 2768mK

Soubor-model /ASM-file
Soubor-vykres /DRW -file

PODLOZKA

Meritko / Stale

5:1

C.sesfavy 7/
Assembly No.

KKS-CAE-01-00

KKS

PODLOZKA

KKS-CAE-01-02
lList/sheeT 1 gotef Listu/ no.sheefs 1

PODLOZKA Y
CISL0 VYKRESU ZORAW ING NO
CAE Nazev / Title ’ FS“‘P;EE”

I
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CVICENI X1V

CIL

Tvorba vyrobniho vykresu soucasti kliky sestavy mlynku na maso.

1 2 3 & | 5 ] } 7 [:] ] Q il [ 12
@5 Hr Q/( Ra 3V2/ )
A s A
3.4 o 0 .
s
T 7 (
| B
W . ~
3
s [ U :
i i
1 I [
| |
| | E
i i
TVGRIC PROF I LY
PROF 1 ¥ DRAZKT
. KLTKY |
i i
| |
| ! E
| /M |
|
. ) ‘ [
. T Lo N
5 ? | ] sz r
d
I
D _ D 1l el 1
KLIKA [OOLITEK) C.M. 202070 2 2420.2 o1 0.207  |Q.210 | KKS-CAE-01-00] 3
B ew [ [ ey e vyey R e
i Tine st wa 0 e warr | % (oraenm 3o oe
P . T
% e i [poE]
jage
i | |
i i
Kt e s R DK% 2meny CITGE Dahn | PodITRme
EES
W TOLER AT HOT I TTeA
BT S S
,,,,,,,,,,, O [T = Ay
. 2 =~
— T =
Eg KLIKA (0DLITEK) KKS-CAE-01-01 |5
| e e i S
1 [ z 3 [ [ 5 3 [ 7 ] 9 [ (4 i 1 i

PREDPOKLADY

Znalosti zaklad vytvareni vykresd z predchozich dvou cviceni.

Vymodelovany nebo stazeny model soucasti KLIKA mlynku na maso.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v' Tvorba pohled( v fezech a priirezech
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Krok ¢.1 Otevieni prazdného naformatovaného vykresu

1. Otevrete soucast klika.prt.

2. Kliknéte na N , vyberte Drawing, Name: klika.
3. Déle zvolte Empty with format a po kliknuti na vyberte a2_v1_vyrobak-uni.frm ze seznamu.

e A e B

Sub-type Default Model
Sketch [KLIK& PRT | [ Browss. |
O 0 Par Specify Template
O [0 Assembly () Use template
) ﬂ b anufacturning (%) Empty with format
@ Dirawing O Empty
O [ Fomat Format
O [ Repot |nnne V| [Browse...]
Y - Diagram
O 7] Layout
O @ M arkup
MieTia klila Common Folders 1 brow [:3 a2_vwl_sestava-new.frm m ad_w1_kuzovnik-new. frm
Canimen Mems @In Seszion E;} al_w1_sestava-rew.frm E;] a2_vwl_zestava-uni frm EE ad_w1_kuzovnik-uni frm
mDesktop o a0 v _sestavaunifin 7] a2_w1_wprobak-newfim |3 a4 w1_sestava-new fim
Uz& default template @ My D ; o a0 w1 _wwobak-newfm [0 B2 -.-_l,ln:ul:u.al:_-l_ii_frrn Fd ad_w1_sestava-unifm
v Documents
3 a0 w1 _wwobak-unifm [} a2_zcu_asm.fim ' ad_vl_vwobak-new.frm
% Working Directory .
3 a0 _zcu_asm.fim [ a2_zcu_asm_bom.fim P ad_w1_vyrobak-unifrm
NEtWUTk Meighborhood ' a0 _zcu_asm_bam.fim ' a2_zcu_det.fim ' a4 zcu_asm.frm
Templates ' al_zcu_det.frm [ a3 vwl_sestava-newfm [ 7] ad_zou_asm_bom frm
ﬁKNIHDVNY-STANDAHDS o al vl _sestavanewfm |73 a3 w1_sestava-unifrm Fd ad_zcu_det fim
System Fomats Fd al_wl_sestavaurifim [ a3_v1_vylobak-ne.t-\l.flm
_ g al_wl_wwobak-newfim |3 &3_w1_wprabak-uni frm
User Formats o al_wl_wwobakunifm [} a3_zcu_asm.fim
%Favorites 3 al_zcu_asm.fim [’ a3 _zcu_asm_bom.fim
F' al_zcu_asm_bom fim ' a3_zcu_detfim
' al_zcu_det.frm '3 ad_bom.frm
File name: a2_+1_vprobak-unifrm Date modified: 16-5ep-03 05:34:50 Phd Previgw
File name: | a2_+w1_wyrobak-uni.frm | T}lpe|AII Files [) V|
Falder Tree o I Open 'H Cancel ]

>  PFi otevirani vykresu nas systém vyzve k vyplfiovani parametrd razitka, zatim tyto vyzvy mdZzeme odentrovat.
> Nyni mame otevny prazdny a naformatovany vykres formatu A2.
4. Vykres ulozte do stejné slozky, ve které mate umistén model klika.prt.

T T T T T T T T T T T T T il T




Krok ¢.2 Vytvoreni zékladniho pohledu

5.

6. Kllkvnvete vI_evo v nabidce na Vlev_v Display. Categaries  iew display options

7. Zmeénte Display style na No Hidden. Wiew Type

8. Tangent edges display zmérite na Solid. ‘;'S"ﬂl'e Area Dl sl | (5 No Hidd

, . cale 1Izplay stple o0 Hidden b

9. Potvrd'te provedeni zmén |_#pely_|, Sections
Tangent edges display style ﬂ Solid v
Hidden line remowal for quilts Colors come from

alignment i es (#) The drawing

ORI ) The model
Skeleton model display
(%) Hide wWeldment szection dizplay
) Show

Hidden line remaorval for khatches

IORTT
) Na

ytvofte z3kadni pohled **

10. Potvrd'te vytvoreni pohledu tlacitkem .
>  Nyni vytvorime novy pohled v modelu podlozky.

11.V menu Window kliknéte na KLIKA.PRT.

» Tim se pfepnete do rezimu objemového modelare.

12. Pikazem "* Reorient (Orient by reference) nastavte pohled:
13. Reference 1: vyberte Right a vyberte rovinu DTM1.

14. Reference 2: vyberte Front a vyberte plochu (na obr. Cerveng).
15. Novy pohled uloZte pod nazvem ZAKL_POHLED.

B Orientation @
Tvpe
Options
Reference 1
Right w
DTM1:FEDATUM PLANE]
Reference 2
Frank b
Surf:F22[EXTRUDE_1]
Standard Orientation b
Default Orientation w

Mame | 24kL_POHLED

[ Set ] [Sa\fe] [Delete]

I OF. ] [Eancel] [Undo]
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Krok ¢.3 Zmeéna mefitka vykresu

> Zménime méritko vykresu na 2:1.
> Povsimnéte si v levém dolnim rohu grafického okna textu SCALE:... TYPE:... NAME:... SIZE:... (viz obr. nahofe). Tyto udaje
zobrazuji zékladni informace o vykrese a nékteré z nich (SCALE a SIZE) Ize zménit poklepanim na tento text.
16. Poklepejte na text SCALE. .
17. Piepiste mé&Fitko vykresu na 2(viz obr. dole). 5 Enter value for scals 2
SCALE: 241
Krok ¢.4 Vytvoreni pohledl vykresu
18. Kliknéte pravym tlacitkem na pohled a z nabidky vyberte Insert Projection View...
19. Kliknéte pod zakladni pohled pro umisténi nového pohledu (viz obr. vpravo).

————————— — Pick Frarn Lisk

Mext
Prewvious

Delete
Show Dirmensions
Wiew Info

Insert Projection Yiew. .,

lsr Mgl in Trer

20.

21

22.

23.
24.

25.

.V dialogu Drawing View kliknéte vlevo

Poklepejte na promitnuty pohled.

v nabidce na View Display.
Zménte Display style na Hidden.

Potvrd'te provedeni zmén .

Na zaloZce View Type pojmenujte

pohled: TOP. B
Potvrd'te [L_OK_1, !

-
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26. Kliknéte pravym tlacitkem na pohled a z nabidky vyberte Insert Projection View...

27. Kliknéte vpravo od zakladniho pohledu pro umisténi nového pohledu. Pojmenujte pohled LEFT_1.
28. Tento postup zopakujte jesté jednou (dostanete rozloZeni jako na obr.). Pojmenuj te pohled LEFT_2.

1 ] A I I & i T I ] I ] 0 11 i+ |
i L3
i— Y
i i !
i | ]
| i
13 i i i
i !
1 i i 1
i I
¥ i i ¥
Ak ; i
] N = ]
i I
i i
] i i 0
i i
I B-B | LT
| |
E ! ! E
| !
i I
1 | | 1
|
F F
5 —_— = e - T [—] i ““II-M-’ lgl ; | — ] élﬁ
—1 [ 1 LI 1] =]
] =
I ‘—|——’ b, | I == |
[T e
i == ol l—EEl Iy
CAE I |Er'
. KKS R s
1 1 4 I T 5 I £ 1 k I ] I T 2 g 1 1 i
29. Poklepejte na jeden z nové promitnutych pohledd.
30. V dialogu Drawing View kliknéte vlevo v nabidce na View ’l_ﬁ o T—D
Display. Y N

31. Zménte Display style na Wireframe .
32. Zmériite Tangent edges display style na None.

33. Potvrd'te provedeni zmén .

34. TotézZ proved'te pro druhy promitnuty pohled.
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35. Pfepnéte se do rezimu objemového modelare.
36. Vytvorte rovinu ROVINA_REZU_A kolmou na rovinu DTM2 a prochazejici osou OSA_1 (viz obr.).
37. Presurite ve stromé rovinu ROVINA_REZU_A za rovinu DTM2.

Flacement | Display || F'mpertiesl

References
DTH2F11{DATUM P, Momal
A_2F10[DATUM &xI5) Through

F7 DT

7 HORMI

Faz
DTMZ, =

w x PHTD"

/'\ Dbejte na to, aby normaly vytvarenych rovin (oznaceny zlutou Sipkou) mély stejny smér jako na obrazcich. Smér
. normalv zménite klepnutim na zlutou Sioku. nebo na zalozce Displav kliknutim na tlacitko .

38. Vytvorte rovinu ROVINA_REZU_B kolmou na rovinu DTM1 a prochazejici osou OSA_Z (viz obr.).
39. Presurite ve stromé rovinu ROVINA_REZU_B za rovinu ROVINA_REZU_A.

= DATUM PLANE 3

Placement |Displa_l,l || Prnpertie&l

References
DTMT:FSDATUM PL... Mormal
0Sa_Z:F7DATUM A Through

DTM1

Foosat
7 DTz

ROWINA REZL_A
o PNTD &

S 0sa_z

40. Prikazem g Reorient (Orient by reference) nastavte pohled
41. Reference 1: vyberte Front a vyberte rovinu ROVINA_REZU_A.
42, Reference 2: vyberte Top a vyberte plochu (na obr. Cervené).
43. Novy pohled uloZte pod nazvem REZ_A.

— | e—— |
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44, Vytvorte fez A (:2), ktery bude definovan rovinou ROVINA_REZU_A (viz obr.).
ROVINA REZU_A

45. Prikazem * Reorient (Orient by reference) nastavte pohled
46. Reference 1: vyberte Front a vyberte rovinu ROVINA_REZU_B.
47. Reference 2: vyberte Top a vyberte plochu (na obr. Cervené).
48. Novy pohled ulozte pod ndzvem REZ_B .

50. Prikazem ‘* Reorient (Orient by reference) nastavte pohled
51. Reference 1: vyberte Front a vyberte rovinu DTM1.

52. Reference 2: vyberte Top a vyberte plochu (na obr. Cervené).
53. Novy pohled ulozte pod ndzvem REZ_D .
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54. Vytvorte fez D (E‘E' ), ktery bude definovan rovinou DTM1 (viz obr.).

55. Pfepnéte se zpét do rezimu vykresu.

56. Vytvorte novy pohled il |

57.V kolonce Model view names vyberte pohled REZ_A a kliknéte na ,
58. Na zalozce View Display zmérite Display style na No Hidden a Tangent edges display style na None.

59. Potvrd'te provedeni zmén .

- —

60. Na zalozce Sections zvolte volbu 2D cross-section.

61. Kliknéte na .

62.V kolonce Name vyberte fez A.
63. Potvrd'te [_2enl .
i—/

>  Tim jsme vytvofili fez jednim koncem kliky.
A-A

> Nyni vytvofime Castecny pohled fezu A.

64. Na zaloZce Visible Area zvolte View visibility: Partial View.

65. Vyberte bod (viz obr. vlevo).

66. Nyni kolem tohoto bodu levym tlacitkem oklikejte oval (viz obr. vpravo).

67. Potvrdte vﬁoFem’ ovalu prostfednim tlacitkem.
68. Potvrdte .

> Tim jsme vytvorili ¢asteCny pohled (Partial View) fezu A-A (viz obr. dole).

A-A

A=A
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69. Vytvorte novy pohled sl |

70. V kolonce Model view names vyberte pohled REZ_B a kliknéte na ,
71. Na zaloZce View Display zmérite Display style na No Hidden a Tangent edges display style na None.

72, Potvrd'te provedeni zmén .

= —

73. Na zalozce Sections zvolte volbu 2D cross-section.
74. Kliknéte na .

75.V kolonce Name vyberte ez B.
76. Potvrd'te [feo .

> Tim jsme vytvorili fez jednim koncem kliky.

B-B

77. Na zalozce Visible Area zvolte View visibility: Partial View.
78. Vyberte bod (viz obr. vievo).
79. Nyni kolem tohoto bodu levym tlacitkem oklikejte oval (viz obr. vpravo).

80. Potvrdte vﬁoFem’ ovalu prostrednim tlacitkem.
81. Potvrdte .

> Tim jsme vytvorili ¢aste¢ny pohled (Partial View) fezu B-B (viz obr. dole).

B-B @

B-B

82. Vytvorte promitnuty pohled pohledu ZAKLADNI a umistéte jej vpravo od pohledu ZAKLADNI.
83. Pohled nazvéte REZ_D.
84. Na zalozce View Display zménte Display style na No Hidden a Tangent edges display style na None.

85. Potvrd'te provedeni zmén .

86. Na zalozce Sections zvolte volbu 2D cross-section. - e

87. Kliknéte na .

88. V kolonce Name vyberte fez D.
89. Potvrd'te a h

L

U-D
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5]
90. Vypnéte zdmek pohybu pohledd =~ ..
91, Presunte pohledy na vykrese do stavu jako na obr.

- o 2] RS o
i — = e - s B e A C T 1 70 L
(— (] T 1 [l =1 ] =]
o ] | s | —_ o]
z = O
— - -
l | I 1 i 1 [ [
| | —
e —
g = [ I e I
CAE |/ | =
. KKS P—
T T T 1 T T T = T £ I T T E T [] T 0 T il —T

>  Vytvorime priiez v bodé PNT1.
92, Piepnéte se do objemového modelare.
93. Vytvorte rovinu ROVINA_PRUREZU_C kolmou na krivku KRIVKA_1 v bodé PNT1.

94, Presunte tuto rovinu ve stromé pod prvek KRIVKA_1.
= DATUM PLANE 3

Flacement | Display | Properties

References
Curve:F13[CLIRWE) Mormal
PHT1:F18[DATUM P... Through

s 0583

X PNTL

A KRIVES 1 oo
| e, I N

L.

SKICA_1
SKICA 2
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95, Vytvorte fez definovany rovinou ROVINA_PRUREZU_C.

P

a3 S

ROVINA_PRUREZU_C

96. Prikazem “* Reorient (Orient by reference) nastavte pohled.

97. Reference 1: vyberte Front a vyberte rovinu ROVINA_PRUREZU_C.
98. Reference 2: vyberte Bottom a vyberte rovinu PUDORYS.

99, Novy pohled ulozte pod nazvem PRUREZ_C.

100. Prepnéte se do rezimu tvorby vykresu.

101. V menu Insert --> Drawing View vyberte pfikaz Revolved...
102. Vyberte pohled ZAKLADNI.

103. Kliknéte levym tlacitkem pro umisténi pohledu.

104. V nabidce Cross-section vyberte C.

105. Potvrdte a [ Cose |,

Drawing View

Categories
Wiew Tope
Visible duea | Wiew name |revalved 22

Wiew type

Scale Type

Wiew States Revolved wiew properties

Crigin

Aligrment Alignment reference | S elect item |

[ 0k l [ Eancel] [ Apply ]
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106. Prepnéte se do rezimu objemového modelare.
107. Zkontrolujte ve stromé&, zdali nejsou skryté prvky: KRIVKA_1, SKICA_1, SKICA_2, SKICA_3 a SKICA_4.
108. Paklize mate nékteré z téchto skic skryté zobrazte je pfikazem Unhide (ve stromé).

109. Prepnéte se zpét do rezimu vykresu. /TN - ﬁZ)

110. Kliknéte na ikonku = Use v bo¢ni nastrojové liété. N
111. Drzte CTRL a oklikejte vSechny kfivky na obrazku zobrazené Cervené.

112. Potvrdte

113. Poklepejte na jeden z nové promitnutych pohledd. D
114. V dialogu Drawing View kliknéte vlevo v nabidce na View [ [ @ @
Display.

115. Zménte Display style na No Hidden .
116. Potvrd'te provedeni zmén [ox ],
117. Totéz provedte pro druhy promitnuty pohled.

» Timto postupem jsme dostali do vykresu plvodni skici, které nyni
mdZeme okétovat.
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118. Poklepejte na pohled ZAKLADNI.
119. V dialogu Drawing View kliknéte vlevo v nabidce na View Display.
120. Zménte Display style na Wireframe .

121. Potvrd'te provedeni zmén ok J.
122. Pfikazem Y Use promitnéte kfivku KRIVKA_1 z modelu do vykresu (¢ervené na obrazku).

123. Poklepejte na pohled ZAKLADNI.

124. V dialogu Drawing View kliknéte vlevo v nabidce na View Display.

125. Zmérte Display style na No Hidden.

126. Potvrd'te provedeni zmén

127. Poklepejte na promitnutou kfivku KRIVKA_1 a zméite styl ¢ary dle obr. vpravo.

Modify Line Style X

Copy From

Style centerling w
Draving
Attributes

Lire Font | CTRLFONT w
Width

Color @

tdodel Edge Dptions

[ Apply ] [ Cancel ] [ Feset ]
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128. Prepnéte se do rezimu objemového modelare.
129. Skryjte skici SKICA_1, SKICA_2, SKICA_3, SKICA_4 a kfivku KRIVKA_1.
» Tyto pomocné prvky je potfeba skryt, aby se nezobrazovaly ve vykrese.

> Nejlépe vloZte vSechny tyto prvky do jedné vrstvy (layer) a tu potom skryjte.
130. Prepnéte se zpét do rezimu vykresu.

w Skryvani pomocné geometrie pomoci vrstev viz 6.cviceni (Snek) krok ¢.9

Krok ¢.5 Promitnuti os do vykresu

>  Nyni promitneme osy z modelu do vykresu.
0w . v

131. Kliknete na ikonu + Show and Erase.

> Objevi se okno Show/Erase.

132. Vyberte promitani os ~~*', nastavte Show By: View.
133. Kliknéte na pohled ZAKLADNI.

» Zobrazi se vSechny osy modelu zobrazené v tomto pohledu.

>  Zkontrolujte, zdali je aktivni tlacitko , coZ znamena, ze vybrané osy budou
promitnuty z modelu do tohoto pohledu..

134. Vyberte osy zobrazené Cervené na obrazku vievo.
135. Kliknéte na

Show [ Erase g|

Type

Show By

Optionz | Preview

[ Sel to Keep ][ Accept Al ]

[ Sel to Remove ] [ Eraze All ]




136.
137.
138.

139.

Nyni pro urychleni nastavte Show By: View.
Kliknéte do jakéhokoliv pohledu.

Vyberte osy zobrazené na obrazku Cervené.
Potvrdte

)

B-B
[m]
B QL
D-D 3
),_a_x ,-;taj
53, |
WIS — |
140. Natocte a protahnéte osy dle obrazku.

Nataceni os viz 11.cviceni (vykres sitka)

Kliknéte pravym tlacitkem na fez A-A.

Z kontextové nabidky vyberte Add Arrows.
Vyberte pohled zakladni.

Totéz proved'te u fezu B-B a D-D.

Upravte vytvorené Sipky fezu dle obr.
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Krok ¢.6 Srafovani

» Vytvofime Srafovani u skic v pohledech LEFT_1 a LEFT_2.

146. Vyberte jednu ze skic (sklada se ze dvou polovin, drzte CTRL a vyberte obé).
147. Kliknéte na skicu pravym tlacitkem a z nabidky vyberte Hatch/Fill.

148. Zadejte nazev fezu napt.: SRAF1.

149. Totéz provedte pro ostatni ti skici (zadavejte libovolné nazvy rezd).

-0 "
[exk
Previous
Pick From Lisk
Cuk

] Copy
Delete Dl
Edge Display. ..

Line Skyle

0 A L
Hooo e | |

\/

N

150. Upravte véechna Srafovani tak, aby jejich hustota a sklon Srafovani byly stejné. Uhel (Angle) 45° a vzdalenost
mezi Srafy (Spacing) 2.
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Krok ¢.7 Kotovani

151. Nyni okdtujte vykres dle obrazkd.
152. Nejprve prikazem e promitnéte vyuzitelné kéty.
153. Poté rucné dokotujte zbytek dle obrazkd -

. B5HI 0

>

]
-

Z

=

N
1
N

| %45

%/
% =

;s

Toleranci H7 nastavite tak, ze v dialogu Dimension Properties nastavite Tolerance table na Hole a v Table name

urcite toleranci HZ7.

XIV-17




3.4

> Nepotiebné kéty mizete skryt pravym tlacitkem a volbou pfikazu Erase.

85,1

» . Rozdil mezi prfikazem Erase a prikazem Delete je v tom, Ze pfi pouziti pfikazu Erase se objekt neodstrani, pouze neni

ey vy . . M L . -
videt, nicméné v pripade potreby Ize jednoduse zobrazit pfikazem * . Show and Erase, ktery si popiSseme pozdé€ji.

9 5
. - . —...___.__Q\\
/
f N e |
- ' i -
__ _ _ !
= !
| .
< i -
pel !
N o | |
. \ ‘?\1/) : >
! 59 {)\__\ ! 59 4
T | — e ||

\,,:(' Kotovani soucasti je podrobné popsano v predchozich dvou cvicenich.
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> Jedté si ukdzeme jakym zplsobem Ize u két zménit Sipka na tecku (viz obr. vpravo).
154. Vyberte kotu a presunte kurzor k horni Sipce, kterou chceme zménit.
»  Kurzor zméni tvar (viz obr. vlevo).
155. Podrzte pravé tlacitko mysi a z menu vyberte Arrow Style...
V nabidkovém menu vyberte moznost Filled Dot a potvrdte.

Default
Arrowhead
= Dot

Filled Dok

0

|

I

I

I

Double Arrow I
Slash !
I

I

|

t

|

@

Integral

J B
Fill=d Box

Mone

ol o

M

Target
Done/Return

Krok ¢.8 Drsnosti

156. Vlozte do vykresu znacky drsnosti dle obrazkd.

P50, |

k45 ||
A-A N
/// i
I B I R :
iof Ra 3.7 7&“
7%

w Vkladani znacek drsnosti je podrobné popsano v predchozich dvou cvicenich.

XIV-19




Krok ¢.8 Poznamky vykresu

157.
158.
159.
160.
161.
162.
163.

Spustte piikaz * Note.

V Menu Manageru vyberte With Leader.

Drzte CTRL a vyberte dvé krivky ¢ervené zobrazené na obrazku vlevo.
Potvrdte a zadejte text poznamky: TVORICI PROFILY KRIVKY.
Potvrdte a vytvorte dalSi poznamku stejnym postupem dle obrazku vpravo.

Zadejte text druhé poznamky: PROFILY DRAZKY.
Potvrd'te a ukoncete prikaz Note kliknutim na Done/Return.
—
/) |
. :
TVORICI FROFILY
FROFILY DRATKY
KLIKY
i
\Qj
1
LN
I )
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Krok ¢.9 VypInéni razitka
164. Vyplite razitko dle obrazku.
KLIKA (OOLITEK) C.M, 202010 L2 2670.2 001 0,145 0.210 | KK5-CAE-01-00] 3
Pocei ; . . : [T
kisu Nazew - rozmer Palofovar Material kanecnysyychezi o |T.odp. |  C.hmat.  [He.nmat. cecfary Poz.
Luan- . . . Raw
fiiy Title - siTe Elanki End malerial Material W eight weinht Orawing asm. Mo, |Fos.
Datum Jmenoshame Datum Hame
I resLil Techro-
D, 16-Feb-10 | MOVAK Jan logvist
Prezk, Prezk.
#LHE SLHK
Schval Schval.
shPP SAPF indau #No | Schealil ~&ppr. popis zmenychange Daium Padpis.sNama
Methada 1 FoznamkaMate;
YSEOBECNE TOLERANCE 150 B0oMs 150 27e8mk
150 128 3G {erpmn ORI e 190 o 190 2
Soubor-model #A5M-Fil 551 i
oubor -model rASH-File KLIKa | Beree < Stee | e b KKS-CAE-01-00
Soubor-wykres DARW - File 211
KL KA ;];‘;’
Mazev ¢ Title CIEL0 YYKRESU <DRAW ING MO, FSD:-;-,Ear

CAE
KKS

KLIKA (ODLITEK)

KKS-CAE-01-03

List sheai 1 pocel lislus no.cheafs 1

/
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CVICENI XV

CIL

Tvorba vyrobniho vykresu soucasti Sroubu sestavy mlynku na maso.

1 2 k] [ [ 5 ] T 8 g
2
A
B
o @
=
9.2
C
45 5 42 o
Y P
LY
0 . b
L R
E Bl.5 SLISOYANC
" NEKOTOVANE POLOMERY RO.5
| R 12 SSN d23510.12 Il 3130 A0 o.08% (&1 BHS-CAE-01-0k| 4
PRI MONTRZ| ROZNYTOWAT Freed Nizes - razmer Polotorar Watsrial kenesiyivgeioct [Tuodp | € imet, fir hoot{ %, M- lpor,
fasn Title - size Blant End material/Naterial Weight |70 [oraring aam. Ho Jpas,
F Datun | menadbiane | Oatun hane
whilai-Fan- 10| novan oo |JEITE
chedl] Sl
MAXIMALNT NYTQWACT SILA 100N AIE PR 1 1hpar. pop /1 ZmeaTchange Datun [ FodelaiHme
[ Nottoda 1 Prmamka ot
S RIS S
Suter-nalelAi-flle SROUB_NEROZTEPANY | Mt  Sale | Ceevia f KE&-CAE-DI -0
G Soutior-vires IFW-Tile SROLR M "
CAF Haoer 7 Title - e
KKS SRCUB KKS-CAE-0Q1-04
1 bl 3
1 P 3 & 5 [ & I 7 -
PREDPOKLADY

¢ Vymodelovany nebo stazeny model soucasti SROUBU mlynku na maso.
e Znalosti zaklad@ vytvareni vykrest z pfedchozich dvou cviCeni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v’ Prepisovani két
v’ Vytvareni poznamek vykresu
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Krok ¢.1 Otevieni prazdného naformatovaného vykresu

1. Ovt_eVFetve squcast sroub.prt. _ & Select Instance § ]
2. Pri vybéru instance vyberte SROUB_NEROZTEPANY (viz obr.). —
Y i . BuMame | By Parameter
3. Kliknéte na , vyberte Drawing, Name: sroub. The qenei
, . . , gernernc
4. Déle zvolte Empty with format a po kliknuti na vyberte SROUE_ROZTERANY
a3_v1_vyrobak-uni.frm ze seznamu. B CE A B Bl i
Instance | SROUE_MERODZTERANY
Krok ¢.2 Vytvoreni zakladniho pohledu
v P ’ #h g .
5. Vytvorte zakladni pohled ™ . Drawing View (x]
6. Kllkvnvete vI_evo v nabidce na Vlev_v Display. Calegories  \ieyw display options
7. Zmeénte Display style na No Hidden. View Type
8. Tangent edges display zménte na Solid. \SfiSitl'le Hiea =
" , v cale Dizplay style Hidden ~
9. Potvrd'te provedeni zmén |_Apely |, Sections
ew Stats Tangent edges display style ﬂ Mone w
View Display
Origin Hidden line removal for quilts Colors come fram
Alignment ) es (%) The drawing
= Mo ) The model
Skeleton model display
(3 Hide Weldment xzection dizplay
) Show
Hidden line remonal for shatches
(%) Yes
3 Na
[ Ok [ Eancel] [ Apply ]

10. Kliknéte na zaloZku View Type.

11. Pohled nazvéte: ZAKLADNI.

12. VyuZijte predvytvorenych pohledd (NARYS, BOKORYS,..) nebo vytvorte v rezZimu modelafe novy pohled a
zorientujte pohled ZAKLADNI dle obrazku.

13. Potvrd'te tladitkem (2],

il

>
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14. Na zalozce View Type kliknéte na Angles.

15. Zadejte 90° a potvrdte .
16. Tento postup zopakuijte, dokud nedostanete pozici jako na obr. vpravo.

i

:>C \/

17. Promitnéte kfivku zobrazenou na obrazku ¢ervené pomoci piikazu = . (obr. vievo).

18. U pohledu ZAKLADNI zmérite Display style na No Hidden.

> Tim jsme docilili zobrazeni pomocné skici v zakladnim pohledu bez zobrazeni dalsich skrytych hran. Tuto skicu budeme
vyuzivat ke koétovani.

Krok ¢.3 Vytvoreni pohled@ vykresu

19. Kliknéte pravym tlacitkem na pohled ZAKLADNI a z nabidky vyberte Insert Projection View...
20. Kliknéte pod zakladni pohled pro umisténi prvniho promitnutého pohledu.

21. Tento pohled nazvéte PRAVY.,
22, Kliknéte pravym tlacitkem na pohled ZAKLADNI a z nabidky vyberte Insert Projection View...

23. Kliknéte vpravo od zakladniho pohledu pro umisténi druného promitnutého pohledu.

24. Tento pohled nazvéte DOLNI.

> Rozlozeni by mélo vypadat jako na obrazku.

[ ]
©
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25. Promitnéte kfivku zobrazenou na obréazku ¢ervené pomoci piikazu Y .

26. Zménte Display style na No Hidden a Tangent edges display style na None.
27. Potvrd'te provedeni zmén
28. Totéz provedte u pohledu DOLNI.

-
(CHID

C

] ( D,

Krok ¢.4 Promitnuti pomocnych skic

29. Kliknéte pravym tlacitkem na pohled ZAKLADNI a z nabidky vyberte Insert Projection View...
30. Kliknéte pod zakladni pohled pro umisténi prvniho promitnutého pohledu.

31. Tento pohled nazvéte PRAVY.,

32. Kliknéte pravym tlacitkem na pohled ZAKLADNI a z nabidky vyberte Insert Projection View...
33. Kliknéte vpravo od zakladniho pohledu pro umisténi druhého promitnutého pohledu.

34. Tento pohled nazvéte DOLNI.

> Rozlozeni by mélo vypadat jako na obrazku.

A

Krok ¢.5 Vytvoreni fezd a prirezl

35. Piepnéte se do rezimu objemového modelare.
36. Vytvorte rovinu ROVINA_REZU_A ve vzdalenosti 20mm od roviny HORNI.
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37. Vytvorte fez A ("2 ), ktery bude definovan rovinou ROVINA_REZU_A (viz obr.).

g

ROVINA_REZU A

MNARYS

40. Prepnéte se zpét do rezimu vykresu.
41. Poklepejte na text SCALE.
42, Zménte méfitko vykresu na 2:1.

» Enter value for zzale 2

SCALE: 24
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43, Usporadejte pohledy na vykrese dle obr.

z [ 1 L S ) 7 3 ]
A /_\
P
! Ly
=
4
il
E
H TN ool
et [T Fetptorar | Walariol buetcy i | floom.
-
£ G o W
AR
e e
"or i
ey im
e e TR FTTRTTSTTT [T PP
| Hunae 4 Paznarhacmii:
s 2 RIS A Sl
e rodal 458 1 T e
3 Soutaor-pprm k- e s | &
e 5 ing [T VPR D, Forran
CAE pif
KKS SROUB KNS CAE-01-04 3
st 1 peon vt mareme 1
1 B 3 & 5 [ [ 7 2 I

44.V nabidce Insert --> Drawing View spust'te piikaz Revolved...
45, Dvakrat kliknéte na pohled zakladni. Tim umistite prifez (viz obr.).

46. Kliknéte pravym tlacitkem na vytvoreny priifez a vyberte Properties.
47. Kliknéte na Visible Area, zvolte View visibility na Partial View.
48, Orezte pohled tak, aby zbyla pouze elipsa vpravo (viz obr.).

w Podrobnéji o vytvareni ¢aste¢ného pohledu viz cvi¢eni ¢.14 v kroku ¢.4.
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49, Presunte prirez tak, aby lezel uvniti pohledu ZAKLADNI dle obrazku.

—

50. Poklepejte na pohled PRAVY.

51. Zobrazte tento pohled v fezu A (V zalozce Sections vyberte 2D cross-section a zvolte fez A).
52. Pridejte do pohledu ZAKLADNI Sipky fezu A (pfikaz Add Arrows) viz obr. vievo.

|

&N

53. Vytvorte Castecny fez C dle obrazkd.

Drawing View

Categaries Section options

iew Type ) No section

g:;hlle Area (%) 2D cross-section

Sections

iew Stte3 () Single part surface
Wiew Dizplay
Crigin E Model edge visibility
Alignment
t ame Sectioned Area R eference
C | Local + | Edge:F21[ROUMD_T1)
<

w Podrobnéji o vytvareni ¢astecného fezu viz cviceni ¢.14 v kroku ¢.4.
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54, Upravte Srafovani u fezu i priifezu tak, aby bylo stejné. (viz obr.).
55. Uzamknéte pohyb pohled{ ikonou =2,

_"‘-\\l
,/’

T
=]
A
N
': - C .'ﬂ'. B ."i.
Krok ¢.6 Promitnuti os do vykresu

56. Promitnéte osy dle obrazku prikazem . /EH\

H
=
N

|

|

|

|

|

!
w Podrobnéji promiténi os do vykresu ve 12.cvigeni (sitko) krok &.6 W

Krok ¢.7 Kotovani

57. Nyni okétujte vykres dle obrazkad. /T\

58. Nejprve piikazem X promitnéte vyuzitelné kéty. :

59. Poté rucné dokdtujte zbytek dle obrazkd pfikazem =, i
|

1,040, ¢

4 ™
e e oy

Bl 3 35,63
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3 ——
o i
B | ! ]
s o L ol

i

—— g

A a

45 5 4?2

W Kdtovani soucasti je podrobné popsano ve cvienich 12 a 13.

> PrepiSeme Cervené zobrazenou kotu na text SLISOVANO.

60. Poklepejte na Cervené zobrazenou kétu (35.63).

61. Piepiste text na zalozce Dimension Text na
@0 SLISOVANO.

> operand @0 umoznuje manualni prepsani kéty, bez
tohoto operandu nds systém nenechd prepsat
hodnotu koty.

Dimension Properties

Properties | Dimension Text | Test Style

@0 SLISOVAND

Mame |adl?73
Frefix

Postfix

Maove... ] [ fdorve Teut... ] [ Edit Attach... ][

Orient...

] [ Teut Sumbol... ]

]S

I

Cancel

|

5. &3

SLISOVAND
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> Nyni potfebujeme vytvorit Uhlovou kétu v mistech oznacenych na obrazku.

1.5£0.2

)

e & )

- Bl.5 —l aL | SOVARD

62. Spust'te prikaz ™ Line.
63. Kliknéte na , vyberte k¥ivku (viz obr. vlevo) a potvrdte Lo ],
64. vytvorte Usecku propojenim prvniho a posledniho bodu vybrané krivky (viz obr. vpravo).

65. Nyni jiz mlZeme vytvorit Uhlovou kétu dle obr.

Krok ¢.8 Pridani jiného modelu do vykresu

> Tento vykres vyuziva zdrojl z modelu SROUB z jeho instance SROUB_NEROZTEPANY. w FILE PRO
>  Systém ProEngineer véak umoziiuje na vykresu vedle sebe mit pohledy z vice modeld.
> Nyni si ukdZeme jakym zptsobem Ize do vykresu pridat pohled z modelu SROUB_ROZTEPANY.

Crawing Models

66. Kliknéte pravym tlacitkem v prazdném mist& vykresu a z kontextového menu vyberte Drawing Cptiens

Properties. Tolerance Standard
67.V Menu manageru vyberte Drawing Models a poté Add Model. Done/Return
68. Vyberte v dialogu model SROUB.PRT. w Wi MODELS

69. V nabidce Select Instance vyberte SROUB_ROZTEPANY.

70. Potvrdte Done/Return. m
Dl Model

Set/add Rep
Replace
Model Disp
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71. Vytvorte hlavni pohled L1 |

72. Kliknéte vlevo v nabidce na View Display.

73. Zméiite Display style na No Hidden a Tangent edges display zmérite na None.
74. Pohled zorientujte dle obrazku.

75. Vyuzijte stavajici fez nebo vytvorte novy.
76. Nastavte tento pohled jako ¢astecny pohled (viz obr.).

Krok ¢.9 Vykresové poznamky

77. Spustte piikaz *~ Note.

78. V Menu Manageru vyberte With Leader.

79. Potvrdte a vyberte hranu Cervené zobrazenou na obrazku.
80. Text poznamky: PRI MONTAZI ROZNYTOVAT.

’:__ ___________________________________ 1 e _

PRI MONTAZD ROGINYTOVAT

vz Wz

81. V Menu Manageru vyberte No Leader.
82. Potvrdte a kliknéte do prostoru pod ¢aste¢nym fezem pro umisténi poznamky.
83. Text poznamky: MAXIMALNI NYTOVACI SILA 1000N.

|24

MAX IMALMIT NYTOYACT SILA TO0ON
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84.

V Menu Manageru vyberte No Leader.

85. Potvrdte a kliknéte do prostoru nad razitkem pro umisténi poznamky.
86. Text poznamky: NEKOTOVANE POLOMERY RO0.5.
p’ y NERDTOVANE POLOMERY EO.3
87. Potvrdte a Done/Return.
TR aol] 0asg |
Wateriol ketecnpfvfchagil.odp.| © hmet,  Hi.hmed C”:f:“ Fo
End materiol fMaterin] e ghd bf?:hi Didaing asm. No |[Pes.
Krok ¢.9 Razitko vykresu
88. Vyplite razitko dle obrazku.
KR 12 CSN 42551012 [ 373.0 G0l 0.089 0.1 KKS-CAE-01-00] 4
Pocet Nazey - rozmsr Palotavar Material konecnyfeyehozi [T.od < ohmot Hr. hmaot C. vjkr. Poz
kusuy pivy - 0dp. : - : ! sesiavy
Q:??y Title - size Blank End maderial /Material Weighd WE?EM Drawing asm. No.|[Pes
Datum Imeng /Name Datum Hame
reslil] Techno-
/DWN_E‘I-Feb-ID NOVAK Jan logrist
Prazk, Prazk.
ACHK JUHK
Schwal Sthyal.
/APP /APP indessMoSchvalilfdppr. pepii Tmenylchange Datum [ FodpisfName
Methode 1 Poznamka-Note:
YSEOBECME TOLERAMCE 150 80015 150 2748mK
150128 €7HG)  LEnceaL TOLCRAMCES 190 B00% 190 236tmk
Soubor-model #ASM-file SROUB _NERQITEPANTY | Meritko # Scale | C.sestavy # KES-CAE-D1-00

Soubor-vykresORW -file

SROUB

21

Agsembly Ho.

- Avp
- Aypt

CAE
KKS

Mazev / Title

SROUB

List sheet 1

CISLO VYRRESU LRAW IHG HO,

KKS-CAE-01-04

pocet listus no.sheets 1

Format
S1ZE

3
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CVICENI XVI

CIL

Samostatné vytvoreni dvou jednoduchych soucasti OSICKA a TYCKA sestavy mlynku na maso.

Ra 6.3/ Ra 1.6/
\V/ v o) Rus.S/( Ra L6/ )
25+ 1
Q|
- I8
)
kS
Ra 1.6 w
o
0.3:45" b 343"
0.5:45° |l o
886
KR 2.5 - 30 LEN 52657012 11373 BOT | 0007 | 0.001 KES-CRE-D1-00| &
Pocet Wizey - rozmer Folotavar Watarial kunecnyevichoz | [Todp.| ot ebmot. | SouBn oo
P Title - sice Blak End materialNaterial weight | 2% |0rawing a6n. Ko [pos.
Danm_ | marm/ibm | natn nane
Freetil g yov—aw | st an | e
. -1at
Prack; WE!:.
/TH JCHE
5| N
"APP ‘-’M‘F Imder | Schudl ILkgpr awle 2nenythange Dahm_| Pusplethne
Hathuds 1 Pamamkatofa:
o e TR S
DSICKA 5\'1'1‘, Soubor- nodelrA-file TYIKA Hu'i“m 4 Sole Esgﬁ‘\;{’é KNS-[AE-1-00
e osicka | & Seulor-tres TN -l . =
ST INB D " - Farnat
KKS OSICKA KKS-CAE-01-05 , KKS TYCKA KKS-CAE-01-06 A

PREDPOKLADY

¢ Vymodelovany nebo stazeny model soucasti OSICKA a TYCKA mlynku na maso.
e Znalosti zaklad( vytvareni vykrest z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Broken View (pferuseny pohled)

XVI-1




Krok ¢.1 Vytvoreni vykresu osicky

»

NhWNK

JelikoZ jsou vykresy v tomto cviéeni velmi jednoduché a v&echny potfebné znalosti pro vytvoreni té&chto vykrest byly

probrany v predchozich cvi¢enich, nebude v tomto cvi¢eni popsan postup k vytvoreni téchto vykrest, pouze zde bude uveden
rdmcovy postup a kone¢na podoba obou vykresu.

Oteviete soucast OSICKA.PRT.

Vytvorte novy vykres OSICKA.DRW formatu A4.
Vlozte a zorientujte zakladni pohled.

Promitnéte osu soucasti a nékteré koty.

Doplnte koty a znacky drsnosti a vyplite razitko.

F!e:lE.E‘.f( Ra | B/ )
7 0.2x45" o
% -~
W Ra |.6 L=
1 Z’ 1
il
] ]
b 23 0.5345" _ ||
KR 12 csn 42 591092 M 3730 om 0.915 0.02 KRS-CAE-91-09 | 5
Tu;; Hémy - rozmer Polatovar Material kanecnwyichezl |T.wdp.| <.hmet.  Hre-hmet- Cafgy:vr,; [y=-8
n'ﬁ{',l,_ Title - sice Blanh End material-Material ‘W eight w?l'.:hi Orawing zsn. Hu. (Pos-
Darum Jmenosthng Oatun Nane
okl ao-ranan | aovaw san [JeETR-
] s
bl Tl
AR il Inder Ak ] Sctwdl IL-Agnr pm e zney chage Dahn_| Podpletene
Hethoda 1 Prenarkatobe
s 3 IR S
S ol A-file (]S Eﬂ‘jlﬁ” Scale | Loewlav e KKS-CAE-ML00
Loubar-dres RW-flle msicks < -
CAE Mo 7 TIHe FF?I?EET
KKS DSICKA L
HKVA=2




jeden jejich rozmér vyrazné vétsi, nez ostatni.

Drawing View

6. Poklepejte na pohled, aby se vam zobrazilo dialogové okno Drawing View.
7. V kategorii Visible Area zménite v kolonce View visibility hodnotu na Broken View.

X

> Jedinym novym prvkem, ktery si zde ukdzeme bude preruseni pohledu (Broken View), které se vyuziva u téles, u kterych je

86

I:e!tegories ‘izible area options
a iew visibilty | Broken View
Scale
Sections
\-"!ew Stlates Direction 1zt Break Line 2nd Break Line
Wiew Dizplay
Qrigin
Alignment
< >
Z-direction clipping
[ Clip wiew in Z-direction
Clipping reference
8. Kiiknéte na [*].
9. Kliknéte na Cervené zobrazenou hranu (viz obr.) a poté pohnéte mysi smérem dold.
» Tim se zaCne zobrazovat modra ¢ara znazornujici smér preruseni.
10. Potvrd'te kliknutim levym tlacitkem.
S 0.2x45° o0
el / 8
L
=] sy -—-—-— - —fRed £ ———-—-— @
| 'y
—, J
—_— I. - . S PP _B_ ______________________________________ |
@ 1
: \ '}
o —fF—-— - — - — - - e m e — — [t
_— 3o N 0.5xd5° ||
86
11. Nyni kliknéte na misto zobrazené na obrazku zelenou teckou.
» Tim se vytvori druhda modra ¢ara znazornujici druhou hranu preruseni (viz obr.).
12.V kolonce Break Line Style vyberte moznost S-curve on view outline.
13. Potvrd'te alox ]
oo 0.2xd5 ©
&
o
Al Ra ‘ | .6 o
N S I i e * _______________________ Il
) \
=] ‘ O
- 3.3 0.5%45°
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> Pohled se pFerusil a ob& poloviny Ize nyni vi¢i sobé& polohovat ve vodorovném sméru.
14. Napolohujte pohledy a proved'te Upravy dle obrazkd.

0,2:45°

o

!

RGN

L

- - 0. 5545"

- 8h

!

A
D5 h8

DIl
N
C
\

i

36
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Ra 6v3/< Ra 1.6 >

O
B 0.2x45° =
7> o
e 5 &
W Ra 1.6
— 0.5x45°
- 86
KR 12 tsn 42 5510.12 11 373.0 001 0.015 0.02 KKS-CAE-01-00 | 5
Pocet Ndzev - rozmer Polotavar Material konecny/vychozi |T.odp C.hmot Hr.hmot C. vy, Poz
kusu J S . . i . sesfavy
Quan- ; 3 ; ; ; Raw ;
tity Title - size Blank End material/Material Weight wolght Drawing asm. No. [Pos.
Datum Jmeno/Name Datum Name
Kreslil Techno-
DWN. 22-Feb-10 | NOVAK Jan lo/ist
Prezk, Prezk.
/CHK /CHK
Sthval Schval.
/APP /APP index/Na| Schvalil/Appr. popis zmeny/change Datum Podpis/Name
Methode 1 Poznamka/Note:
n VSEORECNE TOLERANCE IS0 80015 1SQ 2768mK
RO28 E]@' GENERAL TOLERANCES IS0 80015 ISO 2768mK

Soubor-model /ASM-file 0SICKA Meritko / Stale %éii;rvayy N/u. KKS-CAE-01-00
Soubor-vykres/DRW -file 2‘1

oSIcka| ™" -t/

CAE Nazev 7 Title CIoL0 VYKRESU ZDRAW NG NO. Fsolr;;f
OSICKA KKS-CAE-01-05
KKS

ltist/sheef /| EoteT listu/ no.sheefs 1 ZF
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Krok ¢.2 Vytvoreni vykresu tycky

15. Otevrete soucast TYCKA.PRT.

16. Vytvorte novy vykres TYCKA.DRW formatu A4.
17. Vlozte a zorientujte zakladni pohled.

18. Promitnéte osu soucasti a nékteré koty.

19. Doplite kéty a znacky drsnosti.

20. Vyplnte razitko.

Ra E.SK( Ro 1.6/ )
2ot
| &
]

[

[T} - —_—

w

g 0.3u45" 0.3x45" ||,

KR 2.5 - 30 L3N 425510.72 1373 oo 0.001 0.001 [KEZ-CAE-O1-0Q( &
TLLEJ: Hézey - reemer Polgtovar Material kanecnwyfchez [ |T-wdp. | <.bmat.  Hre-hoeto c&m{; Pz -
u'ﬁp,l,' Title - sice BMank End material-Material ‘W eight WE:.l:M Orewing aem. M. |Pos-

Datum Jmoro e Oalum Mane
ET..‘H 19-Mew—IF | MOwAK Jan T":lﬁ'l':r"
Prack Prezi.
JTHH JCHE
or bl Timal.
APR i3 Il Ma | Schwdd IL-Agmr - pls zneny-change Dahm_| Pudplstane
Hottoda 1 Prnamkastinie:
VSEONECNE TOLERARCE 150 ADTE |50 TTASTH
15D 118 Eﬂ@' BEMERAL TOLERANCES |50 BI01S 190 roHmi
Sl nadel A file TYTKR | Witk / Scale | Comptany £ KNS-LAE-01-00
Seuber-vir e TRW-flle L1
w M= - TlHo -
KKS TYCKA KKS-CAE-01-06
il
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CIL

CVICENI XVII

Tvorba vyrobniho vykresu soucasti rukojeti sestavy mlynku na maso.

Ra 3i%/

EIENE
— S p45°
. - 1=
[ 145 = |
] | ?5 -
1=
%\ o N
_ ' L. [ru]
BROUSIT 14 6 =
28 =
57
13

POYRCHOVA UPRAYA
YNEJS! ROTACHI PFLGCHU LAKOVAT BEZBARVYM LAKEM VODGU REDITELNYM

KR 32 - 8D neEen - mue | 001| 00kE [0.05 kesCeE-ptng | 0
PE‘E;I_I Migey - rome Palod pvar Maleral horecnyfs ichoz | [Toodp-|  C-tmpd.  (Hr-hool . ;E;.Ij:.'r." Pz
L Tille - size BLank End maler sl Waler ial Wegnt ",‘:i'a.“ Drawmg asm. Wo. [Pos.
0xum JmenpMame Darum hame
fireaLil] Tex -
DR 1A 10 | VAR lan Logisl
Fresh)| Frers.
JCHE LHE
S, SEhmal
ape ZAPP e sho| SoneanLéappe . [0S TreEnyANEDe Dahm | Podpishame
Medhade 1 Pornartiashinie-
WSECBELME TOLERAMCE |50 SOOMG  150 274K
190 9 E1G8 SR Toltian e 0 B 1o 1ot
Sopar-moel-ASH e RUKLJET 5‘{:'* 7l | Lo R S-CAE--00
Tibaar- i e IR - i B
RURIET =
M ——
Mazex 7 Tille TISL0 FTRRESLI <R NG O pa—
CAE RUKOJET KKS-CAE-01-07 |
KKS et seneal s g 1 ‘II‘
PREDPOKLADY
[ )

Vymodelovany nebo stazeny model soucasti RUKOJET mlynku na maso.
Znalosti zakladd vytvareni vykresd z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v’ Uprava povrchu
v' zména materialu
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Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Oteviete souCast rukojet.prt.

2. Kliknéte na N , vyberte Drawing, Name: rukojet.
3. Déle zvolte Empty with format a po kliknuti na vyberte a4_v1_vyrobak-uni.frm ze seznamu.

Krok ¢.2 Vytvoreni zékladniho pohledu
4. Vytvorte zakladni pohled ™" . Drawing View
5. Kllkvnvete vI_evo v nabidce na Vlev_v Display. | catsgories i, display optians
6. Zmeénte Display style na No Hidden. View Type
7. Tangent edges display na None. gisiblle Area
Display styl Mo Hidd
8. Potvrd'te provedeni zmén . gzztiem splay syle | () No Hidden 3

Tangent edges display style :ﬂ Mone

W

Origin Hidden line remaoval for quilks Colors come fram
Aligrment () Ves %) The drawing
() Mo ) The madel

Skeleton model dizplay
() Hide
() Show

weldment ssection display

Hidden line remowyal for shatches

) Yes
) Ma

Cloge

9. Na zalozce View Type zvolte v Model view names pohled NARYS.

10. Pod polozkou Angles zadejte Uhel rotace 90° a potrvrdte ,
11. Pohled pojmenujte ZAKLADNI.

> Dostaneme orientaci modelu jako na obrazku.

Drawing View @

Categories View type

Wigw Type

Visitle Avea | Wiew name |ZAKLADNI

Scale

T

Sections yRe

Wiew States Wiew orientation

g'?“’\_" Display Select orentation method (%) Views names from the model

figin
Aligrment 8 Eeolmetry references
noles
todel view names Default orientation
MaRys User Defined A
Default Qrientation A  angle |-120.00
BOKORYS
ML
M2
[ (]S ] [ Cancel ] [ Apply ]
12. Poklepejte na text SCALE. 2 Enter value | "
v av vy , . Ater valle [ar zcale 3
13. Prepiste meritko vykresu na 2(viz obr. dole). ks

SCALE: 24
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Krok ¢.3 Vytvoreni fezu

14. Pfepnéte se do rezimu modelovani.
15. Vytvorte fez A (:@), ktery bude definovan rovinou NARYS (viz obr.).

16. Prepnéte se do rezimu tvorby vykresu.
17. Poklepejte na pohled ZAKLADNI.

Drawing View

18. Na zaloZce Section vyberte fez A (viz obr.). | Cateasries Section options
19. Potvrd'te ‘J!e.w Tvpe () Mo section
- ' Yizible Area .
Scale (%) 2D cross-section
T — 30 cross-section Show =-Hatching
View States | (0 Single part surface | |
Wiew Dizplay
I:Ir_lgln E Model edae visibility &) Total ) Area
Alignment
Mame Sectioned Area Reference
EFS v |Ful v |
< >
[ OF. ] [ Eancel] [ Apply ]
Krok ¢.4 Skryti pomocné geometrie a zména Srafovani

20. Vytvorte vrstvu s nazvem POMOCNE_SKICI a vioZte do ni tfi pomocné skici.
21, Skryjte vrstvu POMOCNE_SKICI.
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22, Poklepejte na Srafovanou oblast a v Menu manageru zvolte moznost Retrieve.
23. Vyberte z nabidky material PE nebo ISO.

Open

S ey 1 » List - | ¥4 | |Search...
N

Bly Organize ~

Common Folders

:ﬂ Desklop

£ My Documents

% working Directoy
Metwark. Meighborhood
[ List

Termplates

Folder Tree

«“

"F‘-‘ Tools

alu
alurnirm
betan
blech
bioden
copper
edelstahl

OONHOEEn

File name: pe Date modified:

electric
folie
glaz
glazs
qumni

iran

Oooooon

iz

D k.apillar
O
plaztic
zilik.on
stahl

stee]

Oooo

titatiiuim

D zinc

File narme: ||:|e

| T_I.Jpel #hatch Style [ wch]  » |

[ Open

'] [ Cancel ]

f/ f!\i Nabidka materiald je dostupna pouze mate-li k dispozici knihovny a spravné nastavené cesty v config.pro.

Krok ¢.5

Vytvoreni pomocnych os v modelu

> Casto musime doplnit do modelu pomocné prvky, které potfebujeme pfi kdtovani vykresu.
24, Prepnéte se do reZzimu modelare.

25. Vytvorte pomocnou osu OSA_0 kolmou na rovinu BOKORYS a prochazejici bodem PNTO.

B DATUM AXIS

3

Flacement | Display | Properties |

References
PNTO:F12[DAT ... Through
BOKORYS:F1[... Mamal

Oftget references
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26. Vytvorte pomocnou osu OSA_1 kolmou na rovinu NARYS a prochazejici bodem PNT1.
27. Vytvorte pomocnou osu OSA_2 kolmou na rovinu NARYS a prochazejici bodem PNT2.
28. Vytvorte pomocnou osu OSA_3 kolmou na rovinu NARYS a prochazejici bodem PNT3.

Krok ¢.6 Promitnuti os a kot modelu do vykresu

29. Prepnéte se do rezimu tvorby vykresu.
30. Kliknéte na ikonu e Show and Erase.
> Objevi se okno Show/Erase.

31. Vyberte promitani os ~—*! a két 7“1, nastavte Show By: View.
32. Kliknéte na pohled ZAKLADNI.

33. Vyberte osy a kéty zobrazené na obrazku.
34. Potvrdte h

-

@20

—

13
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Krok ¢.7

Pridani kot, znacek drsnosti a toleranci do vykresu

35. Dokotujte model dle obrazku.

g ) - ol 1x4 S
345° | xR — i
BEmae KA S
90900 |
IS *
| KK . ; F
1= [ | I A N I ™
F | . % ' |
|
‘i‘x\/ \\,;:u g
e &
36. Doplnite geometrickou toleranci a znacku drsnosti dle obrazku.
Ra 3.7

. | S — |
145 AT o | i
SERRERKS o
SRS = ‘
| XKL | | u
B I | — B I O — S Y N T &
= | | | | (&
r ﬁ% 1
%/ % | | - | < r
L 4.6 =
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Krok ¢.8 povrchova Uprava

37. Kliknéte na & EI a vyberte ptikaz ' Offset.

38. Vyberte na kfivku zobrazenou Cervené na obrazku a zapiste velikost offsetu -5mm.
39. Potvrd'te dvakrat prostfednim tlacitkem.

e =iERE
= —~ O 15457
w2 — ) o
1445° —
145° ] 3 _
: ]
: |
I , r
“ ! | =
= i ' =
1 ' ' l
|

QBHSé

28

40. Poklepejte mysi na nové vytvorenou kfivku.
41. Nastavte styl ¢ary na PHANTOMFONT o Sifce 0.7 (viz obr. vpravo).

0.05 Modify Line Style %]

Copy From
[xd5° Style hone w
Drawing [ Select Line... ]
!
[ Attributes
! (TN ST | PHAMTORMFOMT IR

width 0.700000

Color @

Model Edge Optionz

D13

@20

—

‘/\/
@6 HE

[ Apply ][ Cancel ] [ Fezet ]
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42, Vytvorte poznamku ( 4 Note) s odkazovou Carou (With Leader) s textem BROUSIT dle obrazku.
43. Vytvorte dalsi poznamku, bez odkazové ¢ary(No Leader), o dvou fadcich textu POVRCHOVA UPR... (viz obr.).

.;’D” 0,05
L ]
< 1.5t
=)
|45
[
|
I
1 1
—_ - ' [ |
=) | =y
1 ! I
‘Q»/ !
~ PN
- - -
o
BROUS I T -
[
- 08 _ =
— 36 -
- 3 -
FOVROHGY A UPRAVA
WHNEJST ROTACHT PLOCHU LAKOVAT BEZBARNVYM LAKEM VODOU REDITELNYM
w Vytvareni poznamek vykresu je podrobné&ji popsano ve cviceni ¢.15 (Sroub).
Krok ¢.9 Vyplnéni razitka
44. \Vyplite razitko dle obr.
KR 32 - a0 OREVD - OUR 001 0.048 0.05 KRS-CAE-01-00 | 7
PEEEL Mirew - rozmer Paolotavar Material konecnySwychozi  (T.odp.| C.hmet.  |Hr.hmot, Csl.e;T%ah:vl Paoz.
D”I?I“v‘ Title - size Blank End material-Marerial W oeight fg‘igm Orawing asm. MNo. |Pos.
Datum Imeno<Hame Datum Hame
Foraslil Technao-
i | 01-Mar-10 | NOVAK Jan | 0
Prezh. | Prezk.
ZLHE ALHE
=Chval SCvaL.
SHPP SHPP index Mo| Schwalil Appr- popis ZmenySChange Datum Paodpis sHame
Methode 1 Foznamia-Mote:
WSEOBECHE TOLERANCE 150 80045 150 Z788mkK
150 128 €38 LN TRnr TOlERAICES 150 Boge 190 Zaotom

- SREM- T i } .
Soulor-model AASH-tile RUKOJET Meritko # Scale .%.;_z,isr;:ti\;yl'lo. KKS-C AF -01-00
Soubor-vykres ORW -File 2:1
RUKDJET K

CIGL0 VTKRESL <DRAW ING MD. Farmat

CAE Mazey / Tille I7E
KKS RUKOJET KKS-CAE-01-07

listsheed 1 poLet Lisius no.sheels 1 &
; ! Pro spravny vypocet &isté hmotnosti tfeba zménit hustotu materialu (hustota dubového dfeva: 1550kg/m?3).

w Nastaveni hustoty materidlu je popsano ve cviceni ¢.0 (Sablona).
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Ra 3.2
A o, ns
S TY A
| £d5° =~
|
|
o =
— ol
! T
1 |
1 ]
CN . -
/ "'-..H” II_-_..--" "'-u..,‘_.” I#”)‘-{’ﬁg’
L Lo [ .
-y, ..--"'-'I =]
BROUST T 46 | T - -
o o i
~ 25 _ T
- b
FOVRCHOWA UPRAYA
YHE JST ROTACHI FLGCHU LAKOVAT BEZBARVYM LAKEM YODCU REDITELMYM
KR 37 - &0 OREYD - DUR 0ot | 0.0ue | 0u0% KRS-CAE-04-00 ) 7
rpﬂ Migey - Coomer PoL mvar Maleral korecnya ghoz | [1.odp|  C.mmot. |wrnen {";E"'JE" Poz.
':'“I‘;':‘{ Tile - cize Biank Eral malerial Haler ial Weunt “f':i"gr" Orawing asm, ko, [Pre.
[31uR mennMana Darum Hame
Fesaitlgnmer-1o | wover san [ 20T
Frezh, [FreTh.
JTHE ALHE
T SLial.
Lo "APP iredeetha| SenedniL A . [0S ZEerAnan D Datun | PadpisHome
Mzihads 1 ) Pormantaskola
IS0 VB E 8 (ihgnaL TOLEGAW L 150 BOCE 130 274G
Sinpar-m el ATH- il RURIET 5“]"'“ | N, KR 5-CAE-01- 00
Soubar- e res IRY - Hle .
RUKQIET P—
CAE Mazay ¢ Tille Li5L0 WPRRESL ~DOFAW ING W0 F:-I;[al
I
RUKOJET KKS-CAE-01-07
KKS M
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CVICENI XVIII

CIL

Tvorba vyrobniho vykresu soucasti Sroubu kliky sestavy mlynku na maso.

1 2 3 L 5 6 7 8 9
A 23 2 A
, %)
N T, TRy 5 [
o W \\\ ,,,,,,,,,,,
o | N
B '/ 1_ \ B
e ———— e ——)F
w© "« Bl e 7
e “ T %
— o - —
S =
o st a
(& e i NG C
o |
2
L %ﬁ 9 | & L
QS | o)
1
D ! D
)| !
= | .
M6x0.5 |
t
1
E | POZICE 2: DELKA DRATU 93mm E
QIZC R 3 CSN 42 651017 1373 001 003 KKS-CAF-01-08 2
L I{kr22 2 CSN 42 5010.12 1373 001 | 6.012 KKs-CAE-01-08 | | |
froce Nocer - rozme Polofova aerial dp| Cotmot. [irtmet] Cisto rikresu |
foases Title - sire Al | weignt [ 10 ] orawine wo o
F Jmeno/Nar Name E
= NOVAK Jan
e
Chyel Schyal
APP /405 [nsex/ dscheal 1 Apor Sop1s am [ Pods 1 1/N
| et Poznamka/Note: 1
28 g CNE TOLERANCE IS0 8005 IS0 2768mk
EANCES ISD €015 ISD 2768nK
yAH-Ae SROUBLKLIKY |'&! ch SR " <KS-CAE-D1 €0
G e SROUB_KLIKY| V" |6
w e oy 700 VIKRSU /DRRWIMC MO Fans
KKS SROUB._KL IKY KKS-CAE-01-08 3
Liat roheat 1 cocet Lich/ oo creete | b
1 2 3 6 I 9 8 9

PREDPOKLADY

Vymodelovany nebo stazeny model svarence SROUB_KLIKY sestavy mlynku na maso.
Znalosti zaklad vytvareni vykresd z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Nastaveni 3D pohledu pomoci soufadnic natoceni
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Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Oteviete soucast svarence sroub_kliky.prt.

2. Kliknéte na N , vyberte Drawing, Name: sroub_ kliky.
3. Déle zvolte Empty with format a po kliknuti na vyberte a3_v1_sestava-uni.frm ze seznamu.

Krok ¢.2 Vytvoreni zékladniho pohledu
4. Vytvorte zékladni pohled ™~ General. BY Select Combined State  [X]
5. Potvrdte v dialogu No Combined State (obr. vpravo). Combined state names
6. Kliknéte vlevo v nabidce na View Display. Ma Combined State
7. Zménte Display style na No Hidden. DEFALILT ALL
8. Tangent edges display na None.
9. Potvrdte provedeni zmén .
[] Do nat promipt for Combined State

10. Na zaloZce View Type zvolte v Model view names pohled NARYS.
11. Pohled pojmenujte ZAKLADNI.

> Dostaneme orientaci modelu jako na obrazku.

Drawing View @

Categories Yiew type

Wiew Type

Visible Area | View name | ZAKLADNI

| Scale
Tvpe
03{00] 99 Sections *
0 3 View St_ates Yiew arientation
o \D'f"_ﬂ"_" Display Select orientation method (%) Yiews names from the model
4 5 . O nain () Geometry references
Alignment ) Aingl
ngles
bodel view names Drefault arientation
3 MAaRYS |Jzer Defined W
—’ Dfault Drientation | % angle 12000
BOKORYS
DAOLKI Yangle 20000

[ 0K ] [ Ean-:el] [ Apply ]

12. Poklepejte na text SCALE.
13. Pfepiste méfitko vykresu na 5:1.

SCALE : 51

» Automaticky se do vykresu pridala kota svarovani, ktera je definovana typem pouzitého svaru pfi modelovani svarku.
14. SmaZte tuto kotu.

0. 300.0) 9.9

.
o =
=
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Krok ¢.3 Promitnuti a vytvoreni os ve vykresu

> Nejprve se prepneme do objemového modelare - modelu SROUB_KLIKY

15. Ve stromé kliknéte na L. -> Model Tree
16. Pravym tlacitkem kliknéte na SROUB_KLIKY.ASM a zvolte z nabidky pfikaz Open.

> Tim jsme se prepnuli do modelu svafence SROUB_KLIKY.ASM

17. Oteviete ve stromé& model SROUB_KLIKY_OKO.PRT a zobrazte si roviny “&.
18. Vytvorte novou rovinu STREDNI ve vzdalenosti 10mm od roviny PUDORYS (viz obr.).

19. Ulozte =l save a zavFete okno.
}\ NARYS

— 10.00

BORKGRYS

B DATUM AXIS

Flacement | Display || Properties |

References

NARYS:FIDATUM F... Through
STREDMIFHDATUM... Through

Oiffzet references
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21. Pfepnéte se zpét do vykresu.
22, Skryijte zobrazeni rovin.

23. Promitnéte osy dle obrazku prikazem ¥ Show and Erase. /

24, Spust'te v nabidce Format prikaz Line Style..
25. Vyberte kfivku Cervené zobrazenou na obrazku. e ———
26. V dialogu nastavte styl ¢ary na Centerline a potvrdte. '

Modify Line Style 3
Copy From
Siyle centerline w
Drawig
Attributes
Line Font | CTRLFONT A
fidth |

Color @

tModel Edge Options

[ Apply ] [ Cancel ] [ Feset ]

Krok &.4 Srafovani svaru

27. Promitneme hrany plochy, kterou chceme vysrafovat o Use (dle obr.).
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28. VVyberte promitnuté prvky.

29. V nabidce Edit spust'te prikaz Hatch/Fill.
30. Potvrd'te libovolny nazev.

31.V nabidce vyberte ptikaz Retrieve.

32. Z nabidky styll Srafovani vyberte ISO.

Krok ¢.5 Priifez

>  Vytvorime prdfez pomoci piikazu Revolved.. a ten nasledné ofizneme (Partial View)
33.V menu Insert --> Drawing View spust'te pfikaz Revolved...

34. Kliknutim levym tlacitkem kdekoliv do vykresu fez umistéte.

35. Ve Visible Area nastavte Partial View.

36. Viyberte oblast dle obrazku vybranim stfedového bodu a oblasti ofezu.

37. Potvrdte .

Drawing View @|

Cateqories
Yiew Type

Wizsible area options

Wiew vigibility | Partial View  w

Reference point on geometry | Edge-SECTION >SECOD

View States Spline boundany Spline defined
Yiew Dizplay Show spline boundany on view

Origin

Alignment

Z-direction clipping

Clipping reference

Close

38. Umistéte prlifez do zakladniho pohledu dle obrazku.

8
39. Zablokujte pohyb pohledd 5% Lock View Movement.

XVIII-5




Krok ¢.6 Promitnuti os a kot modelu do vykresu

> Nyni si ukdZeme rychlejsi zplsob promitnuti kot z modelu do vykresu, ma oviem tu nevyhodu, Ze se automaticky promitnou
vSechny kéty, aniz bychom si je mohli vybrat. Nezadouci kéty odstranime z vykresu volbou Erase z kontextového menu.

40. Kliknéte ve stromé pravym tlacitkem na SROUB_KLIKY_TELO.PRT. SROUB_KLIKY.aSM

41. 7 menu vyberte moznost Show Dimensions (dle obr. vpravo). g SEST_BOKORYS
. Y s . SEST_PUDORYS
» Promitnou se z modelu vSechny do§tupne koty (viz obr. vlevo). £7 SEST_NARYS

A sEST_CS0
e SR OUE KLIKY TELOLPRT
+ :I SROUB_KLIKY _OKOLPRT COpen

“h Groove Weld id 303 Add Drawing Model

Jimensions k

Shiow Dimensions by Wigw

l5

0‘5/ 514

42, Upravte koty dle obrazku, nepotfebné koty smazte pomoci Erase v kontextovém menu.

| 5

MG« 5
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Krok ¢.7 Dokdtovani, pozice

43, Dokdtujte model dle obrazku.

23
“;
[y
L
. 1
(]
Y
(&
L
- o
MEx0. 5
[
@20
> Nyni doplnime pozice. Custom Drawing Symbol @
- Crn
44. Kliknéte na Custom. General | Grouping | Yariable Text Ea——
45,V dialogu nastavte pole dle obrazku. Dfirition
46. Na zalozce Variable Text vypliite Cislo Spmbol name| POSICE
pozice 2.
47. Umistéte levym tlacitkem pozici a
potvrd'te umisténi prostfednim
tlacitkem.
Flacerment
Type With Leaders w0 Yosth mbr o poriceh
MHew leader | W= R | Arowhead | Filled Dat w
ScreenPnt
Froperties Drigin
Height |9.073232
Angle | 0000000 +90
o
Calar &

Je potfeba mit k dispozici knihovny a nastaveny cesty k nim v souboru config.pro
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Krok ¢.8 Znacka svaru

. Coa
48.Kliknetena .

49, Stisknéte a v adresafi SVARY v knihovné vyberte SVAR KOUTOVY.
50. Svar umistéte do vykresu dle obrazku kliknutim levym tlacitkem a potvrzenim prostfednim tlacitkem.

23 2

4’(—

@
5
'9(?
e
=
ME:D.5

@20
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51. Poklepejte na ikonu svaru.

52. Na zaloZce Grouping zaskrtnéte moznost PRILEHLY.
53. Na zaloZce Variable Text zadejte vysku a délku svaru dle obrazku.

Custom Drawing Symbol

E X

General | Grouping | “ariable Text Presiew
wyzka svaru |5 v
delka | v
Wy sl dear bileah
ove ][ Ok ][ Cancel
Krok ¢.9 poznamka nad razitkem

A

54. Aktivujte prikaz Note.
55. Nastavte dle obr. prikaz Note.

56. Kliknéte na Make Note.
57. Vepiste text dle obrazku.

FOZICE 2

DELKA DRATU 9 3mm

) r

With Leader
150 Leader
on Item
Cffzet

File

Horizonkal
Vertical

Angular

Standard

Center
Right
Defaulk
Style Lib
Cur Style
Make Note

Done/Return

Krok ¢.10 Vyplnéni razitka
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58. Vypliite razitko dle obrazku.

TIKR 3 - 50 CsM &2 651012 11 373 201 0.003 kKES-CAE-01-08| 2
T[KR 22 - 25 C5N &2 501012 11 373 001 0,012 KkS-CAE-01-08] 1
PEEEL NaZRY - rpzmer PoLotovar Material T.Odl:l. Chmod. Hr.imat . Cislo kaPESLI Poz.
Huan- . : . . Raw .
ity Tille - size Blank Material Weight we ght Drawing Mo. Pos,
Datum Imenp/Hame Oatum Wame
Kreslil Technn-
W 27-Jul-10 | NOWAK Jan Log/1st
Prezk, Pragh.
LHE SLHE,
Schval Srhyal .
SAPP “APP indew Mo | Schvalil/appr. popis zmenyschange Datum | Podpis/hame
Meinode 1 Poznambz /Mot e:
WCEDRECHE TOLERANCE 150 80015 (50 27e8mK C.hmornosk sestasys
15028 EH@ GEMERAL TOLERAMCES 150 80075 150 2768mK ASm, weight 0.015
Soubor-mogel SASM-File SROUB_KLIKY Herilko # Scale | C.sesfavy / KES-C AF-0- 00

Sounor-yykres ORW - file

SROUB_ELIEY _WEW

1 Ascembly Mo,

-
- Ivpe

CAE
KKS

Mazew # Title

SROUB_KLIKY

CISLO YYKRESU <ORAW ING MO,

KKS-CAE-01-08

Listsgneer | poret Listu/ no.sheets

Farmal
SIZE

| 4

\'f Vyplnéni razitka podrobné popsano ve cviceni ¢.13 krok ¢.10

Krok ¢.11

3D pohled
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59. Pridejte novy pohled.

60. V dialogu Drawing View nastavte Model view names: Default Orientation.

61. V kolonce Default orientation nastavte User Defined a vyplite natoCeni v prostoru dle obrazku.

Drawing View

Cateqaries

Wiew Type
Yizible Area
Scale
Sections
Wiew States
Wigw Digplay
Origin
Alignment

Type

Wigw wpe

Yiew name |3|:'view

| General W |

"Wiew orientation

Select orientation method (%) Views names from the model
() Geometry references

() Angles
Model view names Default arientation
Default Orientation | I zer Defined L |
Standard Orientation -

Default Orientation

BOKORY'S ¥ angle
DOLNI P

NARYS

PRAYY v

[ (] 4 ] [ Ear‘u:el] [ Apply ]

62. Nastavte Display style a Tangent edges display style dle obrazku.

Drawing View

Categaries

Wiew display optionz
Wi Type
Vizible Area

Scale
Sections

Dizplay style

@ Mo Hidden

W

Wiew States

Tangent edges dizplay style

View Digplay

v

ﬂ Dirmrmed

Origin
Alignrment

Hidden line remaval for quilks

() Yes
(%) Ma

Skeleton model digplay

(%) Hide
) Show

(*) Yes
Mo

Hidden line remorval for shatches

Colorz come fram

(%) The drawing
(3 The model

YWweldment xzection display

[ (] ] [ Cancel ] [ Apply ]
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(K=}

15

M6x0.5

13

ol || (S N I S

@20

5 6 7 8 9
e}
SRR S S S
POZICE 2: DELKA DRATU 93mm
I KR 3 - 50 N 4?2 6510.1? Il 373 001 0003 KKS-CAF-01-08 ?
I | KR 22 25 CSH 42 5010.12 1373 001 0.012 KKS-CAE-01-08 |
nmmm.” Nazey - rozmer Polotovar Ma-erial “.odp.| C.hmot. Hr.hmet] Cisle evkresu [Pos.
s Title - size Rlank Ma-erial Weight awwui Drawing No  [Pos
Jatun Jmeno/Kare Jatum Name
4-Ssp- 1| NOVAK Jon mwcﬂc
Mrezk.
/LHK
Schyal .
/APP ndex/NdScheal il /Appr popis zmeny/change Patum | Podpis/Nane
Methode 1 Poznamka/Note
) — 2, VSEOBECNE TOLERANCE 1SO 80015 SO 2768mk C.hmotnos- sestavy/
IS0 128 £ {85 GENERAL TOLERANCES 1O €015 1SD 2768nK AsT. weigh 0.015
SbarTcL/ASH:Alle SROUB_KL I KY [ Meritho / Scale | L.sestacy @ {KS-CAE-21 -60
v .
Sotbar-vyk-es/DRY -file 5:1
SROUB_KL IKY
2 R T1S-0 VYKRESU /DRAWINC RO
ot choot | L it posreete ]
5 6 [ T 8 9
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CVICENI XIX

CIL

Tvorba vyrobniho vykresu soucasti vicka mlynku na maso.

A (15) A

|
|
|
ME0x1.5
-
g
="
Lo

W

T =
\
=
P60.5
U]

1l
[

I
<
7
0

(

VicKo| Herlho /S
VICKO

S0

CAE | ™" VICKO KKS-CAE-01-09

; . § _ s
2 3 4 5 [ 6 7 R 1 )

PREDPOKLADY

¢ Vymodelovany nebo stazeny model svarence VICKO ze sestavy mlynku na maso.
e Znalosti zaklad( vytvareni vykrest z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Zakonceni kéty Sipkou
v Nastaveni 3D pohledu
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Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Oteviete soucast vicko.prt (instanci The generic).

2. Kliknéte na N , vyberte Drawing, Name: vicko.
3. Déle zvolte Empty with format a po kliknuti na vyberte a3_v1_sestava-uni.frm ze seznamu.

Krok ¢.2 Vytvoreni pohledt

Vytvorte zakladni pohled * General.

Kliknéte vlevo v nabidce na View Display. (
Zménte Display style na No Hidden. \
Tangent edges display na None. —“‘\f
Na zaloZce View Type zvolte v Model view names pohled ZADNI.

Pohled pojmenujte ZAKLADNI. ]

10. Potvrd'te provedeni zmén .

WONGOU A

l
_—

N

11. Na zalozce Sections zvolte 2D cross-section.

12. Kliknéte na a vyberte fez REZ1 a potvrd'te zmény . -

13. Odstrarite popisku REZ1-REZ1.

14. Ve stromé kliknéte pravym tlacitkem na % SKELET 3 skryjte ji pfikazem Hide.

o
i } Pokud chcete tuto skicu schovat natrvalo, vlozte ji do vrstvy, tu poté skryjte a prikazem Save status uloZite aktudlni stav
N) zobrazeni. Tento postup byl probiran v nékterém z predchozich cviceni.

15. Poklepejte na text SCALE.
16. Piepiste méfitko vykresu na 2:1.

SCALE: 21
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17. Vlozte detailni pohled Insert -> Drawing View -> Detailed..
18. Vyberte stfedovy bod a poté oblast detailu dle obrazku.

A

> Zmeénte méritko detailniho pohledu.
19. Poklepejte na pohled detailu.
20.V menu Scale nastavte Custom scale: 5.

Drawing View

Categories Scale and perspective options
Wiew Type
Yizible Area

Crale (%) Cuztam zcale

Sechions
Wiew States o

Wiew Display Eve point digtance I:I b b
Origin Yiew diameter I:I b i

Aligrment

[ k. ] [ Eancel] [ Apply ]
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Krok ¢.3 okotovani

21. Promitnéte do modelu kéty dle obrazku.

g0

2.9

Ipe

@605

> U kéty @60.5 odstranime spodni dvojsipku (viz obr.)
22, Oznacte kétu @60.5.

23. Kliknéte pravym tlacitkem na spodni Cerveny Ctverecek (dle obr.).

24. Z kontextového menu vyberte Arrow Style...
25. Z nabidky vyberte None a potvrdte.

=

o 6.0 . 50

Mexk

Prervious

Pick From List

Clip Witness Lines

Edge Display. .. !!

Default
arrowhead

Dok

Filled Dok
Double Arrow |::>

Slash
Inteqral
Box

Filled Box
Mone
Targek

Done/Return

@605
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26. Promitnéte do modelu koty dle obrazku.

9

MEDy |

Krok c.4 Tolerance a drsnosti

27. Doplrite do vykresu tolerance a drsnosti dle obrazku.

P15

A
/f——-\
1z DR ~
L]
Siin
e [ Iy |
| \ﬂ
. . - e
=
“ =
‘\\_______
|| 2.5
o

—{~]

‘i,) Postup vkladani toleranci a drsnosti byl probran v predchozich cvicenich.

dpe

@605
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Krok ¢.5 Razitko

28. Vyplnte razitko dle obrazku.

M. 7 1 N - -)1-
C.M. 0272010 LY 2470 oo 0162 K5-CAE-01-Q0 | D
Pocer , . A T, v
kLS U Nizey - rozmer Polotavar Material konacnysvigchoz i |T.odp.|  C.nmat.  |Hr.nmat. cpalavy Poz.
[Juan- ! - ! ! - Raw !
tity Title - 5i7e Blank End matlerial Material W oaight weight Orawing asm. Mo. [Pos.
Datum Jmena /Hame Datum Wame
reslil] Technao-
D 30-Aug-10 | MOVAK Jan Log/ist
Prezk, Frezk,
ZTHE SCHE
Schyal SChval,
#HPP 7APP index Na| Schvalilstppr- popis zmenythange Dalum | Padpis/Mame
Methode 1 Paznamika Mot e:
YSEOBECWE TOLERAWCE 150 80015 150 2748mK
150 128 £ GEMERAL TOLERANCES 150 8006 |50 2768rH
Soutior-model AASM-File Merilko # Scale | C.sestawy #
VICKD Besembly No. KKS-LAE-D71-00
Soubor-wykres ORW - File 2:1
WILKD S
I
Hazew # Tille C15L0 VTKRESU /URAW ING NO. Formal
CAE VICKO KKS-CAE-01-09 | °
List sgheet 1 pocel Lisius no.sheeis 1 4

Y

w Vyplnéni razitka podrobné popsano ve cviceni ¢.13 krok ¢.10

Krok ¢.6 3D pohled

29. Prepnéte se do modelu.
30. Napolohujte model dle obrazku vlevo.

31. UlozZte tento pohled (pomoci E'fi') dle obrazku vpravo a nazvéte jej 3D.

Simp Rep ><seu:| Orient |f.'a.||

B View Manager, r5__<|

| Edt~ || Display~ |

Mames

L]
Muj2
Mays
Prasy
Pudorys

Default Origntation

30

Cloze

XIX-6




32. Pfepnéte se zpét do vykresu.

33. VloZte novy pohled.

34. Navéte jej Izometricky pohled.

35. V kolonce Model View names vyberte predvytvoreny pohled 3D.

Drawing View

X)

Categories Wiew bype
Jiew Type - -
Wisible Area Wiew name ||zornetr|ck_l,l pohled |
Scale
Type
Sections e
Wiew States Wiew origntation
E"?”_" Display Select orientation method (&) Yiews names fram the model
figin
Aligrmert () Geometry references
) Angles
Model view names Default arientation
D |UserDefined |
Standard Orientation ~  angle |-120.00
Default Orientation E
erz)
BOKORYS 0
LoLMI
kLI v
[ 0k, ] [ Cancel ] [ Apply ]

36. Na zaloZce View Display nastavte Display style na No Hidden a Tangent edges na Solid.

Drawing View @

Categories Yiew dizplay options

Wiew Type

Wizible Area

Scale Dizplay st_l,lle| @ Mo Hidden V|

Sections

'EW Slates Tangent edges display style ‘ = Solid v |

|. A E —

Origin Hidden line removeal for quilks Colors come from

Aligrmest ) Ves (#) The drawing
&) Mo () The model

Skeleton model dizplay
() Hide
) Shiow

Weldment szection display

Hidden line remaowal for shatches

i Yes
) No

Cloze
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CVICENI XX

V'

CIL

Tvorba vyrobniho vykresu soucasti noze mlynku na maso.
1 I 2 I 3 L 5 I 6 T 7 I 8 I 9

B B
C C
D D
8 — TRAJEKTORIE OBRABENI BRITU FREZOU & 10mm
OSTRI KALIT NA 50+2 HRC
C.M. 0372010 0.0 01-00
aeet [ f q Ma-sria [ C.hmot. Fr.h
3l ark E£nd mater ol 0 | W ']“ ]
F Jmeno/Name I Jatur Nare
— YR —
NUZ| Meriro / Scele (s
G NUZ 21
TISL0 VYRNES] DRAW INC ND orm:
KKS-CAE-01-10 |
. 5 : » : . : - s
PREDPOKLADY

¢ Vymodelovany nebo stazeny model svarence NUZ ze sestavy mlynku na maso.
e Znalosti zaklad( vytvareni vykrest z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v Kontrolni kdta
v’ Trajektorie stfedu frézy pfi obrabéni bfitu
v Pomocny pohled (Auxiliary View)

XX-1




Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Otevrete soucast nuz.prt.

2. Kliknéte na N , vyberte Drawing, Name: nuz.
3. Déle zvolte Empty with format a po kliknuti na vyberte a3_v1_sestava-uni.frm ze seznamu.

Krok ¢.2 Vytvoreni pohledd

4. Vytvorte zakladni pohled * General.
5. Kliknéte vlevo v nabidce na View Display.
6. Zménte Display style na No Hidden.
7. Tangent edges display na Solid.

8. Na zalozce View Type zvolte v Model view names pohled PUDORYS.
9. Vyberte moznost Angles a zapiste Uhel -45° dle obr. vlevo.

10. Pohled pojmenujte ZAKLADNI.

11. Potvrd'te provedeni zmén [4eply |,

> Pohled byste méli mit zorientovany jako na obrazku vpravo.

Drawing View @

Categories  wiew tupe
igw Tope
Visible Area| iew name |ZAKLADNI
S cale Type General v
Sechions
Wiew States Yiew orientation
g'?"‘_’ Display  elact prientation method () Wiews names from the model
rigin
Blignment 8 Eeolmetry references
ngles
=
Reference Angle
0.00

Ratation reference | Marmal w

Angle value -45
< >

[ (0] ] [ Cancel ] [ Apply ]

12. Vytvorte promitnuty pohled dle obrazku vlevo (Display style: No Hidden, Tangent edges: Solid).
13. Vytvorte izometricky pohled dle obrazku vpravo (Display style: Hidden, Tangent edges: Solid), méfitko 1:1.

N

!1
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Krok ¢.3 Vytvoreni fezd a prirezl

14. Pfepnéte se do rezimu tvorby modelu.
15. Ve View Manageru vytvorte fez A dle obrazku.

—

REZ A

16. Vytvorte rovinu ROVINA_REZU_B ve vzdalenosti 7mm od roviny ROVINA_2 dle obrazku vlevo.
17. Ve View Manageru vytvorte fez B rovinou dle obrazku vpravo.

ROVINA REZU B

" ¥ oo o
18. Prepnete se do rezimu tvorby vykresu.+ SOV I RMOE | WA REZUREE HA_ |

19. Zapnéte zobrazeni rovin =)
20. V nabidce Insert -->Drawing View -->Auxiliary...
21. Kliknéte na rovinu BOKORYS a zvolte umisténi pohledu.
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22, Poklepejte na nové vytvoreny pohled.

23. Pfejmenuijte pohled na REZ_A.

24, Display style: No Hidden, Tangent edges: None.
25. Na zaloZce Sections zvolte 2D cross-section.

26. Kliknéte na , vyberte fez A a potvrdte zmény .

A-A

27.V nabidce Insert -->Drawing View -->Revolved...
28. Kliknéte na pohled ZAKLADNI.

29. Kliknéte kamkoliv do vykresu pobliz pohledu ZAKLADNA.

> Objevi se okno Drawing View.
30. Poklepejte na nové vytvoreny pohled.

31.V nabidce Cross-section vyberte fez B, pojmenujte pohled REZ_B a potvrdte (viz obr. vlevo).

32. Upravte pozici pohledu vici pohledu ZAKLADNI.

Drawing View @

Categories gy tupe

Wisible Area|  Yiew name |REZ_E
Scale

Type
Yiew States Revalved view properties
View Display  rpoesection B v
Origin
Alignment Alignment reference | Select item

LXTH KS-CAE-01- 0 10

[T Vore AR

KKS-CAL-01-19

..... SRR I
T E)

L]




34. Poklepejte na text SCALE.
35. Prepiste méfitko vykresu na 2:1.

SCALE: 21

Krok ¢.4 Detailni pohled

36. Vlozte detailni pohled Insert -> Drawing View -> Detailed..
37. Vyberte stfedovy bod a poté oblast detailu dle obrazku.
38. Nastavte méfitko detailu 20:1 a nazev pohledu B.

A

20

Krok ¢.5 Trajektorie obrabéni britu frézou

>  Nyni vytvofime trajektorii jako £ Offset hran bfitu.

39, Spust'te nastroj = Offset v bocni dialogové lista.
40. Vyberte hranu Cervené zobrazenou na obrazku vlevo.
41. Zadejte velikost offsetu -10.

g Enter offset in the direction of the amow [Quit] -5

XX-5



42, Vyberte hranu Cervené zobrazenou na obrazku vlevo.
43. Zadejte velikost offsetu -10.

44, Stejny postup zopakuijte i na dalsich tfech ostfich noze.

A




45, Vyberte vSechny vytvorené kfivky.

47.V dialogovém okné nastavte PHANTOMFONT, tloustku ¢ary 0.25 a barvu
cernou (viz obr.).

48. Potvrd'te a [ Ooss ],

46. Kliknéte na nékterou z kfivek pravym tlacitkem a vyberte pfikaz Line Style.

M Modify Line Style %

Copy From
Shyle none v
Drawing Select Line...
Attributes

Line Font | PHANTOMFONT (&
“wfidth 0.25

Calor @

Maodel Edge Options

[ Apply ] [ Cancel ] [ Rezet ]

Krok ¢.6 Okoétovani a promitnuti os a kot

49. Promitnéte do vykresu osy a koty dle obrazka.
50. Dokotujte vykres dle obrazkd.

A

—enl

—

10.84

22. 0l

—g

7.5

!
i

o

8.5

!
i

5

0

20
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> U kéty @60.5 odstranime spodni dvojsipku (viz obr.)

51. Oznacte kétu ©60.5.

52. Kliknéte pravym tlacitkem na spodni Cerveny Ctverecek (dle obr.).
53. Z kontextového menu vyberte Arrow Style...

54, Z nabidky vyberte None a potvrdte.

A
) w ARRCAW STYLE
gl Default
Arrowhead
@ Dat -
Filled Dat s
::> Double Arrow I::> L)
Slash \®\
Intearal
B
Hext Filled Box
Previous Mone
Pick From List Target
Clip Witness Lines Done,/Return

Krok ¢.7 Drsnosti a textové popisky

55. Doplnite do vykresu drsnosti a textové popisky dle obrazku.

BRABENY BRIT,

|'V6/‘FD

5

A

200
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Krok ¢.8 Kontrolni koty

56. Poklepejte na kétu Cervené zobrazenou na obrazku vievo.

57. Vyberte v kolonce Display moznost Inspection (viz obr. vpravo) a potvrdte.

58. TotéZ proved'te u koty 1.5°.

Dimension Properties

Properties | Dimenzion Test | Text Style

Walue and tolerance

Farmat

Tolerance mode | Mominal v| (® Decimal
Tolerance table | General v| O Fractional
| | Mumber of decimal places
2
Angular dimenzion units
Dizplay Dualdi =
O Basic ual dimenzion
(®) Inspection
() Neither
Text arientation
Witneszsline display
Charmfer style Ordinate Style [ hon ] [ Eraos ] [ Dafadlt ]
Move... ] [ Move Text.. ] [ Edit &ttach... ] [ Orient... ] [ Text Symbal... ]
[ Ok, ] [ Cancel

)
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Krok ¢.9

Razitko a popisky nad razitkem

59. Doplnite razitko a popisky nad razitkem dle obrazku.

TRAJEKTORIE OBRABENI BRITU FREZOU @ 1 0mm

4
CM. 03/2010 - 2 2420 | 0lor7 | oo kKs-cAL-01-00] 10
Focel Nazev - reamer Pelatevar Material kenecny/fvychozi [T, odp.[ C.hmet, Hr.hmot Coongkr. Poz
fusy ! oep. : : : : sesiawy
Muen - . . . ) . R ow )
tity Title - size Blank End mogderial/Material Weaighd welght Drawing asm. Mo, |Fos
Datum Imeng AMame Datum Name
Kreslil| . _ Techng-
DWh. I5-Sep- 10| NOVAK Jun logis]
Prezk.| Prezk.
ZLHE FLHK
S hyal Schval.
2APP ~APF indexSNaSchval o] Fhppr . popis Imenyichange Dotum | PodpiséHame
Methode 1 ] Paznamha Hole:
WSEORECME TOLERAMCE 150 BOOMS 150 Z748mK
10 128 G@ GENERAL TOLERANCES 15O BOOTS 1S 2768mK
- JASM-T - )
Soubor-model AASM-file Wi7 | Meritho / Scale Esziﬁgﬁyrﬂjo‘ KKS-CAE-01-00
Soubor-vykres/ORW - file 2 I
N A
i
CAE Nazev # Tille JUTSL0 WIRRESU /URAW ING NO. FSUF;E“
I

KKS

NUZ

JListsheet 1

pocet Listus no.sheets 1

KKS-CAE-01-10

3
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| SOMETRICKY POHLED BRABENY BRIT

%v\m HF &/

o ;m

— - TRAJEKTORIE OBRABENI BRITU FREZOU @ |0mm
OSTRI KALIT NA 50+2 HRC

XX-11

C.M. 03/2010 ‘ 4 2R | a0 KKS-CAE-01-00] 10
vMMMp Nézev - rocmer Polo-evar Ma-erial <onecny/vichoei [ .odp.[ C.hmot. fr.hmet| Ou,o”.an& Po¢
nﬁy Tit e - size Blark End material/Material Weight suqul D-awing asm. ho.|Pos

Jatun Jmeno. Jatum Name |
5-Sep-IC| NOVAK Jan
/APP index/NgScheal il fAppr pepis zmely/chonge Datum | Podpis/Name
Mettode 1 Poznamka/Note.
— s VSEOBECNE TOLERANCE IS0 80015 IS0 2768mK
130 129 ‘vf? % GENERAL TOLERANCES IS0 80215 ISOD 2768nK
o "ASM-fi i zl 3 vy / s
SoLbar-nocel /ASM-file NUZ 12. ko / Stele Mmmmmﬂwm&zW {KS CAL 21 €€
SoLbar-vses IRV ~file 2:1
NUZ
— < . — n
Hazes 7 Tifla CI1SLD VYKRES) /ORAW INC NO. Format
CAE NUZ KKS-CAE-01-10 | 5
S List/steot 1 pocet Listu/ no.shests | /
i,

2 3 4 5 [ 6 [ 7 | 8 [ 9




CVICENI XXI

CIL

Tvorba vyrobniho vykresu obrabéni souéasti téla mlynku na maso.

( mll 1 =
__._:ﬁ.__ T
1 !
|
— Jf - cl—f L&g_‘ v v w— v — *‘lc
Y. I =)
N\ 4
TN i
WiE li 1T
N B %*' i =5
S u 'l --‘l ‘
| il
w i il
: 3 T -
‘ W
| N ]
— o~
o =
T i i
o = ]
¥ i /o I
{ £ | &\-\_\_\_ 1 bt ;
( = ) ‘j‘ 3
D:D ; : — |
PREDPOKLADY

¢ Vymodelovany nebo stazeny model soucasti TELO ze sestavy mlynku na maso.
e Znalosti zaklad vytvareni vykrest z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v lomeny fez

XXI-1




Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Otevrete soucast telo.prt (instance: OBROBEK).

2. Kliknéte na N , vyberte Drawing, Name: telo-obrobek.
3. Déle zvolte Empty with format a po kliknuti na vyberte a0_v1_sestava-uni.frm ze seznamu.

Krok ¢.2 Vytvoreni pohledd

4. Vytvorte zakladni pohled * General (na obrazku cervené) jako pohled PRAVY.
5. Promitnuté pohledy vytvorte dle obrazku a pojmenuijte je.

BOKORYS

Krok ¢.3 Lomeny fez

SETUP 3k PLM

Model Lse Prew

6. Prepnéte se do rezimu tvorby modelu. w %3EC OPTS
7. Vytvorte fez, nazvéte jej: B.

8. V Menu manageru zvolte Offset a potvrdte Done.
9

1

. Vyberte rovinu NARYS.
0. Jako referenci vyberte rovinu PUDORYS. a nastavte ji jako TOP.

Flanar

Top
Baktan
Zone Right
One Side Left
Both Sides Default
i
Done
ik
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11. Doplrite do referenci rovinu ROV_NOHA (obr. vpravo).

12. Nacrtnéte skicu, jejiz horni polovina lezi na roviné
BOKORYS a dolni polovina lezi na roviné ROV_NOHA
(viz obr. vlevo).

13. Potvrdte ¥ .

» Tim jsme vytvofili lomeny fez B.

References

F2(PUDORYS)
F1[BOKORYS]
FEIROV_MOH)

Select| |Jze Edge/Offzet W

Replace Delete Salve

Reference status
Fully Placed

Cloze

Krok ¢.4 Vytvoreni fezd

14. Ve View Manageru e vytvorte fez A rovinou NARYS dle obrazku.
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15. Vytvorte fez C rovinou PUDORYS dle obrazku.

B DATUM PLANE

| Placement | Displa_l,l|

| Properties |

References

MARYS:FIDATLIR
A_T12(AxISEF132HO... Through

E Parallel

Offzet
Tranzlatior
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17. Vytvorte fez D rovinou ROVINA_DIRY dle obrazku.

Krok ¢.5 Pomocna osa

18. Vytvorte pomocnou osu /" dle obr.

» Osa bude prochazet stfedem oblouku definovaného skicou Cervené zobrazenou na obrazku.

19. Osu nazvéte OSA_ROZESTUPU_NOHOU.
20. Vrat'te se zpét do rezimu tvorby vykres(.

B DATUM AXIS

Flacement | Display " F'ru:uperties|

References

Edoge:F72[Swept Blen...

Center

Offzet references
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Krok ¢.6 Rezy

21. Pohled NARYS zobrazte v fezu A (viz obr.).

22. Zménte zobrazeni na: No Hidden a zobrazeni tangentnich hran na: None.
23. Skryjte skeletonové krivky zobrazené modre.

\l.) Nejlépe je skryjtete tim, Ze je vloZite do jedné vrstvy(layer) a tu poté skryjete (probrano v predchozich cvicenich).

XXI-6




24, Pohled BOKORYS zobrazte v fezu B (viz obr.).
25. Zménte zobrazeni na: No Hidden a zobrazeni tangentnich hran na: None.

)

4 :\

g-B

26. Pohled HORNI zobrazte v fezu C (viz obr.).
27. Zménite zobrazeni na: No Hidden a zobrazeni tangentnich hran na: None.

C-G
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28. Vytvoite promitnuty pohled REZ.

29. Zobrazte pohled REZ v fezu D.
30. Poté vytvorte detail diry D v tomto pohledu (dle obr.) a pojmenujte jej DETAIL_D.

b-0
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31. Ve vlastnostech pohledu (pravym tlacitkem na pohled a Properties) prepnéte typ modelu na General.

> Tim z detailniho pohledu v fezu udé&lame hlavni pohled nezavisly na ostatnich pohledech. Nyni mdZeme smazat pohled REZ,
jelikoz jej dale nebudeme potfebovat.

32. Smazte pohled REZ.

|| Drawing View
Categories Yiew type
isible Area | Wiew name |DET.-’-‘«IL_D |
Scals Type | General Vl
Sections
Wiew States Wiews orientation
\D-"ln_aw Display Select orientation method (%) Wiews names from the model
.fi‘n.lrigrl'ur;nent () Geometry references
() Angles
tModel view names Default orientation
| Uzer Defined v |
Standard Orientation ~ * angle __1 2000
Default Drientation | -
BE E " angle | 200.00
BOKORYS |
COLMI
kL

Krok ¢.7 Prirezy

33. Vytvorte pomocnou osu /" dle obr.

» Osa bude prochazet stfedem oblouku definovaného skicou Cervené zobrazenou na obrazku.

34. Osu nazvéte OSA_ROZESTUPU_NOHOU.
35. Vrat'te se zpét do rezimu tvorby vykres(.

B DATUM AXIS

Flacement | Display " F'ru:uperties|

Feferences

EdogeF72[Swept Blen... Center

Offzet references
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36. V fezimu modelare vytvoite rovinu ROVINA_E dle obrazkd.

B DATUM PLANE

Flacement | Dizplay || Praperties

References

ROV_STOLL:F133[0ATUM P Offset
0SA_ROZESTUPU_MOHOU:... Through

Offget

Fotation (135,00 A

37. Vytvorte fez E rovinou ROVINA_E (viz obr.).
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38. V fezimu modelare vytvoite rovinu ROVINA_F ve vzdalenosti 35mm od roviny PUDORYS (viz obr. vlevo).
39. Vytvorte fez F rovinou ROVINA_F (viz obr. vpravo).

40. Vytvorte fez G rovinou ROVINA_G (viz obr.).
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41. Vlozte pohled Revolved, kliknéte dvakrat na pohled pravy pro umisténi prirezu.
42,V okné Drawing View vyberte fez E a potvrd'te . &= )

43. Aligment reference zvolte osu OSA_NOHY a potvrd'te .

[
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45. Ofiznéte dle obrazku.

44, Na zalozce Visible Area vyberte View visibility:

Partial View.

(

Drawing View

Categories
Type
Visihle Area | Wiew name |revolved 17
Scale

View type

Type
Wiew States Revolved view properties
View Display | Crogscection F
Qrigin
Aligrment Alignment reference | Selact item

46. Vytvorte novy pohled Revolved.
47. Poklepejte na pohled NARYS.

48.V menu Cross-section vyberte fez F a potvrdte .

Cloze

3
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49. Vytvorte novy pohled Revolved.
50. Poklepejte na pohled NARYS.

51.V menu Cross-section vyberte fez G a potvrd'te .

Drawing View @

Cateqgories View bype
Vishle Area | Wiew name |revolved 18
Scale Type
Wiew States Rewolved view properties
Vn_aw Display Cross-zection G w
Origin
Alignment Alignment reference | 5 elect item
‘Qf
Q- — B
|
' »J | ﬂ
I a |
Y
|
B — - — -t
Krok ¢.8 Castecny rez

>  Nyni vytvofime v pohledu NARYS dva Castecné fezy.

52. Poklepejte na pohled NARYS.

53. V dialogovém okné Drawing View pod zalozkou Sections nastavte u fezu A Sectioned Area: Local.
54. Vyberte oblast dle obrazku vlevo.

55. Vytvorte novy fez A - Sectioned Area: Local a oblast nastavte dle obrazku vpravo.

N fer
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Krok ¢.9 Izometricky pohled

56. Vytvorte izometricky pohled dle obrazku v méfitku 1:1 a s popiskem, umistéte jej v pravé spodni Casti vykresu.

IZOMETRICKY POHLED

Krok &.10 Uprava pohledd

57. Proved'te nasledujici Upravy u vSech pohledd: upravte hustotu a orientaci Srafli v fezech a prifezech, promitnéte
osy dle obrazkd, nastavte zobrazovani tangencialnich hran na : CENTERLINE.
58. V pohledu PRAVY zobrazte Cary fezu A a D (viz obr. vpravo). D
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B a C (viz obr. vpravo).

cary fezu

vz

59. V pohledu NARYS zobrazte

I
o8

1T 1]

B-B
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60. U izometrického pohledu nastavte zobrazeni tangentnich hran na: SOLID.

IZOMETRICKY POHLED |ZOMETRICKY FOALED

Krok ¢.11 Okotovani, tolerance a drsnosti

61. Okotujte, doplite tolerance a drsnosti, vse dle obrazkd.

77 5HE
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Krok ¢.12 Uprava razitka a pozndmek nad razitkem

62. Razitko vcetné poznamek vyplnte dle obrazku.

Stav pri dodani: nemastne, bez Delivering condition: Freely
trisek, bez oleje a cizich teles of o1l and foreign pileces
Nekotovane radiusy R Not indicated radius RI

C.M. 0472010 L2 2420 001 1,299 KS-CAE-01-00 | 0
PESEL Nazey - rozmer Polotovar Material komecmysvychozi |T.odp.| C.mor.  |Hr.imor. Csegigx Poz
BUT?P\; Title - size Blank End material/Material Weight \ES\’SM Orawing asm. Ho. |Pos

Datum Jmeno/MName Oatum Hame

oot m-sep-10 | Novak Jan | TG
Prezk. Prezk.,
ACHK /LHE
Schyal Schval.
7APR ZAPP index /Mo| Schvalil-Appr., popis zmeny/change Datum Podpis/Mame
Methode 1 PoznamkasNote:

150 128 g@

VSENBECME TOLERANCE IS0 800

GENERAL TOLERANCES 150 80015

15 150 ZT768mHK

150 2768mK

Soubor-model ~ASM-file

Soubor-wykres /DRW -fiLe

OBROBEK
TELO-0BROBEK

C.gestavy /
Ascembly No.

Meritko v Scale

KKS-CAE-01-100

Z2:1

- hp s
- e

CAE
KKS

MNazay / Title

TELO

CI5L0 VTKI?ES-U AORAW NG MO

KKS-CAE-01-12

Lictroneer | pocet Listus no.cheets |

Format
SIZE

0

XXI-22




D-D
sl

%

%
\
\ \

P 1
4 :
3 i

% g !
Wl

X
S
==

ws-casore |

XXI-23




CVICENI XXII

CIL

Tvorba vyrobniho vykresu Sneku mlynku na maso.

[
1

Mg T

KKS SNEK ) KKS-CAE-01-11

PREDPOKLADY

¢ Vymodelovany nebo stazeny model soucasti SNEK ze sestavy mlynku na maso.
e Znalosti zaklad( vytvareni vykrest z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

v’ Zobrazeni grafll na vykrese
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Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Otevrete soucast snek.prt.

2. Kliknéte na N , vyberte Drawing, Name: telo-obrobek.
3. Déle zvolte Empty with format a po kliknuti na vyberte al_v1_vyrobak-uni.frm ze seznamu.

Krok ¢.2 Priprava modelu pro vykres

4. Prepnéte se do rezimu objemového modelare.

5. Prepnéte strom do zobrazeni vrstev ( --> Layer Tree).
6. Do vrstvy POMOCNE_ROVINY pridejte prvky:
Wrapl, Intersectl a Intersect2 (3 Sroubovice — viz obr.).

Vytvoite novou vrstvu s nazvem GRAFY.

Vlozte do ni skicu Sketch_2 (vytvorenou v tutorialu 6, v bodé 6).
Skryjte vrstvy GRAFY a POMOCNE_PLOCHY.

0 V nabidce Layer vyberte Save status.

B©©N

+ Hidden Items
=7 B¥I5
= CLIRNE
o= DATUM_C5YS
=2 DATUM_PLAKE
o= DATUM_POINT
= GRAFY
7% F13(SKETCH_2)
= POMOCMHE_PLOCHY
o F11{KUZEL)
o F12{WALEC)
Fl4{WRAP 1)
A FIS(VAR_SECT_SWEEP_1)
F16({OFFSET 17
5 F18(INTERSECT _1)
S F17{INTERSECT _2)
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11. Pfepnéte se ve stromé zpét do zobrazeni prvki ( --> Model Tree).

> Nyni vytvofime instanci modleu Sneku, ve které budou potlaceny vSechny prvky nasledujici po prvku Sketch 2. Tuto instanci
pozdéji vyuzijeme pfi tvorbé grafu.

12.V nabidce Tools spust'te piikaz Family Table.

13. Vytvorte instanci do radku a nazvéte ji SNEK_GRAF.

14. Jako sloupce vyberte typ: Feature a ve stromé oznacte vSechny prvky nasledujici po prvku Sketch 2.

@ Family ltems, Generic : SNEK

Items Filter

F17E51, [CHAMFER_1] ~

F17EE3, B

F16721, [HOLE_1] Feature

F16813, [ROUND_26]
F1BE51, [ROUND_25]
F1BE16, [ROUND_24]
F1B607, [DRAFT_1]
F16577, [EXTRUDE 5|
F15050, [ROUND_17]
F14548, [ROUND_16] -
F14911, [ROUND_15] =

F14936, [REVOLVE_5]
F14830, [SOLIDIFY_2]
F14328, DTM2
F14E56, [ROUND_14]
F15EE4, [ROUND_21]

F12418, [ROUND_13] v
==
Add ltem
() Dimenszion ) Group
() Feature () Parameter () Pattem Table
() Merge Part () Fief Model ) Other

15. Nastavte u vSech sloupcli pro novou instanci: N (viz obr.).
16. Potvrd'te OK a ulozte model.
17. Vrat'te se do rezimu vykresu.

B Family Table :SMEK

File Edit Insert Tools
; o + |
Laak In| SNEK v ¥ 2 i f Y oo 8 B0 T
F17681 F17663 F16721 F16813 F16651 F1E616
Twpe | InstanceMame | CommenMame | -amrER 1] | B [HOLE_1] [ROUND_28]  [ROUND_25]  [ROLUND
| SNEK | snek3 prt v ¥ v v v v
SNEK_GRAF [ snekapitINST1 N M Y Y N Y
< >
o
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Krok ¢.3 Vytvoreni pohledd

18. Vytvorte pohledy dle obrdzku vlevo. Show ¥ | Laper v ][ Settings v |
19. Méfitko zvolte 2:1, pro izometrické pohledy 1:1. E NARTS =

> Pokud se budou v jednotlivych pohledech zobrazovat pomocné prvky, nejprve se = Layers
ujistéte, zda jsou v modelu Sneku skryty vrstvy GRAFY a POMOCNE_PLOCHY ¥

(viz pFedchozi krok), pokud ano, zkontrolujte vrstvy ve vykresu, v kazdém -+~ Hidden Items
pohledu zvlas't (viz obr. vpravo). ¥ @AXIS
> Pohledy u tohoto modelu maji rozsifené hranice, které se prekryvaji, a Ize s nimi + @CURVE

velmi patné manipulovat, je to zplsobeno pomocnymi prvky v modelu a bohuzel
hranice pohledd v tomto pFipadé nelze upravit.

+

7 DATUM_CSYS
2 DATUM_PLANE
2 DATUM_POINT

+

+

20. Doplrite kéty, osy, tolerance a drsnosti dle obrazkd.

0.8

EL
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1145

158.5 m
%\ 15 jf
6.3

I o .
= 1 J4 L i L
<
2|
60. 7 | AL SECTIoR— 1 2.5
85.¢ | A5 4]
1033 o
124.9 QQ
14118
Krok ¢.4 Rucni dokresleni pohled(

>  Nyni doplnime rucné kreslené elementy do modelu (Sipky, znacky pro délici rovinu)

21. Aktivujte nasledujici ikony: (<, %4,

22. Nakreslete pomoci funkce ™ oblouk dle obr. vievo (promitnéte libovolny prvek pro umisténi oblouku).
23. Sipku nakreslete pomodi ti usedek .

24. Vlozte textové pole E obycejné a napiste do néj pouze znak b, potvrdte a ukoncete Done/Return.
25. Poklepejte na tento znak a v zalozce Text Style vyberte v kolonce Font: Symbol. (viz prostfedni obr.)
26. Natoceni Angle zvolte 315° (viz prostfedni obr.).

> Vysledna kéta je vidét na obrazku vpravo.

Tewxt | TextStyle

Copy from
Style name | Default w

Existing text | Select Text...

Character
Fant T Symbal w
Height Default  Slant angle | 0.000000
Thickness Default ] Underline

‘Wwidth factor [ keming

Maote/Dimenzsion
Horizontal| Drefault | Line spacing Default

Wertical ] Hirror
Angle EREE. no000C [] Break crosshatching

Color @ b argin

[ Preview ] [ Reset

XXII1-5



27. Obdobnym zplsobem dokreslete dalsi pohled dle obr.

28. Pomoci Usecek vytvorte v mistech dle obrazku dvé znacky délici roviny a vypliite je piikazem Fill/Hatch ¢ervnou
barvou.

|

=
7@
~ e
K‘b

b, 4 h, 4
A | A
= -
A | , % %%
5. 6.3 - T j e
L
36
29. Vytvorte dvé Cary typu centerline dle obrazkd.
114.5
94.3 ) i
Copy Fram 13.5 ) |
Style centerling A 18 _rL_____#
. - h o 1
orming e 3 |
. 45 1
Aftributes o 15
6.3
LineFort |CTRLFONT v W '
I % P
width g / | @
|
Color @
=
Maodel Edge Options o o |
&
80,7 AT SECTI{%N | 2.5
55.2 :
[ Apply ] [ Cloze ] [ Reszet ] 103.8 ‘I‘ -~
124.9 <
147,18
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30. Pomoci Usecek vytvoite v mistech dle obrazku znacky délici roviny a vyplrite je pfikazem Fill/Hatch Cervnou

barvou.
1145
94.3 |
13.5 N
13
n ' __,__+4__,_J_~——44——=—~——44'—1
) 15.5 . gﬂyll |
2 15 ]
\“\ ‘ 6.3 o3
- | | o ] ~
= | ‘ f ¢ =
B o | |
- T pd '
!
60.7 ALL SECTTON ‘I+ | 12.5
852 »o AR
103.8 ! -
1249 <
147.18
Krok ¢.5 Grafy

> Ukazeme si dva zplsoby, jakymi Ize vloZit graf (respektive skicu) z modelu do vykresu.

>  Prvni zplisob bude vloZeni grafu pomoci ptikazu Insert-->Graph. Tato metoda mé tu nevyhodu, Ze graf jiz nelze jakymkoliv
zplsobem na vykresu upravovat, pouze ménit méfitko a presouvat koty.

31. Spustte ptikaz Insert-->Graph...

32. Nyni kliknéte kamkoliv na vykres pro umisténi grafu do tohoto mista.

33. Poklepejte na graf a zadejte méfitko 3:1.

GRAPHI
3l

\l/ Systém vas nevyzve k zadani grafu, jelikoZ v modelu byl definovan jen jeden (GRAPH1)

34. Promitnéte do grafu koty z modelu i

25

20

]

10

N

GRAFHI
K3

Th
A
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35. Upravte rozmisténi két dle obrazku. 1 10

3
/\Z .

> Vzhledem k tomu, Ze do grafu nelze pfidat dalsi koty, budeme muset nasledujici popisky pridat textové.
36. Pridejte do grafu text zobrazeny cervené na obrazku.

37. Pridejte do grafu Sipky (viz obr.), bud’ je vytvorte ru¢né nebo je vlozte z knihoven.

> Tim jsme dokoncili Upravu tohoto grafu.

GRAF SKLONU BOKU SNEKL

U 1V | (R
T
& a5 .
&b
/\1 - ?
b
=
=
j—
=
=
=
i
2 = =

~— POLOHA B
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> Nyni si ukdzeme tvorbu grafu pomoci skici, kterou si promitneme do vykresu a nasledné zakétujeme a doplnime textem.
> Zacneme vlozenim nového pohledu modelu instance SNEK_GRAF.

38. Kliknéte pravym tlacitkem na prazdné misto modelu a z kontextové nabidky vyberte Properties.

39.V Menu Manageru zvolte Drawing Models-->Add Model--> Snek.prt-->zvolte instanci SNEK_GRAF.
40. Potvrd'te Done/Return.

Drawing Mo

Menu Manager

Drawing Options
w FILE PROPERTIES

Tolerance Standard
Drawing Models Done/Return
Drawing Options

Tolerance Standard

Done/Return

Del Madel
Set Model

Remove Rep
Setfadd Rep
Replace
Madel Disp

41. Aktivujte instanci SNEK_GRAF.
42. Vlozte pohled, nazvéte jej graf a vyberte pohledovou rovinu ZADNI (viz obr. vpravo ).

43. Méritko tohoto pohledu zvolte 0.7 (neni nutné volit normalizované).
» Zobrazi se krivka (viz obr. dole), tuto kfivku nyni zakétujeme, pfiddme osy a popisky os.

Drawing View

Categories Yiew type

Wiew Tupe
Visible Area | View name | graf |
Scale
Tvpe
Sectionz ¥
Wiew States Wiew arisntation
\é'?“" Display|  5alact arisntation method (5 Yisws names from the model
MNAME 1 SNEK GRS ngin
_ SHEK Aligrment () Geometry references
SNEK_GRAF © Angles
% Model view names Default orientation
ZADNI |User Defined v
:‘E&?{S #| ¥angle |-120.00
PR&VY Ny angle 200,00
FUDORYS

Cloze
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44, Promitnéte kéty z modelu (viz obr.).

i

8
§1.6

52,6

42.z

27

12.3

147. 4

2536

47,8

439

527

00

45, Vyberte vSechny horizontalni kéty, stisknéte pravé tlacitko a vyberte Toggle Ordinate/Linear.

88

6.6

.6

qe.2

2

12,3

7.

556

4T.6

139

527

00

46. Upravte zobrazeni dle obrazku a pfidejte popisky.

47. ZvétsSete tloustku kfivky pomoci pfikazu Line Style.

@
@

=3

=S
=
=S

52.6

GRAF

FRUBEHU STOUPANT SMEKU

42.2

ro

STOUPRNT 5 —fe

2.3

141,38

255.8
T8

DELHA [ —-

439

521

600
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Krok ¢.6

Razitko a pozndmky nad razitkem

48. Vyplite

POVRCH BEZ PORU,

razitko a poznamky nad razitkem dle obrazku.

DELICT ROVINA

TRHLIN,

NEKOTOVANE RADIUSY R?

VYROBNICH ZNACEK

M. / AT - _01-
SHEK(DDLITER) LM, Q5/2010 L2 L0007 001 0.471 KS-CAE-01-00 | 0
Pocet ; . . . C.owykr,

e Ndzev - rozmer Polotovar Material konecnysvychoz i |T.odp. C.hmat.  Hr.hmat. sesiavy Poz.
Huan- . . E . . Raw ;
ity Title - cize Blank End material/Material W eight weight Drawing asm. Mo. |Pos,
Datum JmenaHame Datum Name
reslil| Techno-
D 03-Dec-10 | NOWAE Jan Log/ist
Prezk | Prezk.
AL HK ALHE
Schval Srhval .
PP PP indexsMo| Schvalit/appr. popis zmeny change Datum | Podpic/Name
Methade 1 PoznamkasMate:
VEEOBRECHE TOLERANCE 150 BOOS 150 2TaémK
IS0 128 £ |€8)  GEERaL TOLERANCES 150 80015 IS0 2768mK
Soubor-model FASH- File SNEK | Meritho / Stale E;Ss.zsrnTI?Lvnyfo. KRS-CAE-01-00
Soubor-vykres/DRW -file 2:1
SHEK X
Nazer ¢ Tille CISLO VYKRESU /DRAW ING ND. Format
CAE SNEK KKS-C AE-01-11
S Listrchoet 1 pocet Listu/ no.shests 1 /‘
Krok ¢.7 RozlozZeni pohledd
49, Upravte rozlozeni pohledd dle obrazku.
1 T T 1 T 5 . T T [ T T T BI I k] k7] T ] T T T 1)' T kT T if T ¥
a &
¢l

LI

GRAT PRUBEHU ST00PAM SRENI

2.6

a2

i

STORMI 3 —ie

1z

[TIR]
255
FIEN]

Fe

121

a0

[ITH3

w TTA

[T

GRAT SaLonl B0ny saCn
10 I

o 5|y

3

o

!

ant
L'
r

et FOLOHA

* PELIGI Feplud

FOVRUH BIZ Fofn, TEML I, YAA0BRICH DRACER
NEROTOVANL FADIISY F2

— (=] = O[O
—T1 [ =
ams [ I = [===— =] — [———
T T T T T
= [ e = T - !
] H I —
| — = - i
== ——
= gy ==——
H|
& | I
SHER FHS- LAE-DI-11
KKS = ——1 1
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2
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CVICENI XXIII

CIL

Tvorba sestavového vykresu mlynku na maso a katalogového listu véetné Sablony.

{ ,‘: ‘ g { éﬁf}@%& Q\\/

PREDPOKLADY

e Seskladany model sestavy mlynku na maso dle tutorialu ¢.11.
e Znalosti vytvareni vykresl z predchozich cviceni.

PROBIRANE PRVKY, FUNKCE A POSTUPY

Tvorba Sablony vykresu
Tvorba vykresu sestavy
Vytvareni pozic
Kusovnik

Tvorba tabulky

SNENENENEN
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Krok ¢.1 Vytvoreni prazdného naformatovaného vykresu

1. Otevrete sestavu sestava_mlynek.asm.

2. Kliknéte na N , vyberte Drawing, Name: sestava_mlynek.

3. Déle zvolte Empty with format a po kliknuti na vyberte al_v1_sestava-uni.frm ze seznamu.

Krok &.2 Uprava modelu

4. Prepnéte se do rezimu objemového modelare pro editaci sestavy SESTAVA_MLYNEK.ASM.

5. Vratte se v historii pfed vlozeni komponenty KLIKA.PRT (viz obr. vlevo).

6. Editujte vazby komponenty SNEK.PRT (pravym tlacitkem na komponentu-->Edit definition).

[T] SESTAYA_MLYMEEK, ASM
£ F SEST_BOKORYS

£ F SEST_PUDORYS

£F SEST_MARYS

2% SEST_CS0

[0 TELO-DOERCEEK PRT
[) SMEK.PRT )

F

F

[ "ELIEA.PRT
[l "sROUB_KLIKY ASM
[0 "MUZ.PRT

1 "RUKCIET.FRT

[ "oSICKA.PRT

[0 *"T¥CEAPRT

(] "SITEC.PRT

(] "WICKOPRT

(] "sROUB.PRT

(] "POOLOZEA.PRT

[ O s e Oy Oy O B

Odskrtnéte polozku Allow Assumptions (viz obr. vlevo).

Vytvorte novou vazbu dle obrazku a potvrdte (.
Vrat'te se v historii zpét na konec.

vsimnéte si, 7e v disledku pozmé&néni vazeb jsme zménili pozici natogeni kliky.

vV ©® N

= Setl [User Defined | Constraint Enabled = Setl [User Defined )
| aign
g SNEK0Se ZF7paTD| || Constaint Tupe Mate
2 TELO-OBROBEK:0%A © Align W Mate Angle
Mates Oifest 24 SNEK:NARYS:FADATU
Mew Constraint m % SEST_PUDORYS:F2[D

Mew Congtraint

Statuz
[ allows Azzumptions
Fartially Constrained

Mew Set Mew Set

Constraint Enabled

Canstraint Type

_IL M ate W

Offzet
[ Argle Offset v || 0.00

Status
Fully Constrained

w
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> Vytvorte Fez B rukojeti kliky dle obrazku.

> Vytvorte fez C dle obrazku.
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Krok ¢.3 Pohledy

10. V modelu vytvorte pomocné pohledy dle obrazkd.
11. Vytvorte pohledy dle obrazku.
>  Skryjte pomocné elementy pomoci skryti vrstev: GRAFY, MALY_TROJUHELNIK, OSY, OSY_POMOCNE,

POMOCNA_GEOMETRIE, POMOCNE, POMOCNE_PLOCHY, POMOCNE_ELEMENTY, TRAJEKTORIE, SKICI a dalSich, které jste
vyuzivali pro pomocnou geometrii.

12. Méfitko zvolte 1:1, u izometrického pohledu 7:10.

[ ——
W

JJ"|:\
Ve

f»'

H
- _ @
\,________\ / \ / . [IZOMETRICKY |
d e e

—_—
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14. Vytvorte pohled PUDORYS, ofeZte zobrazovanou oblast a zobrazte jej v fezu C dle obrazku.
15. Méfitko zvolte 2:1.
16. Upravte Srafovani a volbou Exclude vyfadte SROUB_KLIKY z fezu.

@ [

A

C-C

20

17. Promitnéte do modell osy, doplnte koty dle obrazka.
18. Upravte Srafovani, volbou Exclude vyrad'te soucasti SROUB, SROUB_KLIKY, SNEK a OSICKA z iezu.

237

%@%

133

=

C

WA 40
WIN, 20

i
[
153

A-A
B-B
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Krok ¢.4 Trajektorie kliky a rukojeti

> Do pohledu BOCNI zakreslime ¢ast trajektorie pohybu kliky ruéné pomoci obloukd
19. Aktivujte nasledujici ikony: 2&, Ré),
20. Pomoci funkce Y nadrtnéte oblouk dle obrazku (podrobnéji viz predchozi tutorial).

21. Stejnym zplsobem naskicujte dle obrazku i druhy oblouk.
22, Pohled zakétuijte dle obrazku.

T e —
//F -"'Hf‘_
~ f/'
ol
-‘?.fl;{ / .-’/
N A
P/
Jlll.f ff% [
;o]
)
||
P!
Vot
VoY
A
VN .

> Nyni si ukdZeme, jakym zplsobem Ize dokreslenou geometrii pfifadit k danému pohledu (coZ nam zajisti, ze p¥i posunuti
pohledu se posune i dokreslena geometrie - v nasem pripadé oblouk.)

23. Vyberte oba oblouky a v menu Edit-->Group-->spust'te prikaz Relate to View.

24. Vlyberte pohled, ke kterému se maji oblouky pfifadit.

\l‘) V menu Edit-->Group najdete i pfikaz Draft Group, ktery slouZi k provazani nacrtnuté geometrie k sobé.
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Krok ¢.5 Krajni polohy kliky a rukojeti

25. Prepnéte se do objemového modelare.
26. Definujte rovinu prochazejici dvéma piimkami: pfimkou OSA_Z soucasti SNEK a osou OSA_Z soucasti RUKOJET
(viz obr.).

-
-

N

G

-
il
i

>  Vytvofime fez D vedeny soucasti RUKOJET rovinou ROVINA_REZU_D.
27. Definujte fez D, v Menu Manageru prepnéte volbu na One Part (viz obr.).
28. Potvrd'te Done, potom vyberte souc¢ast RUKOJET a nasledné rovinu ROVINA_REZU_D.

Model
Model & Qlks
Surf Quilk

one Part

Flanar

Zone

Done

it
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29, Spust'te piikaz ~ Curve.

30. V Menu Manageru vyberte volbu Use Xsec a pokraCujte Done (obr. vilevo).
31. Déle vyberte nazev fezu D (prostredni obr.).

>  Vytvori se obvodova kfivka soucasti v fezu (viz obr. vpravo).

32. Kfivku pojmenujte KRIVKA_KLIKY.

¥ CRY CRTIONS w ¥SEC NAMES
Thru Paints Names
From File o
C
Fram Equation B
Done A
it

33. Vyberte kfivku KRIVKA_KLIKY.

34. Zkopirujte tuto kfivku do schranky (napt. kombinaci CTRL+C).

35. Spustte prikaz Edit-->Paste Special...

36. Aktivujte moznost Apply Move/Rotate transformations to copies (viz obr. vlevo) a potvrdte.

37. Ve spodni listé aktivujte moznost rotace |£| a poté vyberte osu OSA_Z soucasti SNEK.

svvs

I= Paste Special @

Dependent copy
Apply Move/Botate transformations to copies

Advanced reference configuration
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39. TentyZ postup opakujte a vytvorte takto skicu v krajni horni poloze (viz obr.).
40. Rotace od kfivky KRIVKA_KLIKY do horni polohy je ziejmé 140°.

> Vysledny stav Ize vidét na obrazku.

>  Nyni musime zajistit skryvani/odkryvani t&chto kfivek v jednotlivych pohledech sestavy, z tohoto dlivodu vytvofime dvé
vrstvy, které budeme poté skryvat na vykrese.

41, Vytvorte vrstvu KLIKA-POMOCNA a vloZte do ni kfivku KRIVKA_KLIKY.
42, Vytvorte vrstvu KLIKA-MAXMIN a vloZte do ni dvé zkopirované kfivky.
43, Obé vrstvy skryjte a ulozte tento stav zobrazeni pomoci volby Save Status.
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44. Pfepnéte se do rezimu vykresu.

45, V pohledech, ve kterych jsou zobrazeny nové pridané skici je skryjte pomoci vrstev. Ponechejte je zobrazené
pouze u pohledu PREDNI.

46. V pohledu PREDNI zakoétujte nové vytvorené krivky dle obrazku.

32

17l

e )
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ﬁ
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Krok ¢.6 Pozice

> Nyni vlozime do vykresu sestavy pozice jednotlivych komponent.
47.V menu Table --> spustte ptikaz BOM Balloons...
48.V Menu Manageru kliknéte na moznost Custom a poté kliknéte na kusovnik (obr. vlevo).

»  Tim urcite aktivni kusovnik, ze kterého budou generovany pozice. Pokud byste potiebovali tento postup vratit, vyuzijte
pfikazu Clear Region v Menu Manageru.

49. 7 nabidky GET SYMBOL vyberte moznost Retrieve (obr. uprostied).

> Timto postupem mame moznost vybrat vzhled pozic z knihovny. Dal$i mozny postup je vybrat v Menu Manageru vybrat
moznost Simple, ta vSak vytvofi pozice v krouzku. Vzhled pozic Ize dodatecné meénit pomoci pfikazu Change Type.

50. Vyberte z knihoven v adresafi POZICE polozku posice.sym nebo libovolnou jinou (obr. vpravo).

- BN BEALLOCM-

Set Region

o Commen Folders I:“ ll

¢ o )

w GET 5% 7] Desktop [y posice_pocet.sym
Marme & My Documents DﬁJ posice_stara. sym

DﬁJ posice_voly.sum
DﬁJ pozice_1_2 sym
E}J pozice_3.sum

Pick Inst % working Directory
Metwork, Meighborhood

Reqg Default User Syms E‘ipozice_ﬁ'.sym
i [&] System 5
Quit & System Spms File name: pozice spm Date modified: 21-Feb-04 06:38:30 Pk Preview «
Done ! -
¥ File name: |p03|c:e.sym | Type| Uszer Symbol [*epm]  » |
w BOMBAL TYPE Folder Tres - [ Open 'H Cancel ]
Simple
With Gty

Cuskam

51. Nyni pomoci prikazu Create Ballon pozice zobrazte.
52.V podnabidce BOM VIEW vyberte moznost Show All (obr. vlevo).
53. Vysku symboll zvolte 10mm (viz obr. vpravo).

Shiow Al

Custom Balloon Height

By View

By Comp Custorn BOM balloon syrmbal height in drawing units [MM]
C LR

By Record

Done/Return
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> Pozice se umisti do vykresu, obvykle do 1 pohledu, nyni je musime pFemistit do jednotlivych pohledd a upravit je, aby byl
vykres prehledny.
54. Kliknutim pravym tlacitkem na islo pozice a volbou Move Item to View presunite Cisla pozice dle obrazkd.

> Umistovani pozic Ize zjednodusit pouzitim pFichytavaci kfivky - = Snap Line.

o
e

& s,
\Q;/

e
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Krok ¢.7 Kusovnik

> Nyni si ukdZzeme zplsob editace kusovniku.

55. Pfepnéte se do rezimu objemového modelare (editace sestavy mlynku).
56. Pod polozkou Settings spust'te prikaz Tree Columns... (viz obr. vlevo).
» Zde si mlzete nastavit zobrazeni informaci ve stromé.

57. Vyberte parametry dle obrazku vpravo a potvrdte.

Mot Digplayed Digplayed
T¥Pe | Model Params v| Order Column Name  width
1 HAZEY 10
: AUTOR
[ Show = |[  Settings = | CISL0 SEST 2 ROZMER 10
" 3 5N ]
_E' — Tree Filkers. .. POZMAMEA 4 MaT WCH 5
— TECH_CISLO
P owon
' PUVODNI_NAZEV 7 C_HMOTHOST &
8  HR_HMOTNOST 7
[°% Open Settings File... 9 CISLO_WYK B
— 10 POZICE 4
E] Save Settings File, .
< | ®
Name width [0 ]
I 0K ] [ Apply ] [Eancel]

> Nyni se ve stromé zobrazi tabulka, kterd zhruba odpovida tabulce v kusovniku. Jednotlivé polozky mGzete libovolné
pfepisovat, pouze u prazdnych poli musime nejprve definovat format hodnoty, kterou budeme zadavat, bézné budeme
vyuzivat typ String (textové pole). Do polozky Value pak zapiSeme vlastni hodnotu pole (viz obr.).

I= Parameter Properties fz|

M ame

Type
| String w |

Walue
142 242 |

I rits

| o

Optionsg
[] Designated

Access

‘ @Etl'hFuII w |

Source
|Usel-Defined |

D ezcription

I Ok l [ Cancel ]
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58. Vyplnite tabulku ve stromé dle nasledujiciho obrazku.

MAZEY ROZMER CSh MAT _WYCH  MAT_KOM

TELO C.M. 042010 CDLITEE 42 2420 -
SMEK .M, 05/2010 CDLITEE 42 2420 -
ELIKA C.M. 082010 CDLITEE 42 2420 -
SROUB_KLIKY -- SWAREMETC -—-- -
MUZ C.M, 03/2010 CDLITEE 42 2420 -
RUKCIET KR 32-80 DREVO - DUE  ----
OSICEA KR 12-90 CSM 425510 11373 -
TYCRA KR. 2.5 - 30 CSM 425510 11373 -
SITKD PRUMER. 55 - 7 CSM EN 10088 “46Cr13 -
VICKC C.M, 0z/2010 QDLITEK 42 2420 -
SROUB KR 12 - 180 SN 425510 11373 -
PODLOZEA P1 - 500 1500 C3M 425301 11 500 -

T_ODP C_HMOTRCST

1.299000
0.471000
0, 207000
0.015000
0.017000
0.048000
0.015000
0.001000
0.061000
0.162000
0.082000
0.005000

HR,_HMOTHOST  CISLG WK

POZICE

KK3-CAE-O1-12 12
KK3-CAE-O01-11 11
KK3-CAE-01-03 3

KKS-CAE-01-08
KK5-CAE-01-10
KKS-CAE-01-07
KK5-CAE-01-05
Kk5-CRE-01-06
KK3-CAE-01-01
Kk5-CRE-01-09
KK3-CAE-01-04
KK3-CAE-01-02

oo
=

| T Y T L B

59, Prepnéte se zpét do vykresu sestavy a prohlidnéte si kusovnik.

60. Doplrite chybéjici Udaje v razitku a poznamky nad razitkem dle obrazku.

PRED MONTAZI QCISTIT, ODMASTIT,

LAVITY MAZAT POUZE ZIVOCTSNYM TUKEM

IBAVIT OTREPU A JINYCH NEZADOUCICH TELES

TELO
1 LM 0L 22010 OOLITER B2 2420 ——— 1.299 ERS-CAE-01-12| 12
SNEK
YIE M. 052010 ODLITEK 42 2620 | 0T KKS-CAE-01-11] 11
MUZ
TIEM. 032010 ODLITEK &2 2420 —-e= | 0017 KKS-C AE-01-10 | 10
WICKD
T oM, 027070 ODLITEK 42 2620 R LY KES-CAE-01-09] 9
1 [SROUBKL (kY SYARENEC | 00 KKS-CAE-01-08| B
RUKOJET )
T1kR 32 - 80 DREVO - DUB |- | 0,048 KKS-[ AE-01-07] 7
TYCKA
1 . - -
1 KR 2.5 - 10 CSM 425510 1 373 0,00 KES-CAE-O1-0a&] &
OSICKA
YRR 12 - o0 L3N 425510 11 373 - | D015 KKS-CAE-071-05| §
SROUB
kR 12 - 180 LN 425510 1373 | 0089 KKS-CAE-01-04 &
BLIEA
TIEM, 062010 ODLITEK 42 2620 - | zo7 KKS-CAE-01-03 | 3
PODLOZK A
TP - 500 « 1500 (SN 425301 11500 ——-- | 0.005 KKS-LAE-01-02 | 2
SITRD
" [PRUMER 55 - 7 (SN EN 10058 Kablrid - | D061 KKS-LAE-01-01] 1
PE;:L Mirey - rozmer Folatovar Maker ial T.odp. | C.bmel.  Hrbmab, | Cislo vykresu  |Poz
"1'?,';',( Title - size Blank Mater ial W eignt u?:iﬁm Drawing bo.  |Pos.
Oarum ImangAame Datum Mame
firen il 3-Oec-10 | NOvAK Jan | [ETRE
Prezk. Frezk.
ATHE A HK
SChval Schval.
SAPP SAPP indea Ma | Scheal il #&ppr. popis menyschange Oaium Podpis AMame
Methode 1 PornambiasHote:
SEOBECHE TOLERAMCE 150 24015 150 2768 f
150 128 £ 48 Ginchal TOLERANC S 190 BOOR 190 2hebmh e we 6717
Soubor- model AA5M- File SESTAVA_MLYNEK | Meritko < crde i;ﬁ:gﬂ“’;_ —
Soubor-wekress0RW -Fila 1:1
SESTAVA_MLYNER s
C AE Nazev # Tifle EISLE ¥ IRRESL LA NG MO, F;Ir;,;r
KKS SESTAVA MLYNEK KKS-CAE-01-00 1
bicisneer 1 potet Listus no.sheets
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Krok ¢.8 Tvorba Sablony vykresu

» Vytvofime Sablonu katalogového listu, ktera bude obsahovat nadpis a tabulku se seznamem soucastek.

61. Kliknéte na N vyberte Format, Name: format-katalog_list.
62. Potvalte 0

63. Déale zvolte Empty, Landscape, A1l a potvdte

Sub-tupe _

Sketch Specify Template

Part : _

B () Emply with section
O [T Assembly @ Emply

Manufacturing

Drawi Orientation

rawing
® E;} Farmat D D I?z?
O [ FReport Portrait | Landscape|| Wariable
O =& Diagram Size
O £] Layout Standard Sizelm v|

O @ Markup

Mame format-katalog_list

Carnmon Name | |

> Nejprve musinge upravit nastaveni vychoziho pisma, toto nastaveni je bézné obsazeno v Sabloné, kterou pouzivdme pro
tvorbu vykresu.

64.V menu File spust'te ptfikaz Properties.
65. Editujte polozku drawing_text_height na hodnotu 3.59 (dle obr.).

66. Potvrd'te a poté OK.

Shawing: Sait
| Active Drawing | By Categary w |
Walue Default Status Dieccription
Active Drawing
(= These options control text not subject to ather options
] i 0 B T
text_thickness 0.000000 0.000000 & Sets default tert thickness for new text after regeneration and existing test whose thickness has not been modified. The walue iz in dra
texl_width_factor 0.800000 " 0.800000 & Sets default ratio between the text width and text height. The spstem maintaing this ratio until you change the width using the Text Wid
draft_scale 1.000000* 1.000000 & Dietermines walue of diaft dimensions relative to actual length of diaft entity on diawing,
= These options contral text and line fonts
default_font famt fant L Specifies a font index that determines defaulk text fonts. Do not include the " ndx" extension.
(= These options control leaders
draw_armow_length 0187500 0187500 & Sels length of leader ine amows.
draw_arrow_style clozed ™ clozed & Controls style of arow head faor all detail ikems involving arrows.
draw_arrow_width 0.062500 ¢ 0.062500 & Sets width of leader line amows. Drives these: "draw_attach_sym_height," draw_attach_sym_width." "'draw_dot_diameter."
diaw_attach_spm_height DEFAULT * default Y Sets height of leader line slashes, integral signs. and baxes. If set to "default.” uses value set for 'draw_arrow_width."
draw_attach_sym_width DEFAULT * default @ Sets width of leader line elashes, integral signs, and bowes. [f set to "default,” uses value set for draw_arow_width."
draw_dot_diameter DEFALLT * default & Sets diameter of leader line dats. IF set to "default,” uses value set for "draw_amow_width."
leader_elbow_length 0.250000" 0.250000 L 3 Determines lenath of leader elbow [the horizontal leg sttached ta text).
(= These options control tables, repeat regions, and BOb
sort_method_in_region defimited * delimited & Dretermines repeat regions sort mechanism. String_only - sorts slphabetically. Trailing_numbers - logically evaluates traling numbers [ie
= Miscellansous options
diaft_scale 1.000000 " 1.000000 & Determines value of draft dimensions relative ta actual length of draft entity on drawing
drawing_units mm = Sels units for all drawing parameters
line_style_standard std_ansi ” std_ansi & Controls test color in drawings. Unless zet to "std_ansi,” all drawing tests are displayed in blue, and boundary of detailed views in yello
node_radius DEFAULT * default & Sets the size of the nodes displaved in symbols.
sym_flip_rotated_text ha no @ IF zet to "pes," then for new symbol definiions which allow rotation of text, by defaulk any text which is rotated to be upside doven vill b
yes no_parameter_display tiug_false * tue_false & Controls display of "wes/no" parameters in diawing notes and tables. Wwhen set to "yes_no," parameters use "yes' or "no™. "tue_false
< LIS b3
Option: Walue,
drawing_test_height |[35 | [Add / Change |
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>  Vytvofime jednoduchou tabulku s vypisem nazvi souéasti a jejich pozic. w TAELE CREATE
67.V menu Table-->Insert--> spustte prikaz Table.

o , . Descendin
68. Nastavte menu dle obr. vpravo a potvrdte prostrednim tlacitkem. .ﬁ.sceni
> Na vykrese se objevi stupnice, kterou vybirate Sifku bunky.
69. Na stupnici zvolte 7 a poté 20(tj. druha nula z leva) viz obr. vlevo. Rightveard
70. Prostfednim tlacitkem potvrd'te definovani fadka. Leftward
By MNum Chars
By Length
Quit
w GET POINT
123456789012345678901234567890 vertex
| On Entity
Abs Coords
Quit
>  Nyni definujeme radky.
71. Trikrat za sebou kliknéte na dislici 3. (viz obr. vievo).
72, Potvrdte prostiednim tlacitkem. (tabulka viz obr. vpravo).
[ I |
|
2
3
1N
5
> Nyni musime definovat oblasti tabulky pro vypis komponent.
73. Spust'te v nabidce Table prikaz Repeat Region... % Report Symbol (X
74.V Menu Manageru vyberte prikaz Add. asm...
75. REGION TYPE vyberte Simple. darn...
76. Oznacte dvé horni bunky a potvrdte. fam...
>V hornich burikach se zobrazi obdélnik (viz obr. vievo). harn...
77. Poklepeijte do levé bunky, objevi se okno Report Symbol (viz obr. vpravo). lay...
material...
ribr...
mndl...
mfg...
prs...
k...
weldazm...
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78.V okné Report Symbol postupné navolte asm...-->mbr...-->User Defined.
79. Nyni napiste do okénka nazev parametru: pozice.
> V tabulce se zobrazi celd cesta parametru (viz obr.).

[y

1=} 1]

&asm

mbr . pozice

= 1]

80. Obdobnym zplisobem definujte parametr v pravé horni bunce.
81. Nazev parametru v této bunce: nazev.

& sm

dbiempmbrceazey

82. Do prosttednich dvou bunék napiste text dle obrazku.

Gasm.mbrépemimbr . nazev

Pozice

Nazey

83. Drzte CTRL a oznacte obé dolni buriky.
84.V menu Table spust'te piikaz Merge Cells...

> Tim spojime obé buriky do jedné

85. Nasledné vepiste do této bunky text dle obrazku.
86. Nastavte zarovnani textu na stfed (poklepanim na text a na zalozce Text Style).

ddsm.mb

dpemimbr . nazev

Pozice

Nazey

MASOVY MLYNEK SPS 2285
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87. Do horni ¢asti Sablony napiste text: KATALOGOVY LIST MASOVEHO MLYNKU SPS 2285.

88. Zmeénte velikost fontu textu na velikost 10 (poklepanim na text a na zaloZce Text Style volbou Height).
89. Tabulku umistéte do rohu dle obrazku.

90. Sablonu uloZte.

> Tim mame pfipravenu Sablonu pro katalogovy list.

KATALOGOVY LIST MASOVEHO MLYNKU SPS 2285

i i

PR |lam

WAL NLTIEN P8 T

Krok ¢.9 Druhy list vykresu — katalogovy list

91. Oteviete vykres sestava_mlynek.drw.
92.V menu Insert spustte prikaz Sheet.

> mezi jednotlivi'mi listy se mZete prepinat poklepanim na text ve spodni ¢asti vykresu, nebo pomoci
2 rS

ovladace *1, ktery naleznete v horni nastrojové listé.
> Novy list automaticky prevzal Sablonu listu 1. To nyni musime zménit.

93. V menu File spustte prikaz Page Setup... a poté u listu 2 vyberte Browse... (dle obrazku).

94, Vyhledejte pravé uloZzenou Sablonu format-katalog_list.frm.
95, Vybér Sablony potvrd’te[ Open | a Lok |

+MODELY+ » SESTaWA MLYNEE - |*4 | |Search..

e

Comman Folders 3l formnat-kataloglisk frm
IE| I Session

:ﬂ Desktop

£ My Documents

% working Directory

Metwark Meighborbood File name: format-katalog_list frn
Date modified: 16-Dec-10 02:47:10 P

Freview «

¥ File name: | format-katalog_list frm | T_l,lpelFu:nrmat[“.frm] v|

Folder Tree = [ Open 'H Cancel ]
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> Nyni se nas systém zeptd, zdali chceme zachovat i sou¢asné razitko s kusovnikem, paklize zvolite Keep/Keep All, budete
mit ve vykresu jak razitko tak i tabulku se seznamem soucasti.

96. Zvolte Remove All pro odebrani veskerého predchoziho formatovani.

Format Tables El

Single farmat table

[ Keep ][ Remaove ]

All format tables

[ Keep Al ] [ Remove Al ]

> Nyni madme pfipraven prazdny list s vyplnénou tabulkou se seznamem soucasti mlynku na maso.
> Tabulku je nejprve vhodné seradit dle pozic.

97.V menu Table Spust'te prikaz Repeat Region. ! SITHO
98. V Menu Manageru zvolte Sort Regions a oznacte tabulku. 2 PODLOZKA
99, V nabidce SORT REGION zvolte Add (obr. vievo).
100. Poté zvolte Forward (coZ znamend Fazeni sestupné). 3 KL 1A
101. Poté kliknéte na libovolné Cislo pozice. 1 SROUB
102. Trikrat stisknéte prostiedni tlacitko pro ukonceni ptikazu.
. v . v . LK
» Tabulka se nam seradila dle pozic sestupné (viz obr. vpravo). ’ OSI1¢HkA
6 TYCKA
p TEL REGIONS ; UROJET
Sork Regions 7
m—— B SROUB_KL 1KY
S0R, LECaICIM
W oL REe w SORT ORDER
o g VICKD
Forvaard
1o TIE;
_ Backward
Edit I SNEH
B E TELO
Done
Qi Pozice |Nazew
MASOVY MLYNEK SPS 2285

» Ulozeny rozpad sestavy vytvoreny v jednom z predchozich tutoriall si nyni zobrazime do vykresu.
103. Prepnéte se do objemového modelare.

104. V menu View --> Explode spust'te ptikaz Explode View.

105. Vytvorte pohled s nazvem ISO dle obrazku.

[0
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106. Prepnéte se zpét do rezimu tvorby vykresu.
107. Kliknéte pravym tlacitkem v listu 2 kamkoliv na vykres a zvolte Insert General View...

108. Zvolte No Combined State.

. Select Combined State @

Combined state names

Mo Combined State
DEFALLT ALL

[ Do not prompt for Combined State

Cancel

109. Na zaloZce View States aktivujte volbu Explode components in view (viz obr.).

[ | Drawing View rz|
Ea.tegones Combined state

Wiew Type

Visible Area | Mo Combined State v|

Scale

Sections

B Explode view

\él:;‘nD isplay Explode components in view

Alignment

Azzembly explode state | Default b

Customize Explode State

Simplified represzentation

Simplified representation | DEFAULT REF b

[ 0K, ] [ Cancel ] [ Apply ]

110. Vyberte pohled ISO, stinovani a zobrazeni tecnych hran urcete dle obrazku.

KATALOGOVY LIST MASOVEHO MLYNKU SPS 2285

T

FoLazen

FTis

B

B

TiEs

oy

TP AL

i

g

T

o

e [haer

ST KLTMEN PS5 2505
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111. V menu Table --> spust'te pfikaz BOM Balloons...
112. Zvolte poloZku Set Region a vyberte tabulku.
113. Zvolte poloZku Create Balloon, vyberte tabulku a poté vyberte z Menu Manageru moznost Show All.

114. Upravte polohu pozic dle obrazku.

115. K zobrazenym komponentam dopiste poznamky dle obrazku.

MAZAT POUZE ZIVOCISNYM TUKEM

=
IALISOVAT DO KL IKY
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